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Resumen de cambios

EC Fecha Revisión Descripción

EC000348 Abril de 2008 A Versión inicial

EC001137 Mayo de 2009 AB Actualizado con las siguientes funciones:
■ Módulo de expansión de acceso (AEM): 

consulte las secciones siguientes para obtener 
más detalles:

■ “Módulo de expansión de acceso” en la 
página 15

■ “Operaciones CAP” en la página 70
■ “Operaciones AEM” en la página 74
■ “Tareas de administración de CAP 

giratorio y de AEM” en la página 118
■ “Tareas de administración de cartuchos” 

en la página 130
■ “Tareas de administración de la puerta de 

seguridad AEM” en la página 183
■ “Particiones y CAP giratorios y de AEM” 

en la página 267
■ “Tareas de utilidad de la puerta de 

seguridad AEM” en la página 467
■ “Tareas de operaciones manuales” en la 

página 474
■ FIGURA B-5, “Paredes de módulo de 

expansión de acceso” en la página 511
■ Cambios de capacidad de la biblioteca sin 

interrupción. Consulte “Cambios de 
capacidad sin interrupción” en la página 215. 

■ Particiones sin interrupción. Consulte “Parti-
ciones sin interrupción” en la página 273. 

■ Mensajes de alertas de estado. Consulte 
“Mensajes de alertas de estado” en la 
página 69. 
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EC001137
continúa

Mayo de 2009 AB ■ Informes sobre el control de energía de la 
biblioteca. Consulte la información siguiente:

■ “Visualización del informe sobre el control 
de energía de la biblioteca de las “últimas 
24 horas”” en la página 111

■ “Visualización del informe sobre el control 
de energía de la biblioteca del “último 
mes”” en la página 113

■ “Visualización del informe sobre el control 
de energía de la biblioteca del “último 
año”” en la página 115

AA ■ Informes de eventos de medios y unidades. 
Consulte la información siguiente:

■ “Visualización de Media Events Report” 
en la página 148

■ “Visualización de Drive Events Report” en 
la página 163 

■ “Visualización de Drive Media Events 
Report” en la página 165 

■ Archivo de registro de instantáneas. Consulte 
la información siguiente:

■ “Archivo de registro de instantáneas de 
biblioteca” en la página 409

■ “Transferencia del archivo de registro de 
instantáneas de biblioteca” en la 
página 428

EC Fecha Revisión Descripción
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Prefacio

Esta guía está destinada principalmente a operadores y administradores de sistema 
de la biblioteca SL3000. También la puede utilizar toda persona que sea socio o 
representante de asistencia de Sun StorageTek. 

La mayor parte de la información corresponde al hardware de la biblioteca, la Consola 
de biblioteca StorageTek y operaciones relacionadas. Para obtener información 
específica de unidades o comandos de software de aplicaciones cliente, consulte la 
documentación correspondiente de la unidad o el software. 

Organización

Capítulo 1 Introducción de SL3000. Descripción general de las características y funciones del 
sistema de biblioteca modular Sun StorageTek SL3000. 

Capítulo 2 StorageTek Library Console. Temas y procedimientos para la instalación y el uso de la 
interfaz gráfica de usuario de SL Console. 

Capítulo 3 Operaciones automatizadas de la biblioteca SL3000. Temas y procedimientos para el 
uso de SL Console para configurar, administrar y supervisar la biblioteca SL3000 en 
modo automático. 

Capítulo 4 Licencia. Temas, procedimientos y referencia de pantallas para la instalación y 
administración de las licencias de funciones de SL3000. 

Capítulo 5 Capacidad según demanda. Temas, procedimientos y referencia de pantallas para la 
instalación y administración de la capacidad autorizada de SL3000.

Capítulo 6 Particiones de biblioteca. Temas, procedimientos y referencia de pantallas para la 
instalación y administración de particiones de la biblioteca SL3000.

Capítulo 7 Diagnósticos y utilidades de SL Console. Temas y procedimientos para el uso de 
SL Console para realizar diagnósticos y funciones de utilidades de la biblioteca 
SL3000. 

Capítulo 8 Operaciones manuales. Temas y procedimientos para un uso seguro de la biblioteca 
SL3000 en modo manual. 

Apéndice A Direcciones de recursos de biblioteca. Información de referencia sobre direcciones de 
celdas de almacenamiento, CAP y unidades que se utilizan con la biblioteca SL3000. 
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Mensajes de alerta
Los mensajes de alerta llaman la atención del usuario sobre información que es 
especialmente importante o que tiene una relación única con el gráfico o texto principal.

Nota: Una nota proporciona información adicional que es de especial interés. Una nota 
puede indicar excepciones a reglas o procedimientos. 

Atención: Un aviso de atención informa al lector de condiciones que podrían 
ocasionar daño al hardware, corrupción de datos, corrupción del software de 
aplicación, o problemas de salud a largo plazo en las personas. Un aviso de atención 
siempre precede a la información a la que pertenece.

Aviso: posible daño físico. Un aviso alerta al lector sobre condiciones que 
podrían ocasionar una lesión o la muerte. Un aviso siempre precede a la 
información a la que pertenece.

Apéndice B Diagramas de pared. Diagramas detallados de distribuciones de celdas de 
almacenamiento, CAP y unidades. 

Apéndice C Manejo de cartuchos. Información de referencia sobre las etiquetas y el uso de 
cartuchos en la biblioteca SL3000. 

Apéndice D Servidor SL Console en Web. Temas y procedimientos para la instalación y 
configuración del servidor SL Console en Web. 

Índice Lista de los temas incluidos en este manual por orden alfabético.
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Convenciones
Las convenciones tipográficas subrayan palabras, frases y acciones especiales en esta 
publicación.

Elemento Ejemplo Descripción de convención

Botones MENÚ Fuente y mayúsculas siguen la 
configuración de la etiqueta del 
producto

Comandos Mode Select Mayús. inicial

Títulos de documento System Assurance Guide Fuente en cursiva

Énfasis no o debe Fuente en cursiva

Nombres de archivo fsc.txt Fuente monospace

Vínculos de hipertexto Figura 2-1 en página 2-5 Azul (se imprime en negro en las 
publicaciones impresas)

Indicadores Open Fuente y mayúsculas siguen la 
configuración de la etiqueta del 
producto

Nombres de cables TERMPWR Todo en mayús.

Teclas de teclado <Y> 
<Intro> o 
<Ctrl+Alt+Delete>

Fuente y mayúscula siguen la 
configuración de la etiqueta del 
producto; junto entre corchetes

Nombres de menú Menú Configuration Mayús. sigue la configuración de 
etiqueta del producto

Parámetros y variables Dispositivo = xx Fuente en cursiva

Nombres de ruta c:/mydirectory Fuente monospace

Nombres de puerto o 
conector

SER1 Fuente y mayúsculas siguen la 
configuración de la etiqueta del 
producto; de lo contrario, todo en 
mayúscula

Posiciones de cortacircuitos, 
cables e interruptores

ON Fuente y mayúsculas siguen la 
configuración de la etiqueta del 
producto; de lo contrario, todo en 
mayúscula

Texto de pantalla (incluyendo 
capturas de pantalla, 
mensajes de pantalla y 
entradas de usuario)

descarga Fuente monospace

Nombres de interruptor Power Fuente y mayúsculas siguen la 
configuración de la etiqueta del 
producto

Direcciones URL http://www.sun.com Azul (se imprime en negro en las 
publicaciones impresas)
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Documentación relacionada

Publicaciones de biblioteca modular SL3000 Número de pieza

SL3000 Systems Assurance Guide 3161941xx

SNMP Guide for SL3000 Libraries 3161945xx

SL3000 Troubleshooting Guide 4186091xx

Documentación sobre unidades de cinta Número de referencia

Hewlett Packard Ultrium Tape Drive Manual Se incluye CD con unidad 

IBM Ultrium Tape Drive Manual Se incluye CD con unidad

T10000 Tape Drive Installation Manual 96173

T10000 Tape Drive Service Manual 96175

T10000 Virtual Operator’s Panel User’s Guide (for Service Representatives) 96180

T9840 Tape Drive User’s Reference Manual 95739

T9x40 Tape Drive Installation Manual 95879

T9x40 Tape Drive Service Reference Manual 95740

Publicaciones de software de administración de cintas Número de referencia

Software de biblioteca de sistema de cartuchos automático (ACSLS) 

ACSLS Administrator’s Guide 3161201xx

ACSLS Messages 3161202xx

ACSLS Quick Reference 3161204xx

Publicaciones MVS de componente de software del host (HSC)

HSC Configuration Guide 3126422xx 

HSC Messages and Codes Guide 3126425xx 

HSC Operator’s Guide 3126423xx 

HSC Reference Summary Guide 3126426xx 

HSC System Programmer’s Guide 3126424xx 

Otras publicaciones Número de referencia

Product Regulatory and Safety Compliance Manual 3161956xx

American National Standard Dictionary for Information Processing Systems ANSI X3/TR-1-82

American National Standard Magnetic Tape and Cartridge for Information 
Interchange 

ANSI X3B5/87-009
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Magnetic Tape Labels and File Structure for Information Interchange ANSI X3.27-1978

SCSI-3 Parallel Interface (SPI) ANSI X3T9.2/91-010R7

Small Computer System Interface ISO 9316:1989

Fibre Optics User's Guide 9433

Enlace de publicaciones

SunSolve o docs.sun.com
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Información adicional
Sun Microsystems, Inc. (Sun) ofrece varios métodos para obtener información adicional. 

Sitio Web externo de Sun 
El sitio Web externo de Sun ofrece información sobre marketing, productos, eventos, 
datos de la compañía y servicios. A este sitio Web externo puede acceder cualquier 
persona que tenga un explorador web y conexión a Internet.

La dirección URL es: http://www.sun.com 

La dirección URL para información específica de la marca Sun StorageTek es: 

http://www.sun.com/storagetek 

SunSolve y vínculos útiles
SunSolve y los vínculos de Sun que se muestran a continuación son sitios Web que 
permiten a los usuarios buscar en documentación técnica, descargas, actualizaciones, 
características, artículos y el manual de sistemas de Sun.

■ Descargas de firmware de la biblioteca y códigos SL Console:

http://http://www.sun.com/download/index.jsp 

■ Controladores: http://www.sun.com/download/index.jsp 

■ Documentación (cliente): http://docs.sun.com/app/docs 

■ Información general de productos:

http://www.sun.com/storagetek/products.jsp 

■ Sitio externo de SunSolve: http://sunsolve.sun.com 

■ Manual de sistemas Sun (clientes):

http://sunsolve.sun.com/handbook_pub/validateUser.do?target=
index 

■ Servicios de formación Sun – Training: http://www.sun.com/training 

Sitio de socios
El sitio de socios Sun StorageTek es para socios con un acuerdo de socio StorageTek. 
Este sitio incluye información sobre productos, servicios, servicio al cliente, próximos 
eventos, programas de formación y herramientas de ventas para ofrecer asistencia a los 
socios de StorageTek. El acceso a este sitio está restringido. En la página de inicio de 
sesión de socios Partners Login, los empleados y los socios actuales de Sun que no 
tienen acceso pueden solicitar un ID de inicio de sesión y una contraseña, y los futuros 
socios pueden rellenar una solicitud para ser distribuidores de StorageTek. 

http://www.sun.com/partners 
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CAPÍTULO 1

Introducción de SL3000 

SL3000 es la última adición a la familia de bibliotecas modulares Sun StorageTek, que 
incluye los sistemas de bibliotecas modulares SL500 y SL8500. 

FIGURA 1-1 Sistema de biblioteca modular SL3000

En este capítulo se presenta la biblioteca SL3000 y sus componentes y configuraciones, 
con los siguientes temas:

■ “Características de SL3000” en la página 2

■ “Diseño modular” en la página 3

■ “Módulo básico” en la página 7

■ “Módulo de expansión de unidades” en la página 10

■ “Módulo de expansión de cartuchos” en la página 13

■ “Módulo de expansión de parking” en la página 14

■ “Módulo de expansión de acceso” en la página 15

■ “Unidades de cinta” en la página 17

■ “Puertos de acceso de cartuchos” en la página 19

■ “Unidades robóticas” en la página 20

■ “Opciones de potencia” en la página 22

■ “Refrigeración” en la página 23

■ “Interfaces” en la página 24

■ “Software de administración de biblioteca” en la página 29

■ “Modos operativos” en la página 31
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Características de SL3000 
La biblioteca SL3000 ofrece a los clientes las siguientes ventajas: 

■ Escalabilidad en una capacidad de almacenamiento de 200 a 5821 celdas de 
almacenamiento 

■ Rendimiento (de 1 a 56 unidades de cinta) 

■ Soporte para una variedad de unidades de cinta

■ Soporte de medios combinados con la tecnología Any cartridge, Any slot™ 

■ Accesorios heterogéneos con interfaces estándar 

■ Múltiples programas y opciones de software de administración de biblioteca 

SL3000 se ha diseñado para: 

■ Controlar sistemas abiertos de tamaño mediano a grande y mercados de mainframe 
de nivel de entrada. 

■ Ocupar un espacio de centro de datos estándar con estas medidas aproximadas: 

■ Altura: 198 cm (78 pulg.), 

■ Profundidad: 124 cm (48,8 pulg.), 

■ Longitud: varía entre 91,5 cm (36 pulg.) con un módulo, y 478 cm (188 pulg.) con 
seis módulos 
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Diseño modular 
La biblioteca SL3000 ofrece un diseño modular, que permite a los clientes satisfacer las 
demandas de un entorno de rápido crecimiento y en continuo cambio. 

Módulos 
Existen cinco tipos de módulos en una biblioteca SL3000. El módulo básico es el único 
que es obligatorio. 

■ Módulo básico: sólo uno 

■ Módulo de expansión de unidades (DEM, Módulo de expansión de unidades): uno 
sólo, anexo directamente al lado izquierdo del módulo básico 

■ Módulo de expansión de cartuchos (CEM, Módulo de expansión de cartuchos): hasta 
un total de ocho, con un máximo de cuatro en el lado izquierdo del módulo básico (y 
DEM opcional) y un máximo de cuatro en el lado derecho

■ Módulo de expansión de parking (PEM, Módulo de expansión de parking): se instala 
siempre por pares, uno en cada extremo de la configuración de la biblioteca 

■ Módulo de expansión de acceso (AEM, Módulo de expansión de acceso): uno o dos, 
se instala siempre al extremo de la configuración de la biblioteca. 

Nota: AEM y PEM no se pueden instalar en la misma biblioteca. 

Los módulos se componen de paredes, columnas y filas que albergan celdas de 
almacenamiento de cartuchos, unidades de cinta, puertos de acceso de cartucho (CAP) 
y unidades robóticas (TallBots). 

Tecnología CenterLine
El diseño modular de SL3000 utiliza tecnología CenterLine para equilibrar la carga de 
trabajo y mejorar el rendimiento de la biblioteca. El lado izquierdo del módulo básico 
sirve como eje central. Puede añadir otros módulos a la izquierda y derecha del módulo 
básico. Las columnas situadas a la derecha del eje central tienen números positivos (+) 
y las columnas situadas a la izquierda tienen números negativos (–). 

La FIGURA 1-2 en la página 4 muestra el eje central de la biblioteca y algunas 
configuraciones de módulo posibles, entre las que se incluyen: 

■ Módulo básico sólo 

■ Módulo básico y módulo de expansión de unidades (DEM) 

■ Adición de módulos de expansión de cartuchos (CEM) y módulos de expansión de 
parking (PEM) 
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FIGURA 1-2 Configuraciones de la biblioteca alrededor del eje central 

Configuraciones del módulo básico 
Configuraciones del módulo básico y el módulo de 

expansión de unidades
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Tecnología Any cartridge, Any slot™
Las celdas de almacenamiento de medios combinados se utilizan para guardar los 
cartuchos. Esto permite a la biblioteca SL3000 admitir la tecnología Sun StorageTek 
Any cartridge, Any slot y aceptar una variedad de tipos de medios sin necesidad de 
volver a configurar la biblioteca. 

Los cartuchos se tumban y se colocan en las celdas de almacenamiento con el eje hacia 
abajo y paralelos al suelo. Para evitar el deslizamiento, los cartuchos se sujetan 
mediante clips de retención internos. 

Capacidades físicas 
SL3000 tiene escalabilidad, con capacidades físicas de 200 a 5821 celdas de almacena-
miento. Además, la función de capacidad según demanda permite pagar sólo por la 
capacidad que realmente utiliza y ampliar capacidad con un trastorno mínimo en las 
operaciones de la biblioteca. 

Consulte el Capítulo 5, “Capacidad según demanda” en la página 211 para obtener 
detalles sobre la instalación y administración de la capacidad de almacenamiento de la 
biblioteca. 

Consulte la TABLA 1-1 en la página 6 para conocer en detalle las capacidades físicas 
de cada tipo de módulo. Para calcular el total de celdas de almacenamiento físicas 
accesibles para una configuración, empiece con el recuento de celdas de configuración 
estándar, marcado con un borde grueso, y, a continuación, haga los ajustes apropiados 
de opciones y posiciones. Algunos ejemplos:

■ Módulo básico con panel de operador, un módulo instalado a la derecha, y tres 
conjuntos de unidades: 

320 + 0 + 13 – 55 – 60 = 218 

■ DEM, un módulo instalado a la izquierda, conjuntos de ventanas, un CAP y cuatro 
conjuntos de unidades: 

410 + 88 + 23 – 77 – 66 – 72 – 78 = 228

■ CEM instalado a la izquierda del eje central, un módulo instalado a la izquierda y un 
CAP:

516 + 104 – 78 = 542

■ PEM (siempre instalados por pares), uno con un CAP, uno sin CAP:

308 + 312 – 78 = 542 

Detección de humos e incendios opcional
Los puertos de acceso situados en el techo de los módulos están provistos de un 
dispositivo opcional para la detección de humo o la supresión de incendios. El cliente 
se debe encargar de la instalación y el mantenimiento de este dispositivo.
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TABLA 1-1 Recuento de celdas físicas accesibles por módulo

Independiente 
o 

independiente 
de posición

Módulo adyacente
instalado a la:

Opciones de módulo Derecha Izquierda
Recuento 

total

Módulo básico

Estándar (con ventana de vistas), 
independiente

320

+13 +88

Con panel de operador +0

Con conjuntos de almacenamiento 
de ventanas 

+23

Con segundo conjunto de unidades -55 -66

Con tercer conjunto de unidades -60 -72

Módulo de expansión de unidades (DEM)

Estándar (con ventana de vistas y 
sin CAP)

— 410 +88

Con conjuntos de almacenamiento 
de ventanas

— +23

Con CAP — -77

Con segundo conjunto de unidades — -55 -66

Con tercer conjunto de unidades — -60 -72

Con cuarto conjunto de unidades — -65 -78

Módulo de expansión de cartuchos (CEM)

Estándar (sin CAP), a la izquierda 
del eje central 

516 +0 +104

Estándar (sin CAP), a la derecha 
del eje central 

620 +0 +0

Con CAP -78

Módulo de expansión de parking (PEM)

Estándar (sin CAP), a la izquierda 
del eje central

308

Estándar (sin CAP), a la derecha 
del eje central

312

Con CAP -78

Módulo de expansión de acceso (AEM)

No se puede utilizar para 
almacenamiento a largo plazo 

0

Recuento de total de celdas de almacenamiento accesibles 
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Módulo básico 
El módulo básico ofrece almacenamiento de cartuchos y un mínimo de ocho unidades 
de cinta. Este módulo incluye las configuraciones de potencia, robótica, módulos 
electrónicos, puerto de acceso de cartuchos, celdas de almacenamiento de cartuchos, 
unidades de cinta y controles de operador. Centraliza la infraestructura para todos los 
demás módulos de la biblioteca. 

Se requiere un único módulo básico para todas las instalaciones de biblioteca.

FIGURA 1-3 Módulo básico: vista frontal

Configuraciones Capacidad 

8 unidades 
16 unidades 
24 unidades 

8 unidades, CAP 
16 unidades, CAP 
24 unidades, CAP 

Consulte la 
TABLA 1-1 en 

la página 6. 

8 unidades, CAP y panel o ventana de 
operador 
16 unidades, CAP y panel o ventana de 
operador 
24 unidades, CAP y panel o ventana de 
operador 

Dimensiones Medidas 

Alto De 197 cm (77,625 pulg.) a 
200 cm (78,63 pulg.) totalmente ajustado 

Ancho  76,76 cm (30,22 pulg.) sin cubiertas1

91,5 cm (36 pulg.) con cubiertas 

Profundidad 121,9 cm (48 pulg.) sin mangos
124 cm (49 pulg.) con mangos 

Peso 265 Kg. (584 lb.) marco sólo 

Espacio libre para 
servicio 

Las dos puertas 
abiertas 

Parte frontal: 46 cm (18 pulg.) 
Parte posterior: 81 cm (32 pulg.) 
262 cm (103 pulg.) 

Espacio libre 
lateral2

Refrigeración: 5 cm (2 pulg.) 
Instalación: 91 cm (36 pulg.) 

Notas: 
1. Cuando se instalan módulos adicionales, se quitan las 

cubiertas del módulo básico y se vuelven a colocar en los 
extremos del último módulo de la cadena. 

2. Se necesita para instalar o quitar las cubiertas laterales; se 
descuelgan y se despegan de los soportes. 
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La parte frontal del módulo básico incluye los siguientes componentes: 

■ Puerto de acceso de cartuchos (CAP) único de doble magazine para 26 cartuchos 

■ Puerta de servicio para acceso a la biblioteca 

■ Panel frontal con tres indicadores LED: Library Active (biblioteca activa), Service 
Required (servicio obligatorio) y Wait (espere). 

■ Ventana de vistas estándar, que se puede reemplazar por una de estas dos opciones:

■ Panel de operador con pantalla táctil 

■ Celdas de almacenamiento de cartuchos

El módulo básico puede alojar hasta 24 unidades de cinta en cualquier combinación que 
la biblioteca admita; consulte “Unidades de cinta” en la página 17 para obtener una 
lista y la descripción. La configuración mínima incluye una bahía de unidades que 
puede tener de una a ocho unidades. Se pueden añadir dos bahías de unidades 
adicionales para alojar 8 o 16 unidades más, para un máximo de 24 unidades. 

Nota: Añadir una bahía de unidades sustituye aproximadamente de 55 a 72 celdas de 
almacenamiento adicionales, según la configuración de la biblioteca. Consulte la 
TABLA 1-1 en la página 6 para conocer el número exacto. 

Consulte la FIGURA 1-4 en la página 9 para obtener una vista de la parte posterior del 
módulo básico. La puerta trasera permite el acceso a:

■ Módulo de control de electrónica (ECM) 

■ Unidades de distribución de potencia (PDU) 

■ Suministros de potencia CC 

■ Unidades de cinta 

■ Dos espacios de bastidor de una unidad (1 unidad = 44,5 mm [1,75 pulg.]) para el 
montaje vertical de dispositivos auxiliares, como conectores Ethernet 

Nota: El módulo básico no contiene espacio de bastidor de 19 pulgadas para uso 
general. 

Consulte la FIGURA B-1, “Paredes de módulo básico” en la página 506 para obtener un 
diagrama detallado de la distribución de la pared. 
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FIGURA 1-4 Módulo básico: esquema de vista de la parte trasera 

Descripción 

Suministros de potencia CC de robótica 
■ DCPS 1 y 2 o 3 

Primera bahía de unidades (arriba)
La primera bahía de unidades es 
estándar.
Las bahías de unidades se añaden de 
arriba a abajo. 



Segunda bahía de unidades (centro) 




Tercera bahía de unidades (abajo) 

Módulo de control de electrónica 

Tarjetas HBC y HBT 
Tarjeta Fibre Channel MPU2 (no se 
muestra)
Dos suministros de potencia cPCI 
Dos ventiladores de refrigeración 
Dos interruptores de potencia (N+1 
y 2N)

Unidades de distribución de potencia 
CA (hasta dos)

■ PDU 1 y PDU 2 

Suministros de potencia CC de unidad 
(hasta ocho) 

■ DCPS 4 a 11 
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Módulo de expansión de unidades 
El módulo de expansión de unidades (DEM) opcional proporciona a la biblioteca unida-
des de cinta adicionales y capacidad de almacenamiento de cartuchos. Un DEM se pue-
de incluir en una instalación de biblioteca, siempre a la izquierda del módulo básico. 

FIGURA 1-5 Módulo de expansión de unidades: vista frontal

Configuraciones Capacidad 

8 unidades 
16 unidades 
24 unidades 
32 unidades 

8 unidades, CAP 
16 unidades, CAP 
24 unidades, CAP 
32 unidades, CAP 

Consulte la 
TABLA 1-1 en 

la página 6. 

8 unidades, CAP y panel o ventana de 
operador 
16 unidades, CAP y panel o ventana de 
operador 
24 unidades, CAP y panel o ventana de 
operador 
32 unidades, CAP y panel o ventana de 
operador 

Dimensiones1 Medidas 

Alto De 197 cm (77,625 pulg.) a 
200 cm (78,63 pulg.)

Ancho 
DEM sólo
Básico y DEM 

 
76,76 cm (30,22 pulg.) 
168,2 cm (66,22 pulg.) con cubiertas2

Profundidad 121,9 cm (48 pulg.) sin mangos
124 cm (49 pulg.) con mangos 

Peso 265 Kg. (584 lb.) marco sólo 

Espacio libre para 
servicio 

Las dos puertas 
abiertas 

Parte frontal: 46 cm (18 pulg.) 
Parte posterior: 81 cm (32 pulg.) 
262 cm (103 pulg.) 

Espacio libre 
lateral3 

Refrigeración: 5 cm (2 pulg.) 
Instalación: 91 cm (36 pulg.) 

Notas: 
1. Las dimensiones del DEM son las mismas que las del módulo 

básico. 
2. Cuando se instalan módulos adicionales, se quitan las 

cubiertas del módulo básico y se vuelven a colocar en los 
extremos del último módulo de la cadena. 

3. Se necesita para instalar o quitar las cubiertas laterales; se 
descuelgan y se despegan de los soportes. 



Módulo de expansión de unidades

418605401 • Revisión AB Capítulo 1 Introducción de SL3000 11

La parte frontal del DEM incluye espacio para los siguientes componentes: 

■ Puerta de servicio para acceso a la biblioteca (estándar) 

■ Panel frontal con tres indicadores LED: Library Active (biblioteca activa), Service 
Required (servicio obligatorio) y Wait (espere). 

■ Puerto de acceso de cartuchos (CAP) opcional de doble magazine para 26 cartuchos 

■ Ventana de vistas estándar, que se puede reemplazar por una de estas dos opciones:

■ Panel de operador con pantalla táctil, si no está ya en el módulo básico 

■ Celdas de almacenamiento de cartuchos

El DEM estándar se suministra con ranuras de unidad para admitir hasta ocho 
unidades de cinta. Las ranuras de unidad del DEM se pueden aumentar, en 
incrementos de ocho, hasta un máximo de 32. 

Nota: Añadir una bahía de unidades sustituye aproximadamente de 55 a 78 celdas de 
almacenamiento adicionales, según la configuración de la biblioteca. Consulte la 
TABLA 1-1 en la página 6 para conocer el número exacto. 

El DEM incorpora un sistema de potencia adicional para admitir las unidades de cinta 
adicionales. 

Consulte la FIGURA 1-6 en la página 12 para obtener una vista de la parte posterior del 
DEM. La puerta trasera permite el acceso a:

■ Unidades de cinta 

■ Suministros de potencia CC de unidad

■ Unidades de distribución de potencia CA (PDU)

Consulte la FIGURA B-2, “Paredes de módulo de expansión” en la página 507 para 
obtener un diagrama detallado de la distribución de la pared. 
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FIGURA 1-6 Módulo de expansión de unidades: esquema de vista de la parte trasera 

Descripción 

Primera bahía de unidades (arriba)
La primera bahía de unidades es 
estándar. 

Las bahías de unidades se añaden 
de arriba a abajo.


Segunda bahía de unidades 





Tercera bahía de unidades 





Cuarta bahía de unidades 




Unidades de distribución de 
potencia CA (hasta dos) 

■ PDU 3 y PDU 4 

Suministros de potencia CC de 
unidad (hasta ocho) 

■ DCPS 15 a 22 
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Módulo de expansión de cartuchos 
El módulo de expansión de cartuchos (CEM) opcional proporciona capacidad y 
aumento de celdas de almacenamiento adicionales. En este módulo no hay unidades 
de cinta. Se admite un máximo de ocho CEM en una sola biblioteca.

Los siguientes puntos optimizarán el rendimiento de la biblioteca: 
■ Como mejor práctica, los CEM se deben alternar en ambos lados del módulo básico 

y un DEM opcional, con el CEM inicial instalado directamente a la derecha del 
módulo básico. Esto reduce la cantidad de trayecto de robótica y ofrece el mejor uso 
de las celdas de almacenamiento de cartuchos. 

■ Si se han instalado TallBot redundantes, los dos CEM externos se convierten en 
módulos de extensión de parking (PEM). Esto proporciona áreas para que los TallBot 
no se tropiecen entre sí. 

Cada CEM añade hasta 620 celdas de almacenamiento físicas para cartuchos de datos. 
La capacidad varía en función de la dirección de crecimiento (izquierda o derecha) y la 
presencia de un CAP. 

Consulte la FIGURA B-3, “Paredes de módulo de expansión de cartuchos” en la 
página 508 para obtener un diagrama detallado de la distribución de la pared. 

FIGURA 1-7 Módulo de expansión de cartuchos con módulo básico 

         Módulo básico     |               CEM

Configuración 
(junto a básico con 24 unidades) Capacidad 

CEM (expansión a la izda.) 
CEM con CAP opcional (izda.) Consulte la 

TABLA 1-1 en la 
página 6. CEM (expansión a la dcha.) 

CEM con CAP opcional (dcha.) 

Dimensiones Medidas

Alto De 197 cm (77,625 pulg.) a 200 cm 
(78,63 pulg.) totalmente ajustado 

Ancho 76,75 cm (30,22 pulg.) sin cubiertas1

La cubierta añade 7,62 cm (3 pulg.) 

Profundidad 80 cm (31,5 pulg.) 

Peso 175 Kg. (385 lb.) marco sólo

Espacio libre 
lateral2 

Refrigeración: 5 cm (2 pulg.) 
Instalación: 91 cm (36 pulg.) 

Espacio libre para 
servicio, frontal y 
posterior 

No se necesita ninguno 

Notas: 
1. Cuando se instalan módulos adicionales, se quitan 

las cubiertas del módulo básico y se vuelven a colo-
car en los extremos del último módulo de la cadena. 

2. Se necesita para instalar o quitar las cubiertas latera-
les; se descuelgan y se despegan de los soportes. 
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Módulo de expansión de parking 
Los módulos de expansión de parking (PEM) opcionales proporcionan capacidad y 
aumento de celdas de almacenamiento adicionales, así como espacio para que los 
TallBot defectuosos se “aparquen” para recibir asistencia. El espacio de parking hace 
inaccesibles las tres columnas de celdas de almacenamiento situadas más al exterior de 
las paredes frontal y trasera. Las celdas inaccesibles se pueden dejar fuera del módulo o 
se pueden instalar para una posterior conversión del PEM a un CEM. Los PEM no 
incluyen unidades de cinta. 

Los PEM sólo se utilizan con TallBot redundantes y siempre se instalan por pares. Debe 
ser los últimos módulos situados en los lados derecho e izquierdo de la cadena de la 
biblioteca. 

Nota: AEM y PEM no se pueden instalar en la misma biblioteca. 

Consulte la FIGURA B-4, “Paredes de módulo de expansión de parking” en la 
página 510 para obtener un diagrama detallado de la distribución de la pared. 

FIGURA 1-8 Módulo de expansión de parking 

Configuración Capacidad 

PEM (expansión a la izda.) 308 celdas
PEM (expansión a la dcha.) 312 celdas 
CAP: 78 celdas
Se instalan por pares para la función de 
TallBot redundante. 

Consulte la 
TABLA 1-1 en 

la página 6. 

Dimensiones1 Medidas

Altura: De 197 cm (77,625 pulg.) a 
200 cm (78,63 pulg.) totalmente ajustado 

Ancho: 76,75 cm (30,22 pulg.) sin cubiertas
77,5 cm (30,5 pulg.) con cubiertas2

Profundidad: 80 cm (31,5 pulg.) 

Peso: 103,4 Kg. (277 lb) marco sólo

Espacio libre lateral Refrigeración: 5 cm (2 pulg.) 
Instalación: 91 cm (36 pulg.)3

Espacio libre para 
servicio frontal y 
posterior 

No se necesita ninguno

Notas: 
1. Las dimensiones del PEM son las mismas que las del módulo 

de expansión de cartuchos. 
2. Cuando se instalan módulos adicionales, se quitan las 

cubiertas del módulo básico y se vuelven a colocar en los 
extremos del último módulo de la cadena. 

3. Se necesita para instalar o quitar las cubiertas laterales; se 
descuelgan y se despegan de los soportes. 
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Módulo de expansión de acceso 
El módulo de expansión de acceso (AEM) contiene las funcionalidades siguientes: 

■ Carga y descarga a granel de hasta 234 cartuchos cada vez en y de la biblioteca 
SL3000 a través del CAP de AEM. Fundamentalmente, el AEM es un CAP muy 
grande, con todas características de un CAP, como estado conectado y desconectado, 
capacidad de ser compartido por particiones, etc. Las ranuras de cartuchos en el 
AEM no se pueden utilizar para el almacenamiento de cartuchos a largo plazo. 

■ Mantenimiento del robot sin interrupción mediante el empleo de una puerta de 
seguridad (o puerta "garaje"), que aísla un robot defectuoso de los otros módulos de 
la biblioteca. Un representante de servicios Sun puede acceder de forma segura al 
robot desactivado a través de la puerta de acceso AEM mientras la biblioteca 
permanece conectada. Si se instalan robots redundantes, la biblioteca puede 
continuar el funcionamiento de forma normal a través del robot funcional restante. 

La biblioteca puede incluir uno o dos AEM. El AEM debe instalarse en el extremo final 
de la cadena de la biblioteca. Si la biblioteca contiene robots redundantes, se deben 
instalar dos AEM, uno en cada extremo de la biblioteca.

Nota: AEM y PEM no se pueden instalar en la misma biblioteca. 

Los AEM no incluyen unidades de cinta. 

Consulte “Operaciones AEM” en la página 74 para obtener más detalles sobre el uso y 
las funciones de AEM. 
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FIGURA 1-9 Módulo de expansión de acceso 

Configuración Capacidad 

AEM (expansión a la izda.) 234 celdas CAP
AEM (expansión a la dcha.) 234 celdas CAP 
Se instalan por pares para la función de 
TallBot redundante. 

Consulte la 
TABLA 1-1 en 

la página 6. 

Dimensiones Medidas

Altura: De 197 cm (77,625 pulg.) a 
200 cm (78,63 pulg.) totalmente ajustado 

Ancho: 91,5 cm (36,0 pulg.) sin cubiertas
96,5 cm (38,0 pulg.) con cubiertas1

Profundidad: 80 cm (31,5 pulg.) 

Peso: 204,12 Kg. (450 lb.)

Espacio libre lateral Refrigeración: 5 cm (2 pulg.) 
Instalación: 91 cm (36 pulg.)2

Espacio libre para 
servicio 

Parte frontal: 58.7 cm (23,1 pulg.)
Parte posterior: Necesita acceso para 
Ethernet; no hay cubierta. 

Notas: 
1. Cuando se instalan módulos adicionales, se quitan las 

cubiertas del módulo básico y se vuelven a colocar en los 
extremos del último módulo de la cadena. 

2. Se necesita para instalar o quitar las cubiertas laterales; se 
descuelgan y se despegan de los soportes. 
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Unidades de cinta 
Consulte la TABLA 1-2 para conocer las unidades de cinta, las interfaces de ruta de 
datos y los tipos de medios compatibles con la biblioteca SL3000. 

Puede instalar hasta 56 unidades en una biblioteca, de la siguiente manera:

■ Hasta 24 en el módulo básico

■ Hasta 32 en un DEM 

El número real de unidades varía según la opción de potencia CA y los tipos de 
medios. Consulte TABLA 1-3 para obtener más detalles. 

TABLA 1-2 Unidades de cinta compatibles 

Proveedor Tipo de unidad Tipo de interfaz Medio

Sun StorageTek1 T9840C 
T9840D (compatible con 
cifrado) 

Fibre Channel
FICON
ESCON

9840 
compatible con VolSafe

Sun StorageTek T10000A, T10000B 
(compatible con cifrado) 

2 Gb/4 Gb 
Fibre Channel 
FICON

T10000 Standard, Sport y 
VolSafe 

HP LTO 3 
LTO 4 (compatible con 
cifrado) 

Fibre Channel LTO 3
LTO 4 
WORM (LT) 
LTO 2 (sólo lectura)4

IBM LTO 3 
LTO 4 

Fibre Channel LTO 3 
LTO 4 
WORM (LT) 
LTO 2 (sólo lectura)2

Notas:
1. Las unidades StorageTek T9840, modelos A y B, y unidades T9940, modelos A y B, no son 

compatibles.
2. Los medios LTO 2 se admiten para compatibilidad inversa de productos LTO (migración de datos).

TABLA 1-3 Opciones de potencia y número de unidades

110-127 PDU 220-240 PDU

Módulo básico DEM Módulo básico DEM

T9840 12 14 24 32

T10000 13 16 24 32

LTO 3, 4 24 32 24 32

Medios 
combinados

varía cualquier intercombinación
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Bandejas de unidades 
En SL3000, una sola bandeja de unidades universal aloja todos los tipos de unidades de 
cinta e interfaces. Las bandejas de unidades SL3000 tienen dos capas, de la siguiente 
manera: 

■ El suministro de potencia y las conexiones están en la parte de arriba. 

■ La unidad de cinta está bajo el suministro de potencia. 

Cada bandeja de unidades se desliza en una bahía de ocho unidades. 

Las tarjetas y los cables de suministro de potencia interna son únicos, según el tipo de 
unidad y la interfaz de la bandeja de unidades. Los cables a la unidad están en la parte 
trasera de la bandeja de unidades y la biblioteca, y, después, pasan por el sistema de 
liberación de tensión. El acceso a cables de tierra y techo está permitido. 

FIGURA 1-10 Bandeja de unidades 

Medidas 

Altura: 16,5 cm (6,5 pulg.)

Ancho: 16,5 cm (6,5 pulg.)

Profun-
didad: 

45 cm (18,5 pulg.)



Puertos de acceso de cartuchos

418605401 • Revisión AB Capítulo 1 Introducción de SL3000 19

Puertos de acceso de cartuchos 
El puerto de acceso de cartuchos (CAP) es un cilindro rotatorio montado en vertical con 
dos magazines de 13 ranuras extraíbles (un total de 26 celdas). Los CAP se utilizan para 
introducir o expulsar cartuchos de la biblioteca. 

El módulo básico se suministra con un CAP como característica estándar. De forma 
opcional, se puede instalar un CAP en cada módulo de expansión, hasta un máximo de 
diez CAP para la biblioteca. 

Cada CAP tiene su propio conjunto de controles, que se compone de un pequeño 
teclado numérico e indicadores. El CAP y sus magazines giran como una sola unidad. 

Consulte “Operaciones CAP” en la página 70 para obtener detalles sobre el uso de CAP. 

FIGURA 1-11 Puertos de acceso de cartuchos

1. Puertos de acceso de cartuchos 
2. Cubiertas en blanco

Cuando no hay un CAP instalado, se instala una cubierta en blanco. Esto siempre se puede actualizar en el 
futuro para incluir un CAP. 

3. Interfaz de usuario para indicadores y teclado numérico. 

1 2 1 2

3
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Unidades robóticas 
La unidad robótica de una biblioteca SL3000 se denomina TallBot. Cada biblioteca 
puede tener un Tallbot (estándar) o dos (redundante). 

Los TallBot son responsables del movimiento y clasificación (o auditoría) de los 
cartuchos en la biblioteca. 

Las medidas de un TallBotson:

■ Ancho: 30 cm (11,84 pulg.)

■ Profundidad: 39 cm (15,36 pulg.)

■ Peso: 8,6 Kg. (19 lb.)

FIGURA 1-12 TallBot 
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Los Tallbot se conducen a lo largo de dos raíles en la pared trasera de la biblioteca: un 
raíl en la parte de arriba y uno pegado al suelo. 

Dos tiras de cobre se insertan en el raíl superior para proporcionar rutas de señales y 
potencia para el funcionamiento de los TallBot. 

■ La potencia procede de suministros de potencia de carga compartida +48 VDC, 
1200 vatios. 

■ Las señales se reciben y se transmiten entre los Tallbot y el controlador de la 
biblioteca. 

■ Un módulo de activación de potencia en raíles (Rail Power Enable) se instala como 
circuito de seguridad para la potencia de los raíles.

El tratamiento de los cartuchos con los Tallbot incluye: 

■ Recuperación de cartuchos de un CAP

■ Inserción de cartuchos en un CAP

■ Inserción y recuperación de cartuchos en celdas de almacenamiento 

■ Montajes y desmontajes de cartuchos en unidades de cinta 

Los Tallbot contienen un escáner láser de códigos de barras que: 

■ Lee los bloques de configuración en cada módulo durante la inicialización de la 
biblioteca. Consulte la FIGURA B-6 “Bloque de configuración” en la página 512 para 
ver un ejemplo. 

■ Destina celdas CAP y celdas de almacenamiento de cartuchos, y unidades de cinta. 
Los destinos tienen la forma siguiente, similar a la letra “N”: 

|\|

■ Especifica identificadores de volumen (VOLID) de cartuchos durante: 

■ entradas de CAP

■ Auditorías

El TallBot lee identificadores de volumen de cartuchos durante auditorías y entradas 
de CAP sólo. Cada ubicación asignada de cartucho se guarda en la base de datos del 
controlador de biblioteca, y el TallBot utiliza esta ubicación para recuperar el 
cartucho. 

TallBot redundantes (dobles) 
Los TallBot redundantes se ofrecen como una opción de disponibilidad alta. Esto 
permite:

■ Un aumento de velocidad para las operaciones de la biblioteca

■ Un TallBot de reserva en caso de que uno falle.

Esta opción requiere PEM en cada extremo de la biblioteca. Un TallBot defectuoso se 
desconectará él mismo y puede que se mueva, o lo pueden empujar, a uno de los PEM, 
lo que permite a la biblioteca seguir realizando operaciones con un TallBot hasta que se 
pueda programar el tiempo para reemplazar el TallBot defectuoso. 

Los requisitos para las operaciones con un TallBot redundante son:

■ Configuración de potencia 240 VAC, 2N

■ Módulos PEM en cada extremo de la biblioteca 

■ Licencia para TallBot dual 
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Opciones de potencia 

Configuraciones de potencia CA 
Las siguientes opciones de suministro de potencia CA están disponibles:

■ Funciones limitadas: 110 VAC, 50/60 Hz, a 20 amperios (rango: 100-127 VAC, 
50–60 Hz, 16 amperios) 

■ Funciones completas: 220 VAC, 50/60 Hz, a 30 amperios (rango: 200-240 VAC, 
50–60 Hz, 24 amperios) 

Las unidades de distribución de potencia (PDU) están situadas en la parte posterior del 
módulo básico y el módulo DEM opcional. 

Redundancia de potencia
SL3000 ofrece redundancia total para unidades de cinta, unidades robóticas y 
electrónica. Las siguientes opciones de redundancia están disponibles: 

■ N+1: una PDU CA, con un suministro de potencia CC extra para redundancia de 
potencia CC. Esta es la configuración de potencia estándar para SL3000. Esta 
configuración requiere al menos un interruptor de circuito de 20 amperios en el 
panel de servicios del cliente. 

■ 2N: dos PDU para redundancia CA; cada PDU tiene un conjunto de suministro de 
potencia CC (suministros de potencia CC N). Esta configuración requiere un 
segundo suministro de potencia del cliente por separado. 

■ 2N+1: dos PDU para redundancia CA; cada PDU tiene suministros de potencia CC 
extra para redundancia N+1 para cada PDU. La segunda PDU no tiene N+1 para el 
TallBot. 

Potencia CC  
Los suministros de potencia CC a 1200 vatios de carga compartida son necesarios para 
la distribución de +48 VDC para operaciones de TallBot y unidades de cinta. El número 
de suministros de potencia CC necesarios depende de la configuración de la potencia y 
el número total de unidades de la biblioteca. 

También se instala un módulo de activación de potencia en raíles (Rail Power Enable) 
como circuito de seguridad para la potencia de los raíles. Dos suministros de potencia 
cPCI (200 vatios cada uno) distribuyen potencia al módulo de control de electrónica. 
Estos suministros de potencia están situados debajo de la tarjeta HBT: dos a la izquierda 
para N+1, o bien, uno a cada lado para 2N. 
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Refrigeración 
La refrigeración dentro de SL3000 se divide en tres áreas: 

■ Electrónica de biblioteca 

■ Unidades de cinta 

■ Suministros de potencia CC 

Electrónica de biblioteca 
Hay dos ventiladores situados a la derecha del módulo de control de electrónica que 
proporcionan refrigeración para el sistema electrónico de la biblioteca. El aire se mueve 
del suelo y los laterales de la biblioteca y fluye a través de los ventiladores a la parte 
posterior de la biblioteca. 

■ Estos ventiladores están controlados por la tarjeta HBC para un correcto 
funcionamiento. 

■ Un indicador de fallo en ámbar se enciende en el ensamblaje del ventilador para 
indicar que hay un fallo. 

Aunque haya dos ventiladores dedicados, un ventilador es suficiente para proporcionar 
la refrigeración adecuada la biblioteca o el sistema electrónico. No obstante, puesto que 
los ventiladores se pueden reemplazar sin interferir en las operaciones de la biblioteca, 
es preferible sustituir un ventilador defectuoso cuando se ha detectado. 

Unidades de cinta
Cada bandeja de unidades de cinta contiene uno o dos ventiladores para refrigeración. 

La potencia para los ventiladores se suministra a través de la tarjeta de convertidor de 
potencia de unidades de cinta. El aire se lleva desde la parte frontal de la unidad y 
fluye a través del ventilador a la parte posterior de la unidad o la biblioteca. 

Suministros de potencia CC
Cada suministro de potencia CC a 1200 vatios contiene un ventilador que arrastra el 
aire desde la parte frontal de la biblioteca, a través de la parte posterior del suministro, 
y lo expulsa por la parte posterior de la biblioteca. 
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Interfaces 
La biblioteca SL3000 es compatible con los siguientes tipos de interfaces: 

■ Ruta de control de la biblioteca: transfiere comandos de administración de la 
biblioteca, como montajes y desmontajes de cartuchos, entre el host y los 
componentes de la biblioteca. Ningún dato de host está presente en esta interfaz. 

■ Ruta de datos: transfiere datos entre el host y las unidades de cinta. 

■ Interfaz de línea de comandos: permite a un representante de asistencia de Sun 
configurar y diagnosticar la biblioteca.

■ SNMP: permite a los administradores de sistema consultar la biblioteca y recibir 
información sobre posibles problemas. 

■ SL Console: permite a los operadores y administradores de biblioteca configurar y 
administrar la biblioteca desde una interfaz gráfica de usuario. 

Ruta de control de la biblioteca 

Nota: Cuando se integra una nueva biblioteca en una red, se recomienda que el 
administrador de sistemas o de red trabaje en estrecha colaboración con un 
representante de Sun StorageTek para definir la configuración. 

La ruta de control asegura la transferencia de los comandos de administración de la 
biblioteca entre el host y la biblioteca. SL3000 es compatible con los siguientes tipos de 
conexión host para la ruta de control: 

■ Interfaz TCP/IP: protocolo TCP/IP con Ethernet 10/100 Base-T y cables CAT-5 

■ Interfaz- FCSCSI: protocolo SCSI (Small Computer System Interface) y conjunto de 
comandos en una interfaz Fibre Channel física 

Una biblioteca no particionada puede utilizar sólo un tipo de interfaz: FC SCSI o 
TCP/IP. Con la función opcional de particiones, una biblioteca puede conectar con 
varios hosts en una combinación de los dos tipos de interfaces. Consulte el Capítulo 6, 
“Particiones de biblioteca” en la página 259 para obtener más detalles. 

Las direcciones de la biblioteca dependen del tipo de conexión host: 
■ Los host TCP/IP utilizan un esquema de numeración de panel, fila y columna (PRC). 
■ Los hosts FC-SCSI utilizan un esquema de numeración de elementos secuencial, 

donde cada tipo de elemento (celdas de almacenamiento, unidades de cinta y CAP) 
tiene su propio rango secuencial. 

Consulte el Apéndice A, “Direcciones de recursos de biblioteca” en la página 487 para 
detalles completos. 



Interfaces

418605401 • Revisión AB Capítulo 1 Introducción de SL3000 25

Interfaz TCP/IP
El tipo de interfaz TCP/IP utiliza el protocolo TCP/IP en una interfaz física Ethernet, 
(cable CAT-5, Ethernet, 10/100 BaseT). Esta interfaz permite que una de las dos 
plataformas siguientes conecte y comunique con la biblioteca: 

■ Plataformas de sistema abiertas con ACSLS (consulte “Software de biblioteca de 
sistema de cartuchos automático (ACSLS)” en la página 30 para conocer detalles). 

■ Mainframes de empresa con HSC (consulte “Componente de software del host” en la 
página 29 para conocer detalles). 

El controlador de biblioteca coordina todas las operaciones de los componentes dentro 
de la biblioteca y proporciona la conexión de interfaz con el host. 

Conexiones

Existen dos conexiones Ethernet independientes en la tarjeta del controlador de 
biblioteca para comunicaciones del host a la biblioteca. 
■ El puerto 2A proporciona la conexión TCP/IP dual; ésta es una función opcional con 

licencia que incluye redundancia incorporada. 
■ El puerto 2B proporciona la conexión de host principal; ésta es la conexión estándar 

para bibliotecas SL3000.

Ambos puertos cumplen con el estándar del Institute of Electrical and Electronics 
Engineers, IEEE 802.3, para redes Ethernet. Ambos puertos pueden gestionar las 
siguientes funciones: 

■ Método de transmisión 

■ Dúplex medio: transmite datos en sólo una dirección al mismo tiempo 

■ Dúplex completo: transmite datos en dos direcciones de forma simultánea 

■ Velocidad de transmisión 

■ 10Base-T: 10 MB por segundo (Mbps)

■ 100Base-T: 100 MB por segundo (Mbps) 

Red

Puesto que SL3000 se instala en una red, es preferible que la actividad de la biblioteca 
quede aislada del tráfico regular de red. Por tanto, las siguientes redes están presentes: 

■ Red pública: administración de todas las redes asociadas del cliente para los puertos 
de controlador de sistema público, como:

■ Acceso a Internet 

■ Comandos de biblioteca a host 

■ Red privada: administración de todas las redes de la biblioteca internas para los 
puertos de controlador de sistema privado, como:

■ CAP

■ Ruta de control de unidades 

■ Panel de operador local 
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Nota: Se recomienda una conexión de red privada entre la biblioteca y el software de 
administración de host, con un concentrador o un conmutador Ethernet, para obtener 
un rendimiento máximo y problemas mínimos de disposición de recursos. 

Si se requiere una red compartida, estas acciones pueden ayudar con la comunicación 
entre el host y la biblioteca: 

■ Conecte directamente la biblioteca a un conector. 

■ Coloque la biblioteca en su propia subred. 

■ Utilice un conector administrado que pueda:

■ Definir prioridades en puertos para máxima prioridad al host y la biblioteca.

■ Suministrar ancho de banda dedicado entre el host y la biblioteca.

■ Crear una red VLAN entre el host y la biblioteca. 

■ Utilice una red privada virtual (VPN) para aislar el tráfico de host a biblioteca. 

Sun El adaptador de ruta de control 9300 de StorageTek ofrece la conexión de hardware 
para hosts mainframe. Este adaptador de interfaz se instala en el mainframe y convierte 
los datos de la red Ethernet en comandos HLI (Host Library Interface) compatibles. 

Interfaz- FCSCSI
El tipo de interfaz FC-SCSI utiliza el conjunto de comandos SCSI en una conexión Fibre 
Channel física. La implementación Sun StorageTek de Fibre Channel cumple los 
estándares siguientes: 

■ ANSI (American National Standards Institute) 

■ NCITS (National Committee for Information Technology Standards) 

Las aplicaciones compatibles con el protocolo SCSI-3 son necesarias para hosts FC-SCSI.

La topología Fibre Channel recomendada para SL3000 es una estructura de intercambio. 
Una estructura de intercambio proporciona interconexiones dinámicas entre nodos y 
varias conexiones Fibre Channel simultáneas para la red.

Si SL3000 está conectada a un host con interconexión Fibre Channel, automáticamente 
se configura como una topología de intercambio y puede admitir hasta 16 millones de 
puertos conectados en la estructura. 

Consulte el documento SL3000 Interface Reference Manual (PN 3161952xx) para obtener 
una información completa. Este manual contiene información sobre el conjunto de 
comandos SCSI, además de información sobre operaciones Fibre Channel, 
implementaciones de comandos, topologías, cables y conectores. 

Nota: Si bien SL3000 admite la topología de bucles arbitrados, no se recomienda esta 
topología.

Nota: SL3000 no admite la conexión obligada de bucles arbitrados mediante la 
definición de ALPA duros (Arbitrated Loop Physical Addresses). 
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Ruta de datos
La ruta de datos, que es independiente y distinta de la ruta de control de la biblioteca, 
admite la transferencia de datos entre el host y la unidad de cinta. Las rutas de datos de 
host a las unidades de cinta pueden ser Fibre Channel, FICON o ESCON, según las 
características operativas del tipo de unidad. Consulte “Unidades de cinta” en la 
página 17 para obtener más detalles. 

Interfaz de línea de comandos 
La SL3000 interfaz de línea de comandos (CLI) es una interfaz de biblioteca sólo para el 
representante de asistencia de Sun experto y cualificado. Esta interfaz permite a un 
representante de asistencia configurar y diagnosticar problemas con la biblioteca. 

Nota: Los clientes no tienen acceso a la interfaz CLI. 

SNMP
El Protocolo Simple de Administración de Red (SNMP) permite a los administradores 
de sistemas y redes controlar y recibir información sobre el estado de la biblioteca, entre 
la que se incluye: 

■ Estado operativo de la biblioteca (como nivel de microcódigo, número de serie, 
estado conectado/desconectado)

■ Estado de los CAP(abierto, cerrado, número de celdas)

■ Elementos de la biblioteca (número de TallBot, celdas de almacenamiento, CAP) 

■ Número de celdas de almacenamiento y tipos de medios de la biblioteca 

■ Número y tipo de unidades de cinta instaladas en la biblioteca

Nota: De forma predeterminada, el agente SNMP está desconectado y lo debe activar 
el representante de asistencia de Sun a través de la interfaz de línea de comandos (CLI). 

SL3000 es compatible con las siguientes versiones de SNMP: 

■ SNMPv2c: para consultas de estado de máquina; la información transmitida no es 
segura.

■ SNMPv3: para Sun Confidential: información de uso interno sólo, ya que incluye el 
cifrado y una estricta identificación de usuario. SNMPv3, por tanto, es el protocolo 
preferido para datos registrados.

Nota: Consulte el documento SL3000 SNMP Guide (PN 3161945xx) para obtener 
información detallada sobre SNMP y los procedimientos de configuración.
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SL Console
La Consola de biblioteca StorageTek (SL Console) es una aplicación de software basada 
en Java que proporciona una interfaz gráfica de usuario (GUI) para la supervisión y 
administración de la biblioteca StorageTek SL3000. Consulte el Capítulo 2, “Consola de 
biblioteca StorageTek” en la página 33 para obtener detalles completos. 
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Software de administración de biblioteca
Los componentes del software de administración de la biblioteca controlan la biblioteca 
para realizar actividades como montajes y desmontajes, introducciones y expulsiones. 
Además, administran sus propias bases de datos de cartuchos, que contienen 
información de atributos y ubicación de volúmenes. 

Sun ofrece varios componentes de software según la plataforma, el tipo de conexión y 
el sistema operativo. Son: 

■ ACSLS

■ HSC (MVS): con una interfaz TCP/IP sólo

■ SCSI direct-attach: con una interfaz Fibre Channel sólo

■ ExLM 

■ ExHPDM 

■ ExPR

■ VSM 

■ VTL 

Nota: Consulte la documentación documentación correspondiente del software de 
administración de bibliotecas para conocer los niveles de versión necesarios para 
compatibilidad con SL3000. 

Nota: LibraryStation no se admite para SL3000. 

Nearline Control Solutions
SL3000 admite los siguientes productos de software Sun Nearline Control Solutions 
(NCS).

■ Componente de software del host

■ Componente de administración de almacenamiento

■ Sun Servidor StorageTek HTTP

Componente de software del host 
Cuando una biblioteca SL3000 se conecta a un host MVS, el host debe ejecutar una 
versión del componente de software del host (HSC) de Sun StorageTek junto con el 
Componente de administración de almacenamiento (SMC).

Juntos, HSC y SMC de Sun StorageTek realizan las siguientes funciones:

■ Influyen en las asignaciones

■ Interceptan mensajes de montaje y desmontaje

■ Reciben solicitudes del host y las traducen en comandos de control de la biblioteca

HSC reside dentro del host MVS, pero es invisible para el sistema operativo real.
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Componente de administración de almacenamiento
Componente de administración de almacenamiento (SMC) es la interfaz entre los 
sistemas operativos OS/390 y z/OS de IBM y una biblioteca Sun StorageTek. SMC 
realiza el proceso de asignaciones, tratamiento de mensajes y el proceso SMS para 
la solución NCS. SMC residen en el sistema host MVS con HSC, o en un sistema 
remoto que utiliza el servidor Sun StorageTek HTTP para comunicar con HSC. SMC 
se comunica con HSC para determinar directivas, ubicaciones de volumen y propiedad 
de unidades.

Nota: SMC es un componente obligatorio de NCS.

Sun Servidor StorageTek HTTP
Sun El servidor HTTP de StorageTek para OS/390 y z/OS proporciona, de forma 
opcional, el middleware para permitir la comunicación entre SMC (cliente) y un 
subsistema HSC remoto (servidor). El servidor HTTP se ejecuta como un subsistema 
independiente en el host MVS donde reside el subsistema HSC remoto. 

Software de biblioteca de sistema de cartuchos 
automático (ACSLS)
El software ACSLS administra el contenido de la biblioteca y controla el hardware de la 
biblioteca para el montaje y desmontaje de cartuchos. 

ACSLS proporciona servicios de administración de biblioteca, como seguimiento de 
cartuchos, agrupación, informes y control de la biblioteca. Mantiene una base de datos 
que registra los nombres de volúmenes de datos y sus ubicaciones actuales en las 
bibliotecas. 
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Modos operativos
Cuatro modos de funcionamiento son posibles para la biblioteca SL3000:

■ Modo automático 

■ Modo manual

■ Modo de mantenimiento

■ Modo degradado

Modo automático 
Cuando está en modo de operación automática, la biblioteca monta y desmonta 
automáticamente cartuchos sin la intervención física de una persona.

Las operaciones automáticas incluyen las actividades siguientes:

■ Montaje y desmontaje de cartuchos
■ Introducción y expulsión de cartuchos a través del CAP
■ Registros de eventos de biblioteca
■ Limpieza de unidades 

Consulte el Capítulo 3, “SL3000 Operaciones automatizadas de la biblioteca” en la 
página 63 para obtener detalles completos. 

Modo manual
El modo manual de funcionamiento sucede cuando la biblioteca no está disponible para 
uso del sistema y se requiere la intervención de una persona. Un ejemplo de esta 
situación sería cuando una biblioteca experimenta un error irrecuperable, lo que hace 
imposible los montajes y desmontajes automáticos.

Otro ejemplo sería cuando un componente de la biblioteca no puede realizar un 
montaje en una unidad para una solicitud de tarea especialmente importante. En este 
caso, la biblioteca puede solicitar a una persona para que entre en la biblioteca, localice 
el cartucho y lo monte manualmente en la unidad solicitada. 

Aviso: posible daño físico. Cualquier persona que entre en la biblioteca debe 
ser advertida sobre los procedimientos de seguridad necesarios. 

Consulte el Capítulo 8, “Operaciones manuales” en la página 471 para obtener detalles 
completos. 
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Modo de mantenimiento
En caso de un fallo en un componente de biblioteca no redundante (por ejemplo, un 
solo TallBot para toda la biblioteca), se dice que la biblioteca no está disponible para el 
sistema. En este caso, se debe desconectar toda la biblioteca hasta que se solucione el 
fallo.

Una vez que el componente defectuoso se haya reparado o reemplazado, la biblioteca 
se puede colocar en modo de mantenimiento mientras se realizan las pruebas de 
comprobación. 

Modo degradado
Cuando está en modo degradado, la biblioteca sigue estando operativa y conectada, 
pero su rendimiento es reducido debido a un componente defectuoso. Ejemplos de 
modo degradado: 

■ En una configuración de TallBot redundante, un TallBot ha fallado; el otro TallBot ha 
asumido todas las operaciones de montaje y desmontaje para toda la biblioteca.

■ Una unidad de cinta ha sufrido un fallo y se debe reemplazar por otra.
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CAPÍTULO 2

Consola de biblioteca StorageTek 

Introducción 
La Consola de biblioteca StorageTek (SL Console) es una aplicación de software basada 
en Java que proporciona una interfaz gráfica de usuario (GUI) para la supervisión y 
administración de la biblioteca StorageTek. 

A continuación, se enumeran algunas de las actividades que se pueden efectuar con 
SL Console:

■ Administrar la capacidad disponible de almacenamiento de la biblioteca

■ Administrar y configurar las particiones de la biblioteca (función opcional)

■ Ver y modificar el estado y las propiedades de la biblioteca y los dispositivos 
asociados (unidades, CAP, robots y elevadores)

■ Realizar una auditoría de toda la biblioteca o sólo de una parte de ella

■ Efectuar una prueba automática de diagnóstico de la biblioteca o de un dispositivo asociado

■ Realizar un movimiento de diagnóstico (ejercicio de un robot)

■ Localizar un cartucho

■ Mover un cartucho de un lugar a otro

■ Mostrar los registros de la biblioteca

■ Mostrar los mensajes de eventos de estado de la biblioteca

■ Mostrar las explicaciones de los errores 

■ Descargar el firmware nuevo mientras la biblioteca está en funcionamiento

■ Mostrar la ayuda de contexto 

Modos de SL Console
Según la necesidad, puede ejecutar SL Console en cualquiera de los modos siguientes: 
Para obtener más detalles e información sobre los procedimientos, consulte: 

■ “Panel de operador local” en la página 40 

■ “Independiente SL Console” en la página 42

■ “SL Console en Web” en la página 49 
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SL Console Seguridad 
Las funciones de seguridad integradas en SL Console controlan la autenticación y la 
autorización de los usuarios. Entre ellas se incluyen:

■ ID de usuario: los identificadores de usuario controlan la autenticación de los 
usuarios. Para iniciar sesión en SL Console, cada uno de los usuarios debe tener un 
 ID y una contraseña que sean válidos.

■ Permisos de acceso: controlan la autorización de los usuarios. Cada  ID de usuario 
cuenta con un conjunto de permisos de acceso que determinan los tipos de 
solicitudes que el usuario puede efectuar en SL Console. Por ejemplo, para poder 
modificar las propiedades de sistema de una unidad, el usuario deberá iniciar sesión 
con un ID de usuario que cuente con los permisos necesarios.

Al iniciar sesión en SL Console con un ID, una contraseña y un nombre de biblioteca 
que sean válidos, el sistema autenticará la identidad del usuario y, a continuación, 
autorizará el acceso a determinadas funciones de SL Console. 

ID de usuario
Para iniciar sesión en SL Console, se precisa un ID de usuario válido y activo; cada 
identificador debe tener asignado una contraseña.

Hay un grupo establecido de identificadores de usuario en el lugar de trabajo. Dichos 
identificadores incluyen: admin (administrador de clientes), service (Sun Técnico de 
servicios al cliente) y oem (técnicos de servicio de terceros). Cuando inicie sesión 
correctamente, SL Console muestra su ID de usuario en la barra de estado de la 
pantalla.

Sólo un usuario a la vez puede iniciar sesión en el panel de operador local, pero 
cualquier número de usuarios puede conectarse a una biblioteca a través de SL Console 
independiente o SL Console en Web. 

Contraseña de activación 
Antes de que los usuarios en su lugar de trabajo puedan utilizar SL Console por 
primera vez, el administrador de la biblioteca debe activar el identificador de usuario 
“admin” con una contraseña especial de activación. Su representante de asistencia de 
Sun suministra al administrador la contraseña de activación, la cual es válida una sola 
vez. 

Tras iniciar sesión con la contraseña de activación, el administrador debe cambiar la 
contraseña del ID de usuario admin para mantener la seguridad del sistema. 

Para obtener más información acerca del proceso, consulte la Guía de instalación de la 
biblioteca correspondiente. 
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Tareas de uso de SL Console
■ Inicio de sesión en SL Console

■ Cierre de sesión de SL Console

■ Cambio de contraseña de usuario

▼ Inicio de sesión en SL Console
Los procedimientos para iniciar sesión dependen del modo de SL Console que se 
utilice. Para obtener instrucciones detalladas, consulte los temas siguientes:

■ “Inicio de sesión en el panel de operador local” en la página 41

■ “Inicio de sesión en SL Console independiente” en la página 48

■ “Conexión a SL Console en Web mediante explorador o línea de comandos” en la 
página 50

■ “Conexión a SL Console en Web mediante icono” en la página 56

Nota:  SL Console obtiene todos los datos de configuración del controlador de 
biblioteca. Por tanto, debe tener cuidado de no iniciar sesión en SL Console antes de 
que la biblioteca se haya inicializado completamente. Podría tener avisos de que los 
datos de configuración aún no están disponibles, en cuyo caso debe salir y volver a 
iniciar sesión de nuevo. Además, si se realiza una auditoría como parte de la 
inicialización, hasta que la auditoría se complete, puede que los datos de configuración 
mostrados no sean totalmente actualizados y precisos. 

▼ Cierre de sesión de SL Console

Nota: Antes de cerrar la sesión, asegúrese de que han finalizado todas las operaciones 
de la sesión actual de SL Console (por ejemplo, cargas de código, auditorías, 
movimientos de diagnóstico, etc.). 

1. En cualquier pantalla de SL Console, seleccione Tools > Log Off

2. En el cuadro emergente Confirm, haga lo siguiente:

■ Haga clic en Cancel para continuar con la sesión de SL Console.

■ Haga clic en OK para terminar la sesión actual de SL Console. 

Aparece la pantalla Login. 

3. Haga clic en Exit para cerrar SL Console.
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▼ Cambio de contraseña de usuario 
1. Seleccione Tools > User Mgmt.

2. En el árbol User, expanda la carpeta Permanent. 

3. Haga clic en la cuenta de usuario que desea modificar. 

4. Rellene los campos siguientes: Current Password, New Password y Retype Password. 

5. Haga clic en Modify.
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SL Console Visualización de pantalla 
La siguiente figura y tabla muestra los componentes de la pantalla de SL Console. 

Nombre de componente Descripción

1 Barra de menús: incluye 
los menús Tools y Help 

El menú Tools proporciona acceso a las funciones de System 
Detail, Reports, Monitors, Utilities, Partitioning, User Manage-
ment y Log off. 
A través del menú Help se accede a la tabla de contenido del 
sistema de ayuda. También identifica la versión de SL Console 
que está en uso.

2 Barra de títulos Muestra el nombre de la pantalla actual. 

3 Fichas de funciones Identifican las funciones que hay disponibles en la pantalla. 

1 2 43

5

78 6

9



 

SL Console Visualización de pantalla

38 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

Sincronización de la pantalla con la base de datos 
del controlador
Al abrir una pantalla de SL Console, se visualizan los datos guardados más 
recientemente en la base de datos del controlador de la biblioteca. Si se utiliza la 
pantalla para modificar el contenido o la configuración de la biblioteca, los cambios no 
se actualizarán en la base de datos del controlador hasta que se hayan confirmado. Para 
ello, debe hacer clic en el botón Apply. Los usuarios pueden acceder a la biblioteca al 
mismo tiempo y realizar sus propios cambios al contenido y la configuración de la 
biblioteca, mediante la interfaz de línea de comandos de SL Console y las aplicaciones 
host. Si otros usuarios efectúan cambios y los aplican a la base de datos del controlador, 
no podrá verlos hasta que haga clic en Apply o Refresh. Por consiguiente, lo que ve en 
la pantalla de SL Console puede no reflejar la actual configuración de biblioteca que 
hay guardada en ese momento preciso.

Por ese motivo, si va a realizar importantes modificaciones en la configuración de la 
biblioteca, como añadir módulos, definir particiones, etc., es importante que coordine 
los cambios con los otros usuarios de la biblioteca. Si no lo hace así, se pueden producir 
conflictos en la base de datos del controlador. 

4 Barra de opciones Ubicación de los botones asociados con la pantalla (por ejem-
plo, Apply, Refresh y Print). Siempre incluye el botón (?), que 
abre la Ayuda de SL Console. Consulte “Sincronización de la 
pantalla con la base de datos del controlador” en la página 38 
para obtener más información sobre de los botones Apply y 
Refresh. 

5 Área de trabajo Ubicación de los datos de la pantalla. 

6 Indicador del estado de la 
biblioteca

Identifica la biblioteca a la que está conectada SL Console y 
muestra la representación gráfica del estado de la biblioteca. 

7 Indicador UserID Muestra el identificador del usuario que está conectado en ese 
momento a SL Console.

8 Indicador del estado de las 
comunicaciones del 
servidor

Muestra un monitor gráfico parpadeante que indica el estado 
de las comunicaciones del servidor.

9 Árbol de dispositivos Enumera los dispositivos incluidos en la biblioteca.

Nombre de componente Descripción
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Modificación de la distribución de pantalla 

Nota: Esta característica está disponible a partir de la versión FRS_3.30 de SL Console, 
y sólo en determinadas pantallas. 

Abajo se explican las formas de modificar la distribución y visualización de la pantalla 
de SL Console. 

Opción Instrucciones

Clasificar (la 
visualización) por 
columna

Haga clic en la cabecera de la columna por la que se 
clasificará la visualización. Al principio estará en orden 
ascendente, pero cada vez que haga clic en ella se cambiará 
entre ascendente y descendente.

Organizar las 
columnas en cualquier 
orden

Arrastre horizontalmente la cabecera de una columna para 
cambiar su posición. 

Cambiar el tamaño de 
las columnas

Haga clic en el borde de la cabecera de una columna y 
arrástrelo hacia la izquierda o la derecha para cambiar la 
anchura de la columna. 
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Panel de operador local 
El panel de operador local es una función opcional de la biblioteca, integrada en el 
módulo básico de la biblioteca SL500 y SL3000. Sirve para ejecutar la mayor parte de la 
aplicación SL Console directamente en la biblioteca mediante una pantalla plana con 
interfaz sensible al tacto. 

El panel de operador local tiene las siguientes características:

■ Pantalla plana, situada en la biblioteca (12,1 pulgadas en la biblioteca SL3000 y 
SL8500, ) 

■ Interfaz táctil, la cual permite la entrada de datos alfanuméricos; estilo y bolígrafo 
disponibles 

■ No hay opción de teclado ni de ratón

Los indicadores LED situados justo debajo del panel de operador local aportan la 
siguiente información de estado:

■ LIB ACTIVE: el procesador de la biblioteca está en funcionamiento. 

■ WAIT: el firmware de la biblioteca está cargándose en ese momento. 

■ SVC REQ: la biblioteca se está reiniciando. 

▼ Introducción de datos mediante teclado 
1. Haga clic en el icono de teclado asociado con el campo deseado.

Aparece un cuadro emergente que contiene un área de visualización y un teclado 
gráfico. 

2. Haga clic en las teclas gráficas para introducir los datos.

3. Haga clic en Enter para guardar la entrada. 

El cuadro emergente se cierra y aparecen los datos en el campo asociado.

▼ Modificación de datos mediante teclado 
1. Utilice las teclas de dirección para posicionar el cursor junto a los caracteres que 

desea modificar.

El texto existente se queda en la pantalla, pero se cambia a texto normal.

2. Haga clic en las teclas de dirección, edición y texto para efectuar los cambios.

3. Haga clic en Enter para guardar los cambios o Cancel para restaurar el texto original. 
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▼ Inicio de sesión en el panel de operador local 

Nota: Sólo un usuario a la vez puede iniciar sesión en el panel de operador local. 

Nota: Si la pantalla táctil está en blanco, tóquela en cualquier parte para activar la 
pantalla Login. 

1. Utilice el teclado para introducir la información de conexión (vea “Introducción de 
datos mediante teclado” en la página 40 para obtener instrucciones detalladas). 

User ID: SLC_login 
Password: contraseña 

donde:

■ conexión_SLC es el ID de usuario de SL Console.

■ contraseña es la contraseña asignada al ID de usuario. 

Nota: El ID de usuario determina las pantallas a las que se tienen acceso. Consulte 
“SL Console Seguridad” en la página 34. 

2. Haga clic en Log on. 
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Independiente SL Console 
SL Console independiente es una función estándar de la biblioteca StorageTek que le 
permite ejecutar la aplicación SL Console de forma remota desde un PC o una estación 
de trabajo que tenga una conexión de red a la biblioteca. A través de SL Console 
independiente puede conectarse a cualquier biblioteca para la que tenga un ID de 
usuario válido. 

Factores de seguridad
La aplicación SL Console interactúa con la interfaz principal de la biblioteca (PLI) a 
través de una capa de software de seguridad (SSL). La capa SSL proporciona una vía 
de comunicación segura entre la biblioteca y el panel de operador del cliente, lo cual 
impide que un usuario de red no autorizado pueda supervisar la actividad de la 
biblioteca.

Requisitos de instalación
Puede instalar SL Console independiente en un ordenador que cumpla los siguientes 
requisitos:  

El software de SL Console independiente se puede descargar de los siguientes sitios de 
Sun Microsystems, Inc.:

Nota: Debe tener un ID de inicio de sesión y una contraseña de conexión que sean 
válidos para el sitio de descargas. Consulte con el representante de asistencia de Sun 
para obtener ayuda. 

Plataforma Solaris 9, SPARC
Solaris 10, SPARC
Windows 2003 Server de 32 bits
Windows XP Client de 32 bits
Windows Vista de 32 bits

Otro Conexión Ethernet a la biblioteca

Usuario Nombre de ubicación URL

Clientes de Sun Sun Download Center http://www.sun.com/download
/index.jsp

Socios y OEM 
de Sun

Sun Partner Exchange https://spe.sun.com/spx/control
/Login 
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Instalación de SL Console independiente

Nota: El CSE de StorageTek puede que haya realizado estos procedimientos durante la 
instalación de la biblioteca.

Para instalar SL Console independiente en el PC o la estación de trabajo, debe emplear 
los siguientes procedimientos:

1. “Descarga e inicio del instalador de SL Console independiente desde el sitio de 
descargas de Sun.” en la página 43. 

2. “Instalación de SL Console independiente” en la página 44. 

▼ Descarga e inicio del instalador de SL Console independiente 
desde el sitio de descargas de Sun.
Utilice este procedimiento para descargar el programa de instalación de SL Console 
independiente e iniciarlo en el PC o la estación de trabajo. 

Nota: Debe tener un ID de inicio de sesión y una contraseña de conexión que sean 
válidos para el sitio de descargas. Consulte con el representante de asistencia de Sun 
para obtener ayuda. 

1. Inicie el explorador web en el PC o la estación de trabajo. 

2. En la barra de direcciones, introduzca la dirección URL del sitio de descargas de Sun. 
Consulte “Requisitos de instalación” en la página 42 para obtener más detalles. 

3. Conéctese al sitio de descargas de Sun con su ID y contraseña.

4. Busque el archivo instalador de SL Console independiente. 

5. Seleccione el nivel de código de SL Console que desee.

6. Elija el archivo instalador que corresponda con su plataforma.

■ Microsoft Windows: SLConsoleWindowsSTK.exe 

■ Sun Solaris: SLConsoleSolarisSTK.bin 

7. Guarde el archivo en el PC o la estación de trabajo. 

8. En el PC o estación de trabajo, haga doble clic en el icono del archivo instalador de 
SL Console para iniciar la instalación. 

9. Para completar la instalación, consulte “Instalación de SL Console independiente” en 
la página 44. 
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▼ Instalación de SL Console independiente
Use este procedimiento para instalar SL Console independiente en el PC o la estación 
de trabajo. 

1. Inicie el programa instalador de acuerdo con las instrucciones de la sección 
“Descarga e inicio del instalador de SL Console independiente desde el sitio de 
descargas de Sun.” en la página 43. 

Aparece la pantalla License Agreement. 

2. Revise la información y haga clic en I accept para aceptar el acuerdo de licencia. 

Aparece la pantalla Introduction.
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3. Revise la información y haga clic en Next. 

Aparece la pantalla Choose Install Folder. 

4. Seleccione la ubicación donde desea instalar el archivo y haga clic en Next.

Aparece la pantalla Choose Shortcut Folder. 

5. Introduzca la ubicación donde desea crear el icono de acceso directo y después haga 
clic en Next. 
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Nota: En Solaris, la ubicación predeterminada para los accesos directos están en el 
directorio principal del usuario. Sin embargo, los accesos directos no pueden crearse en 
/, que es el directorio root del usuario, es decir, si está efectuando la instalación en la 
plataforma Solaris como root debe elegir otro directorio que no sea el predeterminado. 
Se recomienda en ese caso que seleccione /usr/bin u otra ubicación parecida. 

Aparece la pantalla Pre-Installation Summary.

6. Revise la información y haga clic en Install. 

Comienza la instalación y aparece la pantalla Installing SL Console. 
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7. Al finalizar la instalación, aparece la pantalla Install Complete. 

8. Revise la información y haga clic en Done para salir del programa de instalación. 
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▼ Inicio de sesión en SL Console independiente 

Nota: A través de SL Console independiente puede conectarse a cualquier biblioteca 
para la que tenga un ID de usuario válido. 

1. Inicie la aplicación SL Console en el PC o la estación de trabajo de los siguientes 
modos:

■ Haga doble clic en el icono de SL Console que hay en el escritorio.

■ Seleccione Start > RunSLConsole o Launch > RunSLConsole.

Se inicia SL Console y aparece la pantalla Login. 

2. Escriba sus datos de inicio de sesión.

User ID: SLC_login 
Password: password 
Library: library_ID 

donde:

■ conexión_SLC es el ID de usuario de SL Console.

■ contraseña es la contraseña asignada al ID de usuario. 

■ ID_de_biblioteca es la biblioteca a la que desea conectarse, expresado de los siguientes 
modos:

■ Dirección IP de la biblioteca, en la notación decimal con puntos 
(nnn.nnn.nnn.nnn) 

■ Alias DNS de la biblioteca

Nota: El ID de usuario determina las pantallas a las que se tienen acceso. Consulte 
“SL Console Seguridad” en la página 34. 

3. Haga clic en Log on. 

Actualizaciones de SL Console independiente

Nota: Antes de instalar una nueva versión de SL Console independiente, debe 
desinstalar la versión anterior. Consulte la documentación de su PC o estación de 
trabajo para hallar instrucciones detalladas. Si se ejecutan varias versiones de 
SL Console en el mismo PC o la misma estación de trabajo, pueden surgir problemas 
como, por ejemplo, la incoherencia de los datos en los informes. 

Una vez desinstalada la versión anterior de SL Console, consulte “Instalación de 
SL Console independiente” en la página 43 para obtener instrucciones sobre la 
actualización del software. 
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SL Console en Web
SL Console en Web es una función estándar de la biblioteca. Permite instalar 
SL Console en un servidor web centralizado. Los clientes individuales podrán entonces 
utilizar un explorador web compatible para descargar SL Console en Web. A través de 
SL Console en Web puede conectarse a cualquier biblioteca para la que tenga un ID de 
usuario válido.

SL Console en Web se distribuye a los clientes como un proceso Java Web Start, que se 
ejecuta fuera del explorador. 

Factores de seguridad
El software de SL Console en Web tiene una firma digital, que garantiza que ha sido 
distribuido por Sun Microsystems, Inc. y que no ha sido alterado desde el momento de 
su creación. Como todos los procesos Java Web Start, SL Console en Web incluye las 
características de seguridad que proporciona la plataforma Java 2.

El cliente es responsable de la implementación de todos los sistemas de seguridad 
adicionales, como los cortafuegos, el acceso de los usuarios, etc.

Requisitos de cliente
Puede descargar SL Console en Web en los clientes que cumplan los siguientes 
requisitos:  

Actualizaciones de SL Console en Web
Las actualizaciones de SL Console en Web sólo necesitan instalarse en el servidor web 
centralizado. Una vez instaladas las actualizaciones en el servidor, se descargarán 
automáticamente en todos los clientes cuando la aplicación se inicie en el cliente. 

Plataforma Solaris 9, SPARC (Firefox 2.x)
Solaris 10, SPARC (Firefox 2.x)
Windows 2000 de 32 bits (IE 5, IE 5.5, Firefox 2.x)
Windows XP de 32 bits (IE 6, IE 7, Firefox 2.x)
Windows Vista de 32 bits (IE 7, Firefox 2.x)

Otro ■ Complemento Java 1.5 (el explorador lo instalará 
automáticamente si no lo está ya)

■ Conexión Ethernet a la biblioteca
■ Conexión Ethernet al servidor de SL Console en Web 
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Inicio de SL Console en Web en un cliente
Puede utilizar cualquiera de los siguientes métodos para iniciar y conectarse a 
SL Console en Web en un cliente: 

■ Desde una línea de comandos (sólo Solaris) o explorador compatible. Consulte 
“Conexión a SL Console en Web mediante explorador o línea de comandos” en la 
página 50. 

■ Al hacer doble clic en el icono slc.jnlp en el cliente. Para utilizar este método 
desde un cliente, primero debe usar el explorador al menos una vez y después 
guardar el archivo slc.jnlp de forma local. Consulte “Conexión a SL Console en 
Web mediante icono” en la página 56. 

▼ Conexión a SL Console en Web mediante 
explorador o línea de comandos 

Nota: Antes de llevar a cabo esta actividad, debe obtener el alias DNS o la dirección IP 
del servidor de SL Console. Según la configuración del servidor de SL Console en Web, 
es posible que sólo sea accesible mediante dirección IP. Consulte con el administrador 
de la biblioteca para obtener ayuda. 

Nota: La opción de línea de comandos sólo está disponible en las plataformas Solaris. 

En Windows 2000, quizá tenga que instalar complemento Java para el explorador web 
antes de realizar el procedimiento. Puede descargar el complemento de la siguiente 
ubicación:
http://java.sun.com/products/archive/j2se/5.0_04/index.html 

En las plataformas Solaris, es más fácil iniciar sesión en SL Console en Web con la línea 
de comandos. Sin embargo, si prefiere conectarse a través de un explorador web, 
deberá descargar una versión reciente de Firefox de la siguiente ubicación: 
www.mozilla.com

1. Elija el método de conexión:

■ Línea de comandos, sólo disponible en Solaris. Proceda al Paso 2. 

■ Explorador Web, disponible en Windows y Solaris. Proceda al Paso 3. 

2. Abra una ventana de terminal y escriba el siguiente comando:

javaws http://ID_de_servidor/opel/slc.jnlp 

donde:

■ server_ID es uno de los valores siguientes:

■ Dirección IP del servidor de SL Console (en el formato nnn.nnn.nnn.nnn)

■ Alias DNS del servidor SL Console

■ opel es el nombre (contexto raíz) de la aplicación SL Console en Web en el servidor. 

Proceda al Paso 4. 
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3. Inicie un explorador de Web compatible en el PC o la estación de trabajo cliente 
(consulte “Requisitos de cliente” en la página 49 para conseguir una lista de 
exploradores compatibles). A continuación, en la barra o campo de direcciones, 
escriba la dirección URL de la aplicación Web Start de SL Console: 

http://ID_de_servidor/opel

donde:

■ server_ID es uno de los valores siguientes:

■ Dirección IP del servidor de SL Console (en el formato nnn.nnn.nnn.nnn)

■ Alias DNS del servidor SL Console

■ opel es el nombre (contexto raíz) de la aplicación SL Console en Web en el servidor. 

Nota: Puede marcar esta dirección URL como favorita para conexiones futuras. 

4. Aparece la pantalla SL Console Launch. Haga clic en Launch Now.

El proceso Web Start obtiene la aplicación SL Console en Web del servidor. Si hay 
actualizaciones, se descargarán de forma automática. 
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5. Aparece el cuadro emergente Opening slc.jnlp. 

Complete el cuadro de la siguiente manera:

a. Especifique la acción que va a realizar con el archivo slc.jnlp:

■ Haga clic en el botón de radio Open with Java(TM) Web Start Launcher si desea 
iniciar SL Console directamente. 

■ Haga clic en el botón de radio Save to Disk si desea guardar el archivo slc.jnlp 
en el cliente e iniciar sesión en SL Console más adelante. Consulte “Conexión a 
SL Console en Web mediante icono” en la página 56 para obtener instrucciones 
detalladas. 

b. De forma opcional, puede hacer clic en la casilla “Do this automatically for files 
like this from now on”. Si selecciona esta opción, el cuadro emergente no volverá 
a aparecer al iniciar sesión. 

c. Haga clic en OK. 
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6. Si es la primera vez que ejecuta SL Console en Web, aparece un cuadro de aviso 
sobre la firma digital. 

Complete el cuadro de la siguiente manera:

a. Verifique el editor. 

b. De forma opcional, puede hacer clic en la casilla “Always trust content from the 
publisher”. Si selecciona esta opción, el cuadro emergente no volverá a aparecer al 
iniciar sesión. 

c. Haga clic en Run.
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7. Si es la primera vez que ejecuta SL Console en Web, aparece el cuadro License 
Agreement. 

Utilice la barra de desplazamiento para leer todo el acuerdo de licencia. Haga clic en 
“I accept the terms of the License Agreement” para aceptar los términos de la licencia 
y, finalmente, haga clic en OK.
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8. Aparece la pantalla de inicio de sesión en SL Console. 

Introduzca la información de inicio de sesión y haga clic en Log on.

User ID: SLC_login 
Password: password 
Library: library_ID 

donde:

■ conexión_SLC es el ID de usuario de SL Console.

■ contraseña es la contraseña asignada al ID de usuario. 

■ ID_de_biblioteca es la biblioteca a la que desea conectarse, expresado de los siguientes 
modos:

■ Dirección IP de la biblioteca, en la notación decimal con puntos 
(nnn.nnn.nnn.nnn) 

■ Alias DNS de la biblioteca 
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▼ Conexión a SL Console en Web mediante icono

Nota: Para realizar esta actividad, primero debe guardar el archivo slc.jnlp de 
SL Console en Web en el cliente. Consulte “Conexión a SL Console en Web mediante 
explorador o línea de comandos” en la página 50 para obtener más detalles. 

1. Haga doble clic en el icono de slc.jnlp que hay en el escritorio del cliente. 

El proceso Web Start obtiene la aplicación SL Console en Web del servidor. Si hay 
actualizaciones, se descargarán de forma automática. 

■ Dirección IP de la biblioteca, en la notación decimal con puntos 
(nnn.nnn.nnn.nnn) 

■ Alias DNS de la biblioteca 
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2. Aparece la pantalla SL Console Launch. Haga clic en Launch Now.

El proceso Web Start obtiene la aplicación SL Console en Web del servidor. Si hay 
actualizaciones, se descargarán de forma automática. 

3. Si es la primera vez que ejecuta SL Console en Web, aparece un cuadro de aviso 
sobre la seguridad. 

Complete el cuadro de la siguiente manera:

a. Verifique que el editor es Sun Microsystems, Inc. 
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b. De forma opcional, puede hacer clic en la casilla “Always trust content from the 
publisher”. Si selecciona esta opción, el cuadro emergente no volverá a aparecer al 
iniciar sesión. 

c. Haga clic en Yes.

4. Si es la primera vez que ejecuta SL Console en Web, aparece el cuadro License 
Agreement. 

Utilice la barra de desplazamiento para leer todo el acuerdo de licencia. Haga clic en 
“I accept the terms of the License Agreement” para aceptar los términos de la licencia 
y, finalmente, haga clic en OK.
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5. Aparece la pantalla de inicio de sesión en SL Console. 

Introduzca la información de inicio de sesión y haga clic en Log on.

User ID: SLC_login 
Password: password 
Library: library_ID 

donde:

■ conexión_SLC es el ID de usuario de SL Console.

■ contraseña es la contraseña asignada al ID de usuario. 

■ ID_de_biblioteca es la biblioteca a la que desea conectarse, expresado de los siguientes 
modos:

■ Dirección IP de la biblioteca, en la notación decimal con puntos 
(nnn.nnn.nnn.nnn) 

■ Alias DNS de la biblioteca 
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Ayuda de SL Console
SL Console Help muestra información sobre los programadores y administradores de 
sistema, los operadores de la biblioteca y los representantes de servicios. 

Nota: La información se refiere a SL Console solamente. Para obtener información 
sobre el hardware de la biblioteca, las unidades de cinta o el software de host, consulte 
la información suministrada con el propio producto.

Abajo aparece un ejemplo de pantalla de SL Console Help. 

▼ Acceso a SL Console Help
Puede acceder a SL Console Help desde cualquier pantalla de SL Console. Para ello, 
utilice uno de los siguientes métodos: 

■ Para visualizar la ayuda de contexto correspondiente a la pantalla actual de 
SL Console, haga clic en el botón ? de la barra de opciones. 

■ Para mostrar la información general, haga clic en Help > Contents en la barra de 
menús. 

Navegación de la ayuda
El panel izquierdo de la pantalla SL Console Help muestra una de las siguientes vistas:

■ Tabla de contenido (TOC): esquema de los temas y subtemas

■ Índice: lista de términos y temas, en orden alfabético

El panel derecho muestra el tema de ayuda en sí. 
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La parte superior de la pantalla de SL Console Help incluye los siguientes botones de 
desplazamiento. 

Sugerencias de uso de la pantalla SL Console Help
■ Puede minimizar, maximizar o cambiar el tamaño de la pantalla de ayuda según 

precise.

■ Para cambiar el tamaño del panel izquierdo y derecho de la pantalla de ayuda, haga 
clic en los bordes que los separa y arrástrelos hacia un lado u otro. 

■ En la mayoría de los temas, aparece el botón Related Topics en la parte inferior de la 
página. Haga clic en este botón para visualizar los temas de ayuda que contienen 
información relacionada. 

Botón Acción

 Atrás Vuelve sobre los pasos anteriores, yendo hacia atrás un tema 
cada vez. 

 Adelante Vuelve sobre los pasos anteriores, yendo hacia adelante un 
tema cada vez. 

 Imprimir Muestra el cuadro emergente Print, que permite imprimir uno 
o varios temas:
■ Para imprimir el tema actual, haga clic en el botón Print.
■ Para imprimir otro tema, haga clic en el título del tema en la 

tabla de contenido de SL Console Help y, a continuación, 
haga clic en el botón Print.

■ Para imprimir varios temas, resáltelos en la tabla de 
contenido de la ayuda de SL Console, mediante las teclas 
Mayús-Clic o Ctrl-Clic y, a continuación, haga clic en Print. 

 Configura-
ción de la 
impresión

Muestra el cuadro emergente Page Setup, que permite 
modificar la configuración de las páginas que se van a 
imprimir.

 TOC Muestra la tabla de contenido de la ayuda de SL Console. 

 Índice Muestra el índice de la ayuda de SL Console. 
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CAPÍTULO 3

SL3000 Operaciones automatizadas 
de la biblioteca

Modo de operación automático
Cuando está en modo de operación automático, la biblioteca monta y desmonta 
automáticamente cartuchos sin la intervención física de una persona.

Las operaciones automáticas incluyen las actividades siguientes:

■ Montaje y desmontaje de cartuchos

■ Introducción y expulsión de cartuchos a través de un CAP de AEM giratorio u 
opcional 

■ Registros de eventos de biblioteca

■ Limpieza de unidades 

Actividades de montaje y desmontaje de cartuchos
La función principal de la biblioteca es el montaje y desmontaje automático de 
cartuchos. El controlador de biblioteca acepta los comandos de montaje y desmontaje 
del host, y éstos se traducen en comandos robóticos que realizan los TallBot. 

Secuencia de montaje
Una secuencia de montaje simplificada incluye los pasos siguientes:

1. Un host solicita que se monte un número de serie de volumen específico (VOLID) en 
una unidad.

2. El controlador de biblioteca comunica al host que el VOLID está ubicado en la 
biblioteca y una unidad está disponible para satisfacer la solicitud de montaje.

3. La biblioteca asume la responsabilidad del montaje.

4. El controlador de biblioteca traduce el comando del host en comandos de 
movimiento para el TallBot.
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5. Se toma el cartucho de la celda de almacenamiento correspondiente y se coloca en la 
unidad.

6. La biblioteca devuelve al host el estado de que la operación de montaje se ha 
completado.

7. La unidad realiza la actividad de lectura/escritura dirigida por el host.

Secuencia de desmontaje
Una secuencia de desmontaje simplificada incluye los pasos siguientes:

1. Un host solicita que se desmonte un VOLID específico de una unidad.

2. El controlador de biblioteca comunica al host que el VOLID está ubicado en la 
unidad y la biblioteca está disponible para satisfacer la solicitud de desmontaje.

3. La biblioteca asume la responsabilidad del desmontaje.

4. El controlador de biblioteca traduce el comando del host en comandos mecánicos 
para el TallBot.

5. Se toma el cartucho de la unidad y se coloca en la celda principal.

6. La biblioteca devuelve al host el estado de que la operación de desmontaje se ha 
completado.

Determinación sobre cuándo la biblioteca no está en 
modo automático 
La biblioteca no está en modo automático cuando no puede aceptar las solicitudes del 
host. Las siguientes condiciones indican que la biblioteca no está en modo automático:

■ Una puerta principal de acceso de la biblioteca está abierta. 

■ El TallBot no monta y desmonta cartuchos automáticamente. 

■ El árbol de dispositivos de SL Console indica que hay un problema con la biblioteca.
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Estado de biblioteca y dispositivo
La pantalla de SL Console muestra indicadores de mantenimiento para cada uno de los 
siguientes dispositivos:

■ Biblioteca 

■ Unidades

■ CAP giratorios y de AEM 

■ Suministros de potencia

■ Robots 

■ Puertas de seguridad AEM

21 3

4
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En la siguiente tabla se describen los indicadores de control de mantenimiento. 

El indicador del estado de la biblioteca (3) refleja también las alertas de estado, que son 
mensajes sobre problemas importantes con el firmware de la biblioteca o el estado de la 
configuración. Estos mensajes se pueden visualizar y administrar en la pantalla Status 
Module, si la licencia de servicios (Service) está activa en la biblioteca. Consulte 
“Mensajes de alertas de estado” en la página 69 para obtener más detalles. 

Si hay varios problemas con un dispositivo o con las condiciones de alerta de estado, el 
indicador de mantenimiento refleja el problema que es más grave. Por ejemplo, si una 
licencia está a punto de caducar (una condición  “amarilla”) y un CAP ha sufrido un 
fallo (una condición “roja”), el indicador del estado de la biblioteca estará en rojo. Al 
solucionar el problema con el CAP el indicador del estado de la biblioteca cambiará a 
amarillo. El indicador no cambiará de nuevo a verde hasta que se haya resuelto el 
problema con la licencia o se haya borrado el mensaje de alerta de forma manual. 

Indicador Descripción

Comm 
Status

Estado actual del canal de comunicación entre SL Console y el controlador 
de biblioteca. Los iconos posibles son:

Comunicaciones normales. El monitor de latidos parpadea de 
forma periódica cuando SL Console se comunica normalmente 
con el controlador de biblioteca. 

Un aviso. Este icono aparece cuando la respuesta del servidor 
tarda más de 10 segundos.

Un error. Este icono aparece cuando la respuesta del servidor 
tarda más de 30 segundos. 

Userid Identificador de usuario conectado actualmente a SL Console. 

Library Biblioteca a la que SL Console está conectado, y una representación gráfica 
del mantenimiento actual de la biblioteca y sus dispositivos. Los iconos 
posibles son:

Todos los dispositivos de la biblioteca están funcionando 
normalmente. 

Un aviso. Uno o varios dispositivos de la biblioteca están 
desconectados o funcionando en un estado degradado. 

Un error. Uno o varios dispositivos de la biblioteca han 
experimentado un fallo. 

Icono de 
manteni-
miento de 
dispositi-
vo

Estado actual del dispositivo indicado. Si el indicador de un dispositivo 
está en amarillo o en rojo, puede expander la carpeta del dispositivo para 
visualizar los iconos individuales de mantenimiento de dispositivo y, a 
continuación, mostrar los detalles de los dispositivos específicos que están 
experimentando condiciones anormales. 
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Fallos de comunicaciones
Si SL Console pierde la comunicación con el controlador de biblioteca, después de 30 o 
60 segundos aproximadamente, el monitor de latidos se vuelve gris, a continuación, 
rojo, y aparece el siguiente mensaje de error:
No se ha recibido mensaje de latidos del controlador de biblioteca.

Debe desconectar de SL Console y volver a conectar de nuevo para restaurar la 
comunicación.
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Informes de bibliotecas 
Los informes de la biblioteca proporcionan información sobre la biblioteca y los 
dispositivos asociados (por ejemplo: unidades, robots y CAP), eventos y cartuchos de 
cinta. Puede utilizar los informes de la biblioteca para supervisar la actividad de la 
biblioteca e identificar los problemas que puedan surgir. Además de mostrar los 
informes en pantalla, puede guardar los datos del informe en un archivo; después 
puede imprimirlo o incluirlo en un correo electrónico si así lo desea. 

Los resultados del informe son una presentación estática de la información enviada por 
el controlador de biblioteca en el momento de generarse el informe. SL Console no 
actualiza la información de forma dinámica a no ser que se seleccione el botón Update 
en la barra de opciones.

Nota: Si se ejecutan varias versiones de SL Console independiente o SL Console en 
Web en el mismo PC o la misma estación de trabajo, pueden surgir problemas como, 
por ejemplo, la incoherencia de los datos en los informes. Es recomendable que sólo un 
usuario a la vez genere informes de SL Console en un PC o una estación de trabajo, a 
no ser que todas las instancias de SL Console sean de la misma versión.

Tipos de informes
SL Console ofrece los siguientes tipos de informes:

■ Log: es un registro detallado de los eventos del sistema

■ Statistics: proporciona información estadística sobre las operaciones de la biblioteca 

■ Status Detail: aporta detalles acerca del estado de la biblioteca y de los dispositivos 
asociados, como los CAP, las unidades y los robots

■ Status Summary: proporciona información resumida sobre el estado de la biblioteca 
y los dispositivos asociados

■ Version: aporta detalles acerca de las versiones de hardware y software de la 
biblioteca

Barra de opciones de informe
La barra de opciones que hay en cada informe le permite realizar las siguientes 
funciones:

■ Búsqueda de informes de biblioteca

■ Actualización del informe con los datos actuales

■ Guardar datos de informes de biblioteca en un archivo 
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Mensajes de alertas de estado 

Nota: Esta función sólo está disponible si la licencia de servicios (Service) está activa en 
la biblioteca. 

La biblioteca Status Module proporciona un mecanismo centralizado para la 
visualización y administración de las alertas de estado de la biblioteca, que son 
mensajes sobre problemas importantes con el firmware o la configuración de la 
biblioteca. Las alertas de estado aparecen también en el registro de eventos de 
la biblioteca, pero debido al volumen de mensajes en el mismo podrían quedar 
inadvertidas. La pantalla Status Module resalta los mensajes importantes 
facilitándole la identificación y solución de determinados problemas. 

A continuación, se muestran ejemplos de mensajes de alertas de estado que pueden 
aparecer en la pantalla Status Module:

■ Se han instalado robots redundantes pero la licencia para el robot dual no está activa

■ Una función con licencia está a punto de caducar

■ Se ha detectado una configuración de partición no válida 

La pantalla Status Module no incluye mensajes acerca de los problemas de dispositivos 
ya que los detalles sobre éstos se visualizan en las pantallas de estado del dispositivo 
respectivo (CAP Status, Drive Status, etc.) 

Un mensaje de alertas de estado también hace que el indicador del estado de la 
biblioteca cambie a amarillo o rojo según la gravedad del problema. Consulte “Estado 
de biblioteca y dispositivo” en la página 65 para obtener más detalles. 

Siga los procedimientos siguientes para obtener más detalles acerca de la 
administración de mensajes de alertas de estado:

■ “Visualización de alertas de estado de biblioteca” en la página 91

■ “Borrar las alertas de estado de biblioteca” en la página 94
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Operaciones CAP

Nota: La mayoría de las funciones de CAP descritas en esta sección se aplican a AEM 
así como CAP regulares. En casos donde haya una distinción entre los dos, el término 
“CAP giratorio” se usa para referirse a CAP regulares. 

Los CAP (puertos de acceso a cartucho) permiten a un operador de biblioteca 
introducir cartuchos en la biblioteca o expulsarlos de la misma. Puede utilizar los CAP 
sólo cuando la biblioteca esté en modo automático. 

CAP giratorios
Un CAP giratorio está siempre presente en el módulo básico. De forma opcional, el 
módulo de expansión de unidades y el módulo de expansión de cartuchos pueden 
tener también cada uno un CAP giratorio. 

Cada CAP giratorio contiene dos magazines con 13 ranuras extraíbles, lo que permite 
importar o exportar un total de 26 cartuchos al mismo tiempo a través de cada CAP. 

CAP de AEM
Consulte “Operaciones AEM” en la página 74 para obtener una descripción detallada 
de CAP de AEM. 

Secuencia de apertura de CAP
La apertura de un CAP incluye los pasos siguientes:

1. Un host envía un comando para desbloquear el CAP. 

2. El estado del CAP se actualiza a “no bloqueado.”

3. El operador de biblioteca pulsa el botón CAP en el teclado.

4. El estado del CAP se actualiza a “abierto.”

5. El motor del CAP se activa, y el CAP gira hacia fuera para exponer los magazines 
(CAP giratorios). Para los CAP de AEM, una vez que se ilumina el indicador LED 
Enter, el operador de biblioteca puede levantar el seguro y abrir la puerta de acceso 
AEM (CAP de AEM). 

Secuencia de cierre de CAP
El cierre de un CAP incluye los pasos siguientes:

1. El operador de biblioteca pulsa el botón CAP en el teclado. 
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2. El motor del CAP se activa, y el CAP gira hacia dentro para cerrar el CAP (CAP 
giratorios). El operador de biblioteca puede cerrar la puerta de acceso AEM y bajar el 
seguro (CAP de AEM). 

3. El operador de biblioteca pulsa de nuevo el botón CAP para iniciar la secuencia de 
cierre. 

4. El estado del CAP se actualiza a “cerrado” y “bloqueado”.

5. El TallBot audita todas las ranuras del CAP.

Modo de introducción automática
El modo de introducción automática de CAP permite a un operador de biblioteca abrir 
un CAP giratorio o de AEM e iniciar una operación de introducción sin emitir una 
solicitud de introducción explícita y sin una reserva explícita de una aplicación host. 
Cuando un CAP está en modo de introducción automática, está desbloqueado de forma 
predeterminada, y el indicador LED está encendido. El CAP está bloqueado sólo 
durante la introducción o expulsión del cartucho, o las operaciones de auditoría. 

El modo de introducción automática se administra en aplicaciones host. Consulte la 
documentación correspondiente del software de administración de cintas para obtener 
más detalles. Para colocar un CAP en modo de introducción automática, debe 
introducir el comando de sistema apropiado para desbloquear el CAP. 

Para iniciar una operación de introducción con un CAP automático, sólo necesita pulsar 
el botón CAP Open en el teclado. El modo de introducción automática no afecta a 
operaciones CAP de expulsión de cartuchos; por tanto, debe enviar un comando de 
expulsión explícito para expulsar cartuchos a través de un CAP en modo de 
introducción automática.

Modo CAP manual 
El modo manual es el método de operaciones CAP más seguro. 

Cuando está en modo manual, un CAP giratorio o de AEM está bloqueado de forma 
predeterminada y el indicador LED no está encendido. Para iniciar una operación de 
introducción o expulsión mediante un CAP manual, debe introducir una solicitud 
explícita de introducción o expulsión antes de pulsar el botón CAP Open en el teclado. 

Prioridades CAP para la expulsión de cartuchos por 
hosts FC-SCSI
Cuando inicia una operación de expulsión en un host HLI, puede especificar el CAP 
que desea utilizar. Sin embargo, la interfaz SCSI no ofrece este nivel de control. 
Fundamentalmente, la interfaz agrega todos los CAP y AEM a la biblioteca y los 
considera como un solo CAP grande. Cuando inicia una operación de expulsión en un 
host FC-SCSI, el TallBot coloca los cartuchos en los CAP, desplazándose de izquierda a 
derecha y empezando primero con los CAP giratorios; a continuación moviéndose a los 
AEM, si procede. 
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Por ejemplo, se asume que una biblioteca FC-SCSI tiene la configuración siguiente:

■ Módulo básico con CAP giratorio estándar

■ Dos CEM con CAP giratorios opcionales

■ Dos AEM 

Nota: El ejemplo siguiente asume una biblioteca no particionada o una biblioteca 
particionada en las que todos los hosts comparten todos los CAP y AEM. En el caso de 
bibliotecas particionadas, la prioridad CAP depende de cómo se hayan asignado los 
CAP a las particiones. 

En el caso de una operación de expulsión de 350 cartuchos, el TallBot rellenaría las 
celdas CAP en el orden siguiente:

Uso de CAP en una biblioteca particionada

Nota: Este tema sólo es aplicable a bibliotecas particionadas. Consulte “Resumen de 
tareas de particiones” en la página 278 para obtener detalles sobre la partición de 
bibliotecas. 

Módulo
Número de 
cartuchos

Cartuchos
totales

1 CEM izquierdo 26 26

2 Módulo básico 26 52

3 CEM derecho 26 78

4 AEM izquierdo 234 312

5 AEM derecho 38 350
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Un CAP giratorio o de AEM es un recurso de biblioteca compartido, es decir, lo pueden 
utilizar todas las particiones de la biblioteca. Sin embargo, un CAP se puede utilizar 
sólo por una partición cada vez. Mientras una partición esté utilizando un CAP para 
introducciones o expulsiones, el CAP se reserva a esa partición y no está disponible 
para las demás. 

Para que una partición reserve un CAP, se deben reunir las siguientes condiciones:

■ El CAP debe estar disponible, es decir, no debe estar reservado por ninguna otra 
partición. 

■ El CAP debe estar vacío.

■ El CAP debe estar cerrado y bloqueado.

Para obtener detalles adicionales, consulte ““Propiedad” de CAP” en la página 268. 

Información adicional de CAP
Consulte las secciones siguientes de este manual para obtener detalles completos acerca 
de los CAP giratorios y de AEM. 

Sección Tipo de información Página

“Operaciones AEM” Información de uso que se aplica de forma 
específica a los CAP de AEM

74

“Tareas de administración de 
CAP giratorio y de AEM”

Procedimientos para visualizar el estado y 
las propiedades de los CAP giratorios

118

“Tareas de administración de 
cartuchos”

Procedimientos sobre el empleo de los CAP 
giratorios para cargar y descargar cartuchos

130

“Particiones y CAP giratorios 
y de AEM”

Información de configuración de 
particiones relativa a los CAP giratorios

267
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Operaciones AEM 
El AEM (módulo de expansión de acceso) permite a un operador de biblioteca realizar 
cargas o descargas a granel de hasta 234 cartuchos cada vez en la biblioteca o desde 
ésta. El AEM permite también el mantenimiento de una biblioteca sin ninguna 
interrupción TallBot. 

Nota: Los AEM comparten muchas de las mismas características y funciones de los 
CAP giratorios pero también poseen algunas características únicas. Esta sección 
describe qué es único en los AEM. 

Puerta de acceso AEM 
La puerta de acceso AEM es la puerta exterior que puede abrir para cargar o descargar 
cartuchos a granel en la biblioteca o desde la misma. El panel frontal de la puerta de 
acceso incluye los siguientes componentes: 

■ Tres indicadores LED: esperar, entrar y desbloquear

■ Dos cerraduras: 

■ Service Access: sólo puede ser abierto por un Sun CSE de StorageTek. La apertura 
de esta cerradura libera el cerrojo de la puerta de acceso.

■ Deadbolt Override: para “acceder rápidamente” al interior del AEM por un 
operador de biblioteca. Esta acción tiene el mismo efecto en las operaciones de la 
biblioteca que la apertura de la puerta principal de acceso a la biblioteca. 

■ Botón “Operator Request CAP”: para acceder de forma normal al interior del AEM a 
fin de cargar o descargar cartuchos. Pulsando este botón libera el cerrojo de la puerta 
de acceso. 

■ Seguro: abre y cierra la puerta de acceso. El seguro sólo se puede abrir después que 
haya liberado el cerrojo o anulado el mismo. 

Puerta de seguridad AEM
La puerta de seguridad es la puerta interior "garaje" que se baja para separar el AEM 
del resto de la biblioteca. Esta puerta permite el acceso seguro al interior del AEM al 
operador de biblioteca para cargar o descargar cartuchos o al Sun CSE de StorageTek 
para realizar el mantenimiento en el TallBot o en otros componentes del AEM. 

La puerta de seguridad está bajada cuando pulsa el botón “Operator Request CAP” en 
la puerta de acceso AEM o cuando un Sun CSE de StorageTek utiliza la cerradura 
Service Access. La puerta de seguridad no está bajada si “accede rápidamente” al AEM 
desbloqueando la cerradura Deadbolt Override. 

La puerta de seguridad sube automáticamente cuando cierra la puerta de acceso AEM. 
Después el TallBot entra en AEM y lleva a cabo una auditoría de todas las celdas AEM. 
Un auditoría completa de un AEM debería realizarse en menos de tres minutos. 
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Funciones CAP de AEM
Cada CAP de AEM contiene 18 magazines de cartuchos con 13 ranuras extraíbles en la 
pared frontal y trasera, de un total de 234 ranuras de cartuchos. Los magazines están 
organizados en una configuración de 3 X 3 en cada pared. Los magazines son los 
mismos que aquellos utilizados en CAP giratorios.

En términos de cargas y descargas de cartuchos, el controlador de biblioteca considera 
cada AEM como un CAP muy grande. Consulte “Operaciones CAP” en la página 70 
para obtener información sobre las funciones del CAP que se aplican a los AEM. 

Particiones y AEM
Con respecto a las particiones de biblioteca, los CAP de AEM están sujetos a las 
mismas reglas y restricciones que los CAP giratorios. Éstos se pueden asignar para uso 
exclusivo de una partición o se pueden compartir por varias particiones que tengan el 
mismo tipo de interfaz host. Consulte “Particiones y CAP giratorios y de AEM” en la 
página 267 para obtener más detalles. 

Mantenimiento sin interrupción
El AEM permite al CSE de StorageTek de Sun acceder y mantener de forma segura 
un TallBot de la biblioteca sin tener que desconectar la biblioteca. Si un TallBot está 
defectuoso, el mismo se aparca en el AEM. La biblioteca continua conectada y si se 
instalan TallBot redundantes, la biblioteca puede continuar el funcionamiento de forma 
normal a través del TallBot funcional restante. 

Un CSE de StorageTek de Sun puede utilizar una clave especial para desbloquear la 
cerradura Service Access en la puerta de acceso. Esto hace que la puerta de seguridad 
AEM se baje y aisle el AEM del resto de la biblioteca. Una vez que la puerta de 
seguridad se ha cerrado completamente, el CSE de StorageTek de Sun puede abrir 
la puerta de acceso AEM y realizar de forma segura el mantenimiento en el TallBot 
defectuoso o en los otros componentes del AEM, mientras la biblioteca sigue conectada. 
El propio AEM se desconecta durante el período de mantenimiento provocando la 
suspensión de las funciones de carga y descarga de cartuchos. 

Cuando se ha completado el mantenimiento, el CSE de StorageTek cierra la puerta de 
acceso; la puerta de seguridad sube; se reinicializa el TallBot que realiza una auditoría 
de las ranuras de cartuchos CAP de AEM y, a continuación, se vuelve a activar el AEM. 



 

Operaciones AEM

76 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

Información adicional de AEM
Consulte las secciones siguientes de este manual para obtener detalles completos acerca 
de los AEM. 

Sección Tipo de información

“Operaciones CAP” Información de uso que se aplica a los CAP 
giratorios y a los CAP de AEM

70

“Tareas de administración de 
CAP giratorio y de AEM”

Procedimientos para visualizar el estado y las 
propiedades de los CAP de AEM

118

“Tareas de administración de 
cartuchos”

Procedimientos sobre el empleo de los CAP 
de AEM para cargar y descargar cartuchos

130

“Tareas de administración de 
la puerta de seguridad AEM”

Procedimientos para visualizar el estado y las 
propiedades de la puerta de seguridad AEM 
(puerta “garaje”) 

183

“Particiones y CAP giratorios 
y de AEM”

Información de partición de configuración 
relativa a los CAP giratorios y de AEM

267

“Tareas de utilidad de la 
puerta de seguridad AEM”

Procedimientos para reiniciar la puerta de 
seguridad AEM (puerta “garaje”) 

467



 

Administración de cartuchos

418605401 • Revisión AB SL3000 Operaciones automatizadas de la biblioteca 77

Administración de cartuchos 
Todos los cartuchos de biblioteca deben tener una etiqueta externa legible. Consulte el 
Apéndice C, “Manejo de cartuchos” para obtener más detalles. 

Las aplicaciones software de host HSC y ACSLS no admiten cartuchos sin etiqueta y no 
permite que sean introducidos a través del CAP. Si coloca un cartucho sin etiqueta en 
un CAP, el host lo deja allí y debe eliminarlo del CAP. 

Si coloca un cartucho sin etiqueta en una celda de almacenamiento de forma manual, el 
TallBot lo deja allí durante una auditoría de hardware y no intenta colocar otro cartucho 
en la ranura. En una auditoría de ACSLS o HSC, sin embargo, el host mueve el 
cartucho al CAP para su expulsión de la biblioteca. 

El controlador de biblioteca no permite montar un cartucho sin etiqueta o desconocido 
en ninguna unidad de cinta. 

Introducción de cartuchos
Puede introducir hasta 26 cartuchos al mismo tiempo a través de cada CAP giratorio. 
Puede cargar a granel hasta 234 cartuchos a través de cada CAP de AEM. 

Antes de introducir un cartucho en la biblioteca, debe comprobar que está 
correctamente etiquetado. Inserte cada cartucho en una ranura de CAP de manera que 
la etiqueta de cliente (si hay) quede en la parte frontal, el dispositivo en la parte 
posterior, y la etiqueta VOLID también frente a usted. Los cartuchos se pueden colocar 
en cualquier ranura CAP, en cualquier orden; el TallBot audita todas las ranuras CAP 
cuando la puerta del CAP está cerrada. 

Nota: El diseño de CAP evita que se pueda colocar un cartucho T9x40 o T10000 en el 
CAP al revés. Sin embargo, no evita que se pueda colocar un cartucho LTO en el CAP al 
revés. 

El escáner de códigos de barra de TallBot lee identificadores de volumen (VOLID) de 
cartuchos sólo durante operaciones de introducción, ya que los VOLID son nuevos y se 
deben añadir a la base de datos del controlador de biblioteca. El TallBot no necesita leer 
identificadores VOLID de cartuchos durante expulsiones. 

Cuando se introduce un cartucho en la biblioteca, el host le asigna una celda principal 
o se monta en una unidad, según la razón por la que se ha introducido. La ubicación de 
un cartucho almacenado se registra en la base de datos del controlador de biblioteca, 
con el formato de dirección interna de la biblioteca (consulte “Dirección interna de 
biblioteca” en la página 489). La ubicación también se transmite al host para inclusión 
en la base de datos de cartuchos del host.
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Expulsión de cartuchos
Puede expulsar hasta 26 cartuchos al mismo tiempo a través de cada CAP giratorio. 
Puede descargar a granel hasta 234 cartuchos a través de cada CAP de AEM.

Para expulsar un cartucho, debe especificar el identificador de volumen (VOLID) del 
cartucho que desea eliminar de la biblioteca. El TallBot se mueve a la ubicación de 
almacenamiento indicada en la base de datos del controlador de biblioteca, elimina el 
cartucho de la ranura y coloca el cartucho en una ranura de CAP. Consulte “Prioridades 
CAP para la expulsión de cartuchos por hosts FC-SCSI” en la página 71 para obtener 
detalles sobre el orden en el que se utilizan los CAP en las bibliotecas FC-SCSI. Una vez 
que el CAP está abierto, el cartucho y su ubicación se eliminan de la base de datos del 
controlador de biblioteca y la base de datos del host. 

Nota: El TallBot no lee identificadores VOLID de cartuchos durante operaciones de 
expulsión. 

Búsqueda de cartuchos
SL Console permite visualizar la dirección interna de biblioteca de cualquier cartucho. 
Puede ubicar un cartucho según los siguientes criterios:

■ VOLID (identificador de volumen)

■ Dirección interna de biblioteca

■ dirección HLI-PRC 

Esta utilidad es especialmente práctica cuando necesita realizar un montaje manual de 
un cartucho. El software de administración de bibliotecas (por ejemplo, HSC o ACSLS) 
proporciona el VOLID y la dirección HLI-PRC o FC-SCSI del cartucho, y la dirección de 
bahía de una unidad disponible. Antes de introducir la biblioteca, anote el VOLID, la 
ubicación del cartucho y la ubicación de ranura de la unidad. 

Movimientos de recuperación 
Con la función de diagnósticos de movimientos de recuperación, puede mover un 
cartucho de una ubicación a otra. Por ejemplo:

■ Puede devolver un cartucho a su ubicación original desde una celda CAP, unidad, u 
otra ubicación de celda de almacenamiento. 

■ Puede decidir agrupar cartuchos por tipo de datos o mover los más cerca de las 
unidades asignadas. 

■ Puede expulsar un cartucho de limpieza o diagnóstico que ha caducado.

■ Puede introducir un nuevo cartucho de limpieza o diagnóstico y moverlo a una 
celda de almacenamiento reservada. 
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Un cartucho que esté actualmente en una celda de almacenamiento sólo se puede 
mover a un CAP, a una celda reservada, o a otra celda de almacenamiento, pero no a 
una unidad. Un cartucho que esté actualmente en una unidad, CAP o celda reservada 
se puede mover a cualquier otra ubicación vacía de la biblioteca. Siga los 
procedimientos siguientes para obtener detalles completos:

■ “Movimiento de un cartucho especificado por VOLID” en la página 144

■ “Movimiento de un cartucho de una ubicación especificada” en la página 146

Antes de mover un cartucho, es útil generar un informe resumen de cartuchos que 
incluye una lista con el contenido de las celdas de almacenamiento de la biblioteca. 
Consulte “Lista de cartuchos de biblioteca” en la página 139 para obtener más detalles. 
Este informe le ayuda a determinar donde están ubicados actualmente los cartuchos y 
qué celdas de almacenamiento están vacías. 
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Unidades
Puede instalar hasta 56 unidades en una biblioteca, de la siguiente manera:

■ Hasta 24 en el módulo básico

■ Hasta 32 en un módulo de expansión de unidades (DEM)

Consulte “Unidades de cinta” en la página 17 para obtener una lista de unidades de 
cinta compatibles. 

Identificación de unidades
La biblioteca utiliza los siguientes esquemas de dirección para cada unidad de 
biblioteca:

■ Dirección interna de biblioteca: para todas las unidades. Asignada por el controlador 
de biblioteca en función de la ubicación de biblioteca, raíl, columna, lateral y fila en 
la unidad. 

■ Dirección HLI-PRC (Host LMU Interface-Panel, Row, Column): sólo para conexiones 
host TCP/IP. Asignada por las aplicaciones host. 

■ Dirección de elemento SCSI host: sólo para conexiones host FC SCSI. Asignada por 
las aplicaciones host. 

■ Dirección de bahía de unidad: para todas las unidades. Asignada por el controlador 
de biblioteca en función de la ranura física en la que está instalada la unidad. 

■ World Wide Name dinámico: sólo para conexiones Fibre Channel (FC). Asignado por 
el controlador de biblioteca en función de la ranura en la que está instalada la 
unidad. 

Consulte Apéndice A, “Direcciones de recursos de biblioteca” en la página 487 para 
obtener detalles sobre esquemas de direcciones e identificación de unidades. 

Estados de unidades
Una unidad pueden estar en uno de los siguientes estados:

■ Conectada (online): la unidad está disponible para operaciones de lectura y escritura.

■ Desconectada (offline): la unidad no está disponible para operaciones de lectura y 
escritura. 

Información adicional
Para obtener detalles de los procedimientos de unidades, consulte “Tareas de 
administración de unidades” en la página 150. 
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Limpieza de unidades 
Las unidades de cinta de una biblioteca requieren una limpieza periódica para evitar 
errores de lectura y escritura. La biblioteca admite dos métodos de limpieza de 
unidades:

■ Administración de limpieza automática a través de la SL Console 

■ Limpieza manual 

Cartuchos de limpieza

Nota: Debe utilizar cartuchos de limpieza cuyos tipos de medio sean compatibles con 
los tipos de unidad de la biblioteca. 

Los cartuchos de limpieza tienen un periodo de vida limitado. Consulte las 
publicaciones sobre unidades de cinta para determinar el contador de uso, o umbral, 
para cada tipo de cartucho de limpieza.

Cuando introduce un cartucho de limpieza en la biblioteca, el controlador de biblioteca 
considera que el cartucho es nuevo y define el contador de uso en cero. Por tanto, es 
importante introducir sólo cartuchos de limpieza nuevos en la biblioteca. 

Siempre que se utilice un cartucho de limpieza para limpiar una unidad, el contador de 
uso aumenta. Cuando el contador de uso de un cartucho de limpieza supera el umbral, 
se debe sustituir el cartucho. 

Puede utilizar SL Console para visualizar el estado de un cartucho de limpieza en 
cualquier momento. Son posibles los estados siguientes:

■ OK: el cartucho aún está dentro del umbral.

■ Aviso: el cartucho ha alcanzado el umbral.

■ Caducado: el cartucho ha superado el umbral.

Expulsión de cartuchos de limpieza caducados 
Debe prestar atención cuando saque los cartuchos de limpieza caducados de la 
biblioteca. Si mueve un cartucho de limpieza caducado a un CAP y abre el CAP, debe 
eliminar el cartucho. Si cierra el CAP sin eliminar primero el cartucho de limpieza, el 
TallBot volverá a introducir el cartucho caducado en la biblioteca, y el controlador de 
biblioteca restablecerá el contador de uso a cero. 
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Administración de limpieza automática a través de 
la SL Console 
La función de limpieza automática de SL3000 (o “autolimpieza”) permite administrar la 
limpieza automática de la unidad a través de la SL Console. Esta función debe activarse 
sólo para particiones o bibliotecas enteras controladas por hosts FC-SCSI. 

Para todas las otras particiones y bibliotecas enteras, aquellas que están controladas 
por el software de administración de cintas ACSLS o HSC, debe desactivar la función 
de limpieza automática en la SL Console. (Consulte “Configuración de limpieza 
automática de unidades” en la página 168 para obtener más detalles.) ACSLS o HSC 
administrará la función de limpieza automática para estas particiones y bibliotecas, y 
la función de limpieza automática de SL3000 evita que se notifique a HSC y ACSLS 
cuando se necesita una limpieza de las unidades. Consulte la documentación de HSC 
y ACSLS para obtener más detalles. 

La función de limpieza automática de SL3000 no admite actualmente las funciones 
siguientes:

■ Importación automática de cartuchos de limpieza a través del CAP y colocación 
de estas cintas en celdas reservadas y dedicadas para cartuchos de limpieza y 
diagnóstico. 

■ Exportación automática de cartuchos de limpieza caducados a través del CAP. 

Cuando la limpieza automática está activada, el controlador de biblioteca inicia 
automáticamente una operación de limpieza siempre que una unidad precise una 
limpieza. El TallBot recupera un cartucho de limpieza apropiado (según el tipo de 
unidad) de las celdas reservadas, monta el cartucho en la unidad y devuelve el cartucho 
a la celda de almacenamiento asignada una vez que se ha completado la limpieza.

Limpieza manual 

Nota: La limpieza manual de unidades se inicia a través del software de 
administración de bibliotecas. Consulte la documentación de ACSLS o HSC para 
conocer la sintaxis de comandos.

Si la limpieza automática está desactivada, debe iniciar manualmente las operaciones 
de limpieza de unidades. Para comprobar si una unidad necesita limpieza, debe utilizar 
SL Console para visualizar el estado de limpieza de la unidad y la fecha en la que se ha 
limpiado por última vez. 

Si la limpieza automática está activada, aún podrá iniciar una limpieza manual, según 
el tipo de unidad. Algunos tipos de unidad permiten una limpieza manual en cualquier 
momento, mientras que otros no permiten que se inicie una limpieza a menos que se 
haya satisfecho el umbral de uso. En este último caso, la biblioteca puede permitirle 
montar un cartucho de limpieza en una unidad, pero la unidad no realizará realmente 
la operación de limpieza. Consulte las publicaciones sobre unidades de cinta para 
obtener más detalles. 

Para saber el tipo correcto de limpieza para una unidad determinada, puede utilizar la 
SL Console para generar un informe de resumen de cartuchos y detalles de unidad. 
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TallBots 
El TallBot de la biblioteca mueve cartuchos en las ranuras de almacenamiento, las 
unidades de cinta y los CAP. Además, realiza auditorías de la biblioteca. 

El TallBot se incluye con el módulo básico y es accesible desde la parte frontal del 
bastidor. Los tres componentes principales de un TallBot son:

■ Ensamblado de tabla X: proporciona un movimiento lateral de 180 grados. 

■ Ensamblado de unidad Z: proporciona un movimiento vertical. 

■ Ensamblado manual: incluye los siguientes componentes:

■ Agarres para transportar los cartuchos. 

■ Escáner láser de códigos de barra para calibrar la posición y leer las etiquetas de 
los cartuchos. 

■ Sensor de proximidad para detectar celdas de almacenamiento vacías y cartuchos 
sin etiqueta. 

Consulte “Tareas de supervisión de robot y suministro de potencia” en la página 177 
para obtener detalles sobre la visualización y administración de estados de TallBot y 
otra información. 
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Suministros de potencia
SL3000 ofrece redundancia total para unidades de cinta, unidades robóticas y 
electrónica. Las siguientes opciones de redundancia están disponibles: 

■ N+1 

■ 2N 

■ 2N+1 

Las siguientes opciones de suministro de potencia están disponibles:

■ 120-127 VAC, unifásica

■ 200-240 VAC, unifásica

Consulte “Opciones de potencia” en la página 22 para obtener detalles adicionales. 
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Tipo de interfaz host
SL3000 admite las siguientes opciones de interfaz de ruta de control: 

■ HLI (TCP/IP): protocolo TCP/IP con Ethernet 10/100 Base-T y cables CAT-5 

■ FC-SCSI: protocolo SCSI 3 y conjunto de comandos en una interfaz Fibre Channel 
física

Consulte “Ruta de control de la biblioteca” en la página 24 para obtener más detalles. 

Bibliotecas noparticionadas
En bibliotecas no particionadas, todos los hosts deben utilizar el mismo tipo de interfaz 
para conectarse a la biblioteca. 

Puede visualizar el tipo de interfaz en la pantalla System Detail > Status > General. 

Puede cambiar el tipo de interfaz en la pantalla Select Active Cells > Select Active Cells. 

Bibliotecas particionadas
En bibliotecas particionadas, se pueden usar los tipos de interfaz host FC-SCSI y HLI; 
cada partición debe utilizar uno u otro. Cuando crea una nueva partición, especifica 
qué tipo de interfaz emplea la partición. Todos los hosts de una partición utilizan el 
mismo tipo de interfaz. 
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Para obtener detalles completos, consulte “Conexiones host-partición” en la página 261. 
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Tareas de operaciones automáticas 
Las tareas de operaciones automáticas de biblioteca se dividen en las siguientes 
categorías:

■ “Tareas de administración de biblioteca” en la página 89

■ “Tareas de administración de CAP giratorio y de AEM” en la página 118

■ “Tareas de administración de cartuchos” en la página 130

■ “Tareas de administración de unidades” en la página 150

■ “Tareas de limpieza de unidades” en la página 167

■ “Tareas de supervisión de robot y suministro de potencia” en la página 177

■ “Tareas de administración de la puerta de seguridad AEM” en la página 183
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Tareas de administración de biblioteca

Tarea Página

Visualización del estado de biblioteca 90

Visualización de alertas de estado de biblioteca 91

Borrar las alertas de estado de biblioteca 94

Visualización del estado de puerto HLI 96

Visualización de datos de configuración de biblioteca 98

Visualización de propiedades del controlador de biblioteca 99

Visualización de propiedades del controlador de unidades 101

Visualización de propiedades del controlador de unidades 101

Cambio del tipo de interfaz de biblioteca (bibliotecas no 
particionadas)

102

Visualización de un informe de biblioteca 105

Búsqueda de informes de biblioteca 107

Guardar datos de informes de biblioteca en un archivo 109

Visualización del informe sobre el control de energía de la biblioteca 
de las “últimas 24 horas”

111

Visualización del informe sobre el control de energía de la biblioteca 
del “último mes”

113

Visualización del informe sobre el control de energía de la biblioteca 
del “último año”

115
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▼ Visualización del estado de biblioteca 
Vea el estado operativo actual de la biblioteca. Estos valores se actualizan cuando hay 
actividad de host, operaciones en segundo plano o actividad de operador.

Nota: Esta información también está disponible en Reports > Library Details. Consulte 
“Visualización de un informe de biblioteca” en la página 105 para obtener instrucciones 
detalladas. 

1. Seleccione Tools > System Detail y haga clic en la carpeta Library.

2. Haga clic en la ficha Status y, a continuación, en la ficha General.

La pantalla muestra el estado actual de la biblioteca. 
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▼ Visualización de alertas de estado de biblioteca

Nota: Esta función sólo está disponible si la licencia de servicios (Service) está activa en 
la biblioteca. 

Nota: Si la licencia de servicios (Service) no está activada en la biblioteca, esta pantalla 
estará en blanco excepto por el mensaje indicando que “la licencia de servicios (Service) 
no es válida”. 

Utilice este procedimiento para visualizar las alertas de estado de biblioteca, que 
pueden ayudarle a identificar si existen algunos problemas actuales o pendientes con el 
firmware o la configuración de la biblioteca. Puede realizar este procedimiento siempre 
que el indicador del estado de la biblioteca haya cambiado de verde a amarillo o rojo, 
indicando un aviso o error. 

1. Seleccione Tools > System Detail y haga clic en la carpeta Library. 

2. Haga clic en la ficha Status y, a continuación, en la ficha Status Module. 

La pantalla muestra todas las alertas de estado de biblioteca. 
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Campos de la pantalla
Clear Alert Number 

Opcional.

Mensaje de alertas de estado que desea borrar de la pantalla. 

El menú desplegable muestra números del 0 al 20. Aunque puede seleccionar 
cualquiera de éstos, sólo los números que se correspondan con los mensajes de 
alertas eliminables mostrados en la pantalla originarán realmente un mensaje para 
ser borrados. 

Alert #

Sólo visualización.

Número secuencial asignado a los mensajes de alertas de estado. 

Level

Sólo visualización.

Nivel de gravedad de los mensajes de alertas de estado. Las opciones son: 

■ OK: el módulo firmware está funcionando con normalidad. 

■ Information: mensaje de información; el módulo firmware está funcionando con 
normalidad. 

■ Warning: el módulo firmware está funcionando en un estado degradado; puede 
indicar que es posible un fallo. 

■ Error: el módulo firmware ha sufrido un fallo. 

Module Name

Sólo visualización.

El mensaje afecta al módulo firmware del controlador de biblioteca. 

Clearable? 

Sólo visualización.

Indica si los mensajes de alertas de estado se pueden borrar de forma manual de la 
pantalla. Las opciones son:

■ Yes: los mensajes se pueden borrar y el estado del módulo firmware vuelve al 
nivel de gravedad OK. 

■ No: los mensajes no se pueden borrar. De forma general, mensajes de OK e 
información no se pueden borrar. 

Description

Sólo visualización.

Descripción completa de los mensajes de alertas de estado. 
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Botones
Apply

Haga clic para borrar los mensajes de alerta seleccionados de la pantalla Status 
Module. El estado del módulo firmware ha vuelto a OK y el indicador del estado de 
la biblioteca se ha actualizado. 

Nota: Si el mensaje de alerta se actualiza periódicamente, reaparece en el siguiente 
ciclo de actualización.

Refresh 

Haga clic en este botón para actualizar la pantalla con los datos actuales de la base 
de datos del controlador de biblioteca. 
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▼ Borrar las alertas de estado de biblioteca 

Nota: Esta función sólo está disponible si la licencia de servicios (Service) está activa en 
la biblioteca. 

Utilice este procedimiento para borrar una alerta de estado del firmware de la 
biblioteca. No se pueden borrar todas las alertas.

Nota: Borrar una alerta sólo la elimina de la visualización en la pantalla. No resuelve el 
problema subyacente. 

1. Seleccione Tools > System Detail y haga clic en la carpeta Library. 

2. Haga clic en la ficha Status y, a continuación, en la ficha Status Module. 

La pantalla muestra todas las alertas de estado de biblioteca. 

3. En el menú desplegable Clear Alert Number, seleccione el número de alerta que 
desea borrar de la pantalla y haga clic en Apply. 
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Nota: Aunque puede seleccionar cualquier número de alerta, sólo se podrán borrar las 
alertas marcadas como “Clearable” (eliminables). 

Se elimina la alerta de la pantalla Status Module. El indicador del estado de la 
biblioteca vuelve a verde si existen otras alertas de dispositivo o estado. 

Nota: Si la alerta está sujeta a actualizaciones periódicas, reaparece en el siguiente ciclo 
de actualización.
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▼ Visualización del estado de puerto HLI 
Utilice este procedimiento para visualizar el estado actual de los puertos HLI de todas 
las interfaces LMU (library management unit) host de la biblioteca. La información 
incluye socket TCP/IP local, IP local, estado de conexión, estado de puerto, transmisión 
enviada y recibida del tiempo de conexión.

1. Seleccione Tools > System Detail y haga clic en la carpeta Library. 

2. Haga clic en la ficha Status y, a continuación, en la ficha HLI. 

La pantalla muestra el estado actual y la actividad de todos los puertos HLI de la 
biblioteca. 
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▼ Visualización del estado de puerto FC-SCSI 
Utilice este procedimiento para visualizar el estado actual de todos los puertos de la 
interfaz FC-SCSI de host de la biblioteca. La información incluye el número de puerto, 
la velocidad y el estado, identificador de bucles, World Wide Node Name, World Wide 
Port Name y la topología. 

1. Seleccione Tools > System Detail y haga clic en la carpeta Library. 

2. Haga clic en la ficha Status y, a continuación, en la ficha SCSI. 

La pantalla muestra el estado actual y la actividad de todos los puertos FC-SCSI de la 
biblioteca. 
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▼ Visualización de datos de configuración de 
biblioteca
Utilice este procedimiento para visualizar la configuración física, mecánica y lógica 
de la biblioteca. Algunos de estos datos se configuran automáticamente durante la 
inicialización de la biblioteca, mientras que otra información la puede definir el 
usuario. 

Nota: Esta información también está disponible en Reports > Library Information. 
Consulte “Visualización de un informe de biblioteca” en la página 105 para obtener 
instrucciones detalladas. 

1. Seleccione Tools > System Detail y haga clic en la carpeta Library. 

2. Haga clic en la ficha Properties y, a continuación, en la ficha General.

La pantalla muestra información detallada sobre la biblioteca. 
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▼ Visualización de propiedades del controlador de 
biblioteca
Visualice detalles del controlador de biblioteca, como el número de serie y las versiones 
de firmware.

Nota: Esta información también está disponible en Reports > Library Information. 
Consulte “Visualización de un informe de biblioteca” en la página 105 para obtener 
instrucciones detalladas. 

1. Seleccione Tools > System Detail y haga clic en la carpeta Library. 

2. Haga clic en la ficha Properties y, a continuación, en la ficha Library Controller.
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▼ Visualización de propiedades del controlador de 
unidades 
Visualice detalles del controlador de unidades, como el número de serie y las versiones 
actuales de firmware.

Nota: Esta información también está disponible en Reports > Library Information. 
Consulte “Visualización de un informe de biblioteca” en la página 105 para obtener 
instrucciones detalladas. 

1. Seleccione Tools > System Detail y haga clic en la carpeta Library. 

2. Haga clic en la ficha Properties y, a continuación, en la ficha Drive Controller.

Aparece la pantalla Drive Controller. 
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▼ Cambio del tipo de interfaz de biblioteca 
(bibliotecas no particionadas)
Utilice este procedimiento para cambiar el tipo de interfaz que todos los hosts utilizan 
para conectarse a la biblioteca. 

Nota: Este procedimiento sólo es aplicable a bibliotecas no particionadas. Para cambiar 
los tipos de interfaz en una biblioteca particionada, consulte “Modificación del tipo de 
interfaz de una conexión host-partición” en la página 300. “Modificación del tipo de 
interfaz de una conexión host-partición” en la página 300.

1. Seleccione Tools > Select Active Cells. 

Aparece la pantalla Module Map.
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2. Haga clic en la ficha Select Active Cells.

Aparece la pantalla Select Active Cells, donde se muestra el tipo de interfaz 
actualmente asignado a la biblioteca.

3. En el menú desplegable Interface Type, seleccione el tipo de interfaz que desea 
asignar. Haga clic en Apply. 

Aparece el cuadro emergente Confirm Apply. 

4. Haga clic en Yes para actualizar la base de datos del controlador de biblioteca. 

Aparece el cuadro emergente Commit Success. 
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5. Haga clic en OK para volver a la pantalla Select Active Cells. 

El nuevo tipo de interfaz se activa de forma inmediata; no es necesario reiniciar la 
biblioteca. 
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▼ Visualización de un informe de biblioteca 
Utilice este procedimiento para visualizar informes de biblioteca disponibles en el 
menú Tools > Reports.

Nota: Los resultados del informe son una presentación estática de la información 
enviada por el controlador de biblioteca en el momento de generarse el informe. 
SL Console no actualiza la información de forma dinámica a no ser que se seleccione 
el botón Update en la barra de opciones.

Para buscar los datos del informe o guardarlos en un archivo, siga los procedimientos 
siguientes:

■ “Búsqueda de informes de biblioteca” en la página 107 

■ “Guardar datos de informes de biblioteca en un archivo” en la página 109

Informes adicionales están disponibles en los menús siguientes:

■ Tools > Partitions

■ Tools > Select Active Cells 

1. Seleccione Tools > Reports. 

Aparece la pantalla de informes Display. Todas las opciones de informes de biblioteca 
se incluyen en la barra de exploración.
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2. En la barra de exploración, expanda una categoría de informe para ver las opciones 
del informe.

3. Haga clic en el informe que desea visualizar. 

Se mostrará el informe seleccionado. 
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▼ Búsqueda de informes de biblioteca 
Utilice este procedimiento para buscar un informe de biblioteca para una cadena de 
texto determinada. Este procedimiento se puede realizar desde cualquier pantalla de 
informes de biblioteca.

1. Seleccione Tools > Reports. 

Aparece la pantalla de informes Display. Todas las opciones de informes de biblioteca 
se incluyen en la barra de exploración.

2. En la barra de exploración, expanda una categoría de informe para ver las opciones 
del informe.

3. Haga clic en el informe que desea visualizar. 

Se mostrará el informe especificado. Todas las pantallas de informes incluyen el botón 
Search en la barra de opciones. 

4. Haga clic en Search. 

Aparece el cuadro emergente Search Text. 

5. Introduzca la cadena de texto que desea buscar y haga clic en Search. 
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Nota: La búsqueda distingue entre mayúsculas y minúsculas, y no admite comodines. 

6. Aparece el cuadro emergente Search Results, que muestra el número de repeticiones 
de la cadena de texto. Todas las instancias de la cadena de texto del informe se 
señalan. 

7. Haga clic en OK para descartar el elemento emergente. 
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▼ Guardar datos de informes de biblioteca en un 
archivo
Utilice este procedimiento para visualizar un informe de biblioteca y guardar los datos 
en un archivo. Según el informe, puede guardarlos en formato texto (.txt), HTML, 
XML o valores separados por comas (.csv). Este procedimiento se puede realizar 
desde cualquier pantalla de informes de biblioteca.

Una vez guardado el archivo, puede imprimirlo o adjuntarlo en un correo electrónico, 
lo cual puede resultar útil a la hora de comunicarse sobre los problemas de la biblioteca 
con su Sun representante de asistencia. También puede importar un archivo .csv en 
una aplicación de hoja de cálculo o gráfica a fin de entender e interpretar mejor los 
datos. 

1. Seleccione Tools > Reports. 

Aparece la pantalla de informes Display. Todas las opciones de informes de biblioteca 
se incluyen en la barra de exploración.

2. En la barra de exploración, expanda una categoría de informe para ver las opciones 
del informe.
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3. Haga clic en el informe que desea visualizar. 

Se mostrará el informe especificado. Todas las pantallas de informes incluyen el botón 
Save en la barra de opciones. 

4. Haga clic en Save. 

Aparece la ventana emergente Save. 

5. Vaya al directorio donde desea guardar el archivo. En el campo File Name, puede 
aceptar la entrada predeterminada o introducir un nombre de archivo diferente. 

6. En el menú desplegable Files of Type, seleccione el formato en el que va a guardar 
los datos (HTML, Text, XML, .csv). 

7. Haga clic en Save. 

Los datos se guardan en el archivo especificado. 

Nota: Si el archivo ya existe, aparece una ventana emergente que le pregunta si desea 
reemplazar el archivo. 
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▼ Visualización del informe sobre el control de 
energía de la biblioteca de las “últimas 24 horas”

Nota: This feature is available starting with SL3000 firmware version FRS_2.30 and 
SL Console version FRS_4.30. 

El informe sobre el control de energía de las últimas 24 horas muestra el uso de la 
energía y la potencia media de la biblioteca entera, minuto a minuto, durante las 
últimas 24 horas. Este informe le ayuda a supervisar el uso de potencia y de energía e 
identificar los períodos de uso máximo y mínimo durante el día.

De forma predeterminada, el informe está ordenado cronológicamente. Si lo desea, 
puede cambiar la ordenación y reorganizar y cambiar el tamaño de las columnas. 
Consulte “Modificación de la distribución de pantalla” en la página 39. 

Para representar este informe en un gráfico, puede guardar los datos en un archivo 
(.csv) separado por comas y después importar el archivo .csv a una aplicación 
gráfica. Para obtener más detalles, consulte “Save Library Report Data to a File”. 

Para ver informes relacionados, consulte la información siguiente:

■ “Visualización del informe sobre el control de energía de la biblioteca del “último 
mes”” en la página 113

■ “Visualización del informe sobre el control de energía de la biblioteca del “último 
año”” en la página 115 
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1. Seleccione Tools  >  Reports. 

2. Expanda la carpeta Statistics y haga clic en Energy Monitor - Last 24 Hours. 

Campos de la pantalla
Date 

Fecha y hora de las mediciones. 

kWh

La energía usada por la biblioteca entera durante el intervalo de un minuto, medida 
en kilovatio hora. 

kW

La potencia media usada por la biblioteca entera durante el intervalo de un minuto, 
medida en kilovatios. 
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▼ Visualización del informe sobre el control de 
energía de la biblioteca del “último mes”

Nota: This feature is available starting with SL3000 firmware version FRS_2.30 and 
SL Console version FRS_4.30. 

El informe sobre el control de energía del último mes muestra el uso de la energía y la 
potencia media de la biblioteca entera, medido en intervalos de 15 minutos durante los 
últimos 32 días. Este informe le ayuda a analizar el uso de la potencia y la energía, y a 
identificar los períodos de uso máximo y mínimo durante el último mes. 

De forma predeterminada, el informe está ordenado cronológicamente. Si lo desea, 
puede cambiar la ordenación y reorganizar y cambiar el tamaño de las columnas. 
Consulte “Modificación de la distribución de pantalla” en la página 39. 

Para representar este informe en un gráfico, puede guardar los datos en un archivo 
(.csv) separado por comas y después importar el archivo .csv a una aplicación 
gráfica. Para obtener más detalles, consulte “Save Library Report Data to a File”. 

Para ver informes relacionados, consulte la información siguiente:

■ “Visualización del informe sobre el control de energía de la biblioteca de las “últimas 
24 horas”” en la página 111

■ “Visualización del informe sobre el control de energía de la biblioteca del “último 
año”” en la página 115 
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1. Seleccione Tools  >  Reports. 

2. Expanda la carpeta Statistics y haga clic en Energy Monitor - Last Month. 

Campos de la pantalla
Date 

Fecha y hora de las mediciones. 

kWh

La energía usada por la biblioteca entera durante el intervalo de 15 minutos, medida 
en kilovatio hora. 

kW

La potencia media usada por la biblioteca entera durante el intervalo de 15 minutos, 
medida en kilovatios. 
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▼ Visualización del informe sobre el control de 
energía de la biblioteca del “último año”

Nota: This feature is available starting with SL3000 firmware version FRS_2.30 and 
SL Console version FRS_4.30. 

El informe sobre el control de energía del último año muestra el uso de la energía y la 
potencia media de la biblioteca entera, medido en intervalos de un día durante los 
últimos 365 días. Este informe le ayuda a analizar el uso de potencia y de energía y a 
identificar los períodos de uso máximo y mínimo durante el año. 

De forma predeterminada, el informe está ordenado cronológicamente. Si lo desea, 
puede cambiar la ordenación y reorganizar y cambiar el tamaño de las columnas. 
Consulte “Modificación de la distribución de pantalla” en la página 39. 

Para representar este informe en un gráfico, puede guardar los datos en un archivo 
(.csv) separado por comas y después importar el archivo .csv a una aplicación 
gráfica. Para obtener más detalles, consulte “Save Library Report Data to a File”. 

Para ver informes relacionados, consulte la información siguiente:

■ “Visualización del informe sobre el control de energía de la biblioteca de las “últimas 
24 horas”” en la página 111

■ “Visualización del informe sobre el control de energía de la biblioteca del “último 
mes”” en la página 113 
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1. Seleccione Tools  >  Reports. 

2. Expanda la carpeta Statistics y haga clic en Energy Monitor - Last Year. 

Campos de la pantalla
Date 

Fecha de las mediciones. 

Total kWh

La energía total usada por la biblioteca entera durante el día, medida en kilovatio 
hora. 

Avg kW

La potencia media usada por la biblioteca entera durante el día, medida en kilovatio 
hora. 

Max kWh

El valor máximo de energía durante un período de 15 minutos en el día. 

Min kWh

El valor mínimo de energía durante un período de 15 minutos en el día. 
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Avg kWh

Promedio de todos los valores de energía durante un período de 15 minutos en el 
día. 

Max kW

El valor máximo de potencia durante un período de 15 minutos en el día. 

Min kW

El valor mínimo de potencia durante un período de 15 minutos en el día. 

Avg kW

Promedio de todos los valores de potencia durante un período de 15 minutos en el 
día. 
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Tareas de administración de CAP giratorio 
y de AEM

Tarea Página

Visualización de información de resumen de CAP giratorio y de 
AEM

119

Visualización del estado actual del CAP giratorio o de AEM 120

Visualización de las propiedades del CAP giratorio o de AEM 123

Desbloqueo de una puerta de acceso CAP o AEM 126

Boqueo de una puerta de acceso CAP o AEM 128
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▼ Visualización de información de resumen de CAP 
giratorio y de AEM
Utilice este procedimiento para visualizar información de resumen de todos los CAP 
giratorios y de AEM de la biblioteca. 

Nota: Esta información también está disponible en Reports > CAP Summary. Consulte 
“Visualización de un informe de biblioteca” en la página 105 para obtener instrucciones 
detalladas. 

1. Seleccione Tools > System Detail y haga clic en la carpeta CAP. 

La pantalla contiene una lista de los CAP giratorios y de AEM de la biblioteca y sus 
ubicaciones. 
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▼ Visualización del estado actual del CAP giratorio 
o de AEM 
Utilice este procedimiento para visualizar el estado operativo actual de un CAP 
giratorio o de AEM. 

Nota: Esta información también está disponible en el informe de detalles del CAP. 
Consulte “Visualización de un informe de biblioteca” en la página 105 para obtener 
instrucciones detalladas. 

Nota: La información de estado de la puerta de seguridad, la puerta interior “garaje” 
que se baja para separar el AEM de resto de la biblioteca, se muestra en la pantalla 
Safety Door Status. Consulte “Visualización del estado de la puerta de seguridad 
AEM” en la página 184 para obtener instrucciones detalladas. 

Nota: Esta pantalla se usa para CAP giratorios y de AEM. En esta sección, el término 
“CAP” se refiere a ambos tipos de CAP. 

1. Seleccione Tools > System Detail. 

2. Expanda la carpeta CAP Folder y haga clic en el CAP que desea visualizar. 

Nota: Los CAP de AEM se identifican de la siguiente manera: columna “–31” para un 
CAP de AEM izquierdo y columna “31” para un CAP de AEM derecho. 

3. Haga clic en Status.

La pantalla muestra el estado actual del CAP seleccionado. 
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■ Para CAP giratorios: 
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■ Para CAP de AEM: 
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▼ Visualización de las propiedades del CAP 
giratorio o de AEM
Utilice este procedimiento para visualizar información estática de un CAP giratorio o 
de AEM, como el número de serie y el número de celdas. 

Nota: Esta información también está disponible en Reports > CAP Details. Consulte 
“Visualización de un informe de biblioteca” en la página 105 para obtener instrucciones 
detalladas. 

Nota: Para CAP de AEM, esta información también se muestra en la pantalla 
Safety Door Properties. Consulte “Visualización de las propiedades de la puerta de 
seguridad AEM” en la página 185 para obtener instrucciones detalladas. 

Nota: Esta pantalla se usa para CAP giratorios y de AEM. En esta sección, el término 
“CAP” se refiere a ambos tipos de CAP. 

1. Seleccione Tools > System Detail. 

2. Expanda la carpeta CAP y haga clic en el CAP que desea visualizar. 

Nota: Los CAP de AEM se identifican de la siguiente manera: columna “–31” para un 
CAP de AEM izquierdo y columna “31” para un CAP de AEM derecho. 

3. Haga clic en Properties. 

Aparece la pantalla CAP Properties. 



 

Tareas de administración de CAP giratorio y de AEM

124 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

■ Para CAP giratorios:
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■ Para CAP de AEM: 
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▼ Desbloqueo de una puerta de acceso CAP o 
AEM 
Normalmente una puerta de acceso CAP o AEM se desbloquea desde un host. Utilice 
este procedimiento cuando necesite realizar una operación de desbloqueo de forma 
manual en la SL Console. 

Nota: Esta pantalla se usa para CAP giratorios y de AEM. En esta sección, el término 
“CAP” se refiere a ambos tipos de CAP. 

1. Seleccione Tools > Diagnostics. 

2. Expanda la carpeta CAP Folder y haga clic en el CAP que desea modificar. 

Nota: Los CAP de AEM se identifican de la siguiente manera: columna “–31” para un 
CAP de AEM izquierdo y columna “31” para un CAP de AEM derecho. 

3. Haga clic en la ficha Access. 

Aparece la pantalla Access.
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4. En la lista desplegable Locked, haga clic en false. Haga clic en el botón Apply. 

Aparece el cuadro emergente Confirm. 

5. Haga clic en OK.

La puerta del CAP se desbloquea y la luz del botón CAP se enciende.

Nota: El estado del CAP cambia a “desbloqueado” en el software de administración de 
bibliotecas del host.

Nota: La biblioteca reserva el CAP o AEM que será inaccesible para todos los hosts de 
la biblioteca hasta que cierre y bloquee la puerta de acceso CAP o AEM. Consulte 
“Boqueo de una puerta de acceso CAP o AEM” en la página 128 para obtener más 
detalles. 
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▼ Boqueo de una puerta de acceso CAP o AEM
Normalmente una puerta de acceso CAP o AEM se bloquea desde un host. Utilice este 
procedimiento cuando necesite realizar una operación de bloqueo de forma manual en 
la SL Console. 

Nota: Este procedimiento sólo es aplicable a CAP HLI. 

Nota: Esta pantalla se usa para CAP giratorios y de AEM. En esta sección, el término 
“CAP” se refiere a ambos tipos de CAP. 

Nota: Si desbloquea una puerta de acceso CAP o AEM (consulte “Desbloqueo de una 
puerta de acceso CAP o AEM” en la página 126 para obtener más detalles), la biblioteca 
reserva el CAP o AEM y no estará disponible para todos los hosts hasta que realice este 
procedimiento. 

1. Seleccione Tools > Diagnostics. 

2. Expanda la carpeta CAP Folder y haga clic en el CAP que desea modificar. 

Nota: Los CAP de AEM se identifican de la siguiente manera: columna “–31” para un 
CAP de AEM izquierdo y columna “31” para un CAP de AEM derecho. 
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3. Haga clic en la ficha Access. 

Aparece la pantalla Access.

4. En el campo Locked, haga clic en True. Haga clic en el botón Apply. 

El CAP se bloquea y la luz del botón CAP se apaga.
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▼ Introducción de cartuchos mediante un CAP 
giratorio
Utilice este procedimiento para introducir cartuchos en la biblioteca a través de un CAP 
giratorio. 

Nota: Este procedimiento sólo es aplicable a bibliotecas no particionadas. Para 
bibliotecas particionadas, consulte “Introducción de cartuchos en una partición” en la 
página 319. 

Nota: Para obtener instrucciones detalladas sobre la carga de cartuchos a través de un 
CAP de AEM, consulte “Carga a granel de cartuchos mediante un CAP de AEM” en la 
página 135. 

1. Inicie la operación de introducción en el host. Consulte la documentación del 
software de administración de cintas correspondiente para obtener detalles de los 
procedimientos y comandos. 

Nota: Si el CAP está en modo de introducción automática, puede ignorar este paso y 
pasar directamente al Paso 2. 

2. Pulse el botón CAP para abrir el CAP. 

La puerta del CAP se abre. 

Atención: Posible daño de equipo. NO fuerce la apertura o cierre del CAP.

3. Coloque los cartuchos en el CAP.

Inserte los cartuchos de manera que la etiqueta de cliente (si hay) quede en la parte 
frontal, el concentrador en la parte posterior, y la etiqueta VOLID también frente a 
usted. 

Puede introducir los cartuchos directamente en los magazines mientras estén en el 
CAP; o puede eliminar los magazines del CAP, insertar cartuchos en los magazines y, a 
continuación, sustituir los magazines de cartuchos rellenos en el CAP.

Nota: Los cartuchos se pueden colocar en cualquier ranura CAP, en cualquier orden; el 
TallBot audita todas las ranuras CAP cuando la puerta del CAP se cierra.

Atención: Posible daño de medio. Mientras se introduzcan cartuchos que no incluyen 
etiquetas externas o que se colocan al revés, esto no es aconsejable. Presenta problemas 
cuando se realiza una auditoría. De igual modo, los cartuchos que contienen etiquetas 
ilegibles o dañadas no se deben introducir. 
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4. Pulse el botón CAP para cerrar el CAP.

El CAP se cierra y se bloquea automáticamente, y la luz del botón CAP se apaga.

Atención: Posible daño de equipo. NO fuerce la apertura o cierre del CAP.

5. El TallBot audita el CAP y después mueve los cartuchos desde el CAP a las ranuras 
de almacenamiento en la partición apropiada. 

Cuando todos los cartuchos se han movido del CAP, la biblioteca reconoce que el CAP 
está vacío y el CAP se devuelve a su estado predeterminado. 
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▼ Expulsión de cartuchos mediante un CAP 
giratorio 
Utilice este procedimiento para expulsar cartuchos de la biblioteca a través de un CAP 
giratorio. 

Nota: Este procedimiento sólo es aplicable a bibliotecas no particionadas. Para 
bibliotecas particionadas, consulte “Expulsión de cartuchos de una partición” en la 
página 320. 

Nota: Para obtener instrucciones detalladas sobre la descarga de cartuchos a través de 
un CAP de AEM, consulte “Descarga a granel de cartuchos mediante un CAP de AEM” 
en la página 137. 

1. Inicie la operación de expulsión en el host. Consulte la documentación del software 
de administración de cintas correspondiente para obtener detalles de los 
procedimientos y comandos. 

Debe especificar los identificadores de volumen (VOLID) de los cartuchos que desea 
eliminar de la biblioteca. Para hosts HLI, puede especificar los CAP a utilizar. Para 
hosts FC-SCSI, la biblioteca utiliza los CAP en un orden predefinido, consulte 
“Prioridades CAP para la expulsión de cartuchos por hosts FC-SCSI” en la página 71 
para obtener más detalles. 

2. El TallBot coloca los cartuchos en los CAP.

Cuando todos los cartuchos solicitados se han colocado en los CAP o todos los CAP 
están llenos, los CAP se desbloquean. 

3. Pulse el botón CAP para abrir el CAP. 

La puerta del CAP se abre. 

Atención: Posible daño de equipo. NO fuerce la apertura o cierre del CAP.

4. Elimine los cartuchos del CAP.

Puede eliminar los cartuchos directamente de los magazines mientras estén en el CAP; 
o puede extraer los magazines del CAP, eliminar los cartuchos de los magazines y, a 
continuación, sustituir los magazines vacíos en el CAP.

Nota: Si no reemplaza los magazines en el CAP, el controlador de biblioteca marcará 
las celdas como “ausentes”. 
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5. Pulse el botón CAP para cerrar el CAP.

El CAP se cierra y se bloquea automáticamente, y la luz del botón CAP se apaga.

Atención: Posible daño de equipo. NO fuerce la apertura o cierre del CAP.

Si se necesita exportar más cartuchos, el TallBot continúa rellenando los CAP 
necesarios. Espere hasta que la puerta del CAP se desbloquee y repita del Paso 3 al 
Paso 5. 

La operación de expulsión finaliza automáticamente cuando se hayan expulsado todos 
los cartuchos especificados. 

6. El TallBot audita el CAP para comprobar que está vacío.

A continuación, el CAP se devuelve a su estado predeterminado. 
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▼ Carga a granel de cartuchos mediante un CAP de 
AEM
Utilice este procedimiento para cargar cartuchos en la biblioteca a través de un CAP de 
AEM. Puede cargar hasta 234 cartuchos cada vez. 

Nota: Este procedimiento sólo es aplicable a bibliotecas no particionadas. Para 
bibliotecas particionadas, consulte “Introducción de cartuchos en una partición” en la 
página 319. 

Nota: Para obtener instrucciones detalladas sobre la introducción de cartuchos a través 
de un CAP giratorio, consulte “Introducción de cartuchos mediante un CAP giratorio” 
en la página 131. 

1. Inicie la operación de introducción en el host. Consulte la documentación del 
software de administración de cintas correspondiente para obtener detalles de los 
procedimientos y comandos. 

Nota: Si el CAP de AEM está en modo de introducción automática, puede ignorar este 
paso y pasar directamente al Paso 2. 

La luz de Unlocked en la puerta de acceso AEM está encendida. 

2. Pulse el botón CAP de AEM. 

La luz de Wait en la puerta de acceso AEM empieza a parpadear como si se finalizasen 
todos los trabajos en vías de ejecución. Se elimina el robot del AEM y la puerta de 
seguridad desciende. Según el nivel de actividad de la biblioteca, esto puede llevar 
varios minutos.

Una vez que la puerta de seguridad ha descendido completamente y el AEM está 
cerrado herméticamente, la luz de Wait deja de parpadear y la luz de Enter se enciende 
de forma fija.

3. Levante el seguro y abra la puerta.

Atención: Posible daño de equipo. NO fuerce la apertura o cierre de la puerta de acceso 
AEM.

4. Coloque los cartuchos en el CAP de AEM.

Inserte los cartuchos de manera que la etiqueta de cliente (si hay) quede en la parte 
frontal, el concentrador en la parte posterior, y la etiqueta VOLID también frente a 
usted. 

Puede introducir los cartuchos directamente en los magazines mientras estén en el 
CAP; o puede eliminar los magazines del CAP, insertar cartuchos en los magazines y, a 
continuación, sustituir los magazines de cartuchos rellenos en el CAP.

Nota: Los cartuchos se pueden colocar en cualquier ranura CAP, en cualquier orden; el 
TallBot audita todas las ranuras CAP cuando la puerta del CAP se cierra.



 

Tareas de administración de cartuchos

136 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

Atención: Posible daño de medio. Mientras se introduzcan cartuchos que no incluyen 
etiquetas externas o que se colocan al revés, esto no es aconsejable. Presenta problemas 
cuando se realiza una auditoría. De igual modo, los cartuchos que contienen etiquetas 
ilegibles o dañadas no se deben introducir. 

Atención: Posible daño de equipo. Cuando reemplace magazines en las paredes AEM, 
asegúrese de que los coloca correctamente.

5. Cierre y eche el seguro de la puerta de acceso.

Atención: Posible daño de equipo. NO fuerce la apertura o cierre de la puerta de acceso 
AEM.

6. Pulse el botón CAP de AEM.

La luz de Enter se apaga y la luz de Wait empieza a parpadear. 

La puerta de seguridad se eleva.

7. El robot se mueve al AEM, audita el CAP de AEM y, a continuación, mueve los 
cartuchos del CAP de AEM a las celdas de almacenamiento disponibles. 

Cuando todos los cartuchos se han movido del CAP de AEM, la biblioteca reconoce que 
el AEM está vacío y se devuelve a su estado predeterminado. 
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▼ Descarga a granel de cartuchos mediante un CAP 
de AEM
Utilice este procedimiento para descargar cartuchos de la biblioteca a través de un CAP 
de AEM. Puede descargar hasta 234 cartuchos cada vez. 

Nota: Para operaciones de expulsión iniciadas desde un host FC-SCSI, sólo se utilizan 
CAP de AEM una vez que todos los CAP giratorios se han rellenado. Consulte el 
“Prioridades CAP para la expulsión de cartuchos por hosts FC-SCSI” en la página 71 
para obtener detalles completos. 

Nota: Este procedimiento sólo es aplicable a bibliotecas no particionadas. Para 
bibliotecas particionadas, consulte “Expulsión de cartuchos de una partición” en la 
página 320. 

Nota: Para obtener instrucciones detalladas sobre la expulsión de cartuchos a través de 
un CAP giratorio, consulte “Expulsión de cartuchos mediante un CAP giratorio” en la 
página 133. 

1. Inicie la operación de expulsión en el host. Consulte la documentación del software 
de administración de cintas correspondiente para obtener detalles de los procedi-
mientos y comandos. 

Debe especificar los identificadores de volumen (VOLID) de los cartuchos que desea 
eliminar de la biblioteca. Para hosts HLI, puede especificar los CAP de AEM a utilizar. 
Para hosts FC-SCSI, la biblioteca utiliza CAP giratorios o de AEM en un orden 
predefinido, consulte “Prioridades CAP para la expulsión de cartuchos por hosts 
FC-SCSI” en la página 71 para obtener más detalles.

2. El TallBot coloca los cartuchos en las celdas AEM. 

Cuando todos los cartuchos solicitados se han colocado en el AEM, el AEM se 
desbloquea y la luz de Unlocked en la puerta de acceso AEM se enciende. 

3. Pulse el botón CAP de AEM. 

La luz de Wait en la puerta de acceso AEM empieza a parpadear como si se finalizasen 
todos los trabajos en vías de ejecución. El TallBot se elimina del AEM y la puerta de 
seguridad desciende. Según el nivel de actividad de la biblioteca, esto puede llevar 
varios minutos.

Una vez que la puerta de seguridad ha descendido completamente y el AEM está 
cerrado herméticamente, la luz de Wait deja de parpadear y la luz de Enter se enciende 
de forma fija.

4. Levante el seguro y abra la puerta.

Atención: Posible daño de equipo. NO fuerce la apertura o cierre del CAP.
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5. Elimine los cartuchos del CAP de AEM.

Puede eliminar los cartuchos directamente de los magazines mientras estén en el AEM; 
o puede extraer los magazines del AEM, eliminar los cartuchos de los magazines y, a 
continuación, sustituir los magazines vacíos en el AEM. 

Atención: Posible daño de equipo. Cuando reemplace magazines en las paredes AEM, 
asegúrese de que los coloca correctamente.

Nota: Si no reemplaza los magazines en el AEM, el controlador de biblioteca marcará 
las celdas como “ausentes”. 

6. Cierre y eche el seguro de la puerta de acceso AEM.

Atención: Posible daño de equipo. NO fuerce la apertura o cierre de la puerta de acceso 
AEM.

7. Pulse el botón CAP de AEM.

La luz de Enter se apaga y la luz de Wait empieza a parpadear. 

La puerta de seguridad se eleva.

8. Si se necesita exportar más cartuchos, el TallBot continúa rellenando los AEM 
necesarios. Espere hasta que se encienda la luz de Unlocked AEM y repita del Paso 3 
al Paso 6. 

La operación de expulsión finaliza automáticamente cuando se hayan expulsado todos 
los cartuchos especificados. 

El TallBot se mueve al AEM y audita el CAP de AEM para comprobar que está vacío. 
A continuación, el CAP de AEM se devuelve a su estado predeterminado. 

Nota: Un auditoría del CAP de AEM debería realizarse en menos de tres minutos. 
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▼ Lista de cartuchos de biblioteca
Utilice este procedimiento para visualizar información sobre todos los cartuchos de la bi-
blioteca, incluidos los identificadores de volumen (VOLID), ubicaciones y tipos de medios. 

1. Seleccione Tools > Reports. 

Todas las opciones de informes de biblioteca se incluyen en la barra de exploración. 

2. Expanda la carpeta Status Summary.

Todos los informes de Status Summary se muestran en una lista. 

3. Haga clic en Cartridge Summary. 

Se muestra el Cartridge Summary Report. 

4. Para buscar los datos del informe o guardarlos en un archivo, siga los procedimientos 
siguientes:

■ “Búsqueda de informes de biblioteca” en la página 107 

■ “Guardar datos de informes de biblioteca en un archivo” en la página 109
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▼ Búsqueda de cartuchos por ID de volumen
Utilice este procedimiento para visualizar la ubicación actual de un cartucho con un ID 
de volumen especificado. La ubicación se puede visualizar en uno de los formatos 
siguientes:

■ Dirección interna de biblioteca

■ Dirección HLI-PRC (sólo hosts HLI)

1. Seleccione Tools > Diagnostics y haga clic en la carpeta Library. 

2. Haga clic en la ficha Search.

Aparece la pantalla Library Search. 

3. En la lista desplegable Search Type, haga clic en VOLID. 

4. Introduzca el VOLID, el solicitante en Requester y el tipo de cartucho en Cartridge 
Type. 

El campo Requester controla el formato de dirección que se visualizará para la 
ubicación del cartucho. 

■ Para visualizar la dirección interna de biblioteca, haga clic en predeterminada.

■ Para visualizar la dirección HLI-PRC, haga clic en hli0 o hli1. 

Nota: Puede utilizar comodines en el campo VOLID. 
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5. Haga clic en Search. 

La pantalla muestra todos los cartuchos que satisfacen los criterios de búsqueda. 
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▼ Búsqueda de cartuchos por dirección
Utilice este procedimiento para visualizar información detallada sobre cartuchos con 
una ubicación especificada. Los comodines permiten visualizar todos los cartuchos en 
un área general especificada (por ejemplo: en un panel, fila o columna especificada). 
Puede especificar la ubicación utilizando uno de los formatos siguientes:

■ Dirección interna de biblioteca

■ Dirección HLI-PRC (sólo hosts HLI)

■ Dirección FC-SCSI (sólo hosts FC-SCSI) 

1. Seleccione Tools > Diagnostics y haga clic en la carpeta Library. 

2. Haga clic en la ficha Search.

Aparece la pantalla Library Search. 

3. En la lista desplegable Search Type, haga clic en Location. 

Nota: La lista Search Type predeterminada es VOLID. 

Se actualiza la pantalla para visualizar los campos que permiten buscar por ubicación. 

4. En la lista desplegable Location, seleccione el tipo de coincidencia que desea realizar 
en la búsqueda.

5. En la lista desplegable Requester, seleccione el formato de dirección que desea 
utilizar para la búsqueda. 

6. En el campo Location, introduzca los parámetros para la búsqueda. 

Debe utilizar un formato que corresponda al solictante que haya especificado. Por 
ejemplo:

■ Utilice el formato de dirección interna de la biblioteca si el solicitante es 
“predeterminado”.

■ Utilice la dirección HLI-PRC si el solicitante es un host HLI.

■ Utilice la dirección FC-SCSI si el solicitante es un host FC-SCSI. 

Nota: No puede utilizar comodines en este campo. 
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7. Haga clic en el botón Search. 

La pantalla muestra todas las ubicaciones que satisfacen los criterios de búsqueda. 

8. Para conocer detalles sobre un cartucho o ver una asignación de ubicación, haga clic 
en el botón ... de la columna Details. 

Aparece la pantalla Location Details. 

9. Haga clic en Close para descartar el elemento emergente. 
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▼ Movimiento de un cartucho especificado por 
VOLID
Utilice este procedimiento para mover un cartucho con un VOLID especificado a una 
ubicación especificada dentro de la biblioteca. 

Nota: Este procedimiento actualiza la ubicación del cartucho en la base de datos del 
controlador de biblioteca, pero no en la base de datos del host. Por tanto, después de 
realizar este procedimiento, debe llevar a cabo una auditoría del software del host para 
actualizar la base de datos del host. De no hacerlo, se producirá un error en las futuras 
solicitudes de montaje del software del host. 

Atención: Preste atención cuando realice este procedimiento en bibliotecas 
particionadas. Podría mover un cartucho de una partición a otra por error, lo que 
permitiría a la nueva partición sobrescribir los datos del cartucho. 

1. Seleccione Tools > Diagnostics y haga clic en la carpeta Library. 

2. Haga clic en la ficha RcvrMove. 

Aparece la pantalla Recovery Move. 

3. En el campo Source Location Mode, haga clic en VOLID. 

La pantalla se actualiza con los campos Source Location correspondientes. 

4. En el campo VOLID, especifique el VOLID del cartucho que desea mover. 

5. En el menú desplegable Destination Location Type, seleccione el tipo de ubicación a 
la que desea mover el cartucho. Las opciones son:

■ CAP

■ Storage Slots 

■ Drive

■ Reserved Slots

Se aplican las restricciones siguientes:

■ El destino sólo puede ser una unidad si el origen es un CAP o una ranura reservada. 

■ Para poder mover un cartucho a una unidad, el tipo de medios de cartuchos debe ser 
compatible con el tipo de unidad. 

■ No puede mover un cartucho a una ubicación que ya esté ocupada. 

■ Aunque no es estrictamente obligatorio, se recomienda mover sólo cartuchos de 
diagnóstico o limpieza a ranuras reservadas. 

6. En la tabla Destination Location, especifique la dirección interna de biblioteca de la 
ubicación destino realizando las selecciones apropiadas en los siguientes menús 
desplegables:

Las selecciones especiales siguientes están disponibles en los menús desplegables:

■ Mín., primer elemento de ese tipo de ubicación en la biblioteca 

■ Máx., último elemento de ese tipo de ubicación en la biblioteca 
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Atención: Si la biblioteca está particionada, asegúrese de mantener el cartucho en la 
misma partición a la que está asignado actualmente. Mover un cartucho a una celda 
asignada a una partición diferente podría hacer que el host considere el cartucho como 
nuevo y sobrescriba los datos. Mover el cartucho a una celda sin asignar hará que el 
cartucho esté inaccesible para todos los hosts. 

7. En la barra de opciones, haga clic en el botón Start.

El robot mueve el cartucho. Cuando se ha completado la operación, aparece un cuadro 
emergente de operación correcta. 

8. Haga clic en OK.

9. Para comprobar la ubicación nueva, puede visualizar un Cartridge Summary Report. 
Consulte “Lista de cartuchos de biblioteca” en la página 139 para obtener más detalles. 
Por ejemplo: 

10.Para actualizar la nueva ubicación del cartucho en la base de datos del host, inicie 
una auditoría de la biblioteca en el software del host. Consulte la documentación del 
software de administración de cintas correspondiente para obtener detalles de los 
procedimientos y comandos.
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▼ Movimiento de un cartucho de una ubicación 
especificada
Utilice este procedimiento para mover un cartucho de una ubicación especificada a otra 
dentro de la biblioteca. 

Nota: Este procedimiento actualiza la ubicación del cartucho en la base de datos del 
controlador de biblioteca, pero no en la base de datos del host. Por tanto, después de 
realizar este procedimiento, debe llevar a cabo una auditoría del software del host para 
actualizar la base de datos del host. De no hacerlo, se producirá un error en las futuras 
solicitudes de montaje del software del host. 

Atención: Preste atención cuando realice este procedimiento en bibliotecas 
particionadas. Podría mover un cartucho de una partición a otra por error, lo que 
permitiría a la nueva partición sobrescribir los datos del cartucho. 

1. Seleccione Tools > Diagnostics y haga clic en la carpeta Library. 

2. Haga clic en la ficha RcvrMove. 

Aparece la pantalla Recovery Move. 

3. En el campo Source Location Mode, haga clic en Location. 

La pantalla se actualiza con los campos Source Location correspondientes. 

4. En el menú desplegable Source Location Type, seleccione el tipo de ubicación actual 
del cartucho. Las opciones son:

■ CAP

■ Slot

■ Drive

■ Reserved Slots

5. En la tabla Source Location, especifique la dirección interna de biblioteca de la 
ubicación origen realizando las selecciones apropiadas en los siguientes menús 
desplegables:

Las selecciones especiales siguientes están disponibles en los menús desplegables:

■ Mín., primer elemento de ese tipo de ubicación en la biblioteca 

■ Máx., último elemento de ese tipo de ubicación en la biblioteca 

6. En el menú desplegable Destination Location Type, seleccione el tipo de ubicación a 
la que desea mover el cartucho. Las opciones son:

■ CAP

■ Storage Slots 

■ Drive

■ Reserved Slots

Se aplican las restricciones siguientes:

■ La ubicación destino sólo puede ser una unidad si el origen es un CAP o una ranura 
reservada. 

■ Para poder mover un cartucho a una unidad, el tipo de medios de cartuchos debe ser 
compatible con el tipo de unidad. 
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■ No puede mover un cartucho a una ubicación que ya esté ocupada. 

■ Aunque no es estrictamente obligatorio, se recomienda mover sólo cartuchos de 
diagnóstico o limpieza a ranuras reservadas. 

7. En la tabla Destination Location, especifique la dirección interna de biblioteca de la 
ubicación destino realizando las selecciones apropiadas en los siguientes menús 
desplegables:

Las selecciones especiales siguientes están disponibles en los menús desplegables:

■ Mín., primer elemento de ese tipo de ubicación en la biblioteca 

■ Máx., último elemento de ese tipo de ubicación en la biblioteca 

Atención: Si la biblioteca está particionada, asegúrese de mantener el cartucho en la 
misma partición a la que está asignado actualmente. Mover un cartucho a una celda 
asignada a una partición diferente podría hacer que el host considere el cartucho como 
nuevo y sobrescriba los datos. Mover el cartucho a una celda sin asignar hará que el 
cartucho esté inaccesible para todos los hosts. 

8. En la barra de opciones, haga clic en el botón Start.

El robot mueve el cartucho y, a continuación, aparece un cuadro emergente de 
operación correcta.

9. Haga clic en OK.

10.Para comprobar la ubicación nueva, puede visualizar un Cartridge Summary Report. 
Consulte “Lista de cartuchos de biblioteca” en la página 139 para obtener más detalles. 
Por ejemplo: 

11.Para actualizar la nueva ubicación del cartucho en la base de datos del host, inicie 
una auditoría de la biblioteca en el software del host. Consulte la documentación del 
software de administración de cintas correspondiente para obtener detalles de los 
procedimientos y comandos.
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▼ Visualización de Media Events Report

Nota: This feature is available starting with SL3000 firmware version FRS_2.30 and 
SL Console version FRS_4.30. 

Media Events Report resume los eventos de medios del cartucho de la biblioteca. El 
informe se actualiza siempre que se produce un evento de medios o error en cualquier 
unidad. Puede utilizar el informe para ayudar a identificar y diagnosticar cartuchos 
defectuosos. 

Para cada cartucho que que ha sufrido eventos de medios, el informe muestra una lista 
del VOLID del cartucho, el tipo de evento, el número de repeticiones y la fecha y hora 
de la última como evento. El informe puede mostrar hasta 2.000 entradas.

De forma predeterminada, el informe está ordenado según el VOLID. Si lo desea, 
puede cambiar la ordenación y reorganizar y cambiar el tamaño de las columnas. 
Consulte “Modificación de la distribución de pantalla” en la página 39. 

Nota: Para eventos de cartuchos asociados a unidades particulares, consulte 
“Visualización de Drive Media Events Report” en la página 165. 

1. Seleccione Tools  >  Reports. 
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2. Expanda la carpeta Statistics y haga clic en Media Events. 

Campos de la pantalla
Etiqueta de cartucho 

VOLID del cartucho que ha sufrido un evento. 

Tipo de evento

Tipo de evento de medios que se está siguiendo. Las opciones son:

■ Media Error: la unidad indicó que había un problema con los medios; esto 
también podría indicar un problema con la unidad.

■ Misbuckle Error: la unidad no ha podido sujetar el enganche de los medios y no 
pudo deslizar la cinta. Los medios están probablemente dañados. 

Número de eventos

El número total de eventos de este tipo que se han registrado para este cartucho. 

Último visto

Fecha y hora de la repetición más reciente del evento. 
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Tareas de administración de unidades

Tarea Página

Visualización de información de resumen de la unidad 151

Visualización del estado de unidades 153

Visualización de propiedades de unidad 154

Visualización de panel de operador virtual (VOP) de unidad 155

Visualización de panel de operador virtual (VOP) de unidad 155

Visualización de estado del indicador LED de unidades 159

Visualización de estado de bandeja de unidades 162

Visualización de Drive Events Report 163

Visualización de Drive Media Events Report 165
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▼ Visualización de información de resumen de la 
unidad
Utilice este procedimiento para visualizar información de resumen de todas las 
unidades de la biblioteca. 

Si necesita realizar un montaje manual en una unidad, este procedimiento muestra una 
asignación de todas las direcciones para cada unidad de la biblioteca:

■ Firmware (dirección interna)

■ Software de host (dirección HLI-PRC)

■ Hardware (bahía de unidad)

También se visualiza la información siguiente:

■ Estado de acceso: conectado, desconectado

■ Estado de unidades:

■ Empty

■ Unloaded: el cartucho está presente 

■ Ready: el cartucho está cargado

■ NotCommunicating

■ rewindUnload: la unidad está ocupada rebobinando y descargando 

■ Tipo de unidad

■ Número de serie de la unidad

■ Versión actual del código

■ Tipo de interfaz de la unidad

Nota: Esta información también está disponible en Reports > Drive Summary. 
Consulte “Visualización de un informe de biblioteca” en la página 105 para obtener 
instrucciones detalladas. 
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1. Seleccione Tools > System Detail y haga clic en la carpeta Drive. 

La pantalla muestra una lista de las unidades de la biblioteca y sus ubicaciones.Se 
detalla la dirección interna, la bahía de unidades y la dirección HLI-PRC. 
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▼ Visualización del estado de unidades 
Utilice este procedimiento para visualizar el estado operativo actual de una unidad. La 
información incluye:

■ Información sobre el estado de la unidad actual y de la bandeja de la unidad 

■ Si la unidad está cargada

■ VOLID del cartucho si la unidad está cargada

■ Información sobre la limpieza de unidades

■ Actividad del host

Nota: Esta información también está disponible en Reports > Drive Details. Consulte 
“Visualización de un informe de biblioteca” en la página 105 para obtener instrucciones 
detalladas. 

1. Seleccione Tools  >  System Detail

2. Expanda la carpeta Drive Folder y haga clic en la unidad que desea visualizar. 

3. Haga clic en Status.

La pantalla muestra el estado actual de la unidad seleccionada. 
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▼ Visualización de propiedades de unidad 
Vea datos detallados de la configuración de una unidad, como el tipo de unidad, 
número de serie y configuración de puerto.

Nota: Esta información también está disponible en Reports > Drive Details. Consulte 
“Visualización de un informe de biblioteca” en la página 105 para obtener instrucciones 
detalladas. 

1. Seleccione Tools  >  System Detail. 

2. Expanda la carpeta Drive Folder y haga clic en la unidad que desea visualizar. 

3. Haga clic en Properties. 

Aparece la pantalla Drive Properties. 
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▼ Visualización de panel de operador virtual (VOP) 
de unidad

Nota: Este procedimiento es sólo para unidades Sun StorageTek T10000 y T9840D. 

Utilice este procedimiento para visualizar el panel de operador virtual (VOP) para 
unidades T10000 y T9840D. 

1. Seleccione Tools  >  System Detail. 

2. Expanda la carpeta Drive Folder y haga clic en la unidad que desea visualizar. 

3. Haga clic en Display.

Aparece la información sobre el VOP de unidad en la sección Drive Virtual Op Panel. 
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▼ Visualización de los datos de red de unidades
Utilice este procedimiento para visualizar los datos de la dirección IP y MAC de la 
unidad de la biblioteca. 

1. Seleccione Tools  >  System Detail. 

2. Expanda la carpeta Drive Folder y haga clic en la unidad que desea visualizar. 
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3. Haga clic en Display.

Aparecen los datos en la sección Network Data. 
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▼ Visualización de estado del indicador LED de 
unidades
Utilice este procedimiento para visualizar los estados de una unidad seleccionada de 
indicadores LED, que incluyen los estados cargados, conectados, de limpieza y de 
seguimiento disponibles. 

1. Seleccione Tools  >  System Detail. 

2. Expanda la carpeta Drive Folder y haga clic en la unidad que desea visualizar. 
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3. Haga clic en Display.

Aparecen los datos en la sección Drive LED Status. 
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▼ Visualización de estado de bandeja de unidades
Utilice este procedimiento para visualizar el estado actual de una bandeja de unidades. 

1. Seleccione Tools  >  System Detail. 

2. Expanda la carpeta Drive Folder y haga clic en la unidad que desea visualizar. 

3. Haga clic en DriveTray.

Aparece la pantalla Status. 
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▼ Visualización de Drive Events Report

Nota: This feature is available starting with SL3000 firmware version FRS_2.30 and 
SL Console version FRS_4.30. 

Drive Events Report resume los errores y eventos de la unidad que se han producido en 
unidades de la biblioteca. El informe se actualiza siempre que hay un evento de unidad 
que no está relacionado con los medios. Puede utilizar el informe para ayudar a 
identificar y diagnosticar unidades defectuosas.

Para cada unidad que ha experimentado eventos, el informe muestra una lista con el 
tipo de unidad, tipo de error, el número de repeticiones y la fecha y hora del último 
evento. El informe puede mostrar hasta 70 entradas. 

De forma predeterminada, el informe está ordenado según el número de serie de la 
unidad. Si lo desea, puede cambiar la ordenación y reorganizar y cambiar el tamaño de 
las columnas. Consulte “Modificación de la distribución de pantalla” en la página 39. 

Nota: Para obtener más información sobre errores de medios asociados con unidades, 
consulte “Visualización de Drive Media Events Report” en la página 165. 

1. Seleccione Tools  >  Reports. 

2. Expanda la carpeta Statistics y haga clic en Drive Events. 
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Campos de la pantalla
Número de serie

Número de serie de la unidad.

Tipo de unidad

Marca y modelo de la unidad.

Tipo de evento

Tipo de evento que se está siguiendo. Todos estos tipos de eventos indican 
problemas con la unidad, no con los medios. Las opciones son:

■ Drive Error: la unidad tiene un problema general. 

■ Load Error: la unidad no pudo cargar el cartucho. 

■ Load Retry: la unidad solicitada reintenta cargar el cartucho. 

Número de eventos

El número total de eventos de este tipo que se han registrado para esta unidad. 

Último visto

Fecha y hora de la repetición más reciente del error. 
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▼ Visualización de Drive Media Events Report

Nota: This feature is available starting with SL3000 firmware version FRS_2.30 and 
SL Console version FRS_4.30. 

Drive Media Events Report resume los eventos de los medios que se han producido en 
unidades de la biblioteca. El informe se actualiza siempre que se produce un evento o 
error de medios. Puede utilizar el informe para ayudar a identificar y diagnosticar 
unidades o cartuchos defectuosos.

Para cada unidad que ha sufrido eventos de medios, el informe muestra una lista del 
VOLID del cartucho, el tipo de evento, el número de repeticiones y la fecha y hora del 
último evento. El informe puede mostrar hasta 500 entradas. 

De forma predeterminada, el informe está ordenado según el número de serie de la 
unidad. Si lo desea, puede cambiar la ordenación y reorganizar y cambiar el tamaño de 
las columnas. Consulte “Modificación de la distribución de pantalla” en la página 39. 

Nota: Para obtener más información sobre errores de cartuchos no necesariamente 
asociados a unidades, consulte “Visualización de Media Events Report” en la 
página 148. 

1. Seleccione Tools  >  Reports. 
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2. Expanda la carpeta Statistics y haga clic en Drive Media Events. 

Campos de la pantalla
Número de serie

Número de serie de la unidad.

Tipo de unidad

Marca y modelo de la unidad.

Etiqueta de cartucho 

VOLID del cartucho que ha sufrido un evento. 

Tipo de evento

Tipo de evento de medios que se está siguiendo. Las opciones son:

■ Media Error: la unidad indicó que había un problema con los medios; esto 
también podría indicar un problema con la unidad.

Número de eventos 

El número total de eventos de este tipo que se han registrado para este cartucho en 
esta unidad. 

Último visto

Fecha y hora de la repetición más reciente del evento. 
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Tareas de limpieza de unidades

Nota: Las tareas de limpieza de unidades se aplican sólo a unidades administradas por 
host FC-SCSI adjuntos. No se aplican a unidades administradas por HSC o ACSLS. 

Tarea Página

Configuración de limpieza automática de unidades 168

Introducción de cartuchos de limpieza o diagnóstico 170

Expulsión de cartuchos de limpieza o diagnóstico 172

Visualización de cartuchos de limpieza 174

Visualización de estado de limpieza de unidades 175

Limpieza manual de unidades 176
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▼ Configuración de limpieza automática de 
unidades
Utilice este procedimiento para activar o desactivar la función de limpieza automática 
de unidades. Si la biblioteca está particionada, la limpieza automática se puede activar 
o desactivar para particiones individuales. 

Nota: Este procedimiento se aplica sólo a unidades que no son administradas por HSC 
o ACSLS. Consulte la documentación de HSC y ACSLS para obtener detalles sobre 
cómo administrar operaciones de limpieza automática. 

1. Seleccione Tools > System Detail y, a continuación, seleccione la carpeta de la 
biblioteca en el árbol de dispositivos.

2. Haga clic en Auto Clean y, a continuación, en Configure.

Aparece la pantalla Configure Auto Clean. 
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3. Complete la sección Auto Clean Configuration de la siguiente manera:

Para particiones SL3000 o bibliotecas enteras controladas por el software de 
administración de cintas ACSLS o HSC, la limpieza automática se debe desactivar 
siempre en esta pantalla. ACSLS o HSC administrará la función de limpieza 
automática. Consulte la documentación de HSC o ACSLS para obtener más detalles. 

Para particiones SL3000 o bibliotecas enteras controladas por hosts FC-SCSI, puede 
seleccionar “activar” para administrar la limpieza automática mediante la SL Console 
o puede seleccionar “desactivar” para administrar la limpieza de unidades 
manualmente. 

Si la biblioteca está particionada, puede utilizar los menús desplegables individuales 
para activar o desactivar la limpieza automática de forma separada para cada partición. 
Si la biblioteca no está particionada, sólo necesita definir el primer menú desplegable 
(Partición 1 (o ninguna)); los otros menús desplegables se ignorarán. 

4. En la sección Auto Clean Configuration, especifique los umbrales de aviso para cada 
tipo de cartucho.

5. Haga clic en Apply.
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▼ Introducción de cartuchos de limpieza o 
diagnóstico 
Utilice este procedimiento para introducir nuevos cartuchos de limpieza o diagnóstico 
en la biblioteca a través de un CAP. 

Nota: Este procedimiento sólo es aplicable a bibliotecas no particionadas.  

Antes de iniciar este procedimiento, compruebe que se satisfacen todas las condiciones 
siguientes:

■ Las celdas reservadas requeridas están vacías. 

■ El estado Prevent/Allow del CAP está definido en Allow (consulte el Manual de 
referencias SCSI para conocer la sintaxis).

■ El CAP no contiene cartuchos de datos. 

Nota: Si el CAP está en modo de introducción automática, puede proceder 
directamente al Paso 5. 

1. Seleccione Tools  >  Diagnostics. 

2. Expanda CAP Folder, haga clic en el CAP que desea utilizar y, a continuación, haga 
clic en Access. 

Aparece la pantalla Access.
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3. En la lista desplegable Locked, haga clic en false. Haga clic en el botón Apply. 

Aparece el cuadro emergente Confirm. 

4. Haga clic en OK.

El controlador de biblioteca desbloquea la puerta del CAP y el indicador LED de CAP 
Open se enciende.

5. Pulse el botón CAP para abrir el CAP. 

La puerta del CAP se abre. 

6. Coloque los cartuchos de limpieza o diagnóstico en el CAP.

7. Pulse el botón CAP para cerrar el CAP.

El CAP se cierra y se bloquea automáticamente, y la luz del botón CAP se apaga.

8. Mueva manualmente cada cartucho a una celda reservada. Consulte “Movimiento de 
un cartucho de una ubicación especificada” en la página 146 para obtener instruccio-
nes detalladas. 

Cuando todos los cartuchos se han movido del CAP, la biblioteca reconoce que el CAP 
está vacío y el CAP se devuelve a su estado predeterminado. 

Nota: Para mostrar una lista de cartuchos de limpieza y diagnóstico en las ranuras 
reservadas, consulte “Visualización de cartuchos de limpieza” en la página 174. 
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▼ Expulsión de cartuchos de limpieza o diagnóstico
Utilice este procedimiento para expulsar cartuchos de limpieza o diagnóstico 
caducados a través del CAP.

Nota: Este procedimiento sólo es aplicable a bibliotecas no particionadas.  

Nota: Antes de iniciar este procedimiento, compruebe que todas las ranuras están 
vacías en el CAP que desea utilizar.

1. Mueva manualmente cada cartucho de limpieza o diagnóstico que desea expulsar, 
de una celda reservada a un CAP. Consulte “Movimiento de un cartucho de una 
ubicación especificada” en la página 146 para obtener instrucciones detalladas. 

Nota: Para mostrar una lista de cartuchos de limpieza y diagnóstico en las ranuras 
reservadas, consulte “Visualización de cartuchos de limpieza” en la página 174. 

2. Seleccione Tools  >  Diagnostics. 

3. Expanda CAP Folder, haga clic en el CAP que desea utilizar y, a continuación, haga 
clic en Access. 

Aparece la pantalla Access.
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4. En la lista desplegable Locked, haga clic en false. Haga clic en el botón Apply. 

Aparece el cuadro emergente Confirm. 

5. Haga clic en OK.

El controlador de biblioteca desbloquea la puerta del CAP y el indicador LED de CAP 
Open se enciende.

6. Pulse el botón CAP para abrir el CAP. 

La puerta del CAP se abre. 

7. Elimine todos los cartuchos del CAP.

Debe prestar atención cuando saque los cartuchos de limpieza caducados de la 
biblioteca. Si mueve un cartucho de limpieza caducado a un CAP y abre el CAP, debe 
eliminar el cartucho. Si cierra el CAP sin eliminar primero el cartucho de limpieza, el 
TallBot volverá a introducir el cartucho caducado en la biblioteca, y el controlador de 
biblioteca restablecerá el contador de uso a cero. 

8. Pulse el botón CAP para cerrar el CAP.

El CAP se cierra y se bloquea automáticamente, y la luz del botón CAP se apaga.

9. El TallBot audita el CAP para comprobar que está vacío.

A continuación, el CAP se devuelve a su estado predeterminado. 
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▼ Visualización de cartuchos de limpieza
1. Seleccione Tools > System Detail y, a continuación, seleccione la carpeta de la 

biblioteca en el árbol de dispositivos.

2. Haga clic en Auto Clean y, a continuación, en Cleaning Cartridges.

Aparece la pantalla Library Cleaning Cartridges. 

La lista muestra los siguientes detalles para cada cartucho de limpieza:

■ Ubicación de cartucho (celdas reservadas)

■ VOLID (identificador de volumen) 

■ Contador de uso 

■ Estado (OK, aviso, caducado)

■ Tipo de cartucho (por ejemplo, LTO, SDLT)
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▼ Visualización de estado de limpieza de unidades 
Utilice este procedimiento para visualizar el estado de limpieza actual de una unidad. 

1. Seleccione Tools  >  System Detail. 

2. Expanda la carpeta Drive Folder y seleccione la unidad que desea visualizar. 

3. Haga clic en Status.

La pantalla muestra los detalles de limpieza siguientes:

■ Drive needs cleaning (La unidad necesita limpieza).

■ Drive Last Cleaned or Drive Last Autocleaned (Última limpieza de unidad o última 
limpieza automática de unidad).

Nota: Puede programar la limpieza manual de unidades mediante el estado “Drive 
needs cleaning”. 
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▼ Limpieza manual de unidades
Utilice este procedimiento para limpiar una unidad. SL3000 no ofrece una función de 
limpieza de unidades manual y dedicada. Fundamentalmente, debe realizar un montaje 
manual de un cartucho de limpieza en la unidad. 

Puede iniciar una limpieza manual en cualquier momento, incluso si a la unidad no le 
corresponde una limpieza. 

1. Visualice una lista de cartucho de limpieza. Consulte “Visualización de cartuchos de 
limpieza” en la página 174 para obtener instrucciones detalladas. 

La biblioteca podría contener más de un tipo de unidad. Por tanto, compruebe que las 
celdas reservadas tienen los cartuchos de limpieza apropiados para la unidad que se va 
a limpiar. 

2. Mueva manualmente un cartucho de limpieza de una celda reservada a la unidad que 
necesita limpieza. Consulte “Movimiento de un cartucho de una ubicación 
especificada” en la página 146 para obtener instrucciones detalladas. 

3. Visualice el estado de la operación de limpieza en Drive Clean Status Console. 
Consulte “Visualización de estado de limpieza de unidades” en la página 175 para 
obtener instrucciones detalladas. 

4. Cuando se haya completado la operación de limpieza, mueva el cartucho de limpieza 
de la unidad de nuevo a una celda reservada. Consulte “Movimiento de un cartucho 
de una ubicación especificada” en la página 146 para obtener instrucciones detalladas.



 

Tareas de supervisión de robot y suministro de potencia

418605401 • Revisión AB SL3000 Operaciones automatizadas de la biblioteca 177

Tareas de supervisión de robot y 
suministro de potencia

Tarea Página

Visualización de información de resumen de robot 178

Visualización de estado de robot 179

Visualización de propiedades de robot 180

Visualización de información de resume de suministro de potencia 181

Visualización de detalles de suministro de potencia 182

Visualización de información de resume de suministro de potencia 181

Visualización de detalles de suministro de potencia 182
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▼ Visualización de información de resumen de robot
Utilice este procedimiento para visualizar información de resumen de los TallBots de la 
biblioteca. 

Nota: Esta información también está disponible en Reports > Robot Summary. 
Consulte “Visualización de un informe de biblioteca” en la página 105 para obtener 
instrucciones detalladas. 

1. Seleccione Tools > System Detail. 

2. Haga clic en la carpeta Robot del árbol de dispositivos.

Aparece la pantalla Robot Data. 



 

Tareas de supervisión de robot y suministro de potencia

418605401 • Revisión AB SL3000 Operaciones automatizadas de la biblioteca 179

▼ Visualización de estado de robot 
Utilice este procedimiento para visualizar el estado operativo actual de un TallBot. 

Nota: Esta información también está disponible en Reports > Robot Details. Consulte 
“Visualización de un informe de biblioteca” en la página 105 para obtener instrucciones 
detalladas. 

1. Seleccione Tools  >  System Detail. 

2. Expanda Robot Folder y haga clic en el robot que desea visualizar. 

3. Haga clic en Status.

La pantalla muestra el estado actual del TallBot seleccionado. 
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▼ Visualización de propiedades de robot 
Vea información detallada de la configuración de TallBot, como el número de serie y los 
niveles de firmware actuales.

Nota: Esta información también está disponible en Reports > Robot Details. Consulte 
“Visualización de un informe de biblioteca” en la página 105 para obtener instrucciones 
detalladas. 

1. Seleccione Tools  >  System Detail. 

2. Expanda Robot Folder y haga clic en el robot que desea visualizar. 

3. Haga clic en Properties. 

Aparece la pantalla Robot Properties. 
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▼ Visualización de información de resume de 
suministro de potencia
La pantalla Power Supply Data muestra información de resumen de todos los 
suministros de potencia de la biblioteca. Puede utilizar esta pantalla para supervisar el 
estado de los suministros de potencia. 

De forma predeterminada, los información está ordenada por dirección interna de 
suministro de potencia. Si lo desea, puede cambiar la ordenación y reorganizar y 
cambiar el tamaño de las columnas. Consulte “Modificación de la distribución de 
pantalla” en la página 39. 

1. Seleccione Tools > System Detail.

2. En el árbol de biblioteca, haga clic en Power Supply Folder.

3. Aparece la pantalla Power Supply Data. 
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▼ Visualización de detalles de suministro de 
potencia 
La pantalla Power Supply Status muestra información detallada para un suministro de 
potencia seleccionado. Puede utilizar esta pantalla para determinar si el suministro de 
potencia necesita mantenimiento o sustitución. 

1. Seleccione Tools > System Detail.

2. En el árbol de biblioteca, expanda Power Supply Folder.

3. Haga clic en el suministro de potencia que desea mostrar.

4. Aparece la pantalla Power Supply Status. 
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Tareas de administración de la puerta de 
seguridad AEM

Tarea Página

Visualización del estado de la puerta de seguridad AEM 184

Visualización de las propiedades de la puerta de seguridad AEM 185



 

Tareas de administración de la puerta de seguridad AEM

184 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

▼ Visualización del estado de la puerta de 
seguridad AEM 
Utilice este procedimiento para visualizar el estado actual de una puerta de seguridad 
AEM. La puerta de seguridad es la puerta interior “garaje” que se baja para separar el 
AEM del resto de la biblioteca. 

Nota: La información de estado de la puerta de acceso AEM, que es la puerta que se 
abre para cargar o descargar a granel cartuchos en o de la biblioteca, se visualiza en la 
pantalla CAP Status. Consulte “Visualización del estado actual del CAP giratorio o de 
AEM” en la página 120 para obtener instrucciones detalladas. 

1. Seleccione Tools  >  System Detail. 

2. Expanda Safety Door Folder y haga clic en la puerta de seguridad que desea 
visualizar. 

3. Haga clic en Status.

Aparece la pantalla Safety Door Status. 

"Door open” indica que la puerta de seguridad está subida y el TallBot puede moverse 
con libertad dentro y fuera del AEM. “Door closed” indica que la puerta de seguridad 
está bajada y es seguro abrir la puerta de acceso AEM. 
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▼ Visualización de las propiedades de la puerta de 
seguridad AEM
Utilice este procedimiento para visualizar información detallada para una puerta de 
seguridad AEM, incluidos el número de serie y las versiones de firmware actuales. La 
puerta de seguridad es la puerta interior “garaje” que se baja en previsión para la 
apertura de la puerta de acceso AEM.

Nota: Esta información también está disponible en la pantalla CAP Properties y en el 
informe CAP Details. Consulte “Visualización de las propiedades del CAP giratorio o 
de AEM” en la página 123 y “Visualización de un informe de biblioteca” en la 
página 105 para obtener instrucciones detalladas. 

1. Seleccione Tools > System Detail. 

2. Expanda Safety Door Folder y haga clic en la puerta de seguridad que desea 
visualizar. 

3. Haga clic en Properties.

Aparece la pantalla Safety Door Properties. 
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CAPÍTULO 4

Licencia

La utilidad de licencia permite instalar funciones opcionales seleccionadas en la 
biblioteca SL3000. 

Archivo de clave de licencia
Un archivo de clave de licencia se puede suministrar de las siguientes formas:

■ Vía -correo electrónico de Sun Microsystems, Inc.

■ Instalado por el Sun de representante de asistencia

El archivo de clave de licencia es un archivo Java Archive (.jar) firmado digitalmente 
que contiene una o varias clave de licencia para las funciones que se han adquirido. 
Para asegurar que las funciones se instalan en la biblioteca correcta, el archivo de clave 
de licencia incluye el número de serie de la biblioteca de destino y sólo se puede 
instalar en esa biblioteca. 

Todas las funciones de SL3000 que ha adquirido para una biblioteca se incluyen en un 
solo archivo de clave de licencia. 

Atención: Cuando instala un nuevo archivo de clave de licencia, se superpone a 
cualquier licencia instalada previamente en la biblioteca. Por tanto, es fundamental que 
compruebe el contenido de un archivo nuevo de clave de licencia antes de instalarlo a 
fin de asegurarse de que contiene todas las funciones que ha adquirido a lo largo de la 
vida de la biblioteca. Si no contiene todas las funciones que ha adquirido, cuando 
instale el nuevo archivo, podría eliminar funciones que se han instalado previamente en 
la biblioteca. Si un archivo de clave de licencia es impreciso de alguna manera, debe 
solicitar uno nuevo al Sun de representante de asistencia. 
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Caducidad de licencia

Nota: La mayoría de las licencias SL3000 no caducan. La única licencia que caduca es 
“Service.” 

Para licencias que caducan, es importante ocuparse de la caducidad para evitar la 
pérdida no intencionada de características y funciones de la biblioteca.

Utilice la pantalla License Management > Current License para visualizar las fechas de 
caducidad y el tiempo restante. 

Además, cuando una licencia está a punto de caducar, el controlador de biblioteca envía 
mensajes al registro de eventos de SL Console. Por ejemplo, si una licencia de servicios 
(Service) caduca en 30 días, se envía un mensaje de información cada 12 horas, y si le 
quedan menos de 10 días, se envía un mensaje de aviso cada 12 horas. Puede utilizar 
cualquiera de los métodos siguientes para visualizar estos mensajes:

■ Mediante la opción del menú Tools > Reports. Consulte “Informes de bibliotecas” en 
la página 68 para obtener más detalles. 

■ Mediante la pantalla Status Module. Consulte “Mensajes de alertas de estado” en la 
página 69 para obtener más detalles. 
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Tareas de licencia 
En esta sección se ofrecen instrucciones detalladas de todas las tareas implicadas en la 
instalación y administración de licencias de funciones de biblioteca. 

Proceso de instalación de licencia
A continuación, se incluye un resumen del proceso de instalación de una licencia. Si lo 
desea, puede optar porque sea el representante de asistencia de Sun quien realice este 
proceso. 

1. Adquiere una o varias funciones para una biblioteca Sun StorageTek específica de 
Sun Microsystems, Inc. 

2. Sun le envía un correo electrónico con un archivo de clave de licencia adjunto. 

3. Descarga el archivo de clave de licencia en un sistema accesible a la sesión de 
SL Console.

4. Utiliza el SL Console para visualizar y verificar el contenido del archivo de clave de 
licencia. 

5. Utiliza el SL Console para instalar el archivo de clave de licencia en la biblioteca de 
destino.

6. Consulte los siguientes temas para obtener información detallada sobre la 
implementación de funciones con licencia específicas:

■ “Capacidad según demanda” en la página 211

■ “Particiones de biblioteca” en la página 259
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Resumen de tareas de licencia

Tarea Página

Recepción de un nuevo archivo de clave de licencia 191

Visualización y verificación de contenido de nueva licencia 192

Instalación de nueva licencia en la biblioteca de destino 195

Visualización de licencia de biblioteca actual 199
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▼ Recepción de un nuevo archivo de clave de 
licencia
Utilice este procedimiento para recibir un archivo de clave de licencia, que otorga 
licencia para funciones de una biblioteca Sun StorageTek específica. 

Nota: Este procedimiento no se realiza en SL Console. 

1. Adquiera una o varias funciones en Sun Microsystems, Inc. 

Consulte con el representante de asistencia de Sun para obtener ayuda. 

2. Reciba el archivo de clave de licencia de Sun, vía correo electrónico. 

A continuación, se muestra un ejemplo de la cabecera del correo -electrónico: 
Asunto: Clave de licencia de SL3000 CR6636975
Fecha: Mié, 05 de diciembre 2007 19:24:41 - 0700 (MST)
De: siks-devoffshore@sun.com

3. Descargue el archivo de clave de licencia en un sistema accesible a la sesión de 
SL Console.

Utilice el método estándar para guardar los archivos adjuntos del correo electrónico. 
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▼ Visualización y verificación de contenido de 
nueva licencia
Utilice este procedimiento para visualizar un nuevo archivo de clave de licencia antes 
de instalarlo en una biblioteca de destino. 

Antes de llevar a cabo este procedimiento, debe descargar un nuevo archivo de clave de 
licencia en un sistema accesible a la sesión de SL Console. Consulte “Recepción de un 
nuevo archivo de clave de licencia” en la página 191. 

1. Utilice SL Console para iniciar sesión en la biblioteca de destino. 

Consulte “Inicio de sesión en SL Console” en la página 35 para obtener más detalles. 

2. Seleccione Tools > License Management y, a continuación, haga clic en la ficha 
Install License. 

Aparece la pantalla Install License.



Tareas de licencia

418605401 • Revisión AB Capítulo 4 Licencia 193

3. En el campo File Name, introduzca la ruta completa del archivo de clave de licencia 
que desea visualizar y pulse Intro. También puede hacer clic en Browse y navegar a 
la ubicación del archivo. 

Aparecen los detalles del archivo de licencia en la parte inferior de la pantalla. 

Nota: Si el número de serie de biblioteca incluido en el archivo de clave de licencia 
especificado no coincide con el número de serie de la biblioteca en la que ha iniciado 
sesión, aparece un mensaje de aviso y no se muestra el detalle del archivo de clave de 
licencia. 
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4. Revise los detalles del archivo de clave de licencia y, a continuación, haga clic en 
Compare. 

Aparece el panel emergente Compare Licenses. 

5. Revise los datos de la licencia.

Nota: Los cambios que instalará el nuevo archivo de clave de licencia, como cambios 
en la fecha de caducidad o funciones que se eliminan, se señalan en rojo. 

Si hay problemas con el nuevo archivo, póngase en contacto con el representante de 
asistencia de Sun para solucionar los problemas antes de instalar el archivo en la 
biblioteca de destino. 

Atención: No existe la función de “deshacer” licencia para restaurar las funciones 
eliminadas una vez que se ha instalado el archivo de clave de licencia. 

6. Haga clic en OK para descartar el cuadro emergente. 
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▼ Instalación de nueva licencia en la biblioteca de 
destino
Utilice este procedimiento para instalar un nuevo archivo de clave de licencia en la 
biblioteca de destino. 

Antes de llevar a cabo este procedimiento, debe descargar un nuevo archivo de clave de 
licencia en un sistema accesible a la sesión de SL Console. Consulte “Recepción de un 
nuevo archivo de clave de licencia” en la página 191. 

1. Utilice SL Console para iniciar sesión en la biblioteca de destino. 

Consulte “Inicio de sesión en SL Console” en la página 35 para obtener más detalles. 

2. Seleccione Tools > License Management y, a continuación, haga clic en la ficha 
Install License. 

Aparece la pantalla Install License.

3. En el campo File Name, introduzca la ruta completa del archivo de clave de licencia 
que desea instalar y pulse Intro. También puede hacer clic en Browse y navegar a la 
ubicación del archivo.
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Aparecen los detalles del archivo de licencia en la parte inferior de la pantalla. 

Nota: Si el número de serie de biblioteca incluido en el archivo de clave de licencia 
especificado no coincide con el número de serie de la biblioteca en la que ha iniciado 
sesión, aparece un mensaje de aviso y no se muestra el detalle del archivo de clave de 
licencia. 
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4. Revise los detalles del archivo de clave de licencia y, a continuación, haga clic en el 
botón Install de la barra de opciones. 

Aparece el cuadro emergente License Installation Warning.

5. Compruebe las funciones que va a instalar y verifique que el nuevo archivo de clave 
de licencia es correcto. 

Nota: Los cambios que instalará el nuevo archivo de clave de licencia, como cambios 
en la fecha de caducidad o funciones que se eliminan, se señalan en rojo. 

Si tiene problemas con el nuevo archivo, haga clic en No para cancelar la instalación. 
Póngase en contacto con el representante de asistencia de Sun para solucionar los 
problemas antes de continuar con la instalación. 

Atención: No existe la función de “deshacer” licencia para restaurar las funciones 
eliminadas una vez que se ha instalado el archivo de clave de licencia. 

6. Si el nuevo archivo de clave de licencia es correcto, haga clic en Yes para comenzar a 
instalarlo en la biblioteca de destino. 
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7. El controlador de biblioteca verifica el archivo de clave de licencia y procede de la 
siguiente manera:

■ Si no hay problemas, se instalan las funciones incluidas en el archivo. 

■ Si el nuevo archivo de clave de licencia es anterior al que está instalado actualmente 
en la biblioteca, aparece el siguiente cuadro emergente y no se instala la licencia 
nueva. 

8. Puede verificar que la licencia se ha instalado correctamente, visualizando las 
licencias actuales. Consulte “Visualización de licencia de biblioteca actual” en la 
página 199 para obtener más detalles. 

9. Según las funciones contenidas en el archivo de clave de licencia, puede que necesite 
realizar tareas adicionales a fin de utilizar las nuevas funciones. 

■ Consulte “Incremento de capacidad con licencia” en la página 217 y “Reducción de 
capacidad con licencia” en la página 217 para conocer factores especiales que se 
producen cuando instala un archivo de clave de licencia que cambia la capacidad 
con licencia de la biblioteca.

■  Consulte “Instalación de la función de particiones” en la página 260 para conocer 
factores especiales que se producen cuando instala un archivo de clave de licencia 
con la función de partición. 
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▼ Visualización de licencia de biblioteca actual 
Utilice este procedimiento para visualizar las funciones actualmente instaladas en la 
biblioteca en la que ha iniciado sesión. 

1. Seleccione Tools > License Management y, a continuación, haga clic en la ficha 
Current License. 

Aparece la pantalla Current License, con una lista de las funciones actuales instaladas. 
Consulte “License Management > Current License” en la página 201 para obtener 
información detallada sobre estos campos de la pantalla. 
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Referencia de pantallas de licencia
Esta sección contiene descripciones detalladas de todas las pantallas de licencia de 
SL Console, organizadas según la ruta de navegación a la pantalla. Por ejemplo, 
License Management > Install License— Compare indica la pantalla a la que se accede 
al hacer clic en Tools y, a continuación, en License Management en la barra de menús 
y, después, en la ficha Install License, y en el botón Compare. 

Nota: Sólo puede acceder a las pantallas de licencia desde SL Console independiente o 
SL Console en Web. No están disponibles en el panel de operador local. 

Pantalla

License Management > Current License 201

License Management > Install License 203

License Management > Install License—Compare 206

License Management > Install License—Install 208
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License Management > Current License

Pantalla de ejemplo

Descripción
Muestra el contenido del archivo de clave de licencia que está instalado actualmente en 
la biblioteca donde ha iniciado sesión. 

Puede modificar la presentación y visualización de esta pantalla. Consulte 
“Modificación de la distribución de pantalla” en la página 39 para obtener más detalles. 

Campos de la pantalla
Feature 

Sólo visualización.

Nombre de la función instalada en la biblioteca. 
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Expiration 

Sólo visualización.

Número de días hasta que la función caduque o haya caducado. Si no hay fecha de 
caducidad, el campo muestra “noExpiration.” 

Value 

Sólo visualización.

Calificación de la función, si es aplicable. Por ejemplo, para la función de capacidad, 
este campo muestra la capacidad total que suministra la licencia. Según la función, 
este campo puede quedarse en blanco o indicar “Ninguna”. 

Time Remaining

Sólo visualización.

Cantidad de tiempo restante hasta la caducidad de la función. Si no hay fecha de 
caducidad, el campo se muestra en blanco. 

Botones
Refresh

Haga clic en este botón para actualizar la pantalla con los datos actuales de la base 
de datos del controlador de biblioteca. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ License Management > Install License 
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License Management > Install License

Pantalla de ejemplo

Descripción
Permite visualizar el contenido de un nuevo archivo de clave de licencia.. 

También incluye botones que permiten iniciar cualquiera de las actividades siguientes:

■ Comparar el nuevo archivo de clave de licencia con el que hay instalado actualmente 
en la biblioteca. 

■ Instalar el nuevo archivo de clave de licencia en la biblioteca. 

Puede modificar la presentación y visualización de esta pantalla. Consulte 
“Modificación de la distribución de pantalla” en la página 39 para obtener más detalles. 
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Campos de la pantalla
File Name

Obligatorio.

Introduzca la ruta completa del archivo de clave de licencia que va a instalar en la 
biblioteca. También puede hacer clic en Browse y navegar a la ubicación del archivo. 
El archivo debe estar ubicado en un sistema accesible para la sesión de SL Console, y 
el número de serie especificado en el archivo debe coincidir con el número de serie 
de la biblioteca en la que ha iniciado sesión. 

Product

Sólo visualización.

Tipo de biblioteca a la que está destinado el archivo de clave de licencia. Por 
ejemplo, SL3000, SL8500, SL500. 

Serial Number

Sólo visualización.

Número de serie de la biblioteca correspondiente al archivo de clave de licencia. Esta 
entrada debe coincidir con el número de serie de la biblioteca en la que ha iniciado 
sesión para que el archivo de clave de licencia sea válido para esta biblioteca. 

Generated On

Sólo visualización.

Fecha en la que se ha creado el archivo de clave de licencia. 

Comment Line 1

Sólo visualización.

Comentario opcional sobre el archivo de clave de licencia, de Sun Microsystems, Inc. 

Comment Line 2

Sólo visualización.

Comentario opcional sobre el archivo de clave de licencia, de Sun Microsystems, Inc. 

Feature

Sólo visualización.

Nombre de la función incluida en el archivo de clave de licencia.

Expiration

Sólo visualización.

Número de días hasta que la función caduque. Si no hay fecha de caducidad, el 
campo muestra “noExpiration.” 

Value 

Sólo visualización.

Calificación de la función, si es aplicable. Por ejemplo, para la función de capacidad, 
este campo muestra la capacidad total de almacenamiento que suministra la licencia. 
Según la función, este campo puede quedarse en blanco. 
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Botones
Install

Haga clic en este botón para instalar el archivo de clave de licencia mostrado en la 
biblioteca en la que ha iniciado sesión. Aparece el cuadro emergente License 
Management > Install License—Install. 

Browse

Haga clic en este botón para navegar al archivo de clave de licencia que va a 
visualizar e instalar.

Nota: Si el número de serie de biblioteca incluido en el archivo de clave de licencia 
especificado no coincide con el número de serie de la biblioteca en la que ha iniciado 
sesión, aparece un mensaje de aviso y no se muestra el detalle del archivo de clave de 
licencia. 

Compare

Haga clic para comparar el nuevo archivo de clave de licencia con el que hay 
instalado actualmente en la biblioteca. Aparece el panel emergente License 
Management > Install License—Compare. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ License Management > Current License 

■ License Management > Install License—Compare 

■ License Management > Install License—Install 
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License Management > Install License—Compare 

Pantalla de ejemplo

Descripción
Permite comparar los siguientes grupos de información de licencia: 

■ Funciones instaladas actualmente en la biblioteca en la que ha iniciado sesión. 

■ Funciones incluidas en el nuevo archivo de clave de licencia que ha especificado en 
la pantalla License Management > Install License. 

Nota: Los cambios que instalará el nuevo archivo de clave de licencia, como cambios 
en la fecha de caducidad o funciones que se eliminan, se señalan en rojo. 

Esta pantalla es un cuadro emergente que aparece cuando hace clic sobre Compare en 
la pantalla License Management > Install License. 

Campos de la pantalla
Current Features

Sólo visualización.

Lista de funciones, fechas de caducidad y valores de todas las características actuales 
instaladas en la biblioteca en la que ha iniciado sesión. 
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Features to be Installed

Sólo visualización.

Lista de funciones, fechas de caducidad y valores de todas las características 
incluidas en el nuevo archivo de clave de licencia especificado. Los cambios que 
instalará el nuevo archivo de clave de licencia, como cambios en la fecha de 
caducidad o funciones que se eliminan, se señalan en rojo. 

Botones
OK

Haga clic para descartar el cuadro emergente y volver a la pantalla anterior. 

Consulte también
■ License Management > Install License 

■ License Management > Install License—Install 
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License Management > Install License—Install 

Pantalla de ejemplo

Descripción
Permite comparar los siguientes grupos de información de licencia: 

■ Funciones instaladas actualmente en la biblioteca en la que ha iniciado sesión. 

■ Funciones incluidas en el nuevo archivo de clave de licencia que ha especificado en 
la pantalla License Management > Install License. 

Los mensajes de aviso se muestran si la instalación del nuevo archivo de clave de 
licencia implica la eliminación de funciones de la biblioteca. 

Después de comparar la información de licencia, puede instalar el nuevo archivo de 
clave de licencia si hace clic en el botón Yes. 

Atención: Es muy importante comprobar detenidamente que el nuevo archivo de 
clave de licencia es correcto antes de instalarlo, ya que no existe función de “deshacer” 
para restaurar las funciones eliminadas. 

Esta pantalla es un cuadro emergente que aparece cuando hace clic sobre Install en la 
pantalla License Management > Install License. 
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Según las funciones contenidas en el archivo de clave de licencia, puede que necesite 
realizar tareas adicionales a fin de utilizar las nuevas funciones.

■ Consulte “Incremento de capacidad con licencia” en la página 217 y “Reducción de 
capacidad con licencia” en la página 217 para conocer factores especiales que se 
producen cuando instala un archivo de clave de licencia que cambia la capacidad 
con licencia de la biblioteca.

■ Consulte “Instalación de la función de particiones” en la página 260 para conocer 
factores especiales que se producen cuando instala un archivo de clave de licencia 
con la función de partición. 

Campos de la pantalla
Current Features

Sólo visualización.

Lista de funciones, fechas de caducidad y valores de todas las características actuales 
instaladas en la biblioteca en la que ha iniciado sesión. 

Features to be Installed

Sólo visualización.

Lista de funciones, fechas de caducidad y valores de todas las características 
incluidas en el nuevo archivo de clave de licencia especificado. Los mensajes de 
aviso se muestran si la instalación del archivo de clave de licencia implica la 
eliminación de funciones de la biblioteca. 

Botones
Yes

Haga clic en este botón para instalar el archivo de clave de licencia especificado en la 
biblioteca. El controlador de biblioteca verifica la validez del archivo de clave de 
licencia y lo instala. 

No 

Haga clic para cancelar la actualización y volver a la pantalla anterior. 

Consulte también
■ License Management > Install License 

■ License Management > Install License—Compare 
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CAPÍTULO 5

Capacidad según demanda

La biblioteca SL3000 incluye RealTimeGrowth™ y funciones de capacidad según 
demanda. RealTimeGrowth permite instalar capacidad física de almacenamiento 
por encima de las necesidades actuales. La capacidad según demanda separa la 
capacidad física de la capacidad con licencia y permite pagar sólo por la capacidad 
que se necesite. Según aumenten sus necesidades, puede incrementar la capacidad 
de almacenamiento con un trastorno mínimo en las operaciones de biblioteca. Para 
activar la capacidad adicional, sólo necesita comprar e instalar un archivo de clave 
de licencia para la nueva capacidad.

Nota: La capacidad de almacenamiento de la biblioteca se debe instalar mediante la 
utilidad de licencia SL3000. Consulte Capítulo 4, “Licencia” para obtener más detalles. 

Nota: Esta función controla sólo celdas de almacenamiento de cartuchos. Todos los 
CAP y las unidades de cinta están activas de forma predeterminada. 

Características y restricciones de 
capacidad según demanda
En esta sección se describen importantes características y restricciones de la función de 
capacidad según demanda (Capacity on demand) que le ayudarán planificar y utilizar 
esta función en la biblioteca SL3000. 

■ La capacidad mínima con licencia es 200 celdas de almacenamiento. 

■ La capacidad máxima con licencia es el equivalente a la capacidad física de la 
biblioteca, que es de 5821 celdas. 

■ Puede adquirir capacidad adicional con licencia en incrementos de 1, 100, 200, 500 o 
1000 celdas. 

■ La instalación de capacidad adicional con licencia conlleva trastornos mínimos en las 
operaciones de la biblioteca. Una vez que el controlador de biblioteca las ha 
verificado, las celdas de almacenamiento adicional están disponibles de forma 
inmediata; no es necesario reiniciar la biblioteca. Según la interfaz de host (HLI o 
FC-SCSI), puede haber una breve interrupción en operaciones host mientras los 
hosts actualizan la información sobre los nuevos recursos. Consulte “Cambios de 
capacidad sin interrupción” en la página 215 para obtener más detalles. 
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■ La capacidad de almacenamiento actual con licencia de una biblioteca es equivalente 
a la capacidad especificada en el archivo de clave de licencia instalado más 
recientemente. 

■ Los cambios para activar la capacidad se pueden realizar con trastornos mínimos en 
las operaciones de la biblioteca. Consulte “Cambios de capacidad sin interrupción” 
en la página 215 para obtener más detalles.

Terminología
Los siguientes términos se utilizan para describir la administración de la capacidad de 
la biblioteca:

■ Capacidad física o instalada: el número de celdas de almacenamiento presentes 
físicamente en la biblioteca.

■ Capacidad con licencia: el número de celdas de almacenamiento que la biblioteca 
tiene licencia para utilizar. No puede ser mayor que la capacidad instalada. 

■ Capacidad activa: el número de celdas de almacenamiento con licencia que están 
activadas para uso. De forma predeterminada, este número coincide con el 
número de la capacidad con licencia. Si lo desea, puede desactivar las celdas de 
almacenamiento seleccionadas, lo que hará que sea menor que la capacidad con 
licencia. 

■ Zona de almacenamiento activa: área rectangular de celdas de almacenamiento que 
están activas para uso. Una zona de almacenamiento activa puede ser tan pequeña 
como una sola celda de almacenamiento o tan grande como la capacidad total con 
licencia de la biblioteca. 

■ Celda activa: una celda de almacenamiento que está activada para uso. Sólo las 
celdas activadas se pueden utilizar para el almacenamiento de cartuchos.

■ Celda inactiva: una celda de almacenamiento que se ha desactivado de forma 
explícita y, por tanto, no se puede utilizar para el almacenamiento de cartuchos. 

■ Celda seleccionada: una celda de almacenamiento que no está activa actualmente, 
pero que el controlador de biblioteca activará automáticamente cuando la capacidad 
con licencia se incremente. 

Configuración de zonas de 
almacenamiento activas
Las zonas de almacenamiento activas se pueden asignar automáticamente por el 
controlador de biblioteca o manualmente por el usuario. La asignación automática por 
el controlador de biblioteca proporciona un crecimiento equilibrado de los módulos de 
la biblioteca.

Las celdas de almacenamiento individuales pueden estar en uno de los estados 
siguientes:

■ Activa: la celda se puede utilizar para el almacenamiento de cartuchos. 
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■ Inactiva: la celda se ha desactivado y, por tanto, no se puede utilizar para el 
almacenamiento de cartuchos. Puede supervisar la celda en las pantallas y los 
informes de la biblioteca, pero el controlador de biblioteca rechaza las solicitudes 
para mover cartuchos a la celda. 

■ Seleccionada: la celda no está activa actualmente, pero el controlador de biblioteca la 
activará automáticamente cuando la capacidad con licencia se incremente. Este 
estado sólo es aplicable a bibliotecas no particionadas. 

Sólo las celdas activas se pueden utilizar para el almacenamiento de cartuchos de cinta. 
Las celdas de almacenamiento inactivas no se pueden utilizar para el almacenamiento 
de cartuchos ni son accesibles para hosts. 

Reglas de activación de celdas
El controlador de biblioteca emplea las siguientes reglas cuando añade celdas a zonas 
de almacenamiento activas:

■ La activación de celdas se inicia en la parte trasera superior izquierda de la zona de 
almacenamiento activa y se mueve hacia la parte delantera inferior derecha. 

■ Todas las celdas de una columna se activan de arriba a abajo antes de pasar a la 
columna siguiente. 

■ Las columnas de un panel se activan de izquierda a derecha. 

Bibliotecas no particionadas
En una biblioteca no particionada, el controlador de biblioteca selecciona 
automáticamente todas las celdas físicas, pero sólo activa un número de celdas hasta la 
capacidad total con licencia de la biblioteca. Las celdas seleccionadas que no se pueden 
activar debido a los límites de la capacidad con licencia permanecen seleccionadas y se 
activarán automáticamente cuando se instale capacidad adicional con licencia.

Al activar celdas, el controlador de biblioteca comienza en la parte posterior de la 
biblioteca, empezando con el módulo situado más a la izquierda y desplazándose hacia 
la derecha. A continuación, se mueve a la parte frontal de la biblioteca, empezando con 
el módulo situado más a la izquierda y desplazándose hacia la derecha. 

Para optimizar la colocación de cartuchos, si lo desea, puede designar zonas de 
almacenamiento activas en la biblioteca, en las que el controlador de biblioteca aplica 
las reglas anteriores. 

Bibliotecas particionadas
En bibliotecas particionadas, el número total de celdas de almacenamiento asignadas a 
todas las particiones de la biblioteca no puede superar la capacidad con licencia de la 
biblioteca.

En bibliotecas particionadas, no hay región de almacenamiento activa predeterminada. 
Debe asignar explícitamente celdas de almacenamiento a particiones; de ese modo se 
configuran las zonas de almacenamiento activas para cada partición. Consulte “Proceso 
de particiones” en la página 276 para obtener más detalles. 
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Al colocar cartuchos en celdas de almacenamiento, el controlador de biblioteca aplica 
las reglas de activación de celdas predefinidas a cada partición de forma individual. 
Consulte “Reglas de activación de celdas” en la página 213 para obtener más detalles. 

Desactivación de capacidad de almacenamiento 
Puede reducir el tamaño de una zona de almacenamiento activa mediante la 
desactivación de celdas de almacenamiento designadas. Se muestra un mensaje de 
aviso si los cartuchos se quedan huérfanos debido a una reducción de la capacidad.

Cartuchos huérfanos en bibliotecas no 
particionadas

Nota: Para conocer más detalles sobre cartuchos huérfanos en bibliotecas 
particionadas, consulte “Cartuchos huérfanos en bibliotecas particionadas” en la 
página 266. 

En bibliotecas no particionadas, un cartucho huérfano es un cartucho ubicado en celdas 
de almacenamiento inactivas. Los cartuchos huérfanos son inaccesibles para todos los 
hosts. 

Un cartucho puede pasar a ser huérfano por diversas razones. Algunas posibles causas 
son:

■ La capacidad de almacenamiento activa se ha reducido.

■ El cartucho se ha movido a una celda inactiva o inaccesible mediante la intervención 
manual. 

Si SL Console identifica un cartucho huérfano, muestra un mensaje de aviso. Puede 
utilizar las siguientes herramientas que le ayudarán a resolver y disponer del cartucho 
huérfano:

■ Genere un informe de cartuchos huérfanos. 

■ Realice una auditoría de la biblioteca. 

■ Realice un movimiento de recuperación en un cartucho. 

Para obtener instrucciones detalladas sobre la comprobación y resolución de cartuchos 
huérfanos, consulte los siguientes procedimientos:

■ “Visualización de un informe de zonas de almacenamiento activas” en la página 228

■ “Confirmación de cambios en zonas de almacenamiento activas” en la página 225
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Cambios de capacidad sin interrupción
Los cambios para activar la capacidad conllevan trastornos mínimos en las operaciones 
de la biblioteca. El comportamiento de una biblioteca específica depende del tipo de 
conexión host, como se describe en las siguientes secciones:

■ “Conexiones HLI y cambios de capacidad activos” en la página 215

■ “Conexiones FC-SCSI y cambios de capacidad activos” en la página 216

Atención: Aunque los cambios para activar la capacidad no interrumpen los hosts de 
la biblioteca, se recomienda que haga que la biblioteca no esté disponible para otros 
usuarios antes de confirmar los cambios de zonas de almacenamiento activas. Debido a 
que SL Console no verifica los límites de la zona de almacenamiento con la base de 
datos del controlador de biblioteca en tiempo real, pueden surgir conflictos de 
configuración si cambia los límites de la zona de almacenamiento activa mientras otros 
usuarios están moviendo cartuchos o cambiando la configuración de la biblioteca. 
Consulte “Sincronización de la pantalla con la base de datos del controlador” en la 
página 38 para obtener más detalles. 

Conexiones HLI y cambios de capacidad activos
Con bibliotecas HLI, puede incrementar la capacidad activa sin parar los trabajos del 
host o teniendo que desconectar las conexiones host. Cuando la capacidad disminuye, 
la biblioteca sólo se desconecta momentáneamente y, después, se conecta de nuevo 
automáticamente.

Añadir capacidad activa 
Siempre que añada celdas de almacenamiento activo, la biblioteca permanece conecta-
da. El controlador de biblioteca envía un mensaje asíncrono a todos los hosts notificán-
doles que la configuración de la biblioteca ha cambiado. Los hosts experimentan una 
breve interrupción mientras actualizan la información de configuración de su biblioteca 
y, después, continúan automáticamente procesando los trabajos. 

Eliminar capacidad activa 
Siempre que realice cualquiera de los siguientes tipos de cambios de capacidad, la 
biblioteca se desconecta temporalmente. 

■ Desactivar una celda de almacenamiento

■ Eliminar una ranura de unidad vacía 

Una vez que se ha actualizado el cambio de configuración en la base de datos del 
controlador de biblioteca, la biblioteca se activa de nuevo y el controlador de biblioteca 
envía un mensaje asíncrono a todos los hosts notificándoles que la configuración de la 
biblioteca ha cambiado. Los hosts experimentan una breve interrupción mientras 
actualizan la información de configuración de su biblioteca y, después, continúan 
automáticamente procesando los trabajos. 
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Conexiones FC-SCSI y cambios de capacidad 
activos
Con bibliotecas FC-SCSI, siempre que haga cualquiera de los siguientes cambios, la 
biblioteca se desconecta temporalmente con una condición Unit Attention: 

■ Activar o desactivar una celda de almacenamiento

■ Añadir, cambiar o eliminar una conexión host

■ Eliminar una ranura de unidad vacía 

Se pueden generar varios mensajes de error y todos los hosts deben enviar los 
comandos apropiados para actualizar la información de configuración de la biblioteca. 
Consulte la documentación del software de administración de cintas correspondiente 
para obtener detalles de los procedimientos y comandos. En el caso de añadir o 
eliminar unidades, también se actualiza la numeración del dispositivo SCSI.
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Incremento de capacidad con licencia
Las siguientes factores especiales se suceden después de instalar correctamente una 
licencia de capacidad para obtener capacidad adicional. Consulte el Capítulo 4, 
“Licencia” en la página 187 para obtener detalles sobre la instalación de archivos de 
clave de licencia. 

■ La nueva capacidad de la biblioteca es equivalente a la capacidad especificada en el 
archivo de clave de licencia instalado más recientemente. 

■ No es necesario reiniciar la biblioteca para empezar a usar la nueva capacidad, 
pero debe configurar todas las aplicaciones host de la biblioteca afectadas para que 
reconozcan la nueva capacidad. Consulte “Cambios de capacidad sin interrupción” 
en la página 215 para obtener más detalles. 

■ Si la nueva capacidad con licencia es mayor que la capacidad física, se muestra un 
aviso. No es necesario tomar medidas correctivas. 

■ Si la biblioteca no está particionada, el controlador de biblioteca activa 
automáticamente las celdas que el usuario no ha desactivado de forma explícita 
previamente. En este caso, no se requiere la intervención del usuario para que la 
nueva capacidad con licencia esté disponible. Sin embargo, si las celdas se han 
desactivado, puede que necesite seleccionar celdas manualmente para usar la 
capacidad adicional. 

■ Si la biblioteca está particionada, toda la capacidad nueva se añade como celdas 
sin asignar. Debe asignar de forma manual nuevas celdas de almacenamiento a 
particiones para poder usar las celdas; consulte “Diseño de una partición: módulos 
básicos, DEM o CEM” en la página 284 para obtener más detalles. 

Reducción de capacidad con licencia
Los siguientes factores especiales se suceden después de instalar correctamente una 
licencia de capacidad para obtener una capacidad reducida. Consulte el Capítulo 4, 
“Licencia” en la página 187 para obtener detalles sobre la instalación de archivos de 
clave de licencia.

Nota: La instalación de capacidad reducida es una situación excepcional; asegúrese de 
que esto es lo que realmente desea hacer antes de instalar el archivo de clave de 
licencia. 

■ Se muestra un aviso si quedan cartuchos huérfanos como resultado de la capacidad 
reducida. Consulte “Cartuchos huérfanos en bibliotecas no particionadas” en la 
página 214 para obtener más detalles.  

■ Para bibliotecas no particionadas:

■ La nueva capacidad reducida surte efecto de forma inmediata. 

■ El controlador de biblioteca desactiva celdas en orden inverso a su activación; las 
celdas activadas más recientemente se desactivan primero. 
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■ Para bibliotecas particionadas:

■ Si el número total de celdas asignadas a todas las particiones supera la nueva 
capacidad con licencia, la biblioteca se desconecta automáticamente. Debe anular 
manualmente la asignación de celdas de las particiones, de forma que la 
asignación total no sobrepase la nueva capacidad con licencia.

■ Si el número total de celdas asignadas a todas las particiones es menor que la 
nueva capacidad con licencia, la nueva capacidad reducida surte efecto de forma 
inmediata sin cambios en las asignaciones de particiones existentes. La biblioteca 
continúa el funcionamiento sin interrupción. 
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Tareas de administración de capacidad 
En esta sección se ofrecen instrucciones detalladas para todas las tareas involucradas en 
la implementación y administración de la capacidad de almacenamiento activa de la 
biblioteca. 

Proceso de instalación de capacidad de 
almacenamiento
A continuación, se presenta un resumen del proceso empleado para instalar nueva 
capacidad de almacenamiento de la biblioteca. 

1. Debe adquirir e instalar una licencia de capacidad para la biblioteca. Consulte 
“Proceso de instalación de licencia” en la página 189 para obtener más detalles. 

2. La nueva capacidad con licencia está disponible de forma inmediata. No es necesario 
reiniciar la biblioteca. 

3. En bibliotecas no particionadas, de forma predeterminada, todas las celdas recién 
activadas están disponibles de forma inmediata para uso. Proceda de la siguiente 
manera:

■ Si desea utilizar la configuración de zona de almacenamiento predeterminada 
asignada por el controlador de biblioteca, debe configurar todas las aplicaciones 
de host afectadas para que reconozcan las nuevas zonas de almacenamiento. 
Consulte “Cambios de capacidad sin interrupción” en la página 215 para obtener 
más detalles. 

■ Si desea modificar la configuración de zona de almacenamiento predeterminada, 
consulte “Definición de zonas de almacenamiento activas” en la página 222. 

4. En bibliotecas particionadas, todas las celdas recién activadas se añaden como “sin 
asignar,” y, por tanto, no están disponibles para uso. Debe asignar manualmente las 
nuevas celdas a particiones. Consulte “Proceso de particiones” en la página 276 para 
obtener instrucciones detalladas. 

SL Console Espacio de trabajo de zonas de 
almacenamiento activas
Las pantallas Select Active Cells, y todos los paneles emergentes asociados, ofrecen un 
espacio de trabajo dinámico para personalizar la configuración de la capacidad con 
licencia. Toda la información de configuración de la capacidad con licencia se guarda 
automáticamente en el espacio de trabajo de zonas de almacenamiento activas en la 
memoria de SL Console y se conserva durante el tiempo de la sesión de SL Console. 
Esto permite cambiar entre vistas de zona de almacenamiento activas, y salir y volver a 
las pantallas Select Active Cells todas las veces que se quiera sin perder los cambios de 
configuración.
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La información del espacio de trabajo de zonas de almacenamiento activas de 
SL Console se confirma a la base de datos del controlador de biblioteca sólo mediante 
el botón Apply en la pantalla Select Active Cells > Select Active Cells. La información 
se pierde si ocurre una de las situaciones siguientes antes de que haya confirmado las 
actualizaciones: 

■ Desconecta activamente la sesión de SL Console.

■ La sesión de SL Console ha caducado o la conexión a la biblioteca se ha perdido. 

■ Actualiza activamente el espacio de trabajo de zonas de almacenamiento activas en 
la base de datos del controlador de biblioteca actual. Esto se realiza con el botón 
Refresh en las pantallas Select Active Cells. 

Atención: Aunque los cambios para activar la capacidad no interrumpen los hosts de 
la biblioteca, se recomienda que haga que la biblioteca no esté disponible para otros 
usuarios antes de confirmar los cambios de zonas de almacenamiento activas. Debido a 
que SL Console no verifica los límites de la zona de almacenamiento con la base de 
datos del controlador de biblioteca en tiempo real, pueden surgir conflictos de 
configuración si cambia los límites de la zona de almacenamiento activa mientras otros 
usuarios están moviendo cartuchos o cambiando la configuración de la biblioteca. 
Consulte “Sincronización de la pantalla con la base de datos del controlador” en la 
página 38 para obtener más detalles. 
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Tareas de administración de capacidad

Nota: Las siguientes tareas sólo son aplicables a bibliotecas no particionadas. Para 
obtener instrucciones detalladas sobre la configuración de zonas de almacenamiento 
para bibliotecas particionadas, consulte “Proceso de particiones” en la página 276. 

Nota: Las siguientes tareas se pueden realizar sólo desde la SL Console independiente 
o la SL Console en Web. No se pueden realizar en el panel de operador local. 

Tarea Página

Definición de zonas de almacenamiento activas 222

Confirmación de cambios en zonas de almacenamiento activas 225

Visualización de un informe de zonas de almacenamiento activas 228

Impresión de datos de informe de zonas de almacenamiento activas 230

Guardar datos de informe de zonas de almacenamiento activas 232

Visualización del detalle de la celda activa 234
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▼ Definición de zonas de almacenamiento activas 

Nota: Consulte “Proceso de instalación de licencia” en la página 189 para obtener 
información sobre la instalación de capacidad con licencia. 

Cuando instala capacidad adicional con licencia, el controlador de biblioteca activa 
automáticamente el número de celdas de almacenamiento equivalente a la capacidad 
con licencia. El controlador emplea un conjunto de reglas internas cuando selecciona 
las celdas reales que se van a activar. Consulte “Configuración de zonas de 
almacenamiento activas” en la página 212 para obtener más detalles. 

Utilice este procedimiento sólo si desea hacer una de las cosas siguientes:

■ Personalizar las zonas de almacenamiento activas para que sean diferentes de 
la configuración predeterminada asignada por el controlador de biblioteca. Por 
ejemplo, puede configurar celdas de almacenamiento activas para que los cartuchos 
se concentren alrededor de las unidades y los extremos de la biblioteca se queden 
para un crecimiento futuro. 

■ Desactivar celdas de almacenamiento para que el total de celdas de almacenamiento 
activo sea menor que la capacidad con licencia. 

■ Anular la selección de celdas de almacenamiento para que estas celdas no se activen 
automáticamente cuando se incremente la capacidad con licencia de la biblioteca. 

Nota: Si desea usar la configuración de zona de almacenamiento predeterminada 
definida por el controlador de biblioteca, no necesita emplear este procedimiento. 
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1. Seleccione Tools > Select Active Cells. 

Aparece la pantalla Module Map.

2. Haga clic en el módulo para el que va a definir las zonas de almacenamiento activas. 

3. Haga clic en la ficha Select Active Cells.

Se muestra la pantalla Select Active Cells, con la configuración actual del módulo que 
ha seleccionado.
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Nota: La primera vez que se muestra esta pantalla, el número de celdas seleccionadas 
es equivalente a la capacidad física de la biblioteca, y el número de celdas activas es 
equivalente a la capacidad total con licencia de la biblioteca. 

Nota: Haga clic en los botones Move Left o Move Right para mostrar un módulo 
inmediatamente adyacente al módulo actualmente mostrado. 

4. Seleccione el método de selección en Select by y haga clic en el botón de radio Add o 
Remove.

5. Utilice el plano de la biblioteca para seleccionar las celdas de almacenamiento que 
desea activar o desactivar. 

Nota: Consulte “Select Active Cells > Select Active Cells” en la página 239 para obtener 
instrucciones detalladas sobre el uso del plano de la biblioteca. 

Los cambios de la configuración de capacidad se guardan en el espacio de trabajo de 
zonas de almacenamiento activas de SL Console por la duración de la sesión de inicio. 
Puede realizar modificaciones adicionales y salir y regresar a las pantallas Select Active 
Cells todas las veces que quiera sin perder los cambios.

6. Cuando termine de realizar los cambios, vaya a “Confirmación de cambios en zonas 
de almacenamiento activas” en la página 225 para verificar y confirmar los cambios. 
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▼ Confirmación de cambios en zonas de 
almacenamiento activas 
Utilice este procedimiento para verificar y confirmar los cambios de configuración de 
zonas de almacenamiento activas que ha realizado en la pantalla Select Active Cells. 
Este procedimiento avisa de los siguientes errores posibles:

■ La biblioteca tiene cartuchos huérfanos. Consulte “Cartuchos huérfanos en 
bibliotecas no particionadas” en la página 214 para obtener más detalles.

■ Las celdas serán inaccesibles para los hosts de la biblioteca. 

Atención: Aunque los cambios para activar la capacidad no interrumpen los hosts de 
la biblioteca, se recomienda que haga que la biblioteca no esté disponible para otros 
usuarios antes de confirmar los cambios de zonas de almacenamiento activas. Debido a 
que SL Console no verifica los límites de la zona de almacenamiento con la base de 
datos del controlador de biblioteca en tiempo real, pueden surgir conflictos de 
configuración si cambia los límites de la zona de almacenamiento activa mientras otros 
usuarios están moviendo cartuchos o cambiando la configuración de la biblioteca. 
Consulte “Sincronización de la pantalla con la base de datos del controlador” en la 
página 38 para obtener más detalles. 

1. Realice los pasos descritos en “Definición de zonas de almacenamiento activas” en la 
página 222. 

Los cambios realizados se muestran en la pantalla Select Active Cells. 

2. En la barra de opciones, haga clic en Apply. 

Los límites de las zonas de almacenamiento activas se verifican, incluidas las 
ubicaciones de todos los cartuchos de cinta. 
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Nota: This verification is performed only on the active storage region configuration 
defined in the Select Active Cells screens. It does not verify active storage regions 
against the library controller database; therefore it cannot identify configuration 
conflicts that may arise due to other users performing cartridge movements or library 
configuration changes—through the interfaz de línea de comandos, other SL Console 
sessions, or host applications—at the same time you have made changes to active 
storage regions. 

Aparece el cuadro emergente Confirm Apply, indicando si hay cartuchos huérfanos u 
otros problemas en la configuración de zona de almacenamiento activa. 

3. Para ver mensajes de aviso detallados con una explicación de los motivos de la 
existencia de cartuchos huérfanos, haga clic en Details. 

Utilice el botón Details para alternar entre las vistas expandidas y contraídas de los 
mensajes de aviso. 

4. En la vista expandida de los mensajes de aviso puede hacer lo siguiente:

■ Haga clic en Print para imprimir los datos de mensajes detallados.

■ Haga clic en Save to File para guardar los datos del mensaje detallado en un archivo 
separado por comas. 
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5. Proceda de la siguiente manera:

■ Haga clic en No para cancelar la actualización. 

La base de datos del controlador de biblioteca no se actualiza, pero todos los cambios 
que ha realizado se conservan en la pantalla Select Active Cells. 

■ Haga clic en Yes para realizar las siguientes actualizaciones en la base de datos del 
controlador de biblioteca y proceda con el Paso 6. 

■ Las celdas blancas con la esquina izquierda doblada se vuelven inactivas.

■ Las celdas moradas sin la esquina izquierda doblada se vuelven activas, hasta 
alcanzar la capacidad total con licencia de la biblioteca. Las celdas moradas que 
no se pueden activar debido a los límites de la capacidad con licencia permanecen 
en color morado y se activarán automáticamente cuando se instala capacidad 
adicional con licencia. 

■ Todas las demás celdas permanecen sin modificar. 

Aparece el cuadro emergente Commit Success. 

6. Haga clic en OK para volver a la pantalla Select Active Cells. 

Todas las celdas recién activadas están disponibles de forma inmediata para uso; no es 
necesario reiniciar la biblioteca. 

7. Todas las aplicaciones host afectadas de la biblioteca se deben configurar ahora 
para reconocer las actualizaciones. Consulte la documentación del software de 
administración de cintas correspondiente para obtener detalles de los procedimientos 
y comandos.
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▼ Visualización de un informe de zonas de 
almacenamiento activas 
Utilice este procedimiento para mostrar los siguientes informes sobre zonas de 
almacenamiento activas:

■ Cartridge Cell and Media Summary (Resumen de medios y celdas de cartucho): 
muestra una lista detallada de todos los recursos de la biblioteca y su estado (activo 
o inactivo).

■ Orphaned Cartridge Report (Informe de cartuchos huérfanos): muestra una lista 
detallada de todos los cartuchos huérfanos.

Nota: Los informes de zonas de almacenamiento activas incluyen los datos guardados 
en la base de datos del controlador de biblioteca. Si ha realizado cambios en la 
configuración de zona de almacenamiento sin confirmar los cambios al controlador de 
biblioteca, los datos de estos informes serán diferentes de los datos mostrados en la 
pantalla Select Active Cells. 

1. Seleccione Tools > Select Active Cells, y, a continuación, haga clic en la ficha 
View Reports.

Aparece la pantalla View Reports.
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2. En el menú desplegable, seleccione el informe que desea ver. 

La pantalla se actualiza con los datos actuales de la base de datos del controlador de 
biblioteca. 

3. Para imprimir los datos del informe o guardarlo en un archivo, siga los 
procedimientos siguientes:

■ “Impresión de datos de informe de zonas de almacenamiento activas” en la 
página 230

■ “Guardar datos de informe de zonas de almacenamiento activas” en la página 232 
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▼ Impresión de datos de informe de zonas de 
almacenamiento activas
Utilice este procedimiento para imprimir un informe de zonas de almacenamiento 
activas. Este procedimiento se puede realizar desde cualquier pantalla de informes de 
zonas de almacenamiento activas. 

1. Seleccione Tools > Select Active Cells y, a continuación, haga clic en la ficha 
View Reports.

Aparece la pantalla View Reports.

2. En el menú desplegable, seleccione un informe. 

Se mostrará el informe especificado. Todas las pantallas de informes incluyen los 
botones Print y Save to File. 
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3. Haga clic en Print. 

Aparece la ventana emergente Print. 

4. Complete la ventana emergente de impresión y haga clic en Print. 

El informe se imprime en la impresora seleccionada. 



Tareas de administración de capacidad

232 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

▼ Guardar datos de informe de zonas de 
almacenamiento activas
Utilice este procedimiento para guardar datos de informes de zonas de almacenamiento 
activas en un archivo separado por comas (formato .csv). Puede emplear diversas 
aplicaciones de hoja de cálculo para ver el archivo. Este procedimiento se puede 
realizar desde cualquier pantalla de informes de zonas de almacenamiento activas. 

1. Seleccione Tools > Select Active Cells y, a continuación, haga clic en la ficha 
View Reports.

Aparece la pantalla View Reports.

2. En el menú desplegable, seleccione un informe. 

Se mostrará el informe especificado. Todas las pantallas de informes incluyen los 
botones Print y Save to File. 
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3. Haga clic en Save to File.

Aparece la ventana emergente Save. 

4. Vaya el directorio donde desea guardar el archivo e introduzca el nombre del archivo. 

5. Haga clic en Save. 

Los datos se guardan en el archivo especificado. 
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▼ Visualización del detalle de la celda activa 
Utilice este procedimiento para visualizar qué celdas de almacenamiento están 
actualmente activas, inactivas o seleccionadas para activación. También puede 
visualizar información detallada sobre las ubicaciones del cartucho, de la unidad y la 
celda de almacenamiento. 

Nota: Este procedimiento está disponible en el panel de operador local.

1. Seleccione Tools > Select Active Cells. 

Aparece la pantalla Module Map.

2. Haga clic en el módulo que desea mostrar. 
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3. Haga clic en la ficha Current Active Cells.

Aparece la pantalla Active Cells con la configuración actual del módulo que ha 
seleccionado.

Mueva el cursor sobre una celda o unidad para visualizar información detallada. 
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Referencia de pantallas de zona de 
almacenamiento activa
Esta sección contiene descripciones detalladas de todas las pantallas de zona de 
almacenamiento activa de SL Console, organizadas según la ruta de navegación a la 
pantalla. Por ejemplo, Select Active Cells—Select Active Cells—Confirm Apply indica 
la pantalla a la que se accede cuando se hace clic en Tools y, a continuación, en 
Select Active Cells de la barra de menús, clic en la ficha Select Active Cells y, después, 
en el botón Confirm Apply. 

Nota: Estas pantallas están disponibles sólo para bibliotecas no particionadas. Consulte 
“Referencia de pantallas de particiones” en la página 325 para conocer las pantallas que 
se emplean en la administración de la capacidad en bibliotecas particionadas. 

Nota: Solo la pantalla Select Active Cells—Current Active Cells está disponible en el 
panel de operador local. A las pantallas restantes se puede acceder sólo desde 
SL Console independiente o SL Console en Web.

Nota: La pantalla Select Active Cells, y todos los paneles emergentes asociados, 
proporcionan un espacio de trabajo dinámico para diseñar zonas de almacenamiento 
activas. Toda la información de celdas activas se guarda automáticamente en el espacio 
de trabajo de zonas de almacenamiento en la memoria de SL Console y se conserva 
durante el tiempo de la sesión de SL Console. Esto permite realizar modificaciones, y 
salir y regresar a las pantallas Select Active Cells todas las veces que quiera sin perder 
los cambios. 

Atención: La información del espacio de trabajo de zonas de almacenamiento activas 
de SL Console se guarda en la base de datos del controlador de biblioteca sólo mediante 
el botón Apply. Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de confirmar las actualizaciones con el botón Apply, perderá los 
cambios de la zona de almacenamiento activa que ha realizado a través de las pantallas 
Select Active Cells y todos los paneles emergentes asociados. 

Pantalla Pàgina

Select Active Cells > Module Map 237

Select Active Cells > Select Active Cells 239

Select Active Cells > Select Active Cells—Confirm Apply 245

Select Active Cells—View Reports—Cartridge Cell and Media 
Summary

250

Select Active Cells—View Reports—Orphaned Cartridge Report 253

Select Active Cells—Current Active Cells 256
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Atención: Select Active Cells > Module Map

Pantalla de ejemplo

Descripción
Permite seleccionar el módulo de biblioteca para el que activa o desactiva celdas para el 
almacenamiento de cartuchos. 

Campos de la pantalla
Select a module from the map below 

La pantalla muestra una ilustración de la configuración del módulo real de la 
biblioteca. Esta información se toma directamente de la base de datos del controlador 
de biblioteca. 

Haga clic en el módulo para el que desea seleccionar celdas de almacenamiento y, a 
continuación, haga clic en la ficha Select Active Cells. 
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Botones
? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Select Active Cells > Select Active Cells 
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Select Active Cells > Select Active Cells

Pantalla de ejemplo

Descripción

Nota: Si desea usar la configuración de zona de almacenamiento activa predetermina-
da definida por el controlador de biblioteca, no necesita utilizar esta pantalla. 

Permite definir zonas de almacenamiento activas mediante la selección de las celdas de 
almacenamiento que desea activar o desactivar para uso. Esto permite configurar celdas 
de almacenamiento activas para que los cartuchos se concentren alrededor de las 
unidades y los extremos de la biblioteca se queden para un crecimiento futuro.

Puede activar un número de celdas hasta alcanzar la capacidad total con licencia de la 
biblioteca. Las celdas seleccionadas que no se pueden activar debido a los límites de 
capacidad con licencia permanecen seleccionadas y se activarán automáticamente 
cuando se instale capacidad adicional con licencia. 
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Puede emplear cualquiera de los métodos siguientes para seleccionar celdas de 
almacenamiento (consulte “Library Map” en la página 243 para obtener instrucciones 
detalladas): 

■ Seleccione celdas individuales o grupos de celdas. 

■ Seleccione una columna completa de un módulo de biblioteca. 

■ Seleccione un lado de un módulo de la biblioteca (frontal o posterior). 

■ Seleccione un módulo de biblioteca completo. 

■ Seleccione todas las celdas de la biblioteca. 

Atención: La desactivación de celdas de almacenamiento puede ocasionar cartuchos 
huérfanos y datos inaccesibles. Consulte “Cartuchos huérfanos en bibliotecas no 
particionadas” en la página 214 para obtener más detalles. 

Nota: Puede seleccionar sólo celdas de almacenamiento; los CAP y las unidades de 
cinta instalados están siempre activos. 

Nota: La pantalla Select Active Cells, y todos los paneles emergentes asociados, 
proporcionan un espacio de trabajo dinámico para diseñar zonas de almacenamiento 
activas. Toda la información de celdas activas se guarda automáticamente en el espacio 
de trabajo de zonas de almacenamiento en la memoria de SL Console y se conserva 
durante el tiempo de la sesión de SL Console. Esto permite realizar modificaciones, y 
salir y regresar a las pantallas Select Active Cells todas las veces que quiera sin perder 
los cambios. 

Atención: La información del espacio de trabajo de zonas de almacenamiento activas 
de SL Console se guarda en la base de datos del controlador de biblioteca sólo mediante 
el botón Apply. Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de confirmar las actualizaciones con el botón Apply, perderá los 
cambios de la zona de almacenamiento activa que ha realizado a través de las pantallas 
Select Active Cells y todos los paneles emergentes asociados. 

Campos de la pantalla
Select by

Obligatorio.

Indica el método que desea utilizar para seleccionar las celdas de almacenamiento 
que va a activar o desactivar. Las opciones son:

■ Cell: seleccione grupos de celdas rectangulares o individuales.

■ Column: seleccione todas las celdas de una columna. 

■ Side: seleccione todas las celdas de un lateral de un módulo de la biblioteca. 

■ Module: seleccione todas las celdas de un módulo de la biblioteca. 

■ Library: seleccione todas las celdas de la biblioteca. 



Referencia de pantallas de zona de almacenamiento activa

418605401 • Revisión AB Capítulo 5 Capacidad según demanda 241

Nota: Debe seleccionar Add o Remove. 

Add 

Obligatorio.

Indica que va a añadir celdas a la zona de almacenamiento activa. Sólo podrá hacer 
clic en celdas inactivas del plano de la biblioteca. 

Remove

Obligatorio.

Indica que va a eliminar celdas de la zona de almacenamiento activa. Sólo podrá 
hacer clic en celdas activas o seleccionadas del plano de la biblioteca. 

Current Library Totals

Capacity

Sólo visualización.

Capacidad total de almacenamiento con licencia de la biblioteca. 

Active Cells

Sólo visualización.

Número total de celdas de almacenamiento que se han activado para uso en la base 
de datos del controlador de biblioteca. Este número no puede ser mayor que la 
capacidad con licencia. 

Selection Totals 

Selected Cells 

Sólo visualización.

Número total de celdas seleccionadas y activas. Este número puede ser mayor que la 
capacidad con licencia. 

Unselected Cells 

Sólo visualización.

Número total de celdas inactivas o no seleccionadas. 

Nota: Celdas seleccionadas + Celdas no seleccionadas = capacidad física de la 
biblioteca

% Capacity Used 

Sólo visualización.

Porcentaje de capacidad total con licencia que se ha seleccionado para uso (no puede 
ser superior a 100%). Se calcula:

Celdas seleccionadas/Capacidad (con licencia) 
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Interface Type 

Obligatorio.

Tipo de interfaz que se va a usar para la conexión host de la biblioteca. Las opciones 
son:

■ HLI

■ FC-SCSI 

La pantalla muestra el valor asignado previamente. Se puede dejar como está o 
realizar cambios. 

Nota: Para obtener detalles adicionales sobre cómo modificar este campo, consulte 
“Cambio del tipo de interfaz de biblioteca (bibliotecas no particionadas)” en la 
página 102. 

Legend 

Leyenda para el plano de la biblioteca. El estado de cada recurso de biblioteca (celda de 
almacenamiento, unidad de cinta o celda CAP) se indica de la siguiente manera: 

■ Not Accessible (en blanco y -tachado). El recurso no es accesible para ningún host. 
Algunas posibles razones son:

■ Las celdas de almacenamiento se han configurado para cartuchos de diagnóstico. 

■ La bahía de la unidad no tiene ninguna unidad instalada. 

■ CAP se ha configurado para almacenamiento, no para operaciones CAP. 

■ Inactive (blanco). La celda de almacenamiento no está seleccionada. 

■ Si la celda tiene la esquina izquierda doblada, actualmente está activada para uso 
en la base de datos del controlador de biblioteca y ha seleccionado esta celda para 
eliminarla de la zona de almacenamiento activa. La celda pasará a estar inactiva 
en la base de datos del controlador de biblioteca cuando haga clic en el botón 
Apply.

■ Si la celda no tiene la esquina izquierda doblada, actualmente está inactiva en la 
base de datos del controlador de biblioteca. No habrá cambios en el estado de la 
celda en la base de datos del controlador de biblioteca cuando haga clic en el 
botón Apply. 

■ Active (esquina izquierda doblada). Indica el estado de la celda de almacenamiento 
de la base de datos del controlador de biblioteca:

■ Las celdas con la esquina izquierda doblada están actualmente activas. 

■ Las celdas sin la esquina izquierda doblada están actualmente inactivas. 

■ Selected (morado). La celda de almacenamiento está seleccionada. Las celdas se 
pueden seleccionar automáticamente por el controlador de biblioteca o manualmente 
por el usuario. 

■ Si la celda tiene la esquina izquierda doblada, actualmente está activa en la base 
de datos del controlador de biblioteca. No habrá cambios en el estado de la celda 
en la base de datos del controlador de biblioteca cuando haga clic en el botón 
Apply.

■ Si la celda no tiene la esquina izquierda doblada, actualmente está inactiva en 
la base de datos del controlador de biblioteca y ha seleccionado esta celda para 
añadirla a la zona de almacenamiento activa. Cuando hace clic en el botón Apply, 
la celda se volverá activa en la base de datos del controlador de biblioteca, hasta 
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alcanzar la capacidad total con licencia de la biblioteca. Las celdas moradas que 
no se pueden activar debido a los límites de la capacidad con licencia permanecen 
en color morado y se activarán automáticamente cuando se instala capacidad 
adicional con licencia. 

■ No Activation Needed (marrón). El recurso no se puede seleccionar en esta pantalla 
porque está activo de forma predeterminada; se aplica a todas las celdas CAP y las 
unidades de cinta. 

■ Cartridge (icono de cartucho). El recurso contiene un cartucho de cinta. 

■ Las ranuras de unidad con unidades instaladas se destacan con un borde grueso. Las 
ranuras de unidad vacías tienen un borde estrecho. 

Library Map 
Representación gráfica de la configuración de biblioteca actual. La pantalla inicial de 
la sesión de inicio de SL Console actual es de la base de datos del controlador de 
biblioteca; a continuación, la pantalla refleja las modificaciones. La pantalla incluye 
la información siguiente:

■ Tipo de módulo mostrado actualmente (módulo básico, módulo de expansión de 
unidades, módulo de expansión de acceso, módulo de expansión de parking.) 

■ ID de módulo numérico (1–12)

■ Ubicación de todos los recursos (celdas de almacenamiento, unidades de cinta, 
celdas CAP) de la biblioteca. 

Nota: Mueva el cursor sobre un recurso para obtener información detallada sobre la 
celda o la unidad, si está activa en la base de datos del controlador de biblioteca, si está 
actualmente seleccionada en la pantalla, y la identificación de cartuchos residentes. 

Utilice el plano de la biblioteca para modificar los límites de las áreas de capacidad 
de almacenamiento activas. Según si ha hecho clic en los botones de radio Add o 
Remove, las celdas se seleccionarán o se anulará la selección. 

Según la opción elegida en el campo Select by, puede realizar una de las acciones 
siguientes. 

■ Select by cell: seleccione celdas individuales o grupos de recursos. Las celdas de 
almacenamiento activas no necesitan ser adyacentes. 

- Para seleccionar una celda de almacenamiento, haga doble clic sobre ella.

- Para seleccionar un grupo rectangular de celdas de almacenamiento, haga clic 
sobre la celda en una esquina del rectángulo y, a continuación, haga clic en la 
celda diagonalmente opuesta. 

■ Select by column: seleccione una columna completa del módulo. Las columnas de 
celdas activas no necesitan ser adyacentes. Haga clic en cualquier celda de 
almacenamiento de la columna que desea seleccionar. 

■ Select by side: seleccione todas las celdas de almacenamiento de un lado del 
módulo. Los lados activos no necesitan ser adyacentes. Haga clic en cualquier 
celda de almacenamiento del lado que desea seleccionar. 

■ Select by module: seleccione todas las celdas de almacenamiento de un módulo. 
Los módulos activos no necesitan ser adyacentes. Haga clic en cualquier celda de 
almacenamiento del módulo que desea seleccionar. 

■ Select the library: seleccione todas las celdas de almacenamiento de la biblioteca. 
Haga clic en cualquier celda de almacenamiento de la biblioteca. 
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Botones
Move Left 

Haga clic para mostrar el módulo de la biblioteca directamente a la izquierda del que 
se muestra actualmente. Este botón aparece sombreado si no hay ningún módulo a la 
izquierda. 

Move Right 

Haga clic para mostrar el módulo de biblioteca directamente a la derecha del que se 
muestra actualmente. Este botón aparece sombreado si no hay ningún módulo a la 
derecha. 

Apply 

Haga clic para actualizar la base de datos del controlador de biblioteca con la 
configuración actual en la pantalla. Aparece el cuadro emergente Confirm Apply, 
indicando si hay cartuchos huérfanos u otros errores en la configuración de zona de 
almacenamiento activa. 

Nota: Este botón aparece sombreado si no ha realizado cambios en la pantalla 
Select Active Cells desde la última actualización. 

El estado de las celdas se actualizará en la base de datos del controlador de 
biblioteca de la siguiente manera: 

■ Las celdas blancas con la esquina izquierda doblada se vuelven inactivas.

■ Las celdas moradas sin la esquina izquierda doblada se vuelven activas, hasta 
alcanzar la capacidad total con licencia de la biblioteca. Las celdas moradas que 
no se pueden activar debido a los límites de la capacidad con licencia permanecen 
en color morado y se activarán automáticamente cuando se instala capacidad 
adicional con licencia. 

■ Todas las demás celdas permanecen sin modificar. 

Refresh

Haga clic en este botón para actualizar la pantalla con los datos actuales de la base 
de datos del controlador de biblioteca. Todos los cambios de zonas de almacena-
miento activas no aplicados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Cell Selection Refresh, que 
le insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Select Active Cells > Module Map 

■ Select Active Cells > Select Active Cells—Confirm Apply 

■ Select Active Cells—Current Active Cells 



Referencia de pantallas de zona de almacenamiento activa

418605401 • Revisión AB Capítulo 5 Capacidad según demanda 245

Select Active Cells > Select Active Cells—Confirm 
Apply

Pantalla de ejemplo

Descripción
Muestra una lista de errores de configuración en las zonas de almacenamiento activas 
definidas. Esta pantalla es un panel emergente que aparece cuando hace clic sobre 
Apply en la pantalla Select Active Cells > Select Active Cells. 

Después de ver los mensajes de error, puede confirmar todos los datos de la pantalla 
Select Active Cells a la base de datos del controlador de biblioteca con el botón Yes. 

Atención: Aunque los cambios para activar la capacidad no interrumpen los hosts de 
la biblioteca, se recomienda que haga que la biblioteca no esté disponible para otros 
usuarios antes de confirmar los cambios de zonas de almacenamiento activas. Debido a 
que SL Console no verifica los límites de la zona de almacenamiento con la base de 
datos del controlador de biblioteca en tiempo real, pueden surgir conflictos de 
configuración si cambia los límites de la zona de almacenamiento activa mientras otros 
usuarios están moviendo cartuchos o cambiando la configuración de la biblioteca. 
Consulte “Sincronización de la pantalla con la base de datos del controlador” en la 
página 38 para obtener más detalles. 
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Entre los posibles errores se incluyen:

■ La biblioteca tiene cartuchos huérfanos. Consulte “Cartuchos huérfanos en 
bibliotecas particionadas” en la página 266 para obtener más detalles.

■ Las celdas de almacenamiento se han eliminado de la biblioteca. 

Si se presenta cualquiera de estas condiciones de error, la pantalla muestra mensajes de 
error en modo resumido. Para ver mensajes detallados, haga clic en el botón Details. 

Se recomienda resolver todos los errores antes de confirmar los datos a la base de datos 
del controlador de biblioteca. 

Puede imprimir los datos de pantalla o guardarlos en un archivo separado por comas. 

Campos de la pantalla
Warnings found

Sólo visualización.

Mensajes de error en modo resumido sobre la configuración de zona de 
almacenamiento. 

Library 

Sólo visualización.

El número de la biblioteca donde está ubicado el cartucho huérfano. Siempre es “1”. 

Rail 

Sólo visualización.

El número de raíl donde está ubicado el cartucho huérfano. Siempre es “1”. 

Column

Sólo visualización.

El número de la columna donde está ubicado el cartucho huérfano. La ubicación de 
columna se incluye en el borde izquierdo del módulo básico. “+1” es a la derecha; 
“-1” es a la izquierda.

Side

Sólo visualización.

El lado del módulo donde está ubicado el cartucho huérfano. “1” es en la parte 
posterior; “2” es en la parte frontal.

Fila

Sólo visualización.

El número de fila donde está ubicado el cartucho huérfano. Las filas están 
numeradas consecutivamente de arriba a abajo, con la fila “1” en la parte superior.

Cause for Orphaned State

Sólo visualización.

Razón por la que el cartucho se ha identificado como huérfano. Las opciones son:

■ Just Activated: Recién activado 

■ Inactive Media: Medio inactivo 
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Vol Ser 

Sólo visualización.

Número de serie de volumen (VOLID) del cartucho huérfano. 

Explanation

Sólo visualización.

Explicación de por qué el cartucho es huérfano. 

Algunas posibles opciones son:

■ Se ha encontrado medio en una celda inactiva. 

■ La celda inactiva con medio se acaba de activar. 

Botones

Nota: Para mostrar los botones Print y Save to File, puede que necesite desplazarse 
hacia abajo en la ventana interior. 

Print

Haga clic para imprimir el informe en la impresora seleccionada.

Save to File

Haga clic en este botón para guardar el informe en un archivo de texto separado por 
comas (extensión .csv). Los archivos separados por comas se pueden abrir con 
diversos programas de hojas de cálculo y bases de datos. 

Yes

Haga clic en este botón para confirmar que desea actualizar la base de datos del 
controlador de biblioteca con la configuración actual de Select Active Cells. El 
estado de las celdas se actualiza en la base de datos del controlador de biblioteca 
de la siguiente manera: 

■ Las celdas blancas con la esquina izquierda doblada se vuelven inactivas.

■ Las celdas moradas sin la esquina izquierda doblada se vuelven activas, hasta 
alcanzar la capacidad total con licencia de la biblioteca. Las celdas moradas que 
no se pueden activar debido a los límites de la capacidad con licencia permanecen 
en color morado y se activarán automáticamente cuando se instala capacidad 
adicional con licencia. 

■ Todas las demás celdas permanecen sin modificar. 

No

Haga clic en este botón para cancelar la actualización. La base de datos del 
controlador de biblioteca no se actualiza, pero la configuración actual de la pantalla 
Select Active Cells se conserva. 

Details 

Haga clic para alternar entre las vistas expandidas y contraídas de la pantalla de 
mensajes de aviso. 

Consulte también
■ Select Active Cells > Select Active Cells 
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Seleccionar celdas activas: Ver informes

Pantalla de ejemplo

Descripción
Permite seleccionar una de los siguientes informes de zonas de almacenamiento activas:

■ Cartridge Cell and Media Summary (Resumen de medios y celdas de cartuchos)

■ Orphaned Cartridge Report (Informe de cartuchos huérfanos)

Nota: Los informes de zonas de almacenamiento activas incluyen los datos guardados 
en la base de datos del controlador de biblioteca. Si ha realizado cambios en la 
configuración de zona de almacenamiento activa sin confirmar los cambios con el botón 
Apply, los datos de estos informes serán diferentes de los datos mostrados en la 
pantalla Select Active Cells. 
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Campos de la pantalla
Please select a report to display

Obligatorio.

Haga clic en el informe que desea visualizar. El menú desplegable muestra un lista 
de todos los informes disponibles sobre de zonas de almacenamiento activas. 

Botones
Apply 

Haga clic para actualizar la base de datos del controlador de biblioteca con la 
configuración actual en la pantalla. Aparece el cuadro emergente Confirm Apply, 
indicando si hay cartuchos huérfanos u otros errores en la configuración de zona de 
almacenamiento activa. 

Nota: Este botón aparece sombreado si no ha realizado cambios en la pantalla 
Select Active Cells desde la última actualización. 

Refresh

Haga clic en este botón para actualizar la pantalla con los datos actuales de la base 
de datos del controlador de biblioteca. Todos los cambios de zonas de almacena-
miento activas no aplicados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Cell Selection Refresh, que 
le insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Select Active Cells > Select Active Cells 

■ Select Active Cells—View Reports—Cartridge Cell and Media Summary 

■ Select Active Cells—View Reports—Orphaned Cartridge Report 
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Select Active Cells—View Reports—Cartridge Cell 
and Media Summary

Pantalla de ejemplo

Descripción
Muestra información detallada sobre todos los recursos de biblioteca (celdas de 
almacenamiento, unidades de cinta y celdas CAP) y los cartuchos almacenados.

Nota: Los informes de zonas de almacenamiento activas incluyen los datos guardados 
en la base de datos del controlador de biblioteca. Si ha realizado cambios en la 
configuración de zona de almacenamiento sin confirmar los cambios al controlador de 
biblioteca, los datos de estos informes serán diferentes de los datos mostrados en la 
pantalla Select Active Cells. 

Puede modificar la presentación y visualización de esta pantalla. Consulte 
“Modificación de la distribución de pantalla” en la página 39 para obtener más detalles. 

Puede imprimir los datos de pantalla o guardarlos en un archivo separado por comas.
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Campos de la pantalla
Library 

Sólo visualización.

El número de biblioteca donde está ubicado el recurso de biblioteca. Siempre es “1”. 

Rail 

Sólo visualización.

El número de raíl donde está ubicado el recurso de biblioteca. Siempre es “1”. 

Column

Sólo visualización.

El número de columna donde está ubicado el recurso de biblioteca. La ubicación de 
columna se incluye en el borde izquierdo del módulo básico. “+1” es a la derecha; 
“-1” es a la izquierda.

Side

Sólo visualización.

El lado del módulo donde está ubicado el recurso de biblioteca. “1” es en la parte 
posterior; “2” es en la parte frontal.

Row

Sólo visualización.

El número de fila donde está ubicado el recurso de biblioteca. Las filas están 
numeradas consecutivamente de arriba a abajo, con la fila “1” en la parte superior.

Element Type

Sólo visualización.

Tipo de recurso de biblioteca. Las opciones son:

■ CAP
■ CELL
■ DRIVE

Vol Ser 

Sólo visualización.

Número de serie de volumen (VOLID) del cartucho residente en el recurso de 
biblioteca, si lo hay. 

Cell Status

Sólo visualización.

Estado de la capacidad del recurso de biblioteca. Se aplica sólo a celdas de 
almacenamiento. Las opciones son:

■ Active: la celda está activada para uso y se puede usar para el almacenamiento de 
cartuchos. 

■ Inactive: la celda no está activada para uso y no se puede usar para el 
almacenamiento de cartuchos. 
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Botones
Print

Haga clic para imprimir el informe en la impresora seleccionada.

Save to File

Haga clic en este botón para guardar el informe en un archivo de texto separado por 
comas (extensión .csv). Los archivos separados por comas se pueden abrir con 
diversos programas de hojas de cálculo y bases de datos. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Seleccionar celdas activas: Ver informes

■ Select Active Cells—View Reports—Orphaned Cartridge Report
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Select Active Cells—View Reports—Orphaned 
Cartridge Report 

Pantalla de ejemplo

Descripción
Muestra las ubicaciones y los números de serie de volumen (VOLID) de todos los 
cartuchos huérfanos de la biblioteca. Además identifica el motivo por el que el cartucho 
es huérfano. 

Nota: Los informes de zonas de almacenamiento activas incluyen los datos guardados 
en la base de datos del controlador de biblioteca. Si ha realizado cambios en la 
configuración de zona de almacenamiento sin confirmar los cambios al controlador de 
biblioteca, los datos de estos informes serán diferentes de los datos mostrados en la 
pantalla Select Active Cells. 

Puede modificar la presentación y visualización de esta pantalla. Consulte 
“Modificación de la distribución de pantalla” en la página 39 para obtener más detalles. 

Puede imprimir los datos de pantalla o guardarlos en un archivo separado por comas.
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Campos de la pantalla
Library 

Sólo visualización.

El número de la biblioteca donde está ubicado el cartucho huérfano. Siempre es “1”. 

Rail 

Sólo visualización.

El número de raíl donde está ubicado el cartucho huérfano. Siempre es “1”. 

Column

Sólo visualización.

El número de la columna donde está ubicado el cartucho huérfano. La ubicación de 
columna se incluye en el borde izquierdo del módulo básico. “+1” es a la derecha; 
“-1” es a la izquierda.

Side

Sólo visualización.

El lado del módulo donde está ubicado el cartucho huérfano. “1” es en la parte 
posterior; “2” es en la parte frontal.

Fila

Sólo visualización.

El número de fila donde está ubicado el cartucho huérfano. Las filas están 
numeradas consecutivamente de arriba a abajo, con la fila “1” en la parte superior.

Vol Ser 

Sólo visualización.

Número de serie de volumen (VOLID) del cartucho huérfano. 

Explanation

Sólo visualización.

Explicación de por qué el cartucho es huérfano. 

Algunas posibles opciones son:

■ Se ha encontrado medio en una celda inactiva. 

■ La celda inactiva con medio se acaba de activar. 

Botones
Print

Haga clic para imprimir el informe en la impresora seleccionada.

Save

Haga clic en este botón para guardar el informe en un archivo de texto separado por 
comas (extensión .csv). Los archivos separados por comas se pueden abrir con 
diversos programas de hojas de cálculo y bases de datos. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 
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Consulte también
■ Seleccionar celdas activas: Ver informes 

■ Select Active Cells—View Reports—Orphaned Cartridge Report 
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Select Active Cells—Current Active Cells

Pantalla de ejemplo

Descripción
Muestra las zonas de almacenamiento activas actuales. Muestra qué celdas de 
almacenamiento están actualmente activas, inactivas o seleccionadas para activación.

Es la única pantalla de Select Active Cells que está disponible en el panel de operador 
local.

Nota: Esta pantalla es de visualización sólo. 

Campos de la pantalla
Para obtener una descripción detallada de los campos de la pantalla, consulte 
“Select Active Cells > Select Active Cells” en la página 239. 
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Botones
Refresh

Haga clic en este botón para actualizar la pantalla con los datos actuales de la base 
de datos del controlador de biblioteca. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Select Active Cells > Select Active Cells 
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CAPÍTULO 6

Particiones de biblioteca

Nota: Las particiones de la biblioteca constituyen una función con licencia que se debe 
instalar mediante la utilidad de licencia SL3000. Consulte Capítulo 4, “Licencia” para 
obtener más detalles. 

Las particiones de la biblioteca permiten asignar secciones de la biblioteca SL3000 para 
uso exclusivo de hosts específicos. Por ejemplo, puede configurar un grupo de celdas 
de almacenamiento y unidades de almacenamiento que se utilicen sólo en operaciones 
Veritas y otro grupo para utilizarlo sólo en operaciones Tivoli.Esto permite configurar 
una biblioteca SL3000 para aplicaciones que se ejecutan en varios sistemas operativos. 

Características y restricciones de las 
particiones
En esta sección se describen importantes características y restricciones de las particiones 
de una biblioteca que ayudarán a configurar y utilizar particiones en la biblioteca 
SL3000. 

■ Puede configurar hasta ocho particiones en una biblioteca SL3000. 

■ Una partición puede ser tan pequeña como una celda de almacenamiento o unidad 
de cinta, o un CAP giratorio o de AEM completo. Las celdas y las unidades de una 
partición no necesitan ser adyacentes. 

■ Las celdas de almacenamiento y las unidades de cinta asignadas a una partición sólo 
las pueden utilizar los hosts asignados a esa partición. Los hosts asignados a otras 
particiones no pueden acceder al contenido de estas celdas y unidades. Consulte 
“Celdas de almacenamiento y unidades” en la página 265 para obtener más detalles. 

■ Las celdas de almacenamiento y las unidades que no están asignadas a ninguna 
partición no están accesibles para los hosts. Por ejemplo, puede dejar un área de 
celdas sin asignar, en previsión para futuras particiones. 

■ Las conexiones host-partición pueden emplear la interfaz (TCP/IP) FC-SCSI o HLI. 

■ Se pueden asignar CAP giratorios o de AEM completos para uso exclusivo de una 
partición o se pueden compartir por varias particiones. Consulte “Particiones y CAP 
giratorios y de AEM” en la página 267 para obtener más detalles.

■ Los CAP sólo se pueden compartir por particiones con el mismo tipo de interfaz de 
host. Es decir, las particiones FC-SCSI y HLI no pueden compartir el mismo CAP. 
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■ Con la función de partición sin interrupción (NDP), hay un trastorno mínimo del 
host siempre que se asignan recursos a una partición, y los cambios hechos en una 
partición no afectan a otras particiones o sus conexiones host. Consulte “Particiones 
sin interrupción” en la página 273 para obtener más detalles. 

Activación y desactivación de particiones
Para utilizar las particiones en una biblioteca, se debe instalar la función de particiones 
mediante la utilidad de licencia.Consulte Capítulo 4, “Licencia”  en la página 187 para 
obtener más detalles. 

Una biblioteca con particiones activadas puede estar en uno de los siguientes estados: 

■ Particionada: la biblioteca tiene al menos una partición definida por el usuario con 
un identificador de partición válido. 

■ No particionada: la biblioteca no tiene particiones definidas por el usuario. Una 
biblioteca no particionada se comporta de la misma manera que una biblioteca que 
no tiene particiones activadas; es decir, todas las celdas de almacenamiento activas, 
las unidades y los CAP giratorios y de AEM están accesibles para todos los hosts. 

Para desactivar las particiones en una biblioteca, primero debe eliminar todas las 
particiones. El estado de la biblioteca cambiará a “no particionada”. 

Planificación de particiones
La función de particiones ofrece una gran flexibilidad en el uso de la biblioteca. 
Además, requiere una cuidadosa planificación, un sólido conocimiento de las paredes 
de la biblioteca y la asignación de las celdas de almacenamiento, y un dominio en la 
configuración y administración de aplicaciones software de host. Debe haber una 
comunicación clara entre todas las partes involucradas: programadores y 
administradores de sistema, operadores de biblioteca y representantes de servicios Sun. 

Antes de crear particiones, debe planificar el área de almacenamiento que se necesita 
para los cartuchos de cinta residentes y anticipar el número de celdas libres necesario. 
Debe conocer los límites de cada partición y las relaciones de propiedad del host. 
Debe verificar que todas los cartuchos y las unidades de cinta se han movido a las 
ubicaciones apropiadas, según las asignaciones planificadas. 

Instalación de la función de particiones
Las siguientes consideraciones especiales se aplican después de instalar correctamente 
la función de particiones en una biblioteca no particionada. 

■ Puede empezar a crear particiones de forma inmediata; no necesita reiniciar antes la 
biblioteca.

■ Hasta que no cree al menos una partición, la biblioteca permanece en estado de "no 
particionada"; es decir, todas las celdas de almacenamiento, las unidades y los CAP 
giratorios o de AEM con licencia están accesibles para todos los hosts. 
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Capacidad de almacenamiento asignada
En bibliotecas particionadas, el número total de celdas de almacenamiento asignadas a 
todas las particiones de la biblioteca no puede superar la capacidad con licencia de la 
biblioteca. 

En bibliotecas particionadas, no hay región de almacenamiento activa predeterminada. 
Debe asignar explícitamente celdas de almacenamiento a particiones; de ese modo se 
configuran las zonas de almacenamiento activas para cada partición. Consulte “Proceso 
de particiones” en la página 276 para obtener más detalles. 

Al asignar cartuchos a celdas de almacenamiento, el controlador de biblioteca aplica 
las reglas de selección de celdas predefinidas de forma individual a cada partición. 
Consulte “Reglas de activación de celdas” en la página 213 para obtener más detalles. 

Configuración de particiones
Debe utilizar SL Console independiente o SL Console en Web para configurar 
particiones de biblioteca; las pantallas de particiones no están disponibles en el panel 
de operador local. 

Para configurar una partición, debe definir la siguiente información: 

■ Información de resumen de particiones

■ Conexiones host-partición

■ Límites de partición

Para obtener instrucciones detalladas sobre la definición de particiones de biblioteca, 
consulte “Proceso de particiones” en la página 276. 

Información de resumen de particiones
La información de resumen de particiones incluye el ID de partición, el nombre y el 
tipo de conexión host-partición (HLI o FC-SCSI). Los identificadores de partición deben 
ser únicos y pueden incluir números del 1 al 8. 

Conexiones host-partición
Las conexiones host-partición identifican los hosts que pueden acceder a una partición. 
Cada partición aparece en el host como una biblioteca individual. Un host puede 
controlar una o varias particiones. Además, es posible para más de un host controlar 
una única partición FC-SCSI, pero se recomienda que sea cuidadoso a la hora de 
implementar esta configuración, ya que algunas aplicaciones no permiten el uso 
compartido de recursos. 
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Conexiones host-partición HLI

Una partición HLI (Host Library Interface) puede tener hasta 16 hosts asignados. La 
configuración de la conexión host-partición HLI se define a través del software de 
administración de bibliotecas (ACSLS o HSC). Por tanto, no hay pantallas de 
SL Console que muestren o guarden esta información. Consulte la documentación 
correspondiente del software de administración de cintas para obtener más detalles. 

Conexiones host-partición FC-SCSI

Una partición FC-SCSI puede tener una o varias conexiones host-partición. La 
configuración de la conexión host-partición la define el usuario y se compone de la 
información siguiente: 

■ WWPN (World Wide Port Name) del adaptador bus de host FC-SCSI 

■ Número de puerto de la tarjeta FC (Fibre Channel) de la biblioteca 

■ Número de unidad lógica (LUN) de la partición en el host 

Consulte “Configuración de una conexión host-partición” en la página 282 para obtener 
instrucciones detalladas sobre la definición de esta información. 

Límites de partición
Los límites de una partición identifican las celdas de almacenamiento, las unidades y 
los CAP giratorios y de AEM que forman parte de cada partición. Sólo las celdas sin 
asignar se pueden añadir a una partición y sólo las celdas asignadas se pueden 
eliminar. 

Puede definir límites de partición de cualquiera de las siguientes maneras:

■ Seleccione celdas individuales o grupos rectangulares de celdas para añadir o 
eliminar de una partición. Las celdas o los grupos de celdas no tienen que ser 
adyacentes.

■ Seleccione una columna de módulo para añadir o eliminar de una partición. Las 
columnas no tienen que ser adyacentes. 

■ Seleccione un lado completo de módulo (frontal o posterior) para añadir o eliminar 
de una partición. Los lados no tienen que ser adyacentes. 

■ Seleccione un módulo completo para añadir o eliminar de una partición. Los 
módulos no tienen que ser adyacentes. 

Nota: Es posible tener particiones con recursos no asignados. 
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Particiones y recursos de biblioteca

Direcciones de recursos de biblioteca 
Las direcciones de recursos identifican de forma exclusiva cada recurso (celdas de 
almacenamiento, unidades y CAP giratorios y de AEM) en la biblioteca. La biblioteca 
SL3000 y los hosts adjuntos utilizan los siguientes esquemas de direcciones: 

■ Dirección interna de biblioteca

■ Dirección de elementos FC-SCSI de host

■ Dirección HLI-PRC

Cada partición aparece en un host como una biblioteca individual; esto se refleja en la 
dirección de partición. 

Dirección interna de biblioteca
La dirección interna de la biblioteca se utiliza por el controlador de biblioteca SL3000 y 
árbol de dispositivos de SL Console para identificar la ubicación física de cada recurso. 
El esquema de direcciones que emplea SL3000 es un valor separado por comas de cinco 
dígitos que especifica la biblioteca, el raíl, la columna, el lado y la fila, según se ve 
desde la parte frontal de la biblioteca, dando a las bahías de unidad. 

El formato de la dirección interna de la biblioteca SL3000 es b,r,c,l,f donde:

■ b = biblioteca o número de partición; este valor es siempre “1”. 

■ r = número de raíl; este valor es siempre “1”.

■ c = número de columna. La numeración de columna toma como referencia el borde 
izquierdo del módulo básico, si se coloca frente a la pared posterior interna, de la 
siguiente manera:

■ La numeración es estática, lo que permite añadir módulos sin necesidad de 
renumerar las columnas existentes. 

■ Las columnas dentro y a la derecha del módulo básico se numeran en positivo (+), 
en orden ascendente de izquierda a derecha. 

■ Las columnas situadas a la izquierda del módulo básico se numeran en negativo (-
), en orden descendente de derecha a izquierda. 

■ Los paneles del módulo básico van siempre del “1” al “6”. 

■ Los paneles DEM (si hay) van siempre del “-1” al “-6”.

■ Si no hay DEM y un CEM está a la izquierda del módulo básico, las columnas de 
“-1” a “-6” se ignoran y el CEM se asigna a las columnas de “-7” a “-12”. 

■ Las columnas CEM situadas a la derecha del módulo básico empiezan con “7”. 

■ Las columnas AEM izquierdo se enumeran siempre de “–33” a “–31”. Las 
columnas AEM derecho se enumeran siempre de “31” a “33”. En otras palabras, 
las columnas AEM se numeran como si un DEM y cuatro CEM se instalan a la 
izquierda y cuatro CEM se instalan a la derecha del módulo básico. 

■ l = lado. Pared posterior = "1"; pared frontal = "2".

■ f = número de fila. Numeración consecutiva, de arriba a abajo. Valores válidos de 
“1” a “52”, con la fila “1” en la parte superior. 
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Dirección de elementos FC-SCSI de host
La dirección del elemento FC-SCSI se utiliza en hosts con una conexión FC-SCSI a la 
biblioteca SL3000 para identificar de forma exclusiva cada recurso de biblioteca 
disponible para el host. 

La enumeración de elementos FC-SCSI utiliza un número entero para identificar 
cada recurso de biblioteca. La enumeración de elementos FC-SCSI en bibliotecas 
particionadas es continua para cada partición, incluso si las ubicaciones de las celdas 
de la partición no son adyacentes. Las direcciones de elementos FC-SCSI para una 
partición se inician en el módulo, la fila y la columna inferiores dentro de la partición y, 
a continuación, siguen por fila hasta el final de la columna para incrementarse después 
por columna hasta el final del módulo. 

Cuando se asignan recursos adicionales a una partición FC-SCSI existente, los recursos 
originales no se vuelven a numerar. Esto contribuye a minimizar problemas en el host 
FC-SCSI. 

Ejemplos de dirección de elementos FC-SCSI

Si los módulos básico y de expansión de almacenamiento de una biblioteca se asignan a 
la Partición 1 y el módulo de unidades se asigna a la Partición 2, la enumeración de 
elementos FC-SCSI es como sigue:

■ La numeración de la Partición 1 comienza en la primera celda de almacenamiento 
disponible en el módulo básico y continúa a través de la última celda disponible en 
la celda del módulo de almacenamiento. 

■ La numeración de la Partición 2 comienza en la primera celda de almacenamiento 
disponible en la dirección PRC del módulo de unidades y termina en la última celda 
disponible en ese módulo. 

Dirección HLI-PRC
La dirección HLI-PRC (Host Library Interface-Panel, Row, Column) se utiliza en hosts 
con una conexión HLI a la biblioteca SL3000, que incluye ACSLS y HSC. La dirección 
HLI-PRC identifica de forma exclusiva cada recurso de biblioteca accesible para el host 
y se asigna mediante el software del host.

La dirección HLI-PRC es un valor de ocho dígitos que especifica la biblioteca, el panel, 
la fila y la columna donde está ubicado el recurso. El formato es ll:pp:ff:cc, donde:

■ ll = número de biblioteca; este valor es siempre “00”. 

■ pp = número de panel. La numeración es referente al módulo básico, de la siguiente 
manera:

■ Los paneles del módulo básico son siempre “12” y “13”. 

■ Los módulos situados a la izquierda del módulo básico están numerados en orden 
descendente, empezando por “11”; los módulos situados a la derecha están 
numerados en orden ascendente, empezando por “14”. 

■ A las paredes posteriores se le asignan números pares; a las paredes frontales se 
les asignan números impares. 

■ Los paneles DEM (si hay) son siempre “10” y “11”.
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■ Si no hay DEM y un CEM está a la izquierda del módulo básico, los paneles “10” 
y “11” se ignoran y el CEM se asigna a los paneles “8” y “9”. Esto permite añadir 
un DEM a la izquierda del módulo básico más adelante sin volver a numerar los 
módulos. 

■ Para la numeración de paneles AEM, consulte “Numeración CAP: CAP giratorios 
y de AEM” en la página 265. 

■ ff = número de fila dentro del panel. Numeración consecutiva, de arriba a abajo. 
Valores válidos de 0 a 51, con la fila 0 en la parte superior. 

■ cc = número de columna dentro del panel. Numeración consecutiva de izquierda a 
derecha, comenzando en la parte frontal del módulo. Cada panel tiene un máximo 
de seis columnas; por tanto, los valores de columna válidos van del 0 al 5. 

Numeración CAP: CAP giratorios y de AEM

Nota: HSC muestra direcciones HLI-PRC en notación hexadecimal. Por tanto, los 
paneles 10, 11 y 12 se visualizan como “0A”, “0B” y “0C” respectivamente. ACSLS y la 
SL Console muestran direcciones HLI-PRC en notación decimal. 

Los números CAP de biblioteca se asignan por módulo, de izquierda a derecha: 

■ CAP de módulo básico = 6

■ CAP de DEM = 5

■ CAP giratorio en CEM a la izquierda del módulo básico = 1–4

■ CAP giratorios en CEM a la derecha del módulo básico = 7-10

■ CAP de AEM a la izquierda del módulo básico = 0

■ CAP de AEM a la derecha del módulo básico = 11

CAP giratorios contienen una sola columna de celdas con 26 filas; las celdas se 
numeran del 0 al 25. 

El AEM contiene un CAP de carga a granel con 234 celdas organizadas en seis 
columnas. La numeración de columnas empieza en la pared posterior y se ejecuta de 
izquierda a derecha (columnas 0–2); a continuación, continúa en la pared frontal y se 
ejecuta de izquierda a derecha (columnas 3–5). 

Celdas de almacenamiento y unidades 
Todas las celdas de almacenamiento, las unidades de cinta y los cartuchos asignados a 
una partición son propiedad exclusiva del host asignado y no están accesibles para 
otros hosts. Por ejemplo, si un grupo de unidades de cinta está asignado a una 
partición, sólo el host asignado a esa partición puede utilizar esas cintas. 

Las celdas de almacenamiento y las unidades que no están asignadas a ninguna 
partición no están accesibles en absoluto. Por ejemplo, puede dejar un área de celdas 
sin asignar, en previsión para una futura partición planificada. 

En las pantallas e informes de SL Console, las celdas de almacenamiento y las unidades 
pueden tener cualquiera de los siguientes estados:

■ Asignada (Allocated): se ha asignado a la partición actual. 
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■ No asignada (Unallocated o Unassigned): no se ha asignado a ninguna partición; 
disponible para ser asignada a la partición actual. 

■ No disponible (Unavailable): asignada a otra partición. 

■ No accesible (Not accessible): no disponible para operaciones host; por ejemplo, 
celdas reservadas para cartuchos de diagnóstico, celdas que están físicamente 
bloqueadas, y celdas que están inactivas. 

Nota: Los TallBot son recursos compartidos y no se pueden asignar de forma exclusiva 
a una partición. 

Para visualizar asignaciones de particiones para celdas de almacenamiento y unidades, 
consulte “Partitions—Reports—Cartridge Cell and Media Summary” en la página 375. 

Cartuchos huérfanos en bibliotecas particionadas

Nota: Para conocer más detalles sobre cartuchos huérfanos en bibliotecas no 
particionadas, consulte “Cartuchos huérfanos en bibliotecas no particionadas” en la 
página 214.

En bibliotecas particionadas, un cartucho huérfano es un cartucho ubicado en una celda 
o unidad sin asignar (es decir, una celda o unidad no asignada a ninguna partición 
definida). 

Atención: Si un host se encuentra un cartucho huérfano, podría tratar el cartucho 
como nuevo y sobrescribir los datos. Por tanto, es muy importante ubicar los cartuchos 
huérfanos de forma apropiada. 

Un cartucho puede pasar a ser huérfano por diversas razones. Algunas posibles causas 
son:

■ Los límites de la partición han cambiado.

■ Se ha eliminado una partición. 

■ El cartucho se ha movido a una celda sin asignar o inaccesible mediante la 
intervención manual. 

Si SL Console identifica un cartucho huérfano, muestra un mensaje de aviso. Puede 
utilizar las siguientes herramientas que le ayudarán a resolver y disponer del cartucho 
huérfano:

■ Genere un informe de cartuchos huérfanos. 

■ Realice una auditoría de la biblioteca. 

■ Realice un movimiento de recuperación en un cartucho. 

Para obtener instrucciones detalladas sobre la comprobación y resolución de cartuchos 
huérfanos, consulte los siguientes procedimientos:

■ “Verificación de configuraciones de particiones” en la página 289

■ “Resolución de cartuchos huérfanos” en la página 292

■ “Confirmación de cambios en configuración de partición” en la página 293
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Particiones y CAP giratorios y de AEM 

Nota: Los CAP de AEM están sujetos a las mismas reglas y restricciones de particiones 
que los CAP giratorios. En esta sección, el término “CAP” se refiere a ambos tipos de 
CAP. 

Nota: SL3000 no admite CAP comunes, CAP de división, o la asignación de celdas 
CAP individuales a una partición. Estas características están disponibles sólo para 
SL500. 

A la hora de configurar un CAP, debe planificar cuidadosamente para el uso anticipado 
del CAP. Una partición sólo puede utilizar los CAP que se le han asignado de forma 
explícita. No existe CAP “común” en SL3000. 

Cuando asigna un CAP a una partición, todas las celdas del CAP se asignan como un 
conjunto. No es posible asignar o anular la asignación de celdas individuales dentro de 
un CAP. No existe CAP “dividido” en SL3000. 

Asignaciones de CAP
De forma predeterminada, todos los CAP en una biblioteca particionada están sin 
asignar. Se asignan CAP a particiones a través de las pantallas siguientes:

■ “Partitions—Design (Step 3b)” en la página 349 para módulos básicos, de unidad y 
CEM

■ “Partitions—Design (Step 3b) – AEMs Only” en la página 355 para módulos AEM

Las asignaciones de CAP pueden tener una de las siguientes formas:

■ Dedicado: el CAP está asignado para uso exclusivo de una partición.

■ Compartido: el CAP está asignado para el uso de más de una partición especificada. 
Consulte “CAP compartidos” para obtener más detalles. 

Una vez que se ha asignado un CAP, se convierte en un CAP FC-SCSI o un CAP HLI, 
en función del tipo de interfaz de host de la primera partición a la que se asigna. Por 
ejemplo, si asigna un CAP que no se ha asignado nunca antes a una partición con una 
interfaz FC-SCSI, el CAP se convierte en un CAP FC-SCSI. Las asignaciones posteriores 
del CAP sólo podrán ser a otras particiones FC-SCSI. Para cambiar el CAP de FC-SCSI 
a HLI, primero debe anular la asignación del CAP de todas las particiones FC-SCSI y, a 
continuación, asignar el CAP a una partición HLI.

Nota: Las asignaciones de CAP no son obligatorias; es posible tener particiones con 
CAP sin asignar. 
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Nota: Puesto que las aplicaciones host FC-SCSI generalmente no utilizan reservas CAP, 
se recomienda que dedique al menos un CAP para cada partición FC-SCSI siempre que 
sea posible. Esto permite a cada partición operar de forma independiente de las demás 
y evitar los problemas de disposición de recursos que pueden surgir con los CAP 
compartidos. 

CAP compartidos
Puesto que una biblioteca puede tener más particiones que CAP, puede que sea 
necesario compartir CAP entre las particiones. Sólo las particiones con el mismo tipo de 
interfaz de host pueden compartir un CAP. Por ejemplo, cualquier número de 
particiones FC-SCSI pueden compartir un grupo de uno o varios CAP, y cualquier 
número de particiones HLI pueden compartir un grupo diferente de CAP, pero las 
particiones HLI y FC-SCSI no pueden compartir los mismos CAP. 

Para una fácil administración, se recomienda mantener grupos de CAP compartidos 
juntos para todas las particiones a las que están asignados. Por ejemplo, si asigna los 
CAP A y B a una partición, y otra partición también necesita acceder a A o B, debe 
asignar ambos CAP, no sólo uno de ellos, a la segunda partición. 

Nota: Debe administrar cuidadosamente el uso compartido de CAP entre hosts 
FC-SCSI a fin de evitar problemas de disposición. Consulte ““Propiedad” de CAP” en 
la página 268 para obtener más detalles. 

Modo de introducción automática de CAP 
El modo de introducción automática de CAP permite a un operador de biblioteca abrir 
un CAP e iniciar una operación de introducción sin emitir una solicitud de introducción 
explícita y sin una reserva explícita de una aplicación host. El modo de introducción 
automática está disponible para CAP que están dedicados a una partición. Los CAP en 
modo de introducción automática se quedan sin bloquear. 

El modo de introducción automática se administra en aplicaciones host. Consulte la 
documentación correspondiente del software de administración de cintas para obtener 
más detalles. 

“Propiedad” de CAP 
Un CAP se puede utilizar sólo por una partición al mismo tiempo para operaciones de 
introducción y expulsión. Una partición puede tener la propiedad de un CAP de una de 
las siguientes formas:

■ El CAP está dedicado a una partición. En este caso la partición siempre tiene la 
propiedad exclusiva del CAP.

■ Una aplicación host reserva el CAP antes de una operación de introducción o 
expulsión. Se aplica generalmente sólo a aplicaciones host HLI. Consulte “Reservas 
de CAP” en la página 270 para obtener más detalles. 
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■ El usuario asocia de forma explícita la partición al CAP. Esto se aplica sólo a CAP 
FC-SCSI compartidos. Consulte “Asociaciones de CAP FC-SCSI compartidos” en la 
página 271 para obtener más detalles. 

■ Una partición coloca un cartucho en el CAP. Si no se aplica ninguna de las 
condiciones expuestas, la primera partición en colocar un cartucho en el CAP como 
parte de una operación de exportación tendrá la propiedad del CAP hasta que la 
exportación se complete y el CAP se cierre y quede vacío.

Mientras una partición tiene la propiedad de un CAP, éste se reserva exclusivamente a 
esa partición y no está disponible para las demás. La biblioteca envía mensajes de CAP 
abierto y CAP cerrado sólo al host que tiene la reserva. 

Sólo para CAP HLI, cuando un host intenta reservar un CAP que ya ha reservado otra 
partición, la biblioteca envía un mensaje al host solicitante donde especifica el 
identificador de partición y el identificador de host que tiene la reserva. 

Estados de CAP
Un CAP debe estar desbloqueado para que se puedan abrir e insertar o eliminar 
cartuchos. Cuando un CAP está desbloqueado, la luz del botón CAP está encendida. 

Cuando se cierra un CAP, el TallBot realiza una auditoría para determinar si hay 
cartuchos presentes. Durante la auditoría, el CAP está bloqueado y la luz del botón 
CAP está apagada. Una vez finalizada la auditoría, el CAP vuelve a su estado 
predeterminado. 

En la siguiente tabla se describen los estados predeterminados de los diversos tipos de 
CAP dentro de una biblioteca particionada. 

Tipo de CAP
Estado pre-
determinado

Luz de botón 
CAP (prede-
terminado) Comentario

HLI: dedicado o 
compartido 

Bloqueado Apagada La reserva del host desblo-
quea el CAP y enciende la luz. 
Consulte “Reservas de CAP” 
en la página 270 para obtener 
más detalles. 

HLI: modo de 
introducción 
automática

Desbloquead
o

Encendida

FC-SCSI: dedicado Desbloquead
o

Encendida

FC-SCSI: 
compartido

Bloqueado Apagada La asociación partición-CAP 
desbloquea el CAP y enciende 
la luz. Consulte “Asociaciones 
de CAP FC-SCSI comparti-
dos” en la página 271 para ob-
tener más detalles.
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Reservas de CAP
Los hosts FC-SCSI y HLI pueden hacer uso de reservas de CAP. Las reservas de CAP 
proporcionan una propiedad exclusiva de partición de un CAP compartido por la 
duración de una operación de introducción o expulsión. Cuando la operación finaliza, 
la aplicación host debe liberar la reserva para que el CAP pueda estar disponible para 
otras particiones que comparten el CAP. Ninguna otra partición puede acceder al CAP 
hasta que la primera haya terminado la operación y se haya liberado la reserva. 

Para que una partición reserve un CAP, el CAP debe estar sin reservar (sólo aplicable a 
CAP compartidos), vacío y cerrado. 

Reservas de CAP HLI 
Las aplicaciones host HLI utilizan un estricto esquema de reservas para administrar el 
uso de CAP entre clientes host y, por tanto, siempre reservan un CAP antes de 
desbloquearlo o mover un cartucho al mismo. Cuando una aplicación host HLI intenta 
reservar un CAP que ya ha reservado otra partición, el controlador de biblioteca envía 
un mensaje al host solicitante donde especifica el identificador de partición y el 
identificador de host que tienen la reserva. 

Liberación de reservas de CAP 

En operaciones normales, una reserva de CAP para un host ACSLS o HSC se libera de 
las siguientes formas:

■ Operaciones de introducción: después de que todos los cartuchos se hayan 
introducido correctamente en la biblioteca, el host finaliza explícitamente el 
comando de introducción. El controlador de biblioteca libera el CAP después de 
comprobar que está cerrado y vacío. 

■ Operaciones de expulsión: después de que todos los cartuchos se hayan expulsado 
correctamente, el host finaliza automáticamente la operación de expulsión. El 
controlador de biblioteca libera el CAP después de comprobar que está cerrado 
y vacío. 

Si, por alguna razón, una reserva de CAP no se libera según se ha descrito, el CAP no 
estará disponible para todas las demás particiones y los cartuchos que pertenecen a la 
primera partición pueden permanecer en el CAP. En este caso, se recomienda que 
finalice la operación de introducción o expulsión desde el host que mantiene la reserva. 
Esto garantiza una liberación normal de la reserva de CAP. 

Nota: Consulte la documentación de ACSLS o HSC para obtener detalles sobre la 
finalización de operaciones de introducción y expulsión. 
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Anulación de reservas de CAP 

En algunos casos, es posible que no pueda acceder al host que tiene una reserva y, por 
tanto, no pueda realizar una liberación normal del CAP. Esto puede deberse a que el 
host ha finalizado, o bien, a que usted no dispone de la suficiente autorización de 
seguridad o acceso físico para enviar comandos al host. En estos casos, puede anular la 
reserva de CAP de forma manual. Consulte “Anulación de una reserva de CAP” en la 
página 322 para conocer el procedimiento detallado. 

Nota: Tenga mucho cuidado cuando utilice SL Console para anular una reserva de 
CAP. Si no completa el procedimiento, el CAP podría no quedar disponible para todas 
las particiones, y los cartuchos asignados a una partición podrían introducirse en otra 
partición.

Nota: Puede utilizar SL Console para anular una reserva de CAP sólo en una biblioteca 
particionada. Si una biblioteca no está particionada, las reservas de CAP se deben 
liberar siempre a través de ACSLS o HSC. 

Reservas de CAP FC-SCSI 
La mayoría de aplicaciones host FC-SCSI no utilizan reservas de CAP. Las aplicaciones 
host FC-SCSI generalmente asumen la propiedad exclusiva de un CAP y, por tanto, no 
coordinan bien el uso compartido de CAP. Para evitar problemas entre las particiones 
por un CAP compartido, puede asociar manualmente una partición a un CAP. Consulte 
“Asociaciones de CAP FC-SCSI compartidos” en la página 271 para obtener más 
detalles. 

Asociaciones de CAP FC-SCSI compartidos 
Si una partición FC-SCSI comparte CAP con otras particiones, se recomienda que asocie 
manualmente la partición a sus CAP antes de iniciar una operación de introducción o 
expulsión. Consulte “Asociación de una partición FC-SCSI a los CAP compartidos” en 
la página 317 para conocer el procedimiento detallado.

Una asociación partición-CAP ofrece una propiedad exclusiva de partición de los 
CAP compartidos, similar a la reserva de CAP. Esto garantiza que los cartuchos se 
introducen siempre en la partición correcta y evita que otras particiones adquieran la 
propiedad de un CAP compartido que ya está en uso. 

Las siguientes reglas se aplican cuando se realizan asociaciones partición-CAP:

■ Sólo puede asociar una partición a un CAP a un mismo tiempo. 

■ La selección de una partición hace que todos los CAP asignados se asocien a ella al 
mismo tiempo; no puede seleccionar CAP de uno en uno para que se asocien a la 
partición. 

■ Puede seleccionar varias particiones al mismo tiempo, siempre que las particiones 
seleccionadas no compartan ningún CAP entre sí. 

■ Las asociaciones partición-CAP permanecen activas hasta que se eliminan 
explícitamente; las asociaciones no se eliminan de forma automática cuando se 
completa la operación de introducción o expulsión. 
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■ Las asociaciones partición-CAP se eliminan durante los reinicios de biblioteca, los 
ciclos de alimentación, las operaciones de apertura y cierre de puerta de biblioteca, o 
las inicializaciones de CAP. 

■ Las asociaciones partición-CAP se eliminan si el CAP se asigna a una partición 
diferente a través de la pantalla Design (Step 3b). 

■ Si una asociación partición-CAP se elimina mientras el CAP está abierto o tiene 
cartuchos, la propiedad del CAP cambiará al solicitante “predeterminado” y el 
CAP quedará no disponible para todas las particiones. Debe vaciar y cerrar el CAP 
antes de que se pueda asociar a particiones. 
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Particiones sin interrupción
La función de partición sin interrupción (NDP) minimiza el número de interrupciones 
del host que se producen cuando se modifican las particiones. La biblioteca no necesita 
ser desconectada para cada cambio de partición y los hosts se aislan de los cambios de 
partición que no les afectan directamente.

Antes de esta función, siempre que una partición se cambiaba de alguna manera, 
todas las particiones se desconectaban mientras se activaba la base de datos del 
controlador de biblioteca. Como resultado, las interrupciones del servicio de la 
biblioteca necesitaban coordinarse en todos los hosts conectados a una biblioteca 
particionada. 

Las funciones específicas de la función NDP varía según el tipo de conexión host-
partición. Para obtener más detalles, consulte las secciones siguientes:

■ “Particiones NDP y HLI” en la página 273

■ “Particiones NDP y FC-SCSI” en la página 274

Atención: Aunque los cambios de partición no interrumpen los hosts de la biblioteca, 
se recomienda que haga que la biblioteca no esté disponible para otros usuarios 
antes de confirmar los cambios del espacio de trabajo de particiones. Debido a que 
SL Console no verifica los límites de partición con la base de datos del controlador de 
biblioteca en tiempo real, pueden surgir conflictos de configuración si cambia los 
límites de partición mientras otros usuarios están moviendo cartuchos o cambiando la 
configuración de la biblioteca. Consulte “Sincronización de la pantalla con la base de 
datos del controlador” en la página 38 para obtener más detalles. 

Particiones NDP y HLI
Con las particiones HLI, puede asignar recursos adicionales a una partición sin parar 
los trabajos del host o tener que desconectar la partición. En general, una partición 
sólo se desconecta cuando se anula la asignación de los recursos. En todos los casos, 
particiones vecinas permanecen siempre imperturbables.

Asignación de recursos adicionales a una partición
Siempre que realice cualquiera de los siguientes tipos de cambios de partición, la 
partición afectada permance conectada: 

■ Asignar una celda de almacenamiento 

■ Asignar una unidad 

■ Asignar un CAP 

El controlador de biblioteca envía un mensaje asíncrono a todos los hosts conectados 
a la partición notificándoles que la configuración de la biblioteca ha cambiado. Los 
hosts experimentan una breve interrupción mientras actualizan la información de 
configuración de su biblioteca y, después, continúan automáticamente procesando los 
trabajos. 
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Eliminación de asignaciones de una partición
Siempre que realice cualquiera de los siguientes tipos de cambios de partición, la 
partición afectada se desconecta brevemente: 

■ Anular la asignación de una celda de almacenamiento

■ Anular la asignación de una unidad

■ Eliminar una ranura de unidad vacía

Una vez que se ha actualizado el cambio de configuración en la base de datos del 
controlador de biblioteca, la partición se conecta de nuevo automáticamente y el 
controlador de biblioteca notifica a todos los hosts conectados a la partición que se ha 
producido un cambio de configuración. Los hosts experimentan una breve interrupción 
mientras actualizan la información de configuración de su biblioteca y, después, 
continúan automáticamente procesando los trabajos. 

Particiones NDP y FC-SCSI
Con las particiones FC-SCSI, puede asignar un CAP a una partición sin parar los 
trabajos del host o tener que desconectar la partición. 

Todos los otros cambios en una partición FC-SCSI hacen que la partición afectada se 
desconecte con una condición Unit Attention. Particiones vecinas y los hosts conectados 
no se alteran.

Cambios de conexiones host
Los cambios de conexiones host incluyen las actividades siguientes:

■ Añadir una conexión host-partición

■ Cambiar las propiedades de una conexión host-partición 

■ Eliminar una conexión host-partición

Siempre que realice cualquiera de estos cambios, la partición afectada se desconecta 
con una condición LUNS Data Has Changed Unit Attention. Los hosts conectados a 
la partición deben enviar los comandos apropiados para actualizar la información 
de configuración de la biblioteca. Consulte la documentación del software de 
administración de cintas correspondiente para obtener detalles de los procedimientos 
y comandos.

Si un host tiene asignaciones de conexión de nexo ITL único para cada conexión de 
partición, sólo la partición que experimenta el cambio de conexión se verá afectada. Sin 
embargo, debido a que la biblioteca SL3000 admite solamente un puerto de destino (0), 
es posible que un host con varias conexiones de partición pueda hacer referencia al 
mismo par LUN-destino para cada uno. En este caso, siempre que una conexión host-
partición se cambia, todas las particiones con las que el host tiene conexiones también 
se verán afectadas. 
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Cambios de la configuración de partición
Los cambios de la configuración de partición incluyen las actividades siguientes:

■ Asignar una celda de almacenamiento 

■ Asignar una unidad 

■ Anular la asignación de una celda de almacenamiento

■ Anular la asignación de una unidad

■ Anular la asignación de un CAP 

■ Eliminar una ranura de unidad vacía 

Siempre que realice cualquiera de estos cambios, la partición afectada se desconecta 
con una condición Mode Parameters Have Changed Unit Attention. Los hosts 
conectados a la partición deben enviar los comandos apropiados para actualizar 
la información de configuración de la biblioteca; consulte la documentación del 
software de administración de cintas correspondiente para obtener detalles de los 
procedimientos y comandos. En el caso de añadir o eliminar unidades, también se 
actualiza la numeración del dispositivo SCSI. 
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Proceso de particiones

Nota: Las particiones de la biblioteca constituyen una función con licencia que se debe 
instalar mediante la utilidad de licencia SL3000. Consulte Capítulo 4, “Licencia” para 
obtener más detalles. 

Proceso de configuración de partición
Cuando se configuran particiones de biblioteca por primera vez, se recomienda que se 
utilicen las pantallas de partición de biblioteca en el orden siguiente: 

1. Instructions (Step 1): revise las instrucciones para el proceso de configuración de 
partición. 

2. Summary (Step 2): visualice la información en modo resumen sobre la configuración 
de partición y la conexión host-partición. También puede acceder a otras pantallas 
para realizar las tareas siguientes:

■ Add Partition

■ Modify Partition

■ Delete Partition

Nota: Las siguientes tareas están disponibles sólo para conexiones host-partición 
FC-SCSI. 

■ Add Connection

■ Modify Connection

■ Delete Connection

3. Module Map (Step 3a): seleccione el módulo de biblioteca para el que desea diseñar 
límites de partición detallados. 

4. Design (Step 3b): visualice y modifique de forma opcional información detallada de 
límites de partición. También puede acceder a otras pantallas para realizar las tareas 
siguientes:

■ Comprobar configuraciones de particiones. 

■ Actualizar la pantalla con los datos actuales de la base de datos del controlador de 
biblioteca.

5. Commit (Step 4): confirmar todos los cambios realizados en las pantallas Summary 
(2) y Design (3b), y todos los paneles emergentes asociados, en la base de datos del 
controlador de biblioteca. También puede acceder a otras pantallas para realizar las 
tareas siguientes: 

■ Actualizar la pantalla con los datos actuales de la base de datos del controlador de 
biblioteca.

Puede utilizar la pantalla Reports en cualquier momento para visualizar y, de forma 
opcional, guardar o imprimir, datos de configuración de partición de la base de datos 
del controlador de biblioteca. 



Proceso de particiones

418605401 • Revisión AB Capítulo 6 Particiones de biblioteca 277

SL Console Espacio de trabajo de particiones
Las pantallas de particiones Summary (Step 2) y Design (Step 3b), y todos los 
paneles emergentes asociados, ofrecen un espacio de trabajo dinámico para diseñar 
particiones de biblioteca. Toda la información de configuración de particiones se guarda 
automáticamente en el espacio de trabajo de particiones en la memoria de SL Console y 
se conserva durante el tiempo de la sesión de SL Console. Esto permite cambiar entre 
vistas de particiones, y salir y volver a las pantallas de particiones todas las veces que 
se quiera sin perder los cambios de configuración.

La información del espacio de trabajo de particiones de SL Console se guarda en la base 
de datos del controlador de biblioteca sólo mediante la pantalla Commit (Step 4). La 
información se pierde si ocurre una de las situaciones siguientes antes de que haya 
confirmado las actualizaciones: 

■ Desconecta activamente la sesión de SL Console.

■ La sesión de SL Console ha caducado o la conexión a la biblioteca se ha perdido. 

■ Actualiza activamente el espacio de trabajo de SL Console en la base de datos del 
controlador de biblioteca actual. Esto se hace mediante el botón Refresh en las 
pantallas Summary (Step 2) y Design (Step 3b). 

Atención: Aunque los cambios de partición no interrumpen los hosts de la biblioteca, 
se recomienda que haga que la biblioteca no esté disponible para otros usuarios 
antes de confirmar los cambios del espacio de trabajo de particiones. Debido a que 
SL Console no verifica los límites de partición con la base de datos del controlador de 
biblioteca en tiempo real, pueden surgir conflictos de configuración si cambia los 
límites de partición mientras otros usuarios están moviendo cartuchos o cambiando la 
configuración de la biblioteca. Consulte “Sincronización de la pantalla con la base de 
datos del controlador” en la página 38 para obtener más detalles. 
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Resumen de tareas de particiones
Las tareas de particiones se dividen en las siguientes categorías:

■ “Tareas de configuración de partición” en la página 279

■ “Tareas de administración de particiones” en la página 296

■ “Tareas de informes de particiones” en la página 309

■ “Tareas de operaciones de CAP” en la página 316
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Tareas de configuración de partición

Tarea Página

Revisión de instrucciones de partición 280

Creación de una partición 281

Configuración de una conexión host-partición (sólo particiones 
FC-SCSI) 

282

Diseño de una partición: módulos básicos, DEM o CEM 284

Diseño de una partición: módulos AEM 287

Verificación de configuraciones de particiones 289

Resolución de cartuchos huérfanos 292

Confirmación de cambios en configuración de partición 293
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▼ Revisión de instrucciones de partición
Utilice este procedimiento para revisar el proceso de particiones. 

1. Seleccione Tools > Partitions.

La primera vez que realiza esta selección durante una sesión de conexión de 
SL Console, aparece automáticamente la pantalla Instructions (Step 1). 

2. Revise las instrucciones en la pantalla antes de continuar con otras tareas de 
particiones. 
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▼ Creación de una partición 
Utilice este procedimiento para crear una nueva partición de biblioteca y asignar su 
capacidad de almacenamiento. Puede crear hasta ocho particiones, con identificadores 
del 1 al 8. 

1. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Summary (Step 2). 

Aparece la pantalla Summary (Step 2).

2. Haga clic en Add Partition. 

Aparece el cuadro emergente Add Partition. 

3. Seleccione el identificador (ID) de partición que desea añadir e introduzca el 
nombre, la capacidad y el tipo de interfaz.

Nota: Los ID de partición no necesitan ser contiguos. Por ejemplo, puede crear una 
partición 2 y una partición 4, sin particiones 1 o 3. 

4. Haga clic en OK. 

Los cambios de la configuración de partición se guardan en el espacio de trabajo de 
particiones de SL Console para la duración de la sesión de inicio. 

Para actualizar la base de datos del controlador de biblioteca con todos los cambios de 
esta sesión de inicio en SL Console, consulte “Verificación de configuraciones de 
particiones” en la página 289 y “Confirmación de cambios en configuración de 
partición” en la página 293. 
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▼ Configuración de una conexión host-partición

Nota: Este procedimiento sólo se aplica a conexiones host-partición FC-SCSI. Las 
conexiones host-partición HLI se configuran mediante el software de administración de 
bibliotecas host (HSC o ACSLS), no a través de SL Console. Consulte la documentación 
de HSC o ACSLS para obtener más detalles. 

Utilice este procedimiento para configurar la conexión entre un host y una partición 
seleccionada. Debe realizar este procedimiento para que el host pueda acceder a la 
partición.

Cada partición puede tener hasta nueve conexiones host, cada una con un LUN único. 
Además, cada host puede conectar con varias particiones. 

1. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Summary 
(Step 2).

Aparece la pantalla Summary (Step 2).

2. Haga clic en la partición a la que va a añadir una conexión host.

Nota: Si selecciona una partición HLI, todos los botones de la sección Details de la 
pantalla se muestran sombreados. 
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3. Haga clic en Add Connection para añadir una conexión. 

Aparece el cuadro emergente Add Connection. 

4. Introduzca el Initiator (WWPN) y el LUN. 

Nota: Cada iniciador conectado a la biblioteca debe tener una partición de biblioteca 
asignada a LUN 0. Cuando compruebe o confirme los cambios de configuración de 
partición, SL Console notificará si un iniciador no satisface este requisito. 

5. Haga clic en OK. 
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▼ Diseño de una partición: módulos básicos, DEM o 
CEM
Utilice este procedimiento para añadir o eliminar recursos de biblioteca (celdas de 
almacenamiento, unidades de cinta y CAP giratorios) en una partición. 

Nota: Este procedimiento se aplica a módulos básicos, DEM o CEM. Consulte “Diseño 
de una partición: módulos AEM” en la página 287 para obtener instrucciones detalladas 
sobre la asignación o la anulación de la asignación de un CAP de AEM a o de una 
partición. 

Nota: Los recursos de biblioteca se pueden asignar sólo a una partición cada vez. 
Si desea añadir recursos a una partición pero los recursos ya están asignados a otra 
partición, primero debe eliminar los recursos de la partición asignada y, a continuación, 
añadirlos a la nueva partición. 

1. Seleccione Tools > Partitions.

2. Haga clic en la ficha Module Map (Step 3a). 

Aparece la pantalla Module Map (Step 3a). 

3. Haga clic en el módulo para el que va a diseñar una partición. 
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4. Haga clic en la ficha Design (Step 3b).

Aparece la pantalla Design (Step 3b), con la configuración actual del módulo que ha 
seleccionado.

5. En el menú desplegable Partition, seleccione la partición que va a configurar. 

Todos los campos de la pantalla se actualizan para reflejar la configuración actual para 
la partición seleccionada. 

Nota: Haga clic en los botones Move Left o Move Right para visualizar un módulo 
inmediatamente adyacente al módulo mostrado actualmente. 

6. Seleccione el método de selección en Select by y haga clic en el botón de radio Add o 
Remove.

7. Utilice el plano de la biblioteca para seleccionar los recursos que va a añadir o 
eliminar. 
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Nota: Consulte “Partitions—Design (Step 3b)” en la página 349 para obtener 
instrucciones detalladas sobre el uso del plano de la biblioteca. 

Los cambios de la configuración de partición se guardan en el espacio de trabajo de 
particiones de SL Console para la duración de la sesión de inicio. 

Para actualizar la base de datos del controlador de biblioteca con todos los cambios de 
esta sesión de inicio en SL Console, consulte “Verificación de configuraciones de 
particiones” en la página 289 y “Confirmación de cambios en configuración de 
partición” en la página 293. 
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▼ Diseño de una partición: módulos AEM 
Utilice este procedimiento para añadir o eliminar un CAP de AEM a o de una partición. 

Puede asignar o anular la asignación del AEM completo cada vez; no es posible asignar 
sólo parte de un AEM a una partición. Varias particiones puede compartir AEM que 
comparten la misma interfaz host-partición (HLI o FC-SCSI). 

Nota: Consulte “Diseño de una partición: módulos básicos, DEM o CEM” en la 
página 284 para obtener instrucciones detalladas sobre como añadir o eliminar recursos 
de biblioteca en módulos básicos, DEM o CEM a o de una partición. 

1. Seleccione Tools > Partitions.

2. Haga clic en la ficha Module Map (Step 3a). 

Aparece la pantalla Module Map (Step 3a). 

3. Haga clic en el AEM que desea asignar a una partición. 
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4. Haga clic en la ficha Design (Step 3b).

Aparece la pantalla Design (Step 3b) con la configuración actual del AEM que ha 
seleccionado. 

5. En el menú desplegable Partition, seleccione la partición que va a configurar. 

Todos los campos de la pantalla se actualizan para reflejar la configuración actual para 
la partición seleccionada. 

Nota: Haga clic en los botones Move Left o Move Right para mostrar un módulo 
inmediatamente adyacente al módulo actualmente mostrado. 

6. Haga clic en el botón de radio Add o Remove.

7. Haga clic en cualquier lugar en el plano de la biblioteca para seleccionar el AEM e 
indicar que desea asignarlo o anular la asignación del mismo a o de la partición. 

Los cambios de la configuración de partición se guardan en el espacio de trabajo de 
particiones de SL Console para la duración de la sesión de inicio. 

Para actualizar la base de datos del controlador de biblioteca con todos los cambios de 
esta sesión de inicio en SL Console, consulte “Verificación de configuraciones de 
particiones” en la página 289 y “Confirmación de cambios en configuración de 
partición” en la página 293. 
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▼ Verificación de configuraciones de particiones 
Utilice este procedimiento para verificar los cambios en la configuración de particiones 
que ha realizado durante la sesión de inicio de SL Console. Este procedimiento avisa de 
los siguientes errores posibles:

■ Una partición tiene cartuchos huérfanos. Consulte “Cartuchos huérfanos en 
bibliotecas particionadas” en la página 266 para obtener más detalles.

■ Se han eliminado recursos de biblioteca de una partición. 

■ Un host conectado a la biblioteca no tiene una partición asignada a LUN 0. 

■ La capacidad con licencia de la biblioteca es superior, es decir, el total de 
asignaciones de particiones supera la capacidad con licencia.

Nota: Este procedimiento verifica sólo una partición cada vez. Para verificar varias 
particiones, debe repetir este procedimiento de forma individual para cada partición. 

1. Seleccione Tools > Partitions.

2. Haga clic en la ficha Module Map (Step 3a). 

Aparece la pantalla Module Map (Step 3a). 

3. Haga clic en el módulo para el que va a verificar una partición. 

El módulo se marca en la pantalla. 
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4. Haga clic en la ficha Design (Step 3b).

Aparece la pantalla Design (Step 3b), con la configuración actual del módulo que ha 
seleccionado.

5. En el menú desplegable Partition, seleccione la partición que va a verificar. 

Todos los campos de la pantalla se actualizan para reflejar la configuración actual para 
la partición seleccionada. 

6. En la barra de opciones, haga clic en Verify. 

Los límites de la partición seleccionada se verifican, incluidas las ubicaciones de todos 
los cartuchos de cinta. 

Nota: This verification is performed on the current partition configuration in the 
SL Console partition workspace only. It does not verify current partition boundaries 
against the library controller database; therefore it cannot identify configuration 
conflicts that may arise due to other users performing cartridge movements or library 
configuration changes—through the interfaz de línea de comandos, other SL Console 
sessions, or host applications—at the same time you have made partition changes. 

Aparece el cuadro emergente Verify Results, que indica si hay cartuchos huérfanos, 
capacidad de almacenamiento superior, u otros errores en la configuración de partición 
actual. 

Nota: Si la capacidad de la biblioteca es superior (es decir, el total de asignaciones 
de partición supera la capacidad con licencia), antes de que pueda proceder a la 
“Confirmación de cambios en configuración de partición” en la página 293, debe 
eliminar las celdas de almacenamiento de asignaciones de partición para que el total 
de celdas asignadas esté dentro de la capacidad con licencia de la biblioteca. 
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7. Para ver mensajes de aviso detallados con una explicación de los motivos de la 
existencia de cartuchos huérfanos, haga clic en Details. 

Utilice el botón Details para alternar entre las vistas expandidas y contraídas de los 
mensajes de aviso. 

8. En la vista expandida de los mensajes de aviso puede hacer lo siguiente:

■ Haga clic en Print para imprimir los datos de mensajes detallados.

■ Haga clic en Save para guardar los datos de mensajes detallados en un archivo 
separado por comas. 

9. Haga clic en OK para descartar el cuadro emergente Verify Results y volver a la 
pantalla Design (Step 3b). 

Nota: Se recomienda que siga el procedimiento “Resolución de cartuchos huérfanos” 
en la página 292 para confirmar los cambios en la base de datos del controlador de 
biblioteca. 
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▼ Resolución de cartuchos huérfanos
Si SL Console identifica un cartucho huérfano, muestra un mensaje de aviso. Debe 
resolver y colocar todos los cartuchos huérfanos antes de proceder a la “Confirmación 
de cambios en configuración de partición” en la página 293. 

Puede realizar una de las siguientes acciones para resolver cartuchos huérfanos: 

■ Imprima un informe de cartuchos huérfanos. 

■ Realice una auditoría de la biblioteca. 

■ Realice un movimiento de recuperación en un cartucho huérfano. 
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▼ Confirmación de cambios en configuración de 
partición 

Atención: Este procedimiento actualiza la base de datos del controlador de biblioteca 
con todos los cambios de configuración de partición que ha realizado durante esta 
sesión de SL Console. En caso de no utilizar este procedimiento antes de desconectar de 
la sesión SL Console actual, se perderán todos los cambios en la configuración de 
biblioteca.

Atención: Aunque los cambios de partición no interrumpen los hosts de la biblioteca, 
se recomienda que haga que la biblioteca no esté disponible para otros usuarios 
antes de confirmar los cambios del espacio de trabajo de particiones. Debido a que 
SL Console no verifica los límites de partición con la base de datos del controlador de 
biblioteca en tiempo real, pueden surgir conflictos de configuración si cambia los 
límites de partición mientras otros usuarios están moviendo cartuchos o cambiando la 
configuración de la biblioteca. Consulte “Sincronización de la pantalla con la base de 
datos del controlador” en la página 38 para obtener más detalles. 

Nota: Se recomienda que siga el procedimiento “Resolución de cartuchos huérfanos” 
en la página 292 antes de llevar a cabo este procedimiento. 

Nota: No puede realizar este procedimiento si la capacidad actual de la biblioteca es 
superior (es decir, el total de asignaciones de particiones supera la capacidad con 
licencia). El botón Apply se muestra sombreado y, antes de continuar, debe eliminar 
celdas de almacenamiento de las asignaciones de particiones para que el total de celdas 
asignadas esté dentro de la capacidad con licencia de la biblioteca.

1. Varíe la biblioteca para desconexión con ACSLS y HSC. 

Consulte la documentación del software de administración de cintas correspondiente 
para obtener detalles de los procedimientos y comandos.

2. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Commit (Step 4).

Aparece la pantalla Commit (Step 4).

3. En la barra de opciones, haga clic en Apply. 

Los límites de la partición seleccionada se verifican, incluidas las ubicaciones de todos 
los cartuchos de cinta. 



Tareas de configuración de partición

294 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

Nota: This verification is performed on the current partition configuration in the 
SL Console partition workspace only. It does not verify current partition boundaries 
against the library controller database; therefore it cannot identify configuration 
conflicts that may arise due to other users performing cartridge movements or library 
configuration changes—through the interfaz de línea de comandos, other SL Console 
sessions, or host applications—at the same time you have made partition changes. 

Aparece el cuadro emergente Confirm Apply, indicando si hay cartuchos huérfanos u 
otros problemas en la configuración de partición actual. 

4. Para ver mensajes de aviso detallados con una explicación de los motivos de la 
existencia de cartuchos huérfanos, haga clic en Details. 

Utilice el botón Details para alternar entre las vistas expandidas y contraídas de los 
mensajes de aviso. 
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5. Opcionalmente, en la vista expandida de los mensajes de aviso puede hacer lo 
siguiente:

■ Haga clic en Print para imprimir los datos de mensajes detallados.

■ Haga clic en Save para guardar los datos de mensajes detallados en un archivo 
separado por comas. 

6. Proceda de la siguiente manera:

■ Haga clic en No para cancelar la actualización. La base de datos del controlador de 
biblioteca no se actualiza, pero todos los cambios de partición de la sesión se 
conservan en el espacio de trabajo de particiones de SL Console. 

■ Haga clic en Yes para actualizar la base de datos del controlador de biblioteca.

Aparece el cuadro emergente Commit Success. 

Haga clic en OK para volver a la pantalla Commit (Step 4). 

7. Todas las aplicaciones host de la biblioteca afectadas se deben configurar ahora 
para reconocer las actualizaciones. Consulte la documentación del software de 
administración de cintas correspondiente para obtener detalles de los procedimientos 
y comandos. 
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Tareas de administración de particiones

Tarea Página

Modificación de información de resumen de particiones 297

Eliminación de una partición 298

Modificación del tipo de interfaz de una conexión host-partición 300

Modificación de detalle de conexión host-partición FCSCSI 302

Eliminación de una conexión host-partición FCSCSI 304

Actualización del espacio de trabajo de particiones de SL Console 306

Reasignación de recursos de biblioteca 307

Cambio de hardware en una biblioteca particionada 308
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▼ Modificación de información de resumen de 
particiones
Utilice este procedimiento para cambiar el nombre o la capacidad de almacenamiento 
asignada de una partición existente.

Nota: Para cambiar el tipo de conexión host-partición (HLI o FC-SCSI), consulte 
“Modificación del tipo de interfaz de una conexión host-partición” en la página 300. 

Nota: No puede cambiar el identificador de partición. Para asignar un identificador de 
partición diferente, debe eliminar la partición antigua y crear una nueva con el 
identificador nuevo. 

1. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Summary 
(Step 2).

Aparece la pantalla Summary (Step 2).

2. En la sección Partition Summary, seleccione la partición que va a modificar. 

3. Haga clic en Modify Partition para modificar la partición.

Aparece el panel emergente Modify a Partition.

4. Introduzca los cambios de que desea hacer. 

5. Haga clic en OK para confirmar los cambios. 
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▼ Eliminación de una partición
Utilice este procedimiento para eliminar una partición de la biblioteca. Los siguientes 
cambios se realizan en la configuración de una partición de biblioteca:

■ Todos los recursos asignados a la partición se marcan como disponibles. 

■ Todas las conexiones host para la partición se eliminan. 

■ El ID de partición se elimina. 

Atención: La eliminación de particiones puede originar cartuchos huérfanos y datos 
que se podrían perder. Consulte “Cartuchos huérfanos en bibliotecas particionadas” en 
la página 266 para obtener más detalles. 

Nota: La eliminación de todas las particiones de la biblioteca hace que el estado de la 
biblioteca cambie a “no particionada". Todas las celdas de almacenamiento activas, las 
unidades y los CAP giratorios o de AEM estarán accesibles a todos los hosts.

1. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Summary 
(Step 2).

Aparece la pantalla Summary (Step 2).

2. En la sección Partition Summary, haga clic en la partición que va a eliminar.

3. Haga clic en Delete Partition para eliminar la partición.

Aparece un cuadro emergente de confirmación.
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4. Haga clic en OK para confirmar la eliminación. 

■ Si las particiones aún permanecen en la biblioteca, proceda al Paso 7. 

■ Si no hay particiones, aparece el panel emergente Select Library Interface Type. 

5. Seleccione el tipo de interfaz de biblioteca que desea asignar para todas las 
conexiones host con la biblioteca. Las opciones son:

■ HLI

■ FC-SCSI

6. Haga clic en OK para confirmar el cambio. 

7. Las actualizaciones se realizan de la siguiente manera:

Los cambios de la configuración de partición se guardan en el espacio de trabajo de 
particiones de SL Console para la duración de la sesión de inicio. 

Para actualizar la base de datos del controlador de biblioteca con todos los cambios de 
esta sesión de inicio en SL Console, consulte “Verificación de configuraciones de 
particiones” en la página 289 y “Confirmación de cambios en configuración de 
partición” en la página 293. 

Si no quedan particiones en la biblioteca, cuando confirma las actualizaciones, el estado 
de la biblioteca cambiará a “no particionada”. 
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▼ Modificación del tipo de interfaz de una conexión 
host-partición 
Utilice este procedimiento para cambiar el tipo de conexión host-partición de una 
partición existente. Debe utilizar este procedimiento con precaución, ya que puede 
tener los siguientes efectos:

■ Cambiar el tipo de interfaz puede causar la pérdida de conexiones host activas. 

■ Cambiar el tipo de interfaz de FC-SCSI a HLI puede causar la pérdida del detalle de 
conexión FC-SCSI. 

■ Puesto que los CAP giratorios y de AEM no se pueden compartir en los tipos de 
partición, cambiar el tipo de interfaz puede provocar la pérdida de asignaciones 
de CAP compartidos existentes. Las asignaciones de CAP dedicados no se ven 
afectadas. 

Nota: Para cambiar el nombre o la capacidad de almacenamiento asignada de una 
partición existente, consulte “Modificación de información de resumen de particiones” 
en la página 297. 

1. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Summary 
(Step 2).

Aparece la pantalla Summary (Step 2).

2. En la sección Partition Summary, haga clic en la partición que va a modificar. 



Tareas de administración de particiones

418605401 • Revisión AB Capítulo 6 Particiones de biblioteca 301

3. Haga clic en Modify Partition para modificar la partición.

Aparece el panel emergente Modify a Partition.

4. En el menú desplegable Interface Type, seleccione el tipo de interfaz que desea 
asignar. Haga clic en OK.

5. SL Console comprueba la configuración de partición actual en el espacio de trabajo 
de SL Console. Si la partición tiene asignaciones de CAP compartidos o, en el caso 
de particiones FC-SCSI, detalle de conexión host-partición, se mostrará un aviso 
emergente. A continuación, se muestran elementos emergentes que pueden aparecer. 

■ Cambio de HLI a FC-SCSI:

■ Cambio de FC-SCSI a HLI:

6. Haga clic en Yes para confirmar el cambio. 

Los cambios de la configuración de partición se guardan en el espacio de trabajo de 
particiones de SL Console para la duración de la sesión de inicio. 

Para actualizar la base de datos del controlador de biblioteca con todos los cambios de 
esta sesión de inicio en SL Console, consulte “Verificación de configuraciones de 
particiones” en la página 289 y “Confirmación de cambios en configuración de 
partición” en la página 293. 



Tareas de administración de particiones

302 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

▼ Modificación de detalle de conexión host-
partición FCSCSI

Nota: Este procedimiento sólo se aplica a conexiones host-partición FC-SCSI. Las 
conexiones host-partición HLI se configuran mediante el software de administración de 
bibliotecas host (HSC o ACSLS), no a través de SL Console. Consulte la documentación 
de HSC o ACSLS para obtener más detalles. 

Utilice este procedimiento para modificar el WWPN (World Wide Port Name) o el 
número LUN de la biblioteca para una conexión host-partición. 

Nota: No puede modificar el número de puerto de destino para la biblioteca; siempre 
es “0”. 

1. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Summary 
(Step 2).

Aparece la pantalla Summary (Step 2).

2. En la sección Summary de la pantalla, haga clic en la partición para la que va a 
modificar una conexión. 
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3. En la sección Connections, haga clic en la conexión host-partición que va a modificar. 

Nota: Si selecciona una partición HLI, todos los botones de la sección Details de la 
pantalla se muestran sombreados. 

4. Haga clic en Modify Connection para modificar la conexión.

Aparece el cuadro emergente Modify a Connection.

5. Introduzca los cambios de que desea hacer. 

6. Haga clic en OK para confirmar los cambios. 

Los cambios de la configuración de partición se guardan en el espacio de trabajo de 
particiones de SL Console para la duración de la sesión de inicio. 

Para actualizar la base de datos del controlador de biblioteca con todos los cambios de 
esta sesión de inicio en SL Console, consulte “Verificación de configuraciones de 
particiones” en la página 289 y “Confirmación de cambios en configuración de 
partición” en la página 293. 
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▼ Eliminación de una conexión host-partición 
FCSCSI 

Nota: Este procedimiento sólo se aplica a conexiones host-partición FC-SCSI. Las 
conexiones host-partición HLI se configuran mediante el software de administración de 
bibliotecas host (HSC o ACSLS), no a través de SL Console. Consulte la documentación 
de HSC o ACSLS para obtener más detalles. 

Utilice este procedimiento para eliminar una conexión host-partición. Después de 
realizar este procedimiento, el host ya no podrá acceder a la partición. 

1. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Summary 
(Step 2).

Aparece la pantalla Summary (Step 2).

2. En la sección Summary de la pantalla, haga clic en la partición para la que va a 
eliminar una conexión. 

Nota: Si selecciona una partición HLI, todos los botones de la sección Details de la 
pantalla se muestran sombreados. 

3. En la sección Connections, haga clic en la conexión host-partición que va a eliminar.
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4. Haga clic en Delete Connection para eliminar la conexión.

Aparece un cuadro emergente de confirmación.

5. Haga clic en OK para confirmar la eliminación. 

Los cambios de la configuración de partición se guardan en el espacio de trabajo de 
particiones de SL Console para la duración de la sesión de inicio. 

Para actualizar la base de datos del controlador de biblioteca con todos los cambios de 
esta sesión de inicio en SL Console, consulte “Verificación de configuraciones de 
particiones” en la página 289 y “Confirmación de cambios en configuración de 
partición” en la página 293. 
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▼ Actualización del espacio de trabajo de 
particiones de SL Console
Utilice este procedimiento para actualizar el espacio de trabajo de particiones de 
SL Console con los datos actuales de la base de datos del controlador de biblioteca. Los 
datos actuales incluyen todas las actualizaciones que otros usuarios han hecho a la base 
de datos del controlador de biblioteca durante la sesión de conexión, a través de la 
interfaz de línea de comandos, otras sesiones SL Console o aplicaciones host. 

Nota: Una vez completado este procedimiento, se descartan todos los cambios de 
partición sin confirmar que ha realizado durante esta sesión de conexión SL Console. 

1. Seleccione Tools > Partitions.

2. Haga clic en una de las fichas siguientes:

■ Summary (Step 2) 

■ Design (Step 3b)

Aparece la pantalla seleccionada.

3. En la barra de opciones, haga clic en Refresh. 

Aparece el cuadro emergente Partition Refresh.

4. Haga clic en Yes para confirmar la actualización. 

La pantalla de particiones se actualiza con los datos actuales de la base de datos del 
controlador de biblioteca. 
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▼ Reasignación de recursos de biblioteca 
La reasignación de recursos de biblioteca (celdas de almacenamiento, unidades de 
cinta, CAP giratorios o de AEM o cartuchos) de una partición a otra se realiza mediante 
una de las siguientes pantallas: 

■ “Partitions—Design (Step 3b)” en la página 349 para módulos básicos, de unidad y 
CEM

■ “Partitions—Design (Step 3b) – AEMs Only” en la página 355 para módulos AEM

Debe utilizar el siguiente proceso en dos pasos: 

1. Elimine el recurso de la partición a la que está asignado actualmente.

2. Asigne el recurso a una partición diferente. 

Consulte “Diseño de una partición: módulos básicos, DEM o CEM” en la página 284 
para obtener instrucciones detalladas.

Atención: La reasignación de recursos puede originar cartuchos huérfanos y datos que 
se podrían perder. Consulte “Cartuchos huérfanos en bibliotecas particionadas” en la 
página 266 para obtener más detalles. 
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▼ Cambio de hardware en una biblioteca 
particionada
Algunos cambios de hardware de biblioteca, como añadir módulos de expansión, 
añadir un segundo robot, o añadir celdas CAP giratorio pueden requerir la eliminación 
de todo o parte de un módulo existente particionado. Utilice el siguiente proceso para 
realizar estos cambios de hardware sin perder información de particiones para las 
secciones de la biblioteca que permanecen sin cambios. 

Atención: En caso de no seguir este procedimiento, se podría producir la pérdida de la 
información de configuración de particiones de la biblioteca después de un cambio de 
hardware. 

1. Anule la asignación de todos los recursos de la biblioteca (celdas de almacenamiento, 
CAP giratorios o de AEM y unidades) que se eliminarán como parte del cambio de 
hardware de las particiones a las que están asignados actualmente. 

Consulte “Diseño de una partición: módulos básicos, DEM o CEM” en la página 284 
para obtener instrucciones detalladas.

2. Apague la biblioteca. 

Consulte “Apagado de la biblioteca” en la página 479 para obtener instrucciones 
detalladas. 

3. Instale el cambio de hardware.

4. Encienda la biblioteca. 

Consulte “Encendido de la biblioteca” en la página 480 para obtener instrucciones 
detalladas. 

Todas las asignaciones de particiones para las partes sin cambios de la biblioteca 
permanecen efectivas.

5. Asigne los recursos de la biblioteca que se han añadido debido al cambio de 
hardware. 

Consulte “Diseño de una partición: módulos básicos, DEM o CEM” en la página 284 
para obtener instrucciones detalladas.

Atención: La reasignación de recursos puede originar cartuchos huérfanos y datos que 
se podrían perder. Consulte “Cartuchos huérfanos en bibliotecas particionadas” en la 
página 266 para obtener más detalles. 
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Tareas de informes de particiones

Tarea Página

Visualización de un informe de particiones 310

Impresión de datos de informe de particiones 312

Guardar datos de informe de particiones 313

Visualización de detalles de partición 314
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▼ Visualización de un informe de particiones 
Utilice este procedimiento para visualizar cualquiera de los siguientes informes de 
particiones:

■ Cartridge Cell and Media Summary (Resumen de medios y celdas de cartuchos): 
muestra una lista detallada de todas las asignaciones de particiones de recursos.

■ Host Connections Summary (Resumen de conexiones host): muestra información 
detallada de conexión host-partición para todas las particiones.

■ Orphaned Cartridge Report (Informe de cartuchos huérfanos): muestra una lista 
detallada de todos los cartuchos huérfanos.

■ Partition Details (Detalles de partición): muestra información detallada para una 
partición seleccionada.

■ Partition Summary (Resumen de particiones): muestra información de resumen de 
todas las particiones.

Nota: Los informes de particiones muestran los datos guardados en la base de 
datos del controlador de biblioteca. Si ha hecho cambios de configuración de 
partición sin confirmar los cambios al controlador de biblioteca a través de la 
pantalla Commit (Step 4), los datos de estos informes serán diferentes de los datos 
mostrados en las pantallas de particiones Summary (Step 2) y Design (Step 3b). 

1. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Reports.

Aparece la pantalla Reports.
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2. En el menú desplegable, seleccione el informe que desea ver. 

La pantalla se actualiza con los datos actuales de la base de datos del controlador de 
biblioteca. 

3. Para imprimir los datos del informe o guardarlo en un archivo, siga los 
procedimientos siguientes:

■ “Impresión de datos de informe de particiones” en la página 312

■ “Guardar datos de informe de particiones” en la página 313 



Tareas de informes de particiones

312 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

▼ Impresión de datos de informe de particiones
Utilice este procedimiento para imprimir un informe de particiones. Este procedimiento 
se puede realizar desde cualquier pantalla de informe de particiones. 

1. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Reports.

Aparece la pantalla Reports.

2. En el menú desplegable, seleccione un informe. 

Se mostrará el informe especificado. Todas las pantallas de informes incluyen los 
botones Print y Save to File. 

3. Haga clic en Print. 

Aparece la ventana emergente Print. 

4. Complete la ventana emergente de impresión y haga clic en Print. 

El informe se imprime en la impresora seleccionada. 
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▼ Guardar datos de informe de particiones
Utilice este procedimiento para guardar datos de informes de particiones en un archivo 
separado por comas (formato .csv). Puede emplear diversas aplicaciones de hoja de 
cálculo para ver el archivo. Este procedimiento se puede realizar desde cualquier 
pantalla de informe de particiones. 

1. Seleccione Tools > Partitions y, a continuación, haga clic en la ficha Reports.

Aparece la pantalla Reports.

2. En el menú desplegable, seleccione un informe. 

Se mostrará el informe especificado. Todas las pantallas de informes incluyen los 
botones Print y Save to File. 

3. Haga clic en Save to File.

Aparece la ventana emergente Save. 

4. Vaya el directorio donde desea guardar el archivo e introduzca el nombre del archivo. 

5. Haga clic en Save. 

Los datos se guardan en el archivo especificado. 
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▼ Visualización de detalles de partición 
Utilice este procedimiento para visualizar las asignaciones y límites de la partición 
actual. También puede visualizar información detallada sobre las ubicaciones del 
cartucho, de la unidad y la celda de almacenamiento. 

Nota: Este procedimiento está disponible en el panel de operador local.

1. Seleccione Tools > Partitions.

2. Haga clic en la ficha Module Map (Step 3a). 

Aparece la pantalla Module Map (Step 3a). 

3. Haga clic en el módulo que desea mostrar. 

El módulo se marca en la pantalla. 
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4. Haga clic en la ficha Current Partition Definitions.

Aparece la pantalla Partition Definitions con la configuración actual del módulo que 
ha seleccionado.

Mueva el cursor sobre una celda para visualizar información detallada sobre la misma. 
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Tareas de operaciones de CAP 

Tarea Página

Asociación de una partición FC-SCSI a los CAP compartidos 317

Introducción de cartuchos en una partición 319

Expulsión de cartuchos de una partición 320

Eliminación de una asociación partición-CAP 321

Anulación de una reserva de CAP 322
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▼ Asociación de una partición FC-SCSI a los CAP 
compartidos
Utilice este procedimiento para asociar una partición FC-SCSI a los CAP giratorios o de 
AEM compartidos. Debe utilizar este procedimiento antes de introducir o expulsar 
cartuchos de una partición FC-SCSI si se producen las DOS condiciones siguientes:

■ La partición comparte uno o varios CAP con otras particiones, y 

■ la aplicación host FC-SCSI no utiliza reservas CAP y comandos de evitar/permitir.

Nota: Este procedimiento no se debe emplear para particiones HLI porque las 
aplicaciones host HLI siempre utilizan reservas de CAP. Si utiliza este procedimiento 
para particiones HLI, el CAP no estará disponible para hosts ACSLS y HSC. 

Nota: Este procedimiento no es necesario para CAP FC-SCSI dedicados porque una 
partición siempre tiene la propiedad de sus CAP dedicados. 

Nota: Los CAP de AEM están sujetos a las mismas reglas y restricciones de particiones 
que los CAP giratorios. En esta sección, el término “CAP” se refiere a ambos tipos de 
CAP. 

Este procedimiento ofrece la propiedad exclusiva de partición de sus CAP compartidos 
hasta que se elimine explícitamente la asociación. Consulte “Eliminación de una 
asociación partición-CAP” en la página 321 para obtener más detalles. 

1. Seleccione Tools > Shared CAP Assignment. 
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Aparece la pantalla Shared CAP Assignment.

2. Haga clic en la casilla de verificación de las particiones en las que va a introducir 
cartuchos. Consulte “Shared CAP Assignment” en la página 393 para obtener detalles 
de estos campos de la pantalla. 

3. Haga clic en Apply. 

Aparece el cuadro emergente CAP Confirm. 

4. Haga clic en OK. 

5. Realice la operación de introducción o expulsión. Vea uno de los procedimientos 
siguientes para obtener detalles:

■ “Introducción de cartuchos en una partición” en la página 319

■ “Expulsión de cartuchos de una partición” en la página 320
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▼ Introducción de cartuchos en una partición
Utilice este procedimiento para introducir o cargar a granel cartuchos en una o varias 
particiones. Las particiones sólo pueden utilizar los CAP giratorios o de AEM que se les 
han asignado. 

Nota: Si introduce cartuchos en una partición FC-SCSI que tiene uno o varios CAP 
giratorios o de AEM compartidos y la aplicación host no utiliza reservas de CAP y 
comandos de evitar o permitir, debe asociar la partición a sus CAP antes de iniciar este 
procedimiento. Consulte “Asociación de una partición FC-SCSI a los CAP compartidos” 
en la página 317. En caso de no hacerlo, puede ocurrir que el CAP permanezca 
bloqueado y que la partición no pueda adquirir la propiedad del CAP. 

1. Siga los pasos en uno de los siguientes procedimientos, según esté usando un CAP 
giratorio o de AEM:

■ “Introducción de cartuchos mediante un CAP giratorio” en la página 131

■ “Carga a granel de cartuchos mediante un CAP de AEM” en la página 135

2. Cuando se completa el procedimiento, la reserva de CAP se libera de la siguiente 
manera:

■ Si ha iniciado este procedimiento en un host HLI o un host FC-SCSI que utiliza 
reservas CAP, el host elimina la reserva, con lo que el CAP queda disponibles para 
otras particiones. 

■ Si antes de llevar a cabo este procedimiento ha realizado una asociación manual de 
partición-CAP, debe eliminar ahora la asociación si la partición se termina con el 
CAP. Consulte “Eliminación de una asociación partición-CAP” para obtener más 
detalles. 

■ Si la partición FC-SCSI utiliza un CAP dedicado, éste permanece desbloqueado y 
reservado a la partición. 
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▼ Expulsión de cartuchos de una partición
Utilice este procedimiento para expulsar o cargar a granel cartuchos de una biblioteca 
particionada. Las particiones sólo pueden utilizar los CAP giratorios o de AEM que se 
les han asignado. 

Nota: Si expulsa cartuchos de una partición FC-SCSI que tiene uno o varios CAP 
giratorios o de AEM compartidos y la aplicación host no utiliza reservas CAP, debe 
asociar la partición a sus CAP antes de iniciar este procedimiento. Consulte “Asociación 
de una partición FC-SCSI a los CAP compartidos” en la página 317. En caso de no 
hacerlo, puede ocurrir que el CAP permanezca bloqueado y que la partición no pueda 
adquirir la propiedad del CAP. 

1. Siga los pasos en uno de los siguientes procedimientos, según esté usando un CAP 
giratorio o de AEM:

■ “Expulsión de cartuchos mediante un CAP giratorio” en la página 133

■ “Descarga a granel de cartuchos mediante un CAP de AEM” en la página 137

2. Cuando se completa el procedimiento, la reserva de CAP se libera de la siguiente 
manera:

■ Si ha iniciado este procedimiento en un host HLI o un host FC-SCSI que utiliza 
reservas CAP, el host elimina la reserva, con lo que el CAP queda disponibles para 
otras particiones. 

■ Si antes de llevar a cabo este procedimiento ha realizado una asociación manual de 
partición-CAP, debe eliminar ahora la asociación si la partición se termina con el 
CAP. Consulte “Eliminación de una asociación partición-CAP” para obtener más 
detalles. 

■ Si la partición FC-SCSI utiliza un CAP dedicado, éste permanece desbloqueado y 
reservado a la partición. 
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▼ Eliminación de una asociación partición-CAP
Utilice este procedimiento después de completar una operación de introducción y 
expulsión si ha asociado previamente la partición a sus CAP giratorios o de AEM 
compartidos. Este procedimiento elimina las asociaciones partición-CAP previamente 
definidas, lo que hace que los CAP compartidos estén disponibles para otras 
particiones. 

Nota: Los CAP de AEM están sujetos a las mismas reglas y restricciones de particiones 
que los CAP giratorios. En esta sección, el término “CAP” se refiere a ambos tipos de 
CAP. 

1. Seleccione Tools > Shared CAP Assignment. 

Aparece la pantalla Shared CAP Assignment.

2. Anule la selección de la casilla de verificación de las particiones con las asociaciones 
CAP. Consulte “Shared CAP Assignment” en la página 393 para obtener detalles de 
estos campos de la pantalla. 

3. Haga clic en Apply. 

Aparece el cuadro emergente CAP Confirm. 

4. Haga clic en OK. 
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▼ Anulación de una reserva de CAP
Utilice este procedimiento cuando una partición ha reservado un CAP giratorio o de 
AEM compartido pero la reserva no se puede liberar a través del host ACSLS o HSC. 

Nota: Este tema sólo es aplicable a bibliotecas particionadas. Si una biblioteca no está 
particionada, las reservas de CAP se deben liberar siempre a través de ACSLS o HSC. 
Consulte la documentación de HSC o ACSLS para obtener más detalles.

Nota: Debe seguir todos los pasos de este procedimiento. Si no completa el 
procedimiento, el CAP podría no quedar disponible para todas las particiones, y los 
cartuchos asignados a una partición podrían introducirse en otra partición. 

Nota: Los CAP de AEM están sujetos a las mismas reglas y restricciones de particiones 
que los CAP giratorios. En esta sección, el término “CAP” se refiere a ambos tipos de 
CAP. 

1. Seleccione Tools>Diagnostics.

2. Abra la carpeta CAP y, a continuación, haga clic en el CAP cuya reserva desea anular. 

Nota: Los CAP de AEM se identifican de la siguiente manera: columna “–31” para un 
CAP de AEM izquierdo y columna “31” para un CAP de AEM derecho. 
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3. Haga clic en la ficha Unreserve.

Aparece la pantalla Unreserve, donde se identifica la partición que ha reservado el 
CAP.

4. Haga clic en Apply para anular la reserva.

Aparece el cuadro emergente Unreserve Confirm, indicando que “Esto eliminará la 
reserva del host designado...” 

■ Haga clic en OK para continuar con la operación de anulación. La biblioteca elimina 
la reserva de CAP y define el usuario de CAP en “predeterminado,” lo que hace que 
el CAP no esté disponible para todas las particiones.

■ Haga clic en Cancel para cancelar la operación de anulación y volver al Paso 3. 

5. Si el CAP está bloqueado, debe desbloquearlo en SL Console. Consulte “Desbloqueo 
de una puerta de acceso CAP o AEM” en la página 126 para conocer el procedimiento 
detallado. 

6. Pulse el botón CAP para abrir el CAP. 

■ Si está vacío, proceda al Paso 8. 

■ Si contiene cartuchos, elimínelos todos. 

7. Etiquete los cartuchos con el identificador de partición mostrado en el Paso 3. 
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8. Pulse el botón CAP para cerrar el CAP. 

El CAP se cierra y se bloquea automáticamente, y la luz del botón CAP se apaga.

La biblioteca audita el CAP para comprobar que está vacío. A continuación, define el 
estado del CAP en “no reservado,” lo que hace que el CAP esté disponible para todas 
las particiones a las que está asignado. 

Nota: Puede que necesite actualizar la pantalla de CAP para ver el nuevo estado del 
CAP. 

9. Póngase en contacto con una persona responsable de la administración de cartuchos 
eliminados para determinar su disposición. Si se van a volver a introducir en la 
biblioteca, se deben introducir en la partición correcta. 



Referencia de pantallas de particiones

418605401 • Revisión AB Capítulo 6 Particiones de biblioteca 325

Referencia de pantallas de particiones
Esta sección contiene descripciones detalladas de todas las pantallas de particiones de 
SL Console, organizadas según la ruta de navegación a la pantalla. Por ejemplo, 
Partitions—Summary (Step 2)—Add Connection indica la pantalla a la que se accede 
al hacer clic en Tools y, a continuación, en Partitions de la barra de menús, y después al 
hacer clic en la ficha Summary (Step 2)y, a continuación, en el botón Add Connection. 

Nota: Sólo la pantalla Partitions—Current Partition Definitions está disponible en el 
panel de operador local. A las pantallas restantes se puede acceder sólo desde 
SL Console independiente o SL Console en Web.

Las pantallas de particiones se organizan en las siguientes categorías:

■ “Pantallas de resumen de particiones” en la página 326

■ “Pantallas de diseño y confirmación de particiones” en la página 346

■ “Pantallas de informes de particiones” en la página 372

■ “Pantallas de operaciones de CAP para particiones” en la página 392

Nota: Las pantallas de particiones Summary (Step 2) y Design (Step 3b), y todos los 
paneles emergentes asociados, ofrecen un espacio de trabajo dinámico para diseñar las 
particiones de biblioteca. Toda la información de configuración de particiones se guarda 
automáticamente en el espacio de trabajo de particiones en la memoria de SL Console y 
se conserva durante el tiempo de la sesión de SL Console. Esto permite cambiar entre 
vistas de particiones, y salir y volver a las pantallas de particiones todas las veces que 
se quiera sin perder los cambios de configuración. 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 
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Pantallas de resumen de particiones

Partitions—Instructions (Step 1)

Partitions—Summary (Step 2)

Partitions—Summary (Step 2)—Add Connection

Partitions—Summary (Step 2)—Delete Connection

Partitions—Summary (Step 2)—Modify Connection

Partitions—Summary (Step 2)—Add Partition

Partitions—Summary (Step 2)—Delete Partition

Partitions—Summary (Step 2)—Modify Partition
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Partitions—Instructions (Step 1)

Pantalla de ejemplo

Descripción
Muestra instrucciones para el uso de las pantallas de particiones.

Nota: Esta pantalla aparece automáticamente la primera vez que selecciona 
Tools > Partitions durante una sesión de conexión de SL Console. 

Campos de la pantalla
Ninguno

Botones
? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 
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Consulte también
■ Partitions—Summary (Step 2) 

■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4) 

■ Partitions—Reports 
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Partitions—Summary (Step 2)

Pantalla de ejemplo

Descripción
Muestra información de resumen para la biblioteca y, si lo desea, una partición seleccionada. 

También incluye botones que permiten iniciar cualquiera de las actividades siguientes:

■ Añadir una nueva partición 

■ Eliminar una partición de la biblioteca

■ Modificar información de resumen de particiones 

Nota: Los siguientes botones están disponibles sólo para conexiones host-partición 
FC-SCSI. Las conexiones host-partición HLI se configuran mediante el software de 
administración de bibliotecas host (HSC o ACSLS), no a través de SL Console. Consulte 
la documentación de HSC o ACSLS para obtener más detalles. 

■ Añadir una nueva conexión host-partición

■ Eliminar una conexión host-partición

■ Modificar la configuración de una conexión host-partición
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Campos de la pantalla

Partition Summary (Resumen de particiones)

Partition Number

Sólo visualización.

Identificador asignado a la partición. Los identificadores pueden ir del 1 al 8.

Celdas de almacenamiento

Sólo visualización.

Número total de celdas de almacenamiento asignadas a la partición. 

Bahías de unidades

Sólo visualización.

Número total de unidades de cinta asignadas a la partición. 

CAP 

Sólo visualización.

Número total de CAP giratorios asignados a esta partición; este número representa 
CAP completos, no celdas CAP individuales. 

AEM 

Sólo visualización.

Número total de AEM asignados a esta partición; este número representa AEM 
completos, no celdas AEM individuales. 

Celdas CAP+AEM

Sólo visualización.

Número total de celdas CAP giratorio y de AEM individuales asignadas a esta 
partición. 

% de capacidad con licencia 

Sólo visualización.

Porcentaje de la capacidad con licencia de la biblioteca que se ha asignado a la 
partición. Se calcula:

(partición) Celdas de almacenamiento asignadas / (total de biblioteca) 
Capacidad con licencia 

Details for Partition n 

Nota: Los siguientes campos muestran datos de conexión host-partición para la 
partición actualmente seleccionada en la tabla de resumen de particiones Partition 
Summary. 

Name

Sólo visualización.

Nombre asignado a la partición seleccionada. 

Interface Type 

Sólo visualización.
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Tipo de interfaz asignada a la conexión host-partición seleccionada. Las opciones son:

■ HLI

■ FC-SCSI

Nota: Los siguientes campos están disponibles sólo para conexiones host-partición 
FC-SCSI. 

Conexiones

Initiator (WWPN) 

Sólo visualización.

WWPN (World Wide Port Name) del adaptador bus de host FC-SCSI (HBA). 

Target Port 

Sólo visualización.

Número de puerto del controlador de biblioteca SL3000. Esta entrada siempre es “0”. 

LUN

Sólo visualización.

Número de unidad lógica de la partición de biblioteca en el host Esta entrada debe 
ser única en el host. 

Total Library Resources

Celdas de almacenamiento 

Sólo visualización.

Capacidad física total de la biblioteca.

Drive Bays 

Sólo visualización.

Número total de unidades de cinta de la biblioteca.

CAP 

Sólo visualización.

Número total de CAP giratorios de la biblioteca.

AEM 

Sólo visualización.

Número total de AEM de la biblioteca.

CAP cells

Sólo visualización.

Número total de celdas CAP giratorios de la biblioteca.

AEM cells 

Sólo visualización.

Número total de celdas AEM de la biblioteca.
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Licensed Capacity 

Sólo visualización.

Capacidad total de almacenamiento con licencia de la biblioteca. 

Resources Allocated 

Celdas de almacenamiento 

Sólo visualización.

Número total de celdas de almacenamiento asignadas a todas las particiones de la 
biblioteca en la pantalla Design (Step 3b). 

Drive Bays 

Sólo visualización.

Número total de unidades de cinta asignadas a todas las particiones de la biblioteca.

CAP 

Sólo visualización.

Número total de CAP giratorios asignados a todas las particiones de la biblioteca.

AEM 

Sólo visualización.

Número total de AEM asignados a todas las particiones de la biblioteca.

CAP cells

Sólo visualización.

Número total de celdas CAP giratorio asignadas a todas las particiones de la 
biblioteca.

AEM cells

Sólo visualización.

Número total de celdas AEM asignadas a todas las particiones de la biblioteca.

Licensed Capacity 

Sólo visualización.

Capacidad total de almacenamiento con licencia asignada a todas las particiones de 
la biblioteca a través de la pantalla Add Partition o Modify Partition. 

Resources Unallocated 

Celdas de almacenamiento 

Sólo visualización.

Número total de celdas de almacenamiento de la biblioteca que no están asignadas a 
ninguna partición.

Drive Bays 

Sólo visualización.

Número total de celdas de unidades de cinta de la biblioteca que no están asignadas 
a ninguna partición.
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CAP 

Sólo visualización.

Número total de CAP giratorios de la biblioteca que no están asignados a ninguna 
partición.

AEM 

Sólo visualización.

Número total de AEM de la biblioteca que no están asignados a ninguna partición.

CAP cells

Sólo visualización.

Número total de celdas CAP giratorio de la biblioteca que no están asignadas a 
ninguna partición.

AEM cells

Sólo visualización.

Número total de celdas AEM de la biblioteca que no están asignadas a ninguna 
partición.

Licensed Capacity 

Sólo visualización.

Capacidad total de almacenamiento con licencia que no está asignada a ninguna 
partición de la biblioteca a través de la pantalla Add Partition o Modify Partition. Se 
calcula:

(total de biblioteca) Capacidad con licencia – (asignada) Capacidad con licencia 

Botones
Refresh 

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con los 
datos actuales de la base de datos del controlador de biblioteca. Todos los cambios 
de particiones no confirmados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Partition Refresh, que le 
insta a confirmar la actualización. 

? (Ayuda)

Haga clic para mostrar la ayuda en línea de la pantalla. 

Add Partition

Haga clic para añadir una nueva partición. Aparece el panel emergente 
Partitions—Summary (Step 2)—Add Partition. 

Delete Partition

Haga clic para eliminar la partición seleccionada actualmente. Aparece el panel 
emergente Partitions—Summary (Step 2)—Delete Partition. 

Modify Partition

Haga clic para modificar la información de resumen para la partición seleccionada 
actualmente. Aparece el panel emergente Partitions—Summary (Step 2)—Modify 
Partition. 
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Nota: Los siguientes botones están disponibles sólo para conexiones host-partición 
FC-SCSI. 

Add Connection

Haga clic para añadir una nueva conexión host a la partición seleccionada 
actualmente. Aparece el panel emergente Partitions—Summary (Step 2)—Add 
Connection. 

Delete Connection

Haga clic para eliminar la conexión host-partición seleccionada actualmente. 
Aparece el panel emergente Partitions—Summary (Step 2)—Delete Connection.

Modify Connection

Haga clic para modificar la configuración de la conexión host-partición seleccionada 
actualmente. Aparece el panel emergente Partitions—Summary (Step 2)—Modify 
Connection.

Consulte también
■ Partitions—Summary (Step 2) 

■ Partitions—Summary (Step 2)—Add Partition 

■ Partitions—Summary (Step 2)—Delete Partition 

■ Partitions—Summary (Step 2)—Modify Partition 

■ Partitions—Summary (Step 2)—Add Connection 

■ Partitions—Summary (Step 2)—Delete Connection 

■ Partitions—Summary (Step 2)—Modify Connection 

■ Partitions—Module Map (Step 3a) 

■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4) 

■ Partitions—Reports 
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Partitions—Summary (Step 2)—Add Connection

Pantalla de ejemplo

Descripción
Permite configurar la conexión entre un host y la partición seleccionada. Cada partición 
puede tener hasta nueve conexiones host-partición, cada una con un LUN único. 

Nota: Esta pantalla sólo está disponible para conexiones host-partición FC-SCSI. Las 
conexiones host-partición HLI se configuran mediante el software de administración de 
bibliotecas host (HSC o ACSLS), no a través de SL Console. Consulte la documentación 
de HSC o ACSLS para obtener más detalles.

Esta pantalla es un panel emergente que aparece cuando hace clic sobre Add 
Connection en la pantalla Partitions—Summary (Step 2). 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Campos de la pantalla
Connections n 

Sólo visualización.

Identificador de la partición seleccionada. 

Initiator (WWPN)

Obligatorio.

WWPN (World Wide Port Name) del adaptador bus de host FC-SCSI (HBA). 

16 dígitos hexadecimales. Puede introducir dígitos hexadecimales en mayúscula o 
minúscula, pero siempre se muestran en mayúscula. 
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Target Port

Sólo visualización.

Número de puerto del controlador de biblioteca SL3000. Esta entrada siempre es “0”. 

LUN

Obligatorio.

Número de unidad lógica de la partición de biblioteca en el host Esta entrada debe 
ser única en el host. Puede crear hasta nueve LUN únicos por partición. 

Nota: Cada iniciador conectado a la biblioteca debe tener una partición de biblioteca 
asignada a LUN 0. Cuando compruebe o confirme los cambios de configuración de 
partición, SL Console notificará si un iniciador no satisface este requisito. 

Botones
OK

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con la 
configuración de pantalla actual y volver a la pantalla anterior. 

Nota: Hacer clic en este botón no actualiza la base de datos del controlador de 
biblioteca. 

Cancel

Haga clic para descartar la configuración de pantalla actual y volver a la pantalla 
anterior. 

Consulte también
■ Partitions—Summary (Step 2) 
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Partitions—Summary (Step 2)—Delete Connection

Pantalla de ejemplo

Descripción
Permite eliminar la conexión host-partición seleccionada. 

Nota: Esta pantalla sólo está disponible para conexiones host-partición FC-SCSI. Las 
conexiones host-partición HLI se configuran mediante el software de administración de 
bibliotecas host (HSC o ACSLS), no a través de SL Console. Consulte la documentación 
de HSC o ACSLS para obtener más detalles.

Esta pantalla es un panel emergente que aparece cuando hace clic sobre Delete 
Connection en la pantalla Partitions—Summary (Step 2). 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Campos de la pantalla
Ninguno

Botones
OK

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con la 
configuración de pantalla actual y volver a la pantalla anterior. 

Nota: Hacer clic en este botón no actualiza la base de datos del controlador de 
biblioteca. 

Cancel

Haga clic para descartar la configuración de pantalla actual y volver a la pantalla 
anterior. 
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Consulte también
■ Partitions—Summary (Step 2) 
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Partitions—Summary (Step 2)—Modify Connection

Pantalla de ejemplo

Descripción
Permite modificar la configuración de la conexión host-partición seleccionada. 

Nota: Esta pantalla sólo está disponible para conexiones host-partición FC-SCSI. Las 
conexiones host-partición HLI se configuran mediante el software de administración de 
bibliotecas host (HSC o ACSLS), no a través de SL Console. Consulte la documentación 
de HSC o ACSLS para obtener más detalles.

Esta pantalla es un panel emergente que aparece cuando hace clic sobre Modify 
Connection en la pantalla Partitions—Summary (Step 2). 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Campos de la pantalla
Connections n 

Sólo visualización.

Identificador de la partición seleccionada. 

Initiator (WWPN)

WWPN (World Wide Port Name) del adaptador bus de host FC-SCSI (HBA). 

16 dígitos hexadecimales. Puede introducir dígitos hexadecimales en mayúscula o 
minúscula, pero siempre se muestran en mayúscula. 

La pantalla muestra el valor asignado previamente. Se puede dejar como está o 
realizar cambios. 
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Target Port

Sólo visualización.

Número de puerto del controlador de biblioteca SL3000. Esta entrada siempre es “0”. 

LUN

Obligatorio.

Número de unidad lógica de la partición de biblioteca en el host Esta entrada debe 
ser única en el host. 

Nota: Cada iniciador conectado a la biblioteca debe tener una partición de biblioteca 
asignada a LUN 0. Cuando compruebe o confirme los cambios de configuración de 
partición, SL Console notificará si un iniciador no satisface este requisito. 

Botones
OK

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con la 
configuración de pantalla actual y volver a la pantalla anterior. 

Nota: Hacer clic en este botón no actualiza la base de datos del controlador de 
biblioteca. 

Cancel

Haga clic para descartar la configuración de pantalla actual y volver a la pantalla 
anterior. 

Consulte también
■ Partitions—Summary (Step 2) 
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Partitions—Summary (Step 2)—Add Partition 

Pantalla de ejemplo

Descripción
Permite añadir una nueva partición. Puede crear hasta ocho particiones, con 
identificadores del 1 al 8. 

Esta pantalla es un panel emergente que aparece cuando hace clic sobre Add Partition 
en la pantalla Partitions—Summary (Step 2). 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Campos de la pantalla
Select a Partition ID

Obligatorio.

Identificador de partición que va a añadir. Puede ser del 1 al 8. 

El menú desplegable muestra todos los identificadores disponibles; el valor 
predeterminado es el siguiente ID disponible en orden numérico. 

Name 

Opcional.

Nombre que desea asignar a la partición. 

0-60 caracteres ASCII. 

Interface Type 

Obligatorio.

Tipo de interfaz que se va a usar para la conexión host-partición. Las opciones son:

■ HLI

■ FC-SCSI 
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Botones
OK

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con la 
configuración de pantalla actual y volver a la pantalla anterior. 

Nota: Hacer clic en este botón no actualiza la base de datos del controlador de 
biblioteca. 

Cancel

Haga clic para descartar la configuración de pantalla actual y volver a la pantalla 
anterior. 

Consulte también
■ Partitions—Summary (Step 2) 
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Partitions—Summary (Step 2)—Delete Partition

Pantalla de ejemplo

Descripción
Permite confirmar que desea eliminar la partición especificada. Toda la información 
de la partición, entre la que se incluye conexiones host-partición, límites de partición 
e identificador de partición, se elimina del espacio de trabajo de particiones de 
SL Console. 

Esta pantalla es un panel emergente que aparece cuando hace clic sobre Delete 
Partition en la pantalla Partitions—Summary (Step 2). 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Campos de la pantalla
Ninguno

Botones
OK

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con la 
configuración de pantalla actual y volver a la pantalla anterior. 

Nota: Hacer clic en este botón no actualiza la base de datos del controlador de 
biblioteca. 

Cancel

Haga clic para descartar la configuración de pantalla actual y volver a la pantalla 
anterior. 

Consulte también
■ Partitions—Summary (Step 2) 
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Partitions—Summary (Step 2)—Modify Partition

Pantalla de ejemplo

Descripción
Permite modificar el nombre o el tipo de conexión host-partición asignado a la partición 
seleccionada. 

Esta pantalla es un panel emergente que aparece cuando hace clic sobre Modify 
Partition en la pantalla Partitions—Summary (Step 2). 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Campos de la pantalla
Modify Partition n 

Sólo visualización.

Identificador de la partición que va a modificar. 

Name 

Obligatorio.

Nombre que desea asignar a la partición. 

0-60 caracteres ASCII. 

La pantalla muestra el valor asignado previamente. Se puede dejar como está o 
realizar cambios. 

Interface Type 

Tipo de interfaz que se va a usar para la conexión host-partición. Las opciones son:

■ HLI

■ FC-SCSI 
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La pantalla muestra el valor asignado previamente. Se puede dejar como está o 
realizar cambios. 

Nota: Cambiar el tipo de interfaz puede causar la pérdida de conexiones host activas y 
asignaciones de CAP giratorios o de AEM compartidos. Consulte “Modificación del 
tipo de interfaz de una conexión host-partición” en la página 300 para obtener más 
detalles. 

Botones
OK

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con la 
configuración de pantalla actual y volver a la pantalla anterior. 

Nota: Hacer clic en este botón no actualiza la base de datos del controlador de 
biblioteca. 

Cancel

Haga clic para descartar la configuración de pantalla actual y volver a la pantalla 
anterior. 

Consulte también
■ Partitions—Summary (Step 2) 
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Pantallas de diseño y confirmación de 
particiones

Partitions—Design (Step 3b)

Partitions—Design (Step 3b) – AEMs Only

Partitions—Design (Step 3b)—Verify Results

Partitions—Commit (Step 4)

Partitions—Commit (Step 4)—Confirm Apply

Partitions—Current Partition Definitions
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Partitions—Module Map (Step 3a)

Pantalla de ejemplo

Descripción
Permite seleccionar el módulo de biblioteca para el que desea definir límites de 
partición. 

Campos de la pantalla
Select a module from the map below 

Obligatorio.

La pantalla muestra una ilustración de la configuración del módulo real de la 
biblioteca. Esta información se toma directamente de la base de datos del controlador 
de biblioteca. 

Haga clic en el módulo para el que desea diseñar una partición y, a continuación, 
haga clic en la ficha Design (Step 3b). 
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Botones
? (Ayuda)

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Design (Step 3b) 

■ Partitions—Design (Step 3b) – AEMs Only 
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Partitions—Design (Step 3b)

Nota: Esta sección describe las pantallas Design (Step 3b) para módulos básicos, de 
unidad y CEM. Para módulos AEM, consulte “Partitions—Design (Step 3b) – AEMs 
Only” en la página 355. 

Pantalla de ejemplo

Descripción
Permite definir límites de partición mediante la selección de los recursos (celdas de 
almacenamiento, unidades de cinta o CAP giratorios) que dese incluir en la partición. 
Puede utilizar uno de los métodos siguientes para añadir o eliminar recursos de una 
partición (consulte “Library Map” en la página 353 para obtener instrucciones 
detalladas): 

■ Seleccione celdas individuales o grupos de celdas. 

■ Seleccione una columna completa de un módulo de biblioteca (de arriba a abajo) 

■ Seleccione un lado de un módulo de la biblioteca (frontal o posterior) 

■ Seleccione un módulo de biblioteca completo.
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Nota: Esta pantalla está disponible sólo si las particiones se han definido para la 
biblioteca a través de la pantalla Partitions—Summary (Step 2)—Add Partition. 

Atención: Cambiar los límites de las particiones puede originar cartuchos huérfanos 
y datos que se podrían perder. Consulte “Cartuchos huérfanos en bibliotecas 
particionadas” en la página 266 para obtener más detalles. 

Nota: Las pantallas de particiones Summary (Step 2) y Design (Step 3b), y todos los 
paneles emergentes asociados, ofrecen un espacio de trabajo dinámico para diseñar las 
particiones de biblioteca. Toda la información de configuración de particiones se guarda 
automáticamente en el espacio de trabajo de particiones en la memoria de SL Console y 
se conserva durante el tiempo de la sesión de SL Console. Esto permite cambiar entre 
vistas de particiones, y salir y volver a las pantallas de particiones todas las veces que 
se quiera sin perder los cambios de configuración. 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Campos de la pantalla
Partition

Obligatorio.

Partición en la que va a añadir o eliminar recursos (celdas de almacenamiento, 
unidades de cinta o CAP giratorios). 

El menú desplegable muestra todos los identificadores de partición válidos para la 
biblioteca.También identifica el tipo de interfaz host (FC-SCSI o HLI). Si no se han 
definido identificadores de partición, el menú está en blanco. 

Nota: Cuando selecciona una partición, la pantalla se actualiza automáticamente para 
mostrar los datos de esa partición en el espacio de trabajo de particiones de SL Console. 

Select by

Obligatorio.

Indica el método que va a utilizar para definir límites de partición. Las opciones son:

■ Cell: seleccione grupos de recursos rectangulares o individuales.

■ Column: seleccione todos los recursos de una columna. 

■ Side: seleccione todos los recursos de un lado de un módulo de la biblioteca, 
excepto el CAP. 

■ Module: seleccione todos los recursos de un módulo de la biblioteca, excepto el 
CAP. 
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Nota: Debe seleccionar Add o Remove. 

Add 

Obligatorio.

Indica que desea añadir recursos a la partición. Sólo podrá hacer clic en recursos sin 
asignar en el plano de la biblioteca. 

Remove

Obligatorio.

Indica que desea eliminar recursos de la partición. Sólo podrá hacer clic en recursos 
asignados en el plano de la biblioteca. 

Allocated to Partition n 

Nota: Los datos de estos campos se actualizan automáticamente en el espacio de 
trabajo de particiones de SL Console cuando selecciona una partición.

Storage Cells 

Sólo visualización.

Número total de celdas de almacenamiento asignadas a la partición seleccionada, 
según los límites de partición definidos actualmente. 

Drive Bays

Sólo visualización.

Número total de unidades de cinta asignadas a la partición seleccionada, según los 
límites de partición definidos actualmente. 

CAP Cells

Sólo visualización.

Número total de celdas CAP giratorio o de AEM asignadas a la partición 
seleccionada, según los límites de partición definidos actualmente. 

Unallocated in Library 

Nota: Los datos de estos campos se actualizan automáticamente en el espacio de 
trabajo de particiones de SL Console cuando selecciona una partición.

Storage Cells 

Sólo visualización.

Número total de celdas de almacenamiento de la biblioteca que no están asignadas a 
ninguna partición.

Drive Bays

Sólo visualización.
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Número total de celdas de unidades de cinta de la biblioteca que no están asignadas 
a ninguna partición.

CAP Cells

Sólo visualización.

Número total de celdas CAP giratorio o de AEM de la biblioteca que no están 
asignadas a ninguna partición.

Licensed Capacity 

Nota: Este campo aparece sólo si la biblioteca tiene capacidad con licencia sin asignar. 
Si las asignaciones superan la capacidad con licencia (una situación de capacidad 
superior), aparece el campo Oversubscription. 

Sólo visualización.

Capacidad total con licencia de la biblioteca que no se ha asignado a ninguna 
partición. Se calcula:

Capacidad total con licencia – Total de celdas de almacenamiento asignadas 

Oversubscription 

Nota: Este campo aparece sólo si las asignaciones superan la capacidad con licencia 
(una situación de capacidad superior). Si la biblioteca tiene capacidad con licencia sin 
asignar, aparece el campo Licensed Capacity.

Sólo visualización.

Capacidad total con licencia de la biblioteca que se ha superado mediante 
asignaciones de particiones. Se calcula:

Total de celdas de almacenamiento asignadas – Capacidad total con licencia 

Debe eliminar el exceso de asignaciones para poder confirmar los cambios a través 
de la pantalla Commit (Step 4). 

Legend 
Leyenda para el plano de la biblioteca. El estado de cada recurso de biblioteca (celda 
de almacenamiento, unidad de cinta o celda CAP giratorio) se indica de la siguiente 
manera: 

■ Not Accessible (en blanco y -tachado). El recurso no está accesible para ninguna 
partición. Algunas posibles razones son:

- Las celdas de almacenamiento se han configurado para cartuchos de 
diagnóstico. 

- Las celdas de almacenamiento no se incluyen en la capacidad con licencia de la 
biblioteca. 

■ Unallocated. El recurso no está asignado actualmente a ninguna partición y, 
por tanto, está disponible para la partición seleccionada. 

■ Partition n (dorado). El recurso está asignado a la partición seleccionada, 
partición n. 

■ Other Partitions (rojo). El recurso está asignado a otra partición y, por tanto, NO 
está disponible para la partición seleccionada. 
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■ Shared CAP (fondo gris). El CAP se ha asignado a una partición al menos. Se 
muestra el tipo de interfaz host asignado al CAP (HLI o FC-SCSI). 

■ Cartucho (icono de cartucho). El recurso contiene un cartucho de cinta. 

■ Las ranuras de unidad con unidades instaladas se destacan con un borde grueso. 
Las ranuras de unidad vacías tienen un borde estrecho. 

Library Map 
Representación gráfica de la configuración de biblioteca actual. La pantalla inicial de 
la sesión de inicio de SL Console actual es de la base de datos del controlador de 
biblioteca; a continuación, la pantalla refleja los datos del espacio de trabajo de 
particiones de SL Console cuando modifica las configuraciones de particiones. La 
pantalla incluye la información siguiente:

■ Tipo de módulo mostrado actualmente (módulo básico, módulo de expansión de 
unidades o módulo de expansión de parking) 

■ ID de módulo numérico (1–12)

■ Tipo de conexión partición-host de un CAP compartido (FC-SCSI o HLI) 

■ Ubicación de todos los recursos (celdas de almacenamiento, unidades de cinta, 
celdas CAP giratorio) de la biblioteca 

Nota: Desplace el cursor sobre un recurso para visualizar información detallada sobre 
la celda o la unidad, la asignación de particiones y la identidad de los cartuchos 
residentes. 

Nota: Si no se han definido identificadores de partición, el plano de la biblioteca es de 
sólo visualización.

Utilice el plano de la biblioteca para modificar los límites de la partición 
seleccionada. Según si ha hecho clic en el botón de radio Add o en Remove, todos 
los recursos seleccionados se añaden o se eliminan de la partición. 

Según la opción elegida en el campo Select by, puede realizar una de las acciones 
siguientes. 

■ Seleccionar por celda: seleccione celdas individuales o grupos de recursos. Los 
recursos de una partición no necesitan ser adyacentes entre sí. 

- Para seleccionar un recurso individual, haga doble clic en él.

- Para seleccionar un grupo rectangular de recursos, haga clic sobre la celda o la 
unidad en una esquina del rectángulo y, a continuación, haga clic en la celda o 
la unidad diagonalmente opuesta. 

■ Seleccionar por columna: seleccione una columna completa del módulo. Las 
columnas de una partición no necesitan ser adyacentes entre sí. Para seleccionar 
una columna, haga clic en cualquier recurso dentro de la columna. 

■ Seleccionar por lado: seleccione un lado completo dentro de un módulo, excepto 
el CAP. Los lados de una partición no necesitan ser adyacentes entre sí. Para 
seleccionar un lado de un módulo de biblioteca, haga clic en cualquier recurso de 
ese lado. 

■ Seleccionar por módulo: seleccione un módulo completo, excepto el CAP. Los 
módulos de una partición no necesitan ser adyacentes entre sí. Para seleccionar un 
módulo de biblioteca, haga clic en cualquier recurso de ese módulo. 
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Botones
Move Left 

Haga clic para mostrar el módulo de la biblioteca directamente a la izquierda del que 
se muestra actualmente. Este botón aparece sombreado si no hay ningún módulo a la 
izquierda. 

Move Right 

Haga clic para mostrar el módulo de biblioteca directamente a la derecha del que se 
muestra actualmente. Este botón aparece sombreado si no hay ningún módulo a la 
derecha. 

Verify 

Click to verify partition configuration changes you have made during this 
SL Console login session. The Tools > Partitions—Design (Step 3b)—Verify Results 
popup appears, indicating whether there are any orphaned cartridges or other errors 
in the current partition configuration.

Nota: This procedure verifies only one partition at a time. If you need to verify 
multiple partitions, you must repeat this procedure separately for each partition. 

Nota: This verification is performed on the current partition configuration in the 
SL Console partition workspace only. It does not verify current partition boundaries 
against the library controller database; therefore it cannot identify configuration 
conflicts that may arise due to other users performing cartridge movements or library 
configuration changes—through the interfaz de línea de comandos, other SL Console 
sessions, or host applications—at the same time you have made partition changes. 

Refresh

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con los 
datos actuales de la base de datos del controlador de biblioteca. Todos los cambios 
de particiones no confirmados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Partition Refresh, que le 
insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Summary (Step 2) 

■ Partitions—Module Map (Step 3a)

■ Partitions—Design (Step 3b) – AEMs Only

■ Partitions—Design (Step 3b)—Verify Results 

■ Partitions—Commit (Step 4) 

■ Partitions—Current Partition Definitions 

■ Partitions—Reports 
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Partitions—Design (Step 3b) – AEMs Only

Nota: Esta sección describe la pantalla Design (Step 3b) sólo para módulos AEM. Para 
módulos básicos, de unidad y CEM, consulte “Partitions—Design (Step 3b)” en la 
página 349. 

Nota: Esta pantalla sólo está disponible si la configuración de biblioteca incluye uno o 
varios AEM. 

Pantalla de ejemplo 

Descripción
Permite definir límites de particiones mediante la asignación de todas las celdas de un 
AEM a una partición. Como con CAP giratorios, varias particiones pueden compartir 
un CAP de AEM, si las particiones tienen el mismo tipo de interfaz host (HLI o 
FC-SCSI). 
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Nota: Esta pantalla está disponible sólo si las particiones se han definido para la 
biblioteca a través de la pantalla Partitions—Summary (Step 2)—Add Partition. 

Atención: Cambiar los límites de las particiones puede originar cartuchos huérfanos 
y datos que se podrían perder. Consulte “Cartuchos huérfanos en bibliotecas 
particionadas” en la página 266 para obtener más detalles. 

Nota: Las pantallas de particiones Summary (Step 2) y Design (Step 3b), y todos los 
paneles emergentes asociados, ofrecen un espacio de trabajo dinámico para diseñar las 
particiones de biblioteca. Toda la información de configuración de particiones se guarda 
automáticamente en el espacio de trabajo de particiones en la memoria de SL Console y 
se conserva durante el tiempo de la sesión de SL Console. Esto permite cambiar entre 
vistas de particiones, y salir y volver a las pantallas de particiones todas las veces que 
se quiera sin perder los cambios de configuración. 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Campos de la pantalla
Partition

Obligatorio.

Partición a la que va a añadir o eliminar celdas CAP de AEM. 

El menú desplegable muestra todos los identificadores de partición válidos para la 
biblioteca. También identifica el tipo de interfaz host (FC-SCSI o HLI). Si no se han 
definido identificadores de partición, el menú está en blanco. 

Nota: Cuando selecciona una partición, la pantalla se actualiza automáticamente para 
mostrar los datos de esa partición en el espacio de trabajo de particiones de SL Console. 

Select by

Obligatorio.

Indica el método que va a utilizar para definir límites de partición. Sin perjuicio de la 
opción que elija, todas las celdas en el AEM se seleccionan de una vez. 

Nota: Debe seleccionar Add o Remove. 

Add 

Obligatorio.
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Indica que desea añadir el AEM a la partición. Esta opción sólo es válida si el AEM 
está sin asignar actualmente. 

Remove

Obligatorio.

Indica que desea eliminar el AEM de la partición. Esta opción sólo es válida si el 
AEM está asignado actualmente. 

Allocated to Partition n 

Nota: Los datos de estos campos se actualizan automáticamente en el espacio de 
trabajo de particiones de SL Console cuando selecciona una partición.

Celdas de almacenamiento 

Sólo visualización.

Número total de celdas de almacenamiento asignadas a la partición seleccionada, 
según los límites de partición definidos actualmente. 

Bahías de unidades

Sólo visualización.

Número total de unidades de cinta asignadas a la partición seleccionada, según los 
límites de partición definidos actualmente. 

CAP Cells

Sólo visualización.

Número total de celdas CAP giratorio o de AEM asignadas a la partición 
seleccionada, según los límites de partición definidos actualmente. 

Unallocated in Library 

Nota: Los datos de estos campos se actualizan automáticamente en el espacio de 
trabajo de particiones de SL Console cuando selecciona una partición.

Celdas de almacenamiento 

Sólo visualización.

Número total de celdas de almacenamiento de la biblioteca que no están asignadas a 
ninguna partición.

Bahías de unidades

Sólo visualización.

Número total de celdas de unidades de cinta de la biblioteca que no están asignadas 
a ninguna partición.

CAP Cells

Sólo visualización.

Número total de celdas CAP giratorio o de AEM de la biblioteca que no están 
asignadas a ninguna partición.
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Licensed Capacity 

Nota: Este campo aparece sólo si la biblioteca tiene capacidad con licencia sin asignar. 
Si las asignaciones superan la capacidad con licencia (una situación de capacidad 
superior), aparece el campo Oversubscription. 

Sólo visualización.

Capacidad total con licencia de la biblioteca que no se ha asignado a ninguna 
partición. Se calcula:

Capacidad total con licencia – Total de celdas de almacenamiento asignadas 

Oversubscription 

Nota: Este campo aparece sólo si las asignaciones superan la capacidad con licencia 
(una situación de capacidad superior). Si la biblioteca tiene capacidad con licencia sin 
asignar, aparece el campo Licensed Capacity. 

Sólo visualización.

Capacidad total con licencia de la biblioteca que se ha superado mediante 
asignaciones de particiones. Se calcula:

Total de celdas de almacenamiento asignadas – Capacidad total con licencia 

Debe eliminar el exceso de asignaciones para poder confirmar los cambios a través 
de la pantalla Commit (Step 4). 

Legend 
Leyenda para el plano de la biblioteca. El estado de cada celda CAP de AEM se 
indica de la siguiente manera: 

■ Not Accessible (en blanco y -tachado). El recurso no está accesible para ninguna 
partición. Algunas posibles razones son:

- Las celdas de almacenamiento se han configurado para cartuchos de 
diagnóstico. 

- Las celdas de almacenamiento no se incluyen en la capacidad con licencia de la 
biblioteca. 

■ Unallocated. El recurso no está asignado actualmente a ninguna partición y, por 
tanto, está disponible para la partición seleccionada. 

■ Partition n (dorado). El recurso está asignado a la partición seleccionada, 
partición n. 

■ Other Partitions (rojo). El recurso está asignado a otra partición y, por tanto, NO 
está disponible para la partición seleccionada. 

■ Shared AEM CAP (fondo gris). El CAP de AEM se ha asignado al menos a una 
partición. Se muestra el tipo de interfaz host asignado al CAP de AEM (HLI o 
FC-SCSI). 

■ Cartucho (icono de cartucho). El recurso contiene un cartucho de cinta. 
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AEM Map 
Representación gráfica de la configuración AEM actual. La pantalla inicial de la 
sesión de inicio de SL Console actual es de la base de datos del controlador de 
biblioteca; a continuación, la pantalla refleja los datos del espacio de trabajo de 
particiones de SL Console cuando modifica las configuraciones de particiones. La 
pantalla incluye la información siguiente:

■ Tipo de módulo mostrado actualmente; para AEM es siempre “Access Module”. 

■ ID de módulo numérico (1–12)

■ Indicador visual del módulo actual (“Door Closed View” o “Door Open View”) 

■ Tipo de interfaz host de la(s) partición(es) a la que se asigna el AEM (FC-SCSI o 
HLI) 

■ Tipo de CAP; para AEM es siempre “Bulk Load CAP”. 

■ Ubicación de todas las celdas de almacenamiento del AEM 

Nota: Desplace el cursor sobre un recurso para visualizar información detallada sobre 
la celda o la unidad, la asignación de particiones y la identidad de los cartuchos 
residentes. 

Nota: Si no se han definido identificadores de partición, el plano de la biblioteca es de 
sólo visualización.

Utilice el plano de la biblioteca para modificar la ubicación de partición del AEM. 
Según si ha hecho clic en el botón de radio Add o en Remove, el AEM completo se 
añade o se elimina de la partición. 

Botones
Move Left 

Haga clic para mostrar el módulo de la biblioteca directamente a la izquierda del que 
se muestra actualmente. Este botón aparece sombreado si no hay ningún módulo a la 
izquierda. 

Move Right 

Haga clic para mostrar el módulo de biblioteca directamente a la derecha del que se 
muestra actualmente. Este botón aparece sombreado si no hay ningún módulo a la 
derecha. 

Nota: La “Door Closed View” es la vista AEM predeterminada. Puede usar los dos 
botones siguientes para alternar entre las vistas alternativas. 

Show Door Open View

Haga clic para visualizar el diseño de las celdas CAP de AEM como si la puerta de 
acceso AEM estuviera abierta y estuviese mirando directamente al interior del AEM. 

Show Door Closed View

Haga clic para visualizar el diseño de las celdas CAP de AEM como si la puerta de 
acceso AEM estuviera cerrada y estuviese mirando a través del panel de la puerta de 
acceso frontal al interior del AEM. 
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Verify

Click to verify partition configuration changes you have made during this 
SL Console login session. The Tools > Partitions—Design (Step 3b)—Verify Results 
popup appears, indicating whether there are any orphaned cartridges or other errors 
in the current partition configuration.

Nota: This procedure verifies only one partition at a time. If you need to verify 
multiple partitions, you must repeat this procedure separately for each partition. 

Nota: This verification is performed on the current partition configuration in the 
SL Console partition workspace only. It does not verify current partition boundaries 
against the library controller database; therefore it cannot identify configuration 
conflicts that may arise due to other users performing cartridge movements or library 
configuration changes—through the interfaz de línea de comandos, other SL Console 
sessions, or host applications—at the same time you have made partition changes. 

Refresh

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con los 
datos actuales de la base de datos del controlador de biblioteca. Todos los cambios 
de particiones no confirmados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Partition Refresh, que le 
insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Summary (Step 2) 

■ Partitions—Module Map (Step 3a)

■ Partitions—Design (Step 3b)

■ Partitions—Design (Step 3b)—Verify Results 

■ Partitions—Commit (Step 4) 

■ Partitions—Current Partition Definitions 

■ Partitions—Reports 
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Partitions—Design (Step 3b)—Verify Results

Pantalla de ejemplo

Descripción
Muestra una lista de errores de configuración en el espacio de trabajo de particiones de 
SL Console actual. 

Esta pantalla es un panel emergente que aparece cuando hace clic sobre Verify Results 
en la pantalla Partitions—Design (Step 3b). 

Entre los posibles errores se incluyen:

■ Una partición tiene cartuchos huérfanos. Consulte “Cartuchos huérfanos en 
bibliotecas particionadas” para obtener más detalles.

■ Se han eliminado recursos de biblioteca de una partición. 

■ Una conexión partición-host no tiene una partición asignada a LUN 0 (aplicable sólo 
a conexiones FC-SCSI). 

Si se presenta cualquiera de estas condiciones de error, la pantalla muestra mensajes de 
error en modo resumido. Para ver mensajes detallados, haga clic en el botón Details. 

Se recomienda resolver todos los errores antes de confirmar los datos a la base de datos 
del controlador de biblioteca. 

Puede imprimir los datos de pantalla o guardarlos en un archivo separado por comas. 
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Nota: Las pantallas de particiones Summary (Step 2) y Design (Step 3b), y todos los 
paneles emergentes asociados, ofrecen un espacio de trabajo dinámico para diseñar las 
particiones de biblioteca. Toda la información de configuración de particiones se guarda 
automáticamente en el espacio de trabajo de particiones en la memoria de SL Console y 
se conserva durante el tiempo de la sesión de SL Console. Esto permite cambiar entre 
vistas de particiones, y salir y volver a las pantallas de particiones todas las veces que 
se quiera sin perder los cambios de configuración. 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Campos de la pantalla

Nota: Los campos de la pantalla son los mismos que los que se muestran en el panel 
emergente Partitions—Commit (Step 4)—Confirm Apply. 

Warnings found

Sólo visualización.

Mensajes de error en modo resumido sobre la configuración de particiones. 

The library is oversubscribed. Please unallocate nnn storage cells. 

Sólo visualización.

Indica que el total de asignaciones de particiones actuales supera la capacidad con 
licencia de la biblioteca. nnn es el número de celdas que debe eliminar de las 
asignaciones de particiones. El botón Apply de la pantalla Commit (Step 4) 
permanece desactivado hasta que el total de celdas asignadas esté dentro de la 
capacidad con licencia de la biblioteca. 

The following hosts will need re-audited

Sólo visualización.

Los WWPN (World Wide Port Names) de hosts que deben volver a auditar la 
partición de la biblioteca. Esto puede ser porque los recursos de la biblioteca se han 
eliminado de la partición. 

The following hosts do not have Lun 0 set

Sólo visualización.

Los WWPN (World Wide Port Names) de hosts que no han definido particiones de 
biblioteca como LUN 0 en el host. Este error sólo se aplica a conexiones partición-
host FC-SCSI. 

The following orphaned cartridges were found

Sólo visualización.
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Información detallada sobre todos los cartuchos huérfanos de la configuración de 
particiones actual. Incluye ubicación de biblioteca, raíl, columna, lado y fila del 
cartucho, número de serie de volumen del cartucho (VOLID) y posibles causas y 
explicaciones sobre por qué el cartucho es huérfano. 

Botones
Imprimir

Haga clic para imprimir el informe en la impresora seleccionada.

Save

Haga clic en este botón para guardar el informe en un archivo de texto separado por 
comas (extensión .csv). Los archivos separados por comas se pueden abrir con 
diversos programas de hojas de cálculo y bases de datos. 

OK

Haga clic en este botón para cancelar la actualización. La base de datos del 
controlador de biblioteca no se actualiza, pero todos los cambios de partición de la 
sesión se conservan en el espacio de trabajo de particiones de SL Console. 

Details 

Haga clic para alternar entre las vistas expandidas y contraídas de la pantalla de 
mensajes de aviso. 

Consulte también
■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4)—Confirm Apply 
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Partitions—Commit (Step 4)

Pantalla de ejemplo

Descripción
Permite confirmar todos los datos del espacio de trabajo de particiones de SL Console a 
la base de datos del controlador de biblioteca. Los siguientes datos se confirmarán para 
todas las particiones: 

■ Información de resumen de particiones 

■ Datos de configuración de conexión host-partición 

■ Detalles de límites de partición 
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Atención: Aunque los cambios de partición no interrumpen los hosts de la biblioteca, 
se recomienda que haga que la biblioteca no esté disponible para otros usuarios 
antes de confirmar los cambios del espacio de trabajo de particiones. Debido a que 
SL Console no verifica los límites de partición con la base de datos del controlador de 
biblioteca en tiempo real, pueden surgir conflictos de configuración si cambia los 
límites de partición mientras otros usuarios están moviendo cartuchos o cambiando la 
configuración de la biblioteca. Consulte “Sincronización de la pantalla con la base de 
datos del controlador” en la página 38 para obtener más detalles. 

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Atención: Se recomienda que siga el procedimiento Resolución de cartuchos huérfanos 
antes de utilizar esta pantalla. 

Atención: Esta pantalla actualiza la base de datos del controlador de biblioteca con 
todos los cambios de configuración de partición que ha realizado durante esta sesión de 
SL Console. En caso de no utilizar esta pantalla antes de desconectar de la sesión de 
SL Console actual, se perderán todos los cambios en la configuración de biblioteca.

Campos de la pantalla
Ninguno 

Botones
Apply

Haga clic para actualizar la base de datos del controlador de biblioteca con la 
configuración actual del espacio de trabajo de particiones de SL Console. Aparece el 
cuadro emergente Tools > Partitions—Commit (Step 4)—Confirm Apply, que indica 
si hay cartuchos huérfanos u otros errores en la configuración de particiones actual. 

Nota: Este botón se muestra sombreado si las asignaciones de particiones actuales 
superan la capacidad con licencia de la biblioteca. Para activar el botón, debe eliminar 
celdas de almacenamiento de las asignaciones de particiones para que el total de celdas 
asignadas esté dentro de la capacidad con licencia de la biblioteca.

Nota: Este botón se muestra sombreado si no ha realizado cambios en el espacio de 
trabajo de particiones de SL Console desde la última confirmación. 
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? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Summary (Step 2) 

■ Partitions—Design (Step 3b) 

■ Partitions—Design (Step 3b)—Verify Results 

■ Partitions—Commit (Step 4)—Confirm Apply 

■ Partitions—Reports 
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Partitions—Commit (Step 4)—Confirm Apply

Pantalla de ejemplo

Descripción
Muestra una lista de errores de configuración en el espacio de trabajo de particiones de 
SL Console actual. Esta pantalla es un panel emergente que aparece cuando hace clic 
sobre Apply en la pantalla Partitions—Commit (Step 4). 

Tras visualizar los mensajes de error, puede confirmar todos los datos del espacio de 
trabajo de particiones de SL Console a la base de datos del controlador de biblioteca 
mediante el botón Yes. 

Entre los posibles errores se incluyen:

■ Una partición tiene cartuchos huérfanos. Consulte “Cartuchos huérfanos en 
bibliotecas particionadas” para obtener más detalles.

■ Se han eliminado recursos de biblioteca de una partición. 

■ Una conexión partición-host no tiene una partición asignada a LUN 0 (aplicable sólo 
a conexiones FC-SCSI). 

Si se presenta cualquiera de estas condiciones de error, la pantalla muestra mensajes de 
error en modo resumido. Para ver mensajes detallados, haga clic en el botón Details. 

Se recomienda resolver todos los errores antes de confirmar los datos a la base de datos 
del controlador de biblioteca. 

Puede imprimir los datos de pantalla o guardarlos en un archivo separado por comas. 



Pantallas de diseño y confirmación de particiones

368 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

Atención: La información del espacio de trabajo de particiones de SL Console se 
guarda en la base de datos del controlador de biblioteca sólo mediante la pantalla 
Commit (Step 4). Si la sesión de SL Console termina o si actualiza los datos del espacio 
de trabajo antes de que haya confirmado las actualizaciones mediante la pantalla 
Commit (Step 4), perderá los cambios de particiones realizados mediante las pantallas 
Summary (Step 2) y Design (Step 3b) y todos los paneles emergentes asociados. 

Campos de la pantalla

Nota: Los campos de la pantalla son los mismos que los que se muestran en el panel 
emergente Partitions—Design (Step 3b)—Verify Results. 

Warnings found

Sólo visualización.

Mensajes de error en modo resumido sobre la configuración de particiones. 

The library is oversubscribed. Please unallocate nnn storage cells. 

Sólo visualización.

Indica que el total de asignaciones de particiones actuales supera la capacidad con 
licencia de la biblioteca. nnn es el número de celdas que debe eliminar de las 
asignaciones de particiones. El botón Apply de la pantalla Commit (Step 4) 
permanece desactivado hasta que el total de celdas asignadas esté dentro de la 
capacidad con licencia de la biblioteca. 

The following hosts will need re-audited

Sólo visualización.

Los WWPN (World Wide Port Names) de hosts que deben volver a auditar la 
partición de la biblioteca. Esto puede ser porque los recursos de la biblioteca se han 
eliminado de la partición. 

The following hosts do not have Lun 0 set

Sólo visualización.

Los WWPN (World Wide Port Names) de hosts que no han definido particiones de 
biblioteca como LUN 0 en el host. Este error sólo se aplica a conexiones partición-
host FC-SCSI. 

The following orphaned cartridges were found

Sólo visualización.

Información detallada sobre todos los cartuchos huérfanos de la configuración de 
particiones actual. Incluye ubicación de biblioteca, raíl, columna, lado y fila del 
cartucho, número de serie de volumen del cartucho (VOLID) y posibles causas y 
explicaciones sobre por qué el cartucho es huérfano. 
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Botones
Imprimir

Haga clic para imprimir el informe en la impresora seleccionada.

Save 

Haga clic en este botón para guardar el informe en un archivo de texto separado por 
comas (extensión .csv). Los archivos separados por comas se pueden abrir con 
diversos programas de hojas de cálculo y bases de datos. 

Yes

Haga clic para confirmar que desea actualizar la base de datos del controlador de 
biblioteca con la configuración actual del espacio de trabajo de SL Console. 

No

Haga clic en este botón para cancelar la actualización. La base de datos del 
controlador de biblioteca no se actualiza, pero todos los cambios de partición de la 
sesión se conservan en el espacio de trabajo de particiones de SL Console. 

Details 

Haga clic para alternar entre las vistas expandidas y contraídas de la pantalla de 
mensajes de aviso. 

Consulte también
■ Partitions—Commit (Step 4) 

■ Partitions—Design (Step 3b)—Verify Results 
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Partitions—Current Partition Definitions

Pantalla de ejemplo

Descripción
Muestra los límites y las asignaciones actuales de una partición. Es la única pantalla 
Partitions que está disponible en el panel de operador local.

Nota: Esta pantalla es de visualización sólo. 

Campos de la pantalla
Para obtener una descripción más detallada de los campos de pantalla, consulte una de 
las siguientes secciones:

■ “Partitions—Design (Step 3b)” en la página 349 para módulos básicos, de unidad y 
CEM

■ “Partitions—Design (Step 3b) – AEMs Only” en la página 355 para AEM 
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Botones
Refresh

Haga clic en este botón para actualizar la pantalla con los datos actuales de la base 
de datos del controlador de biblioteca. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Design (Step 3b) 

■ Partitions—Design (Step 3b) – AEMs Only
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Pantallas de informes de particiones

Partitions—Reports

Partitions—Reports—Cartridge Cell and Media Summary

Partitions—Reports—Host Connections Summary

Partitions—Reports—Orphaned Cartridge Report

Partitions—Reports—Partition Details

Partitions—Reports—Partition Summary
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Partitions—Reports

Pantalla de ejemplo

Descripción
Permite seleccionar uno de los siguientes informes sobre particiones de biblioteca:

■ Cartridge Cell and Media Summary (Resumen de medios y celdas de cartuchos)

■ Host Connections Summary (Resumen de conexiones host)

■ Orphaned Cartridge Report (Informe de cartuchos huérfanos)

■ Partition Details (Detalles de partición)

■ Partition Summary (Resumen de particiones)

Nota: Los informes de particiones muestran los datos guardados en la base de 
datos del controlador de biblioteca. Si ha hecho cambios de configuración de 
partición sin confirmar los cambios al controlador de biblioteca a través de la 
pantalla Commit (Step 4), los datos de estos informes serán diferentes de los datos 
mostrados en las pantallas de particiones Summary (Step 2) y Design (Step 3b). 
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Campos de la pantalla
Please select a report to display

Obligatorio.

Haga clic en el informe que desea visualizar. El menú desplegable muestra un lista 
de todos los informes de particiones de biblioteca disponibles. 

Botones
Refresh

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con los 
datos actuales de la base de datos del controlador de biblioteca. Todos los cambios 
de particiones no confirmados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Partition Refresh, que le 
insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Summary (Step 2) 

■ Partitions—Design (Step 3b) 

■ Partitions—Commit (Step 4) 

■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Summary 
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Partitions—Reports—Cartridge Cell and Media 
Summary

Pantalla de ejemplo

Descripción
Muestra información detallada sobre todos los recursos de biblioteca (celdas de 
almacenamiento, unidades de cinta y celdas CAP giratorio o de AEM) y cualquier 
cartucho almacenado.

Nota: Los informes de particiones muestran los datos guardados en la base de 
datos del controlador de biblioteca. Si ha hecho cambios de configuración de 
partición sin confirmar los cambios al controlador de biblioteca a través de la 
pantalla Commit (Step 4), los datos de estos informes serán diferentes de los datos 
mostrados en las pantallas de particiones Summary (Step 2) y Design (Step 3b). 

Nota: Las celdas CAP de AEM se identifican de la siguiente manera: celdas CAP de 
AEM izquierdo están en las columnas “-33” a “-31”; celdas CAP de AEM derecho están 
en las columnas “31” a “33”. 
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Nota: Puede modificar la presentación y visualización de esta pantalla. Consulte 
“Modificación de la distribución de pantalla” en la página 39 para obtener más detalles. 

Puede imprimir los datos de pantalla o guardarlos en un archivo separado por comas.

Campos de la pantalla
Library 

Sólo visualización.

El número de biblioteca donde está ubicado el recurso de biblioteca. Siempre es “1”. 

Rail 

Sólo visualización.

El número de raíl donde está ubicado el recurso de biblioteca. Siempre es “1”. 

Column

Sólo visualización.

El número de columna donde está ubicado el recurso de biblioteca. La ubicación de 
columna se incluye en el borde izquierdo del módulo básico. “+1” es a la derecha; 
“-1” es a la izquierda.

Side

Sólo visualización.

El lado del módulo donde está ubicado el recurso de biblioteca. “1” es en la parte 
posterior; “2” es en la parte frontal.

Fila

Sólo visualización.

El número de fila donde está ubicado el recurso de biblioteca. Las filas están 
numeradas consecutivamente de arriba a abajo, con la fila “1” en la parte superior.

Partition ID

Sólo visualización.

Identificador de partición al que está asignado el recurso de biblioteca, si procede. 

Partition Name

Sólo visualización.

Nombre de la partición a la que está asignado el recurso de biblioteca, si procede. Si 
la biblioteca no tiene particiones definidas, aparece “Non-Partitioned 
Library”(biblioteca no particionada). 

Element Type

Sólo visualización.

Tipo de recurso de biblioteca. Las opciones son:

■ CAP (giratorio o de AEM) 
■ CELL
■ DRIVE
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Vol Ser 

Sólo visualización.

Número de serie de volumen (VOLID) del cartucho residente en el recurso de 
biblioteca, si lo hay. 

Cell Status

Sólo visualización.

Estado de la capacidad del recurso de biblioteca. Se aplica sólo a celdas de 
almacenamiento. Las opciones son:

■ Active: la celda está activada para uso en función de la capacidad asignada y se 
puede usar para el almacenamiento de cartuchos. 

■ Inactive: la celda no está activada para uso y no se puede usar para el 
almacenamiento de cartuchos. 

Botones
Imprimir

Haga clic para imprimir el informe en la impresora seleccionada.

Save to File

Haga clic en este botón para guardar el informe en un archivo de texto separado por 
comas (extensión .csv). Los archivos separados por comas se pueden abrir con 
diversos programas de hojas de cálculo y bases de datos. 

Refresh

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con los 
datos actuales de la base de datos del controlador de biblioteca. Todos los cambios 
de particiones no confirmados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Partition Refresh, que le 
insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Summary 



Pantallas de informes de particiones

378 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

Partitions—Reports—Host Connections Summary

Pantalla de ejemplo

Descripción
Muestra información detallada sobre todas las conexiones host-partición para la 
biblioteca. 

Nota: Los informes de particiones muestran los datos guardados en la base de 
datos del controlador de biblioteca. Si ha hecho cambios de configuración de 
partición sin confirmar los cambios al controlador de biblioteca a través de la 
pantalla Commit (Step 4), los datos de estos informes serán diferentes de los datos 
mostrados en las pantallas de particiones Summary (Step 2) y Design (Step 3b). 

Puede modificar la presentación y visualización de esta pantalla. Consulte 
“Modificación de la distribución de pantalla” en la página 39 para obtener más detalles. 

Puede imprimir los datos de pantalla o guardarlos en un archivo separado por comas.
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Campos de la pantalla

Partitions

Nota: Los campos de pantalla de esta sección también aparecen en el informe 
Partitions—Reports—Partition Summary.

Partition ID

Sólo visualización.

Identificador de la partición (1–8). 

Partition Name

Sólo visualización.

Nombre de la partición. 

Connection Type 

Sólo visualización.

Tipo de interfaz empleada en la conexión host-partición. Las opciones son:

■ HLI 

■ FC-SCSI 

Celdas de almacenamiento 

Sólo visualización.

Número total de celdas de almacenamiento asignadas a la partición.

Media in Storage Cells

Sólo visualización.

Número total de cartuchos de cinta residentes en las celdas de almacenamiento de 
una partición. 

% Storage Cells w/ Media

Sólo visualización.

Porcentaje de celdas de almacenamiento que contienen cartuchos de cinta. Se calcula: 
Medios en celdas de almacenamiento / Celdas de almacenamiento. 

Drive Bays 

Sólo visualización.

Número total de bahías de unidad asignadas a la partición. 

CAP Cells 

Sólo visualización.

Número total de celdas CAP giratorio asignadas a la partición. 

AEM Cells 

Sólo visualización.

Número total de celdas CAP de AEM asignadas a la partición. 
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Total Media 

Sólo visualización.

Número total de cartuchos de cinta residentes en la partición; incluye cartuchos en 
celdas de almacenamiento, CAP giratorios y de AEM, y unidades asignadas a la 
partición. 

Active Cells

Sólo visualización.

Capacidad total de celdas de almacenamiento asignadas a las partición en la pantalla 
Add Partition. 

Host Connections

Initiator (WWPN)

Sólo visualización.

WWPN (World Wide Port Name) del adaptador bus de host FC-SCSI (HBA) con una 
conexión a la partición. 

Library Controller Port

Sólo visualización.

Número de puerto del controlador de biblioteca SL3000 en el host. Esta entrada 
siempre es “0”.

LUN

Sólo visualización.

Número de unidad lógica de la partición de biblioteca en el host

Partition ID 

Sólo visualización.

Identificador de partición con la que el host tiene una conexión. 

Botones
Imprimir

Haga clic para imprimir el informe en la impresora seleccionada.

Save

Haga clic en este botón para guardar el informe en un archivo de texto separado por 
comas (extensión .csv). Los archivos separados por comas se pueden abrir con 
diversos programas de hojas de cálculo y bases de datos. 

Refresh

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con los 
datos actuales de la base de datos del controlador de biblioteca. Todos los cambios 
de particiones no confirmados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Partition Refresh, que le 
insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 
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Consulte también
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Summary 
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Partitions—Reports—Orphaned Cartridge Report 

Pantalla de ejemplo

Descripción
Muestra las ubicaciones y los números de serie de volumen (VOLID) de todos los 
cartuchos huérfanos de la biblioteca. Además identifica el motivo por el que el cartucho 
es huérfano. 

Nota: Los informes de particiones muestran los datos guardados en la base de 
datos del controlador de biblioteca. Si ha hecho cambios de configuración de 
partición sin confirmar los cambios al controlador de biblioteca a través de la 
pantalla Commit (Step 4), los datos de estos informes serán diferentes de los datos 
mostrados en las pantallas de particiones Summary (Step 2) y Design (Step 3b). 

Puede modificar la presentación y visualización de esta pantalla. Consulte 
“Modificación de la distribución de pantalla” en la página 39 para obtener más detalles. 

Puede imprimir los datos de pantalla o guardarlos en un archivo separado por comas.
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Campos de la pantalla
Library 

Sólo visualización.

El número de la biblioteca donde está ubicado el cartucho huérfano. Siempre es “1”. 

Rail 

Sólo visualización.

El número de raíl donde está ubicado el cartucho huérfano. Siempre es “1”. 

Column

Sólo visualización.

El número de la columna donde está ubicado el cartucho huérfano. La ubicación de 
columna se incluye en el borde izquierdo del módulo básico. “+1” es a la derecha; 
“-1” es a la izquierda.

Side

Sólo visualización.

El lado del módulo donde está ubicado el cartucho huérfano. “1” es en la parte 
posterior; “2” es en la parte frontal.

Fila

Sólo visualización.

El número de fila donde está ubicado el cartucho huérfano. Las filas están 
numeradas consecutivamente de arriba a abajo, con la fila “1” en la parte superior.

Vol Ser 

Sólo visualización.

Número de serie de volumen (VOLID) del cartucho huérfano. 

Explanation

Sólo visualización.

Explicación de por qué el cartucho es huérfano. 

Puesto que este informe se elabora en la base de datos del controlador de biblioteca, 
la única opción es:

■ No se puede acceder desde ningún host 

Botones
Imprimir

Haga clic para imprimir el informe en la impresora seleccionada.

Save

Haga clic en este botón para guardar el informe en un archivo de texto separado por 
comas (extensión .csv). Los archivos separados por comas se pueden abrir con 
diversos programas de hojas de cálculo y bases de datos. 
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Refresh

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con los 
datos actuales de la base de datos del controlador de biblioteca. Todos los cambios 
de particiones no confirmados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Partition Refresh, que le 
insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Partition Details 

■ Partitions—Reports—Partition Summary 
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Partitions—Reports—Partition Details

Pantalla de ejemplo

Descripción
Muestra información detallada para una partición seleccionada. 

Nota: Los informes de particiones muestran los datos guardados en la base de 
datos del controlador de biblioteca. Si ha hecho cambios de configuración de 
partición sin confirmar los cambios al controlador de biblioteca a través de la 
pantalla Commit (Step 4), los datos de estos informes serán diferentes de los datos 
mostrados en las pantallas de particiones Summary (Step 2) y Design (Step 3b). 
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Puede modificar la presentación y visualización de esta pantalla. Consulte 
“Modificación de la distribución de pantalla” en la página 39 para obtener más detalles. 

Puede imprimir los datos de pantalla o guardarlos en un archivo separado por comas.

Campos de la pantalla
Partition Name

Sólo visualización.

Nombre de la partición. 

Partition ID

Sólo visualización.

Identificador de la partición (1–8). 

Connection Type 

Sólo visualización.

Tipo de interfaz empleada en la conexión host-partición. Las opciones son:

■ HLI 

■ FC-SCSI 

Assigned Cells 

Sólo visualización.

Número total de celdas de almacenamiento asignadas a la partición.

Available Cells 

Sólo visualización.

Número total de celdas de almacenamiento de la biblioteca disponibles para 
asignación a la partición.

Occupied Cells 

Sólo visualización.

Número total de celdas de almacenamiento de la partición con cartuchos de cinta 
presentes.

Active (Capacity Licensed) Cells 

Sólo visualización.

Capacidad total de celdas de almacenamiento asignadas a la partición en la pantalla 
Add Partition. 

Assigned Drive Bays 

Sólo visualización.

Número total de bahías de unidad asignadas a la partición.

Available Drive Bays 

Sólo visualización.

Número total de bahías de unidad de la biblioteca disponibles para asignación a la 
partición.
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Número de unidades

Sólo visualización.

Número total de unidades de cinta instaladas asignadas a la partición. 

Occupied Drives 

Sólo visualización.

Número total de unidades de cinta instaladas en la partición con cartuchos de cinta 
presentes.

Assigned CAP cells 

Sólo visualización.

Número total de celdas CAP giratorio asignadas a la partición a través de CAP 
dedicados o compartidos. 

Available CAP cells

Sólo visualización.

Número total de celdas CAP giratorio de la biblioteca disponibles para la asignación 
a la partición. Este número incluye todas las celdas CAP giratorio o de AEM de la 
siguiente manera:

■ CAP no asignados a ninguna partición. 

■ CAP no asignados actualmente a la partición, pero asignados a otras particiones 
con el mismo tipo de interfaz host que ésta. 

Este número excluye todas las celdas CAP giratorio o de AEM de la siguiente 
manera: 

■ CAP no asignados actualmente a la partición.

■ CAP asignados a particiones con un tipo de interfaz host diferente. 

Occupied CAP cells

Sólo visualización.

Número total de celdas CAP giratorio de la partición con cartuchos de cinta 
presentes.

Assigned AEM cells 

Sólo visualización.

Número total de celdas CAP de AEM asignadas a la partición a través de AEM 
dedicados o compartidos. 

Available AEM cells

Sólo visualización.

Número total de celdas CAP de AEM de la biblioteca disponibles para asignación a 
la partición. Este número incluye todas las celdas AEM de la siguiente manera:

■ AEM no asignados a ninguna partición. 

■ AEM no asignados actualmente a la partición, pero asignados a otras particiones 
con el mismo tipo de interfaz host que ésta. 

Este número excluye todas las celdas AEM de la siguiente manera: 

■ AEM no asignados actualmente a la partición.

■ AEM asignados a particiones con un tipo de interfaz host diferente. 
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Occupied AEM cells

Sólo visualización.

Número total de celdas CAP de AEM de la partición con cartuchos de cinta 
presentes.

% Cell Capacity (Assigned Cells/Total Cells) 

Sólo visualización.

Porcentaje de celdas de almacenamiento de la biblioteca asignadas a la partición. Se 
calcula:

Número de celdas asignadas a la partición / Capacidad física total de la biblioteca 

Botones
Imprimir

Haga clic para imprimir el informe en la impresora seleccionada.

Save

Haga clic en este botón para guardar el informe en un archivo de texto separado por 
comas (extensión .csv). Los archivos separados por comas se pueden abrir con 
diversos programas de hojas de cálculo y bases de datos. 

Refresh

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con los 
datos actuales de la base de datos del controlador de biblioteca. Todos los cambios 
de particiones no confirmados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Partition Refresh, que le 
insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Summary 
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Partitions—Reports—Partition Summary

Pantalla de ejemplo

Descripción
Muestra información de resumen de todas las particiones de la biblioteca. 

Nota: Los informes de particiones muestran los datos guardados en la base de 
datos del controlador de biblioteca. Si ha hecho cambios de configuración de 
partición sin confirmar los cambios al controlador de biblioteca a través de la 
pantalla Commit (Step 4), los datos de estos informes serán diferentes de los datos 
mostrados en las pantallas de particiones Summary (Step 2) y Design (Step 3b). 

Puede modificar la presentación y visualización de esta pantalla. Consulte 
“Modificación de la distribución de pantalla” en la página 39 para obtener más detalles. 

Puede imprimir los datos de pantalla o guardarlos en un archivo separado por comas.
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Campos de la pantalla

Nota: Estos campos de pantalla también aparecen en el informe 
Partitions—Reports—Host Connections Summary.

Partition ID

Sólo visualización.

Identificador de la partición (1–8). 

Partition Name

Sólo visualización.

Nombre de la partición. 

Connection Type 

Sólo visualización.

Tipo de interfaz empleada en la conexión host-partición. Las opciones son:

■ HLI 

■ FC-SCSI 

Celdas de almacenamiento 

Sólo visualización.

Número total de celdas de almacenamiento asignadas a la partición.

Media in Storage Cells

Sólo visualización.

Número total de cartuchos de cinta residentes en las celdas de almacenamiento de 
una partición. 

% Storage Cells w/ Media

Sólo visualización.

Porcentaje de celdas de almacenamiento que contienen cartuchos de cinta. Se calcula: 
Medios en celdas de almacenamiento / Celdas de almacenamiento. 

Drive Bays 

Sólo visualización.

Número total de bahías de unidad asignadas a la partición. 

CAP Cells 

Sólo visualización.

Número total de celdas CAP giratorio asignadas a la partición. 

AEM Cells 

Sólo visualización.

Número total de celdas CAP de AEM asignadas a la partición. 

Total Media 

Sólo visualización.
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Número total de cartuchos de cinta residentes en la partición; incluye cartuchos en 
celdas de almacenamiento, CAP giratorios y de AEM, y unidades asignadas a la 
partición. 

Active Cells

Sólo visualización.

Capacidad total de celdas de almacenamiento asignadas a las partición en la pantalla 
Add Partition. 

Botones
Imprimir

Haga clic para imprimir el informe en la impresora seleccionada.

Save

Haga clic en este botón para guardar el informe en un archivo de texto separado por 
comas (extensión .csv). Los archivos separados por comas se pueden abrir con 
diversos programas de hojas de cálculo y bases de datos. 

Refresh

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con los 
datos actuales de la base de datos del controlador de biblioteca. Todos los cambios 
de particiones no confirmados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Partition Refresh, que le 
insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Reports—Cartridge Cell and Media Summary 

■ Partitions—Reports—Host Connections Summary 

■ Partitions—Reports—Orphaned Cartridge Report 

■ Partitions—Reports—Partition Details 
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Pantallas de operaciones de CAP para 
particiones

Shared CAP Assignment

Diagnóstico > Anulación de reserva CAP
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Shared CAP Assignment 

Pantalla de ejemplo

Descripción
Permite realizar asociaciones partición-CAP antes de utilizar un CAP FC-SCSI 
compartido para introducir o expulsar cartuchos en una partición. Las asociaciones 
partición-CAP reservan un CAP giratorio o de AEM para uso exclusivo de la partición 
seleccionada durante la operación de introducción o expulsión. 

Nota: Esta pantalla no está disponible si la biblioteca no tiene CAP FC-SCSI 
compartidos. 
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Nota: Esta pantalla se usa para CAP giratorios y de AEM. En esta sección, el término 
“CAP” se refiere a ambos tipos de CAP. 

A la hora de utilizar esta pantalla, se aplican las siguientes reglas:

■ Debe utilizar esta pantalla sólo para CAP FC-SCSI compartidos. 

■ No debe utilizar esta pantalla para CAP dedicados porque un partición siempre 
tiene la propiedad de los CAP dedicados. 

■ No debe emplear esta pantalla para particiones HLI porque las aplicaciones host HLI 
siempre utilizan reservas de CAP. 

■ Sólo puede asociar una partición a un CAP a un mismo tiempo. 

■ La selección de una partición hace que todos los CAP asignados se asocien a ella al 
mismo tiempo; no puede seleccionar CAP de uno en uno para que se asocien a la 
partición. 

■ Puede seleccionar varias particiones al mismo tiempo, siempre que las particiones 
seleccionadas no compartan ningún CAP entre sí. 

■ Las asociaciones partición-CAP permanecen activas hasta que se eliminan 
explícitamente; las asociaciones no se eliminan de forma automática cuando se 
completa la operación de introducción o expulsión. 

■ Las asociaciones partición-CAP se eliminan durante los reinicios de biblioteca, los 
ciclos de alimentación, las operaciones de apertura y cierre de puerta de biblioteca, o 
las inicializaciones de CAP. 

■ Las asociaciones partición-CAP se eliminan si el CAP se asigna a una partición 
diferente a través de la pantalla Design (Step 3b). 

■ Si una asociación partición-CAP se elimina mientras el CAP está abierto o tiene 
cartuchos, la propiedad del CAP cambiará al solicitante “predeterminado” y el 
CAP quedará no disponible para todas las particiones. Debe vaciar y cerrar el CAP 
antes de que se pueda asociar a particiones. 

Consulte “Introducción de cartuchos en una partición” en la página 319 y “Expulsión 
de cartuchos de una partición” en la página 320 para obtener detalles sobre el uso de 
esta pantalla junto con el botón CAP Open. 

Campos de la pantalla
Seleccione

Seleccione una o varias particiones para las que desea introducir o expulsar 
cartuchos, de la siguiente manera: 

■ Haga clic en la casilla de verificación para seleccionar la partición; la pantalla se 
actualiza así:

- Todos los CAP asignados a esa partición se marcan con el número de partición 
en el mapa del módulo.

- Todas las demás particiones que comparten CAP con esa partición aparecen 
sombreadas. 

■ No seleccione la casilla de verificación para anular la selección de la partición. 

Las particiones que están sombreadas no se pueden seleccionar. Una partición puede 
estar sombreada por cualquiera de las razones siguientes: 

■ No se han asignado CAP a la partición.

■ La partición tiene un tipo de conexión host HLI. 
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■ El CAP está actualmente en uso por otra partición que comparte el CAP.

■ El CAP está actualmente en uso por el usuario “predeterminado” (operador de 
biblioteca). 

Partition Name

Sólo visualización.

Nombre asignado a la partición. 

Partition ID

Sólo visualización.

Identificador asignado a la partición. Los identificadores pueden ir del 1 al 8.

Connection Type 

Sólo visualización.

Tipo de interfaz asignada a la conexión host-partición. Las opciones son:

■ HLI

■ FC-SCSI

Library module map 

Sólo visualización.

La pantalla muestra una ilustración de la configuración del módulo real de la 
biblioteca. Esta información se toma directamente de la base de datos del controlador 
de biblioteca. 

Las asignaciones de CAP para cada partición se indican de la siguiente manera: 

■ Una “X” en una columna de módulo de biblioteca indica que el CAP en ese 
módulo está asignado a la partición en esa fila.

■ Si no hay “X” en una columna de módulo de biblioteca, significa que el CAP en 
ese módulo no está asignado a la partición en esa fila. 

Botones
Apply

Haga clic para actualizar la base de datos del controlador de biblioteca con la 
configuración actual de la pantalla. Aparece el cuadro emergente CAP Confirm, que 
le insta a confirmar la actualización. 

Refresh

Haga clic para actualizar el espacio de trabajo de particiones de SL Console con los 
datos actuales de la base de datos del controlador de biblioteca. Todos los cambios 
de particiones no confirmados que ha realizado durante la sesión de inicio de 
SL Console se descartarán. Aparece el cuadro emergente Partition Refresh, que le 
insta a confirmar la actualización. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Partitions—Design (Step 3b) 
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Diagnóstico > Anulación de reserva CAP

Pantalla de ejemplo

Descripción
Permite anular una reserva de CAP que ya ha sido iniciada por un host. El controlador 
de biblioteca elimina la reserva de CAP y define el usuario de CAP en "predetermina-
do", lo que hace que el CAP giratorio o de AEM no esté disponible para todas las parti-
ciones. 

Tras anular la reserva, deberá abrir el CAP y eliminar los cartuchos. Tras cerrar el CAP, 
el controlador de biblioteca bloqueará y auditará el CAP para verificar que está vacío. A 
continuación, definirá el estado del CAP en “no reservado,” lo que hace que el CAP 
esté disponible para todas las particiones.

Nota: Para CAP FC-SCSI, la anulación de una reserva de CAP rompe cualquier 
asociación partición-CAP, incluso si el CAP está dedicado a la partición FC-SCSI. Debe 
asociar explícitamente la partición al CAP de nuevo para que la partición pueda utilizar 
el CAP.
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Nota: Esta pantalla se usa para CAP giratorios y de AEM. En esta sección, el término 
“CAP” se refiere a ambos tipos de CAP. 

Consulte “Anulación de una reserva de CAP” en la página 322 para conocer el 
procedimiento detallado. 

Campos de la pantalla
CAP id_de_CAP es (estado). 

Sólo visualización.

Estado del CAP seleccionado. Las opciones posibles son:

■ reserved by nombre_de_host: el host especificado ha iniciado una operación de 
CAP; puede utilizar esta pantalla para anular la reserva del CAP.

■ reserved by default: el host especificado ha iniciado una operación de CAP 
en SL Console; no puede utilizar esta pantalla para anular la reserva del CAP. 

■ not reserved: el CAP no está reservado; no es necesario anular la reserva del 
CAP. 

Module containing selected CAP is displayed below

Sólo visualización.

La pantalla muestra una ilustración de la configuración del módulo real de la 
biblioteca. Esta información se toma directamente de la base de datos del controlador 
de biblioteca. 

El CAP que ha seleccionado se señala con una flecha. 

Botones
Apply

Haga clic para anular la reserva de CAP del host. Aparece el cuadro emergente CAP 
Confirm, que le insta a confirmar la actualización. 

Nota: Este botón está activo sólo si el estado del CAP es 
“reserved by nombre_de_host”. 

? (Ayuda) 

Haga clic para mostrar la ayuda en línea de la pantalla. 

Consulte también
■ Shared CAP Assignment
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CAPÍTULO 7

Diagnósticos y utilidades de 
SL Console

Eventos de biblioteca
El controlador de la biblioteca supervisa continuamente las operaciones de la biblioteca 
y registra todos los eventos. Los eventos se almacenan bajo tres encabezados:

■ Eventos de comunicación: incluye comunicaciones de host a biblioteca, de biblioteca 
a biblioteca y de biblioteca a unidad. 

■ Eventos de error: a cada evento de error se le asigna un código de acción de cuatro 
dígitos (hexadecimal). 

■ Eventos de aviso: indica una pérdida de rendimiento o condiciones que puedan ser 
indicativas de futuros errores graves. 

Monitores de eventos
El usuario o el representante de asistencia de Sun puede utilizar los monitores de 
SL Console para ver los eventos de la biblioteca. Puede enviar la información del 
monitor de eventos a un archivo de texto. 

La siguiente información ayuda a diagnosticar la causa del evento: 

■ Marca de fecha y hora: identifica cuándo se produjo el evento. 

■ Códigos de acción: identifican el comando que se emitió, tal como “load drive”.

■ Códigos de resultado: identifican el resultado de la acción solicitada. Consulte “Lista 
de códigos de resultado” en la página 417 para buscar un código de resultado. 

■ Diagnóstico de plan de servicios conocidos (KSP): identifica el mecanismo o 
componente responsable de la tarea o el error. 

Nota: No existe la opción de borrar el registro de eventos.
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Pruebas automáticas de biblioteca 
La utilidad de diagnóstico de prueba automática está destinada a diagnosticar 
problemas básicos con la biblioteca. Normalmente se ejecuta una prueba automática 
una vez que se haya instalado la biblioteca. La misma se puede ejecutar siempre que 
sea necesario. 

Nota: Las rutinas de prueba automática de la biblioteca no causan ninguna 
interrupción. 

La prueba automática de la biblioteca sigue el proceso siguiente:

1. Verifica la ruta de comunicación entre el controlador de la biblioteca, las unidades y 
los TallBots. 

2. Realiza operaciones de extracción (get) y colocación (put) para verificar el estado de 
los TallBots y los CAP giratorios o de AEM. Esto incluye operaciones de extracción y 
colocación de una celda reservada a uno de los siguientes elementos al azar:

■ celda de almacenamiento 

■ celda CAP

3. Realiza una auditoría completa de la biblioteca. 

4. Realiza montajes y desmontajes de cartuchos de diagnóstico en todas las unidades 
instaladas en la biblioteca.

Nota: La prueba automática no se inicia a menos que haya un cartucho de diagnóstico 
en las celdas reservadas.

Nota: La prueba automática se repite para cada tipo de unidad si hay un cartucho de 
diagnóstico compatible en las celdas reservadas. Si no hay un cartucho de diagnóstico 
para un tipo de unidad, se ignora la operación de montaje y desmontaje para la unidad.
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Actualizaciones de firmware de la 
biblioteca
El firmware de la biblioteca reside en el controlador de biblioteca. El firmware inicial 
viene instalado de fábrica. Cuando se lanza una nueva versión de firmware, debe 
utilizar la utilidad de carga de códigos para actualizar el firmware en la biblioteca y en 
los dispositivos asociados (CAP giratorio o de AEM, y TallBot). 

Nota: El firmware de la biblioteca no contiene actualizaciones de códigos de unidad.

Sitios de descarga de firmware
El paquete de firmware de la biblioteca SL3000 es un archivo .jar (archivo 
Java).Consulte “SunSolve y vínculos útiles” en la página xxxiv para obtener 
información sobre los sitios de descarga. 

Nota: Debe tener un ID y una contraseña de inicio de sesión que sean válidos en el 
sitio de descargas. Consulte con el representante de asistencia de Sun para obtener 
ayuda. 

Proceso de instalación de firmware
El proceso para cargar código firmware en el controlador de la biblioteca es el siguiente: 

1. Localice el paquete de actualizaciones de firmware (archivo .jar ) en el sitio de 
descargas de Sun apropiado. Consulte “SunSolve y vínculos útiles” en la 
página xxxiv. 

2. Descargue el código en una carpeta del PC o de la estación de trabajo local. 

3. Descargue el paquete de firmware del PC al controlador de la biblioteca. Este 
proceso también desempaqueta el paquete después de descargarlo a fin de 
prepararlo para la activación. Consulte “Descarga de código en el controlador de 
biblioteca” en la página 422. 

4. Active el código descargado en el controlador de la biblioteca. Consulte “Activación 
de código en el controlador de biblioteca” en la página 424. 

5. Reinicie la biblioteca para que el código funcione. Consulte “Reinicio de la 
biblioteca” en la página 420. 
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Auditorías 
La auditoría es el proceso de lectura y clasificación de cartuchos en una biblioteca, de 
comprobación de las ubicaciones de los cartuchos o de verificación de un rango de ubica-
ciones de ranuras. El controlador de biblioteca mantiene una base de datos de cartuchos 
que contiene la siguiente información en cuanto a todos los cartuchos de la biblioteca:

■ Identificador de volumen (VOLID o VOLSER) 

■ Ubicación actual (en formato de dirección interna de biblioteca)

■ Estado verificado (true o false)

La biblioteca audita todas las ubicaciones de los cartuchos en áreas de almacenamiento 
y en áreas reservadas en los momentos siguientes:

■ Después de que se haya abierto y cerrado una o las dos puertas de acceso. 

■ Si se ha hecho una solicitud de auditoría a través de SL Console. 

■ Si se ha hecho una solicitud de host para auditar la biblioteca. 

Puede utilizar SL Console para realizar los siguientes tipos de auditorías:

■ Auditoría física 

■ Auditoría verificada

Atención: Podrían surgir problemas en el sistema si un registro de cartuchos del host 
no coincide con lo que existe en la base de datos de cartuchos del controlador de la 
biblioteca. 

Auditoría física
En una auditoría física, el TallBot visita las ubicaciones de los cartuchos y comprueba el 
ID de volumen de los cartuchos residentes, y el controlador de la biblioteca actualiza 
la base de datos de cartuchos. Esta auditoría cambia el estado “verificado” de las 
ubicaciones de cartuchos a “true”. Las veces que se realiza la auditoría varían 
en función del tamaño de la biblioteca. Las auditorías duran aproximadamente 
1/2 segundo por ranura de cartucho, por cada TallBot.

La biblioteca realiza una auditoría física en los siguientes momentos: 

■ Al encender la biblioteca o cuando se haya abierto o cerrado una puerta de acceso a 
la biblioteca. En este caso siempre se realiza una auditoría completa de toda la 
biblioteca. 

■ En la bibliotecas con un AEM, siempre que se cierra la puerta de acceso AEM. En 
este caso se realiza una auditoría completa del AEM. 

■ Cuando se inicia manualmente a través de SL Console. Existen dos tipos de 
auditorías físicas iniciadas de forma manual:

■ Auditoría de toda la biblioteca: el TallBot visita todas las celdas (almacenamiento, 
CAP giratorio o de AEM, y unidad), clasifica los ID de volumen y las ubicaciones, 
y actualiza la base de datos de cartuchos del controlador de biblioteca. Esta 
auditoría es un proceso en segundo plano y, por tanto, no interrumpe las 
operaciones de la biblioteca. Consulte “Auditoría de toda la biblioteca” en la 
página 432 para obtener más detalles. 
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■ Auditoría de rango específico: el TallBot visita sólo un rango específico de celdas 
(almacenamiento, CAP giratorio o de AEM, y unidades) y actualiza la base datos 
de cartuchos del controlador de biblioteca. La información de la auditoría se 
muestra en SL Console mientras se realiza la auditoría. Consulte “Auditoría de un 
rango de celdas” en la página 434 para obtener más detalles.

Auditoría verificada
La auditoría verificada valida el estado de una ubicación de cartucho específica o de un 
rango de ubicaciones (incluidos CAP giratorios y de AEM, y unidades) en la base de 
datos de cartuchos. Si la dirección de un cartucho tiene el estado verificado de “false”, 
se realiza una auditoría física de esa ubicación y se actualiza la base de datos de 
cartuchos. El avance de la auditoría se muestra en la sección Audit Console de 
SL Console. Consulte “Ejecución de una auditoría verificada” en la página 437 para 
obtener más detalles. 
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Movimientos de diagnóstico de robot
Los movimientos de diagnóstico se utilizan para supervisar o diagnosticar un problema 
con un TallBot. El movimiento se puede realizar con o sin cartuchos. 

Los movimientos de diagnóstico correctos no cambian la posición de los cartuchos en 
las celdas de almacenamiento; los cartuchos vuelven a sus ubicaciones originales una 
vez que el movimiento de diagnóstico se haya completado. Sin embargo, algunos 
errores de movimiento de diagnóstico podrían hacer que los cartuchos se queden en 
ubicaciones nuevas. 

El movimiento de diagnóstico incluye los siguientes elementos:

■ Rango de dirección de destino

■ Rango de dirección de conjunto

■ Orden de acceso de movimientos

■ Selección de robot

Rango de dirección de destino 
El rango de dirección de destino define los parámetros de ubicación de una biblioteca 
dentro de los cuales se realiza la operación de extracción (get) en un movimiento de 
diagnóstico. Existen dos tipos de orden de acceso para una dirección de destino:

■ “Orden de acceso secuencial” en la página 405 

■ “Orden de acceso aleatorio” en la página 405 

A continuación, se muestran los tipos de dirección de destino válidos:

■ Celdas de almacenamiento: reserva todas las ubicaciones de almacenamiento como 
el rango de destino o de conjunto.

■ CAP: reserva celdas en un CAP giratorio o de AEM como el rango de destino o de 
conjunto. 

■ Unidad y celdas de almacenamiento: reserva todas las unidades y las celdas de 
almacenamiento como el rango de destino o de conjunto.

■ Celdas de sistema: reserva las celdas del sistema (reservadas) que contienen los 
cartuchos de limpieza o diagnóstico como el rango de destino o de conjunto. 

■ Todos: reserva celdas de almacenamiento, celdas de sistema, celdas CAP giratorio o 
de AEM, y unidades como el rango de destino o de conjunto.

Nota: La selección de una de estas opciones (almacenamiento, CAP, unidad, sistema 
o todos) no reserva todas las ubicaciones asociadas como el rango de destino. Sin 
embargo, solamente la ubicación a la que accede actualmente el TallBot para una 
operación de extracción (get) y colocación (put) no está disponible para el host.
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Rango de dirección de conjunto
Las ubicaciones de rango de dirección de conjunto se utilizan para suministrar los 
cartuchos necesarios para los movimientos de diagnóstico tanto hacia el rango de 
dirección de destino como desde éste. La dirección de conjunto también se utiliza en la 
operación de extracción (get) si una dirección de destino no contiene un cartucho. No 
hay un orden de acceso específico dentro del rango de dirección de conjunto. El rango 
de dirección de conjunto no incluye ubicaciones de unidades.

Nota: El rango de dirección de conjunto no puede contener ubicaciones de unidades.

Orden de acceso de movimientos

Orden de acceso secuencial
En un movimiento de diagnóstico con orden de acceso secuencial, el TallBot realiza una 
operación de extracción (get) empezando por la primera ubicación en los rangos de 
dirección de destino y continúa visitando las ubicaciones en orden consecutivo a lo 
largo del rango hasta que completa el número solicitado de movimientos. 

Nota: Si decide no mover cartuchos, no se realizan las operaciones de extracción (get) 
y colocación (put). El TallBot se limita a colocarse en las direcciones de destino y de 
conjunto.

Orden de acceso aleatorio
En el movimiento de diagnóstico con orden de acceso aleatorio, el TallBot elige una 
ubicación al azar en la dirección de destino para extraer el cartucho. El TallBot puede 
visitar varias veces la misma ubicación en el rango de dirección de destino para extraer 
el cartucho. La rutina de acceso aleatorio finaliza una vez que se haya completado el 
número solicitado de movimientos. 

Si decide no mover cartuchos, no se realizan las operaciones de extracción (get) y 
colocación (put). El TallBot se limita a colocarse en las direcciones de destino y de 
conjunto. 

Selección de robot
El TallBot para el movimiento de diagnóstico se selecciona según los rangos mínimo y 
máximo que haya definido para las direcciones de destino y de conjunto. Se pueden 
seleccionar varios robots si el rango de dirección lo requiere.



 

Movimientos de diagnóstico de robot

406 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

Funciones de control de movimientos de 
diagnóstico
Las siguientes opciones están disponibles para administrar los movimientos 
actualmente abiertos:

Nota: Si varios movimientos de diagnóstico están abiertos, cada movimiento tiene su 
propia pantalla.

Para Opción de menú Notas

Iniciar File > Start Sequence

Poner en pausa File > Pause Sequence Detiene todos los movimientos de 
diagnóstico, pero mantiene la 
ubicación actual en el orden de acceso.

Detener File > Stop Sequence Detiene la operación en ejecución o en 
pausa.

Reanudar File > Start Sequence Reanuda la operación en pausa a 
partir de la última ubicación conocida 
en el rango de dirección de destino.

Borrar los mensajes que se 
muestran en pantalla

File > Clear Output Window Borra las líneas de mensajes anteriores 
y continúa rellenando la pantalla con 
mensajes nuevos.

Enviar datos a archivo Spool File > Start Spooling Dirige la salida de los movimientos 
hacia un archivo.

Dejar de enviar la salida de 
la operación al archivo

Spool File > Stop Spooling Detiene el envío de la salida de los 
movimientos al archivo.
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Solución de problemas 
Antes de ejecutar pruebas de diagnóstico, verifique las áreas siguientes de la biblioteca 
utilizando las sugerencias para la solución de problemas que encontrará en la tabla 
siguiente:

TABLA 7-1 Tabla de solución de problemas 

Problema Qué hacer

El indicador LED de 
Service Required 
(ámbar) está encendido 
constantemente.

Realice el procedimiento siguiente:
Mediante SL Console, compruebe el estado de la biblioteca y los 
dispositivos adjuntos (unidades, CAP giratorios y de AEM, y TallBots). 
Consulte “Consola de biblioteca StorageTek” en la página 33 para 
obtener más información sobre las operaciones.
Para realizar una comprobación de estado:
1. Inicie sesión en la aplicación de SL Console.
2. Acceda al módulo System Detail, View > System Detail.
3. Vea el árbol dispositivos para buscar los indicadores siguientes:
■ Device Healthy
■ Device Error
Las fichas Status (por ejemplo, conectado/desconectado) y Statistics 
(por ejemplo, tiempo de actividad, tiempo de inactividad, errores y 
avisos) contienen más información sobre el estado de la biblioteca y los 
dispositivos. 
Otras comprobaciones:
■ Asegúrese de que los cartuchos estén insertados totalmente y 

orientados correctamente en las celdas de almacenamiento.
■ Inspeccione la tabla X por si hubiese objetos extraños o restos; 

elimine los que haya encontrado.

El indicador LED de 
CAP Open está 
encendido y 
parpadeando.

Abra el CAP giratorio o de AEM, y asegúrese de que los cartuchos de 
las celdas CAP estén insertados correctamente. 

SL Console no muestra 
datos ni información 
modificada que 
permanezca estática.

Vea el icono Heartbeat de SL Console.
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El indicador LED de 
Robot Fault o Library 
Fault Amber está 
encendido 
constantemente.

1. Vea SL Console por si hay algún mensaje de error. Escriba los 
mensajes de error notificados.

2. Abra la puerta frontal. Observe y tome nota del estado de los 
cartuchos, de la mano del robot y de las unidades de cinta.

3. Asegúrese de que los cartuchos estén insertados totalmente y 
orientados correctamente en las celdas de almacenamiento.

4. Asegúrese de que se haya quitado el envoltorio.
5. Inspeccione el suelo de la biblioteca por si hubiese objetos o restos, y 

elimínelos.
6. Examine el estado de las unidades de cinta.
7. Cierre la puerta frontal.
8. Asegúrese de que las unidades de cinta se hayan insertado 

totalmente y que estén ajustados hacia adelante, empujando y 
tirando de la parte trasera de la bandeja de unidades. Cualquier 
movimiento de la bandeja indica que es necesario reinsertarlos y 
bloquearlos.

La unidad de cinta no 
puede expulsar un 
cartucho.

Extraíga manualmente el cartucho de la unidad de cinta. 

El ordenador cliente no 
puede comunicarse con 
la biblioteca o las 
unidades de cinta.

1. Asegúrese de que los cables se hayan conectado de forma segura a 
los conectores de la parte posterior de la biblioteca, las unidades de 
cinta y el ordenador cliente.

2. Asegúrese de que todos los dispositivos SCSI que se encuentren en el 
mismo bus tengan una dirección única y que el último dispositivo 
tenga una terminación correcta.

La biblioteca no se 
puede comunicar con 
las unidades.
El estado de la unidades 
en SL Console indica 
Not communicating.

1. Asegúrese de que los cables se hayan conectado de forma segura a 
los conectores de la parte posterior de la biblioteca, las unidades y el 
ordenador cliente.

2. Asegúrese de que todos los dispositivos SCSI que se encuentren en el 
mismo bus tengan una dirección única y que el último dispositivo 
tenga una terminación correcta.

Mensajes repetidos o 
excesivos sobre 
limpieza o limpieza de 
unidades.

1. Reemplace el cartucho de limpieza con uno nuevo.
2. Ejecute el Library Self-Test y observe si se han notificado errores de 

la unidad.
3. Ejecute las pruebas de diagnóstico de unidad basadas en 

ordenadores cliente.

TABLA 7-1 Tabla de solución de problemas (continuación)

Problema Qué hacer
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Archivos de asistencia para diagnósticos
Los siguientes archivos de asistencia para diagnósticos se guardan en la biblioteca con 
el fin de ayudar a la solución y diagnóstico de problemas:

■ Archivo MIB

■ Archivo de registro de instantáneas de biblioteca

Según las circunstancias, el representante de asistencia de Sun puede solicitar que se 
transfieran uno o ambos archivos a Sun para una evaluación ulterior, o dicha persona 
puede hacer esto por sí misma. 

Archivo MIB
El archivo de base de información de administración (MIB) es una base de datos 
pequeña de protocolo simple de administración de red (SNMP) que se utiliza para 
administrar los dispositivos de la biblioteca. El archivo se puede guardar como archivo 
de texto. Consulte “Transferencia del archivo MIB de la biblioteca” en la página 426 
para obtener instrucciones detalladas. 

Archivo de registro de instantáneas de biblioteca

Nota: This feature is available starting with SL3000 firmware version FRS_2.30 and 
SL Console version FRS_4.30. 

El representante de asistencia de Sun puede usar comandos CLI privilegiados para 
generar una instantánea cifrada del registro de eventos de la biblioteca. Usted no puede 
ver ni editar dicho archivo. El archivo sólo está disponible durante 15 minutos a partir 
del momento en que se genera. Consulte “Transferencia del archivo de registro de 
instantáneas de biblioteca” en la página 428 para obtener instrucciones detalladas. 
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Tareas de diagnóstico y utilidad 
Las tareas de diagnóstico y utilidad de la biblioteca se dividen en las siguientes 
categorías:

■ “Tareas de monitor de eventos” en la página 411

■ “Tareas de utilidad de biblioteca” en la página 418

■ “Tareas de auditoría” en la página 431

■ “Tareas de utilidad de CAP giratorio y de AEM” en la página 439

■ “Tareas de utilidad de unidades” en la página 445

■ “Tareas de utilidad de TallBot” en la página 449

■ “Tareas de utilidad de la puerta de seguridad AEM” en la página 467
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Tareas de monitor de eventos

Tarea Página

Visualización de un monitor de eventos 412

Envío de datos de monitor de eventos a un archivo 413

Visualización de varios monitores 414

Lista de códigos de estado de dispositivo 415

Lista de códigos de resultado 417
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▼ Visualización de un monitor de eventos
La información del monitor de eventos se actualiza según la frecuencia de los eventos 
seleccionados. La información enviada durante una operación de correo electrónico, de 
imprimir, de guardar o de enviar datos a un archivo, refleja los datos (y el formato) que 
se muestran en pantalla en el momento en que se solicita la operación. 

Nota: Los monitores de eventos son herramientas útiles que ayudan a analizar la causa 
principal de los errores. Si la biblioteca está experimentando errores reproducibles, 
puede abrir un monitor de eventos y enviar todos los eventos a un archivo con el fin de 
capturar los datos. Más tarde, puede enviar el archivo al representante de asistencia de 
Sun para su análisis. 

Nota: Para supervisar varios eventos, consulte “Visualización de varios monitores” en 
la página 414.

1. Seleccione Tools > Monitors.

2. Expanda la carpeta Permanent Monitors. 

Se muestran los monitores de la biblioteca a los que tiene acceso. 

3. Haga clic en el monitor de eventos que vaya a utilizar y, a continuación, haga clic en 
Open en la barra de opciones. 

El sistema muestra los datos asociados que se han recopilado para el evento.

4. Utilice estas opciones para administrar la información mostrada en pantalla para el 
evento seleccionado:

5. Para cerrar un monitor, haga clic en la X situada en la esquina superior derecha de la 
ventana. 

Seleccione Para

Monitor > Pause Detener la visualización continua de datos relacionados con el 
evento seleccionado

Monitor > Resume Reanudar la visualización de eventos

Monitor > Stop Detener de forma permanente la visualización continua de datos 
relacionados con el evento seleccionado

Monitor > Clear Borrar la visualización del monitor de eventos 
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▼ Envío de datos de monitor de eventos a un 
archivo
Utilice este procedimiento para enviar y guardar datos de monitor de eventos en un 
archivo. Puede enviar el archivo al representante de asistencia de Sun para que le asista 
en el diagnóstico de problemas. 

1. Seleccione Tools > Monitors.

2. Expanda la carpeta Permanent Monitors. 

Se muestran los monitores de la biblioteca a los que tiene acceso. 

3. Haga clic en el monitor de eventos que vaya a utilizar y, a continuación, haga clic en 
Open en la barra de opciones. 

A continuación, el sistema muestra una ventana de monitor de eventos.

4. En la ventana de monitor de eventos, seleccione Spool File > Start Spooling. 

Se abre la ventana emergente Save.

5. Vaya al directorio donde desee guardar el archivo. En el campo File Name, introduzca 
el nombre del archivo y haga clic en Save. 

Todos los datos de eventos se envían al archivo especificado. 

6. Para detener el envío al archivo, seleccione Monitor > Stop Spooling. 

A continuación se muestra un ejemplo de un archivo al que se envían los datos:
2008-05-29T11:23:27.448  0,1,0,0     root  default       internal        281    warn   
0  rb_Reboot::reboot(): Resetting drive [0,3,4,9]
2008-05-29T11:23:27.760  0,1,0,0     root  default       internal        281    info   
0  Service Beacon is ACTIVE: Current Health Event indicates Drive 04 in Module 03 is 
not operational
2008-05-29T11:23:53.211  0,1,0,0     root  default       internal        281    info   
0  Service Beacon is ACTIVE: Current Health Event indicates Drive 04 in Module 03 is 
operational 
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▼ Visualización de varios monitores
Puede abrir y administrar varios monitores de eventos si utiliza estas selecciones en la 
barra de opciones:

Para Seleccione

Personalizar la organización de los monitores abiertos en 
pantalla

Window > Arrange

Organizar las ventanas de monitores de eventos de forma 
horizontal

Window > Tile 
Horizontal

Organizar las ventanas de monitores de eventos de forma 
vertical

Window > Tile 
Vertical

Apilar los monitores de eventos Window > Cascade
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▼ Lista de códigos de estado de dispositivo
Utilice este procedimiento para obtener una lista de códigos de estado de dispositivos y 
sus descripciones. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha Search.

Se abre la pantalla Library Search. 

4. En el menú desplegable Search Type, haga clic en Device Status. 

5. Complete el campo Device Status, de la siguiente manera:

■ Para buscar un código de estado de dispositivo específico, introduzca el código 
completo; no se aceptan comodines ni códigos parciales. 

■ Para obtener una lista de todos los códigos de dispositivo, haga clic en la casilla de 
verificación List All. 
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6. En la barra de opciones, haga clic en Search. 

La pantalla muestra una lista de los códigos de estado de dispositivo especificados y 
sus descripciones. 



 

Tareas de monitor de eventos

418605401 • Revisión AB Diagnósticos y utilidades de SL Console 417

▼ Lista de códigos de resultado
Utilice este procedimiento para obtener una lista de códigos de resultado y sus 
descripciones. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha Search.

Se abre la pantalla Library Search. 

4. En el menú desplegable Search Type, haga clic en Result Code. 

5. Complete el campo Result Code de la siguiente manera:

■ Para buscar un código, introduzca el código completo; no se aceptan comodines ni 
códigos parciales. 

■ Para obtener una lista de todos los códigos, haga clic en la casilla de verificación List 
All. 
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Tareas de utilidad de biblioteca

Tarea Página

Ejecución de una prueba automática de biblioteca 419

Reinicio de la biblioteca 420

Descarga de código en el controlador de biblioteca 422

Activación de código en el controlador de biblioteca 424

Transferencia del archivo MIB de la biblioteca 426

Transferencia del archivo de registro de instantáneas de biblioteca 428
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▼ Ejecución de una prueba automática de biblioteca 

Nota: Los cartuchos de diagnóstico apropiados para las unidades de biblioteca deben 
estar presentes en la biblioteca. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha SelfTest.

Nota: La pantalla de prueba automática muestra el campo Mode con dos opciones: 
disruptive y non-disruptive. En la actualidad, sólo la opción "non-disruptive" es válida. 

4. En la barra de opciones, haga clic en la ficha Run.

Durante la prueba automática, la ventana de SL Console muestra el estado de los 
diversos diagnósticos que se estén realizando.
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▼ Reinicio de la biblioteca
Utilice este procedimiento para reiniciar la biblioteca. Este proceso conlleva el volver a 
cargar el firmware a partir de la memoria flash y el reinicio del controlador de 
biblioteca.

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. En la barra de opciones, haga clic en Reboot.

Se abre el cuadro emergente de confirmación Reboot. 

4. Haga clic en OK para continuar. 

Si la biblioteca está conectada, se abre el cuadro emergente de confirmación Offline.

5. Haga clic en OK para desconectar la biblioteca. 

Se abre el cuadro emergente de confirmación Reboot 

6. Haga clic en OK para continuar. 

Se abre el panel emergente de finalización de SL Console.
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7. Haga clic en OK para finalizar la sesión de SL Console. 

Se cierra la sesión de SL Console. 

El controlador de biblioteca reinicia la biblioteca. Esto podría tardar varios minutos. 

Nota: No podrá volver a iniciar la sesión en SL Console hasta que la biblioteca se haya 
inicializado totalmente. 
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▼ Descarga de código en el controlador de biblioteca
Utilice este procedimiento para descargar actualizaciones en el firmware del 
controlador de biblioteca. Este procedimiento no se utiliza para descargar 
actualizaciones de firmware de unidades.

Nota: Puede realizar este procedimiento sólo en SL Console independiente o en 
SL Console en Web, y no en el panel de operador local. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha Load Code. 
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4. Haga clic en el botón Browse para buscar, seleccionar la carpeta y el nombre de 
archivo que contenga el paquete de firmware (archivo.jar ) en el PC y, a 
continuación, haga clic en Open.

5. En la barra de opciones, haga clic en el botón Load.

6. Haga clic en OK para confirmar la descarga. 

Nota: El proceso de descarga podría tardar cinco minutos. SL Console indica el avance 
de la transferencia del archivo del PC al controlador de la biblioteca.

Nota: Tras la descarga, el sistema desempaqueta el paquete. 

7. Una vez que el paquete se haya abierto correctamente, puede activar el código de 
forma inmediata, o puede esperar y hacerlo más tarde. Consulte “Activación de 
código en el controlador de biblioteca” en la página 424 para obtener instrucciones 
detalladas.
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▼ Activación de código en el controlador de 
biblioteca 
Con la activación del código, el código que reside en el controlador de biblioteca está 
listo para utilizarse. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha Activate Code.

4. En el menú desplegable, haga clic en Target.
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Nota: El destino se refiere al paquete de firmware (archivo .jar ) que contiene el 
código de la biblioteca SL3000.

5. En la sección Available Versions, haga clic en el código que vaya a activar. 

Nota: La versión con el prefijo “*” es el código actualmente activo. No puede 
seleccionar dicho código de nuevo para la activación.

6. En la barra de opciones, haga clic en el botón Activate.

Nota: El proceso de activación de código podría tardar hasta diez minutos en 
completarse.

Atención: POSIBLE CORRUPCIÓN DE ARCHIVO INTERNO. No reinicie ningún 
dispositivo en la biblioteca ni ejecute ninguna operación en la misma mientras se esté 
activando el código.

7. Haga clic en OK para continuar.

Nota: La pantalla Activate Console muestra el estado del proceso de activación de 
código. El código que acaba de activar se incluye en una lista en la sección de versiones 
disponibles, marcado con un “*”. La versión desempaquetada y las versiones del 
código activadas previamente también se incluyen en la lista (sin “*”). 

8. El sistema le insta a reiniciar la biblioteca. Haga clic en OK para reiniciar la 
biblioteca.

Nota: La biblioteca tiene dos versiones del archivo de imagen que reside en la memoria 
flash. Una vez que la biblioteca completa el proceso de reinicio, la imagen más reciente 
se torna activa y la versión anterior sirve como copia de seguridad. La versión anterior 
se puede restaurar si se necesita. 

9. Haga clic en OK para finalizar la sesión de SL Console.

10.En la pantalla de inicio de sesión, haga clic en Exit para cerrar la aplicación. 

Espere a que la biblioteca complete la inicialización antes de iniciar sesión nuevamente 
en SL Console.

Nota:  SL Console obtiene todos los datos de configuración del controlador de 
biblioteca. Por tanto, debe tener cuidado de no iniciar sesión en SL Console antes de 
que la biblioteca se haya inicializado completamente. Podría tener avisos de que los 
datos de configuración aún no están disponibles, en cuyo caso debe salir y volver a 
iniciar sesión de nuevo. Además, si se realiza una auditoría como parte de la 
inicialización, hasta que la auditoría se complete, puede que los datos de configuración 
mostrados no sean totalmente actualizados y precisos. 
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▼ Transferencia del archivo MIB de la biblioteca
Utilice este procedimiento para copiar el archivo base de información de administración 
(MIB) SNMP público a una ubicación especificada en el PC o en la estación de trabajo 
local. El archivo se guarda como archivo de texto. Puede enviar el archivo por correo 
electrónico al representante de asistencia de Sun para que le ayude a diagnosticar 
problemas con la biblioteca. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha TransferFile. 

Se abre la pantalla de transferencia de archivo. 
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4. En el campo Transfer SNMP public MIB text file, haga clic en el botón Transfer. 

Se abre la ventana emergente Save. 

5. Vaya al directorio donde desee guardar el archivo e introduzca el nombre del archivo 
en el campo File Name. Asegúrese de darle el sufijo .txt. 

6. Haga clic en Save. 

Los datos se guardan en el archivo especificado y se muestra el elemento emergente 
Transferred Successful. 

7. Haga clic en OK para descartar el elemento desplegable. 



 

Tareas de utilidad de biblioteca

428 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

▼ Transferencia del archivo de registro de 
instantáneas de biblioteca

Nota: Utilice este procedimiento sólo bajo la dirección del representante de asistencia 
de Sun. El representante de asistencia de Sun debe de haber generado un archivo de 
registro de instantáneas de biblioteca en los 15 minutos anteriores.

Utilice este procedimiento para copiar el archivo de registro de instantáneas de 
biblioteca en una ubicación especificada en el PC o en la estación de trabajo local. El 
archivo se guarda en un formato cifrado y no podrá verlo ni editarlo. Puede enviar el 
archivo por correo electrónico al representante de asistencia de Sun para que le ayude a 
diagnosticar problemas con la biblioteca. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.
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3. Haga clic en la ficha TransferFile. 

Se abre la pantalla de transferencia de archivo. 

4. En el campo Transfer log snapshot file, haga clic en el botón Transfer. 

Se abre la ventana emergente Save. 
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5. Vaya al directorio donde desee guardar el archivo e introduzca el nombre del archivo 
en el campo File Name. 

6. Haga clic en Save. 

Los datos se guardan en el archivo especificado y se muestra el elemento emergente 
Transferred Successful. 

7. Haga clic en OK para descartar el cuadro emergente. 
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Tareas de auditoría

Tarea Página

Auditoría de toda la biblioteca 432

Auditoría de un rango de celdas 434

Ejecución de una auditoría verificada 437
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▼ Auditoría de toda la biblioteca
Durante esta auditoría, el TallBot visita todas las celdas de almacenamiento, clasifica los 
ID de volumen y las ubicaciones, y actualiza la base de datos del controlador de 
biblioteca. 

Nota: Aunque esta auditoría es un proceso en segundo plano y no interrumpe las 
operaciones de la biblioteca, requiere el uso compartido de los recursos de TallBot. Por 
tanto, no se recomienda que ejecute esta auditoría en periodos de actividad máxima. 

Nota: No se puede detener la auditoría una vez que se haya iniciado. La auditoría dura 
aproximadamente 1/2 segundo por ranura de cartucho. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.
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3. Haga clic en la ficha Audit.

Se abre la pantalla Library Audit. 

4. En el campo Entire Library, haga clic en Yes. A continuación, en la barra de opciones, 
haga clic en el botón Audit.

Se abre un cuadro emergente de confirmación. 

5. Haga clic en OK para realizar la auditoría como proceso en segundo plano o en 
Cancelar para cancelar la auditoría.

Nota: Una vez que haya hecho clic en OK, no puede detener la auditoría; la misma se 
ejecutará hasta completarse. 

6. Puede ver el informe de resumen de cartuchos después de unas horas a fin de 
conocer las últimas ubicaciones y los últimos ID de volumen de cartuchos. Consulte 
“Visualización de un informe de biblioteca” en la página 105 para obtener más detalles.
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▼ Auditoría de un rango de celdas
Durante esta auditoría, el TallBot visita sólo un rango específico de celdas de 
almacenamiento (incluidas el CAP y las unidades) y actualiza la base datos del 
controlador de biblioteca.

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha Audit.

Se abre la pantalla Library Audit. 

4. En el campo Entire Library, haga clic en No. En el campo Physical Audit, haga clic en 
Yes. En el campo Verified Audit, haga clic en No.
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5. En los campos Start Address y End Address, seleccione los tipos de dispositivo 
que vaya a auditar y las ubicaciones de la dirección interna de inicio y fin de la 
biblioteca. Consulte “Dirección interna de biblioteca” en la página 489 para obtener 
una explicación detallada sobre este formato de dirección. 

6. En la barra de opciones, haga clic en el botón Audit.

Se abre un cuadro emergente de confirmación. 

7. Haga clic en OK para realizar la auditoría como proceso en segundo plano o en 
Cancelar para cancelar la auditoría.

Nota: Una vez que haya hecho clic en OK, no puede detener la auditoría; la misma se 
ejecutará hasta completarse. 

8. La sección Audit Console muestra el avance de la auditoría. 



 

Tareas de auditoría

436 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

Nota: También puede ver el informe de resumen de cartuchos para conocer las últimas 
ubicaciones y los últimos ID de volumen de cartuchos. Consulte “Visualización de un 
informe de biblioteca” en la página 105 para obtener más detalles.
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▼ Ejecución de una auditoría verificada
La auditoría verificada valida el estado de una ubicación de cartucho o de un rango de 
ubicaciones específicos (incluidos los CAP giratorios y de AEM, y las unidades) en la 
base de datos del controlador de biblioteca. Si la dirección de un cartucho tiene el 
estado verificado de “false”, se realiza una auditoría física de esa ubicación y se 
actualiza la base de datos del controlador de biblioteca. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha Audit.

Se abre la pantalla Library Audit. 
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4. En el campo Entire Library, haga clic en No. En el campo Physical Audit, haga clic en 
No. En el campo Verified Audit, haga clic en Yes. 

5. En los campos Start Address y End Address, seleccione los tipos de dispositivo 
que vaya a auditar y las ubicaciones de la dirección interna de inicio y fin de la 
biblioteca. Consulte “Dirección interna de biblioteca” en la página 489 para obtener 
una explicación detallada sobre este formato de dirección. 

6. En la barra de opciones, haga clic en el botón Audit.

La sección Audit Console muestra el avance de la auditoría. 
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Tareas de utilidad de CAP giratorio y de 
AEM

Tarea Página

Ejecución de una prueba automática en un CAP giratorio o de AEM 440

Variación de un CAP giratorio o de AEM para desconexión 441

Variación de un CAP giratorio o de AEM para conexión 443
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▼ Ejecución de una prueba automática en un CAP 
giratorio o de AEM 

Nota: En la actualidad, las pruebas automáticas de CAP realizan las mismas rutinas 
que la prueba automática de la biblioteca. En el futuro, se podrá disponer de pruebas 
automáticas específicas de CAP giratorio y de AEM.

1. Seleccione Tools > Diagnostics.

2. Expanda la carpeta CAP y haga clic en el CAP al que vaya a realizar la prueba. 

Nota: Los CAP de AEM se identifican de la siguiente manera: columna “–31” para un 
CAP de AEM izquierdo y columna “31” para un CAP de AEM derecho. 

3. Haga clic en la ficha SelfTest.

4. En el menú desplegable Mode, haga clic en Non-Disruptive. 

5. En la barra de opciones, haga clic en el botón Run.

Se muestran mensajes de estado cuando la prueba automática está en ejecución. 
Cuando la prueba finaliza, se muestra un mensaje que indica que el diagnóstico ha 
finalizado. 
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▼ Variación de un CAP giratorio o de AEM para 
desconexión 
Utilice este procedimiento para poner un CAP giratorio o de AEM en desconexión a 
través de SL Console. 

Nota: You should use this procedure only if you are not using ACSLS or HSC tape 
management software, or if their servers are not able to communicate with the library. 
ACSLS and HSC are not notified when the state of the library or its components are 
changed through the SL Console, possibly leading to disruption in library operations. 
For instructions on changing the state of the library and its components through ACSLS 
or HSC, see the appropriate tape management software documentation. 

1. Seleccione Tools > System Detail. 

2. Expanda la carpeta CAP Folder y haga clic en el CAP que desee modificar. 

Nota: Los CAP de AEM se identifican de la siguiente manera: columna “–31” para un 
CAP de AEM izquierdo y columna “31” para un CAP de AEM derecho. 

3. Haga clic en la ficha Status.

La pantalla muestra el estado actual del CAP. 



 

Tareas de utilidad de CAP giratorio y de AEM

442 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

4. En el campo Transition Request, haga clic en Take Offline. Haga clic en Apply. 

Todos los trabajos pendientes para el CAP se completan y, a continuación, el estado del 
CAP cambia, como se indica:

■ Health State: Warn

■ Device State: Not accessible (conexiones de host HLI); Not ready (conexiones de host 
SCSI) 

■ Access State: Offline
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▼ Variación de un CAP giratorio o de AEM para 
conexión 
Utilice este procedimiento para poner un CAP giratorio o de AEM en conexión a través 
de SL Console. 

Nota: You should use this procedure only if you are not using ACSLS or HSC tape 
management software, or if their servers are not able to communicate with the library. 
ACSLS and HSC are not notified when the state of the library or its components are 
changed through the SL Console, possibly leading to disruption in library operations. 
For instructions on changing the state of the library and its components through ACSLS 
or HSC, see the appropriate tape management software documentation. 

Nota: Library devices that are offline in an error state cannot go online; the error 
condition must be cleared first. 

1. Seleccione Tools > System Detail. 

2. Expanda la carpeta CAP Folder y haga clic en el CAP que desee modificar. 

Nota: Los CAP de AEM se identifican de la siguiente manera: columna “–31” para un 
CAP de AEM izquierdo y columna “31” para un CAP de AEM derecho. 
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3. Haga clic en la ficha Status.

La pantalla muestra el estado actual del CAP. 

4. En el campo Transition Request, haga clic en Bring online. Haga clic en Apply. 

El estado del CAP se actualiza de la siguiente manera:

■ Health State: ok

■ Device State: Ready

■ Access State: Online
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Tareas de utilidad de unidades

Tarea Página

Ejecución de una prueba automática de unidades 446

Variación de una unidad para desconexión 447

Variación de una unidad para conexión 448
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▼ Ejecución de una prueba automática de unidades 
1. Seleccione Tools > Diagnostics.

2. Expanda la carpeta Drive Folder y haga clic en la unidad a la que vaya a realizar la 
prueba. 

3. Haga clic en la ficha SelfTest.

4. En el menú desplegable Mode, haga clic en Non-Disruptive. 

5. En la barra de opciones, haga clic en el botón Run.

Se muestran mensajes de estado cuando la prueba automática está en ejecución. 
Cuando la prueba finaliza, se muestra un mensaje que indica que el diagnóstico ha 
finalizado. 
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▼ Variación de una unidad para desconexión 
Utilice este procedimiento para poner una unidad en desconexión a través de 
SL Console. 

Nota: You should use this procedure only if you are not using ACSLS or HSC tape 
management software, or if their servers are not able to communicate with the library. 
ACSLS and HSC are not notified when the state of the library or its components are 
changed through the SL Console, possibly leading to disruption in library operations. 
For instructions on changing the state of the library and its components through ACSLS 
or HSC, see the appropriate tape management software documentation. 

1. Seleccione Tools > System Detail. 

2. Expanda la carpeta Drive Folder y haga clic en la unidad que vaya a modificar. 

3. Haga clic en la ficha Status.

La pantalla muestra el estado actual de la unidad. 

4. En el campo Transition Request, haga clic en Take Offline. Haga clic en Apply. 

Todos los trabajos pendientes para la unidad se completan y, a continuación, el estado 
de la unidad cambia, como se indica:

■ Health State: Warn

■ Device State: Not accessible (conexiones de host HLI); Not ready (conexiones de host 
SCSI) 

■ Access State: Offline
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▼ Variación de una unidad para conexión 
Utilice este procedimiento para poner una unidad en conexión a través de SL Console. 

Nota: You should use this procedure only if you are not using ACSLS or HSC tape 
management software, or if their servers are not able to communicate with the library. 
ACSLS and HSC are not notified when the state of the library or its components are 
changed through the SL Console, possibly leading to disruption in library operations. 
For instructions on changing the state of the library and its components through ACSLS 
or HSC, see the appropriate tape management software documentation. 

Nota: Library devices that are offline in an error state cannot go online; the error 
condition must be cleared first. 

1. Seleccione Tools > System Detail. 

2. Expanda la carpeta Drive Folder y haga clic en la unidad que vaya a modificar. 

3. Haga clic en la ficha Status.

La pantalla muestra el estado actual de la unidad. 

4. En el campo Transition Request, haga clic en Bring online. Haga clic en Apply. 

El estado del Tallbot se actualiza, de la siguiente manera:

■ Health State: ok

■ Device State: Ready

■ Access State: Online
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Tareas de utilidad de TallBot

Tarea Página

Ejecución de una prueba automática de TallBot 450

Variación de un TallBot para desconexión 451

Variación de un TallBot para conexión 452

Definición de un movimiento de diagnóstico 453

Administración de definiciones de movimientos de diagnóstico 458

Guardar un movimiento de diagnóstico en un archivo 460

Inicio de un movimiento de diagnóstico 463

Supervisión y control de los movimientos de diagnóstico abiertos 465
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▼ Ejecución de una prueba automática de TallBot 

Nota: Para realizar una prueba automática de TallBot, los cartuchos de diagnóstico 
deben estar disponibles en la biblioteca. 

1. Seleccione Tools > Diagnostics.

2. Expanda la carpeta Robot Folder y haga clic en el robot al que vaya a realizar la 
prueba. 

3. Haga clic en la ficha SelfTest.

4. En el menú desplegable Mode, haga clic en Non-Disruptive. 

5. En la barra de opciones, haga clic en el botón Run.

Se muestran mensajes de estado cuando la prueba automática está en ejecución. 
Cuando la prueba finaliza, se muestra un mensaje que indica que el diagnóstico ha 
finalizado. 



 

Tareas de utilidad de TallBot

418605401 • Revisión AB Diagnósticos y utilidades de SL Console 451

▼ Variación de un TallBot para desconexión 
Utilice este procedimiento para poner un TallBot en desconexión a través de 
SL Console. 

Nota: You should use this procedure only if you are not using ACSLS or HSC tape 
management software, or if their servers are not able to communicate with the library. 
ACSLS and HSC are not notified when the state of the library or its components are 
changed through the SL Console, possibly leading to disruption in library operations. 
For instructions on changing the state of the library and its components through ACSLS 
or HSC, see the appropriate tape management software documentation. 

1. Seleccione Tools > System Detail. 

2. Expanda la carpeta Robot Folder y haga clic en el TallBot que vaya a modificar. 

3. Haga clic en la ficha Status.

La pantalla muestra el estado actual del TallBot. 

4. En el campo Transition Request, haga clic en Take Offline. Haga clic en Apply. 

Todos los trabajos pendientes para el TallBot se completan y, a continuación, el estado 
del TallBot cambia, como se indica:

■ Health State: Warn

■ Device State: Not accessible (conexiones de host HLI); Not ready (conexiones de host 
SCSI) 

■ Access State: Offline

5. El TallBot se mueve al extremo del raíl y la biblioteca no lo puede utilizar. Si la 
biblioteca está utilizando una función de TallBot redundante, el segundo TallBot se 
hará cargo de todas las solicitudes. 
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▼ Variación de un TallBot para conexión 
Utilice este procedimiento para poner un TallBot en conexión a través de SL Console. 

Nota: You should use this procedure only if you are not using ACSLS or HSC tape 
management software, or if their servers are not able to communicate with the library. 
ACSLS and HSC are not notified when the state of the library or its components are 
changed through the SL Console, possibly leading to disruption in library operations. 
For instructions on changing the state of the library and its components through ACSLS 
or HSC, see the appropriate tape management software documentation. 

Nota: Library devices that are offline in an error state cannot go online; the error 
condition must be cleared first. 

1. Seleccione Tools > System Detail. 

2. Expanda la carpeta Robot Folder y haga clic en el TallBot que vaya a modificar. 

3. Haga clic en la ficha Status.

La pantalla muestra el estado actual del TallBot. 

4. En el campo Transition Request, haga clic en Bring Online. Haga clic en Apply. 

El estado del TallBot se actualiza de la siguiente manera:

■ Health State: ok

■ Device State: Ready

■ Access State: Online
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▼ Definición de un movimiento de diagnóstico 
Se pueden configurar y ejecutar varias rutinas de movimientos de diagnóstico de forma 
simultánea, siempre que los rangos de dirección de destino y conjunto no se solapen. 

Nota: Este procedimiento requiere el uso compartido de los recursos del TallBot; por 
tanto, no se recomienda ejecutarlo durante periodos de actividad máxima. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha DiagMove y, a continuación, en la ficha Manage. 

Se abre la pantalla Diagnostic Move Manage.
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4. En la sección Defined Sequences, haga clic en Add.

Se abre la pantalla TARGET. 

5. Complete la pantalla TARGET de la siguiente manera: Consulte “Rango de dirección 
de destino” en la página 404 para obtener más detalles. 

■ En el campo Selection Mode haga clic en el tipo de celdas que vaya a diagnosticar. 

■ En los campos Minimum Address y Maximum Address, seleccione la dirección 
interna de biblioteca de las ubicaciones de inicio y fin de las celdas que vaya a 
diagnosticar. 



 

Tareas de utilidad de TallBot

418605401 • Revisión AB Diagnósticos y utilidades de SL Console 455

6. Haga clic en Next. 

Se abre la pantalla SOURCE. 

7. Complete la pantalla SOURCE de la siguiente manera: Consulte “Rango de dirección 
de conjunto” en la página 405 para obtener más detalles. 

■ En el campo Selection Mode, haga clic en el tipo de dirección de conjunto de 
cartuchos apropiado. 

■ En los campos Minimum Address y Maximum Address, seleccione la dirección 
interna de biblioteca de las ubicaciones de inicio y fin del conjunto de cartuchos que 
vaya a diagnosticar.
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8. Haga clic en Next.

Se abre la pantalla Sequence. 

9. Complete la pantalla Sequence de la siguiente manera: Consulte “Orden de acceso de 
movimientos” en la página 405 para obtener más detalles. 

■ Name (nombre del movimiento de diagnóstico)

■ Move Count (contador de movimientos, especifique un número entre 1 y 5000)

■ Access Order (orden de acceso, secuencial o aleatorio)

■ Move Type (tipo de movimiento, robot y cartucho o sólo robot) 

■ Desactive la verificación de la compatibilidad de cartuchos de movimiento previo
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10.Haga clic en Finish para completar la instalación.

Se abre la pantalla Diagnostic Move Manage. La secuencia de diagnóstico que acaba de 
definir se incluye en la lista de la sección Defined Sequences. 
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▼ Administración de definiciones de movimientos 
de diagnóstico 
Utilice este procedimiento para administrar definiciones de secuencias de movimientos 
de diagnóstico. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha DiagMove y, a continuación, en la ficha Manage. 

Se abre la pantalla Diagnostic Move Manage.
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4. En la sección Defined Sequences, seleccione una de las siguientes opciones:

5. Para administrar los movimientos de diagnóstico actualmente abiertos, consulte 
“Supervisión y control de los movimientos de diagnóstico abiertos” en la página 465.

Seleccione 
la opción Para Notas

Add Definir un movimiento de 
diagnóstico 

Open Iniciar un movimiento de 
diagnóstico

Se pueden abrir varios movimientos de diagnóstico al 
mismo tiempo siempre que no se solapen las 
configuraciones de los rangos de dirección de destino y 
de conjunto de los movimientos.

Modify Modificar las opciones de un 
movimiento de diagnóstico

La rutina de movimiento de diagnóstico no debe estar 
abierta o si está abierta debe estar en estado “detenida”.

Remove Eliminar un movimiento de 
diagnóstico

La rutina de movimiento de diagnóstico no debe estar 
abierta.

Copy Copiar un movimiento de 
diagnóstico existente

Copie una definición de movimiento de diagnóstico, 
realice cambios si es necesario y asigne otro nombre.
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▼ Guardar un movimiento de diagnóstico en un 
archivo 
Utilice este procedimiento para guardar un movimiento de diagnóstico definido en un 
archivo local en su PC o estación de trabajo. El archivo se guarda como componente de 
JavaBean representado como documento XML 1.0 (.xml). 

Puede usar el archivo guardado de la siguiente manera:

■ Para restaurar un movimiento que se haya borrado de la biblioteca. 

■ Para copiarlo a otra biblioteca a fin de utilizarlo ahí. 

1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.
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3. Haga clic en la ficha DiagMove y, a continuación, en la ficha Manage. 

Se abre la pantalla Diagnostic Move Manage.

4. Haga clic en el movimiento de diagnóstico que desee guardar y, a continuación, haga 
clic en el botón Save de la barra de opciones. 

Se abre la ventana emergente Save.
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5. Vaya al directorio donde desee guardar el archivo. En el campo File Name, introduzca 
el nombre del archivo. 

6. Haga clic en Save. 

Los datos se guardan en el archivo especificado. A continuación se muestra un extracto 
de ejemplo:
<?xml version="1.0" encoding="UTF-8"?> 
<java version="1.5.0_11" class="java.beans.XMLDecoder"> 
 <object class="com.stortek.ats.elib.opel.model.SequenceBeanList"> 
  <string>FRS_4.10</string> 
  <string>SL500</string> 
  <void method="add"> 
   <object class=
"com.stortek.ats.elib.opel.model.SequenceBeanList$SequenceBean"> 
    <void property="accessOrder"> 
     <string>Sequential</string> 
    </void> 
    <void property="moveCartridge"> 
     <boolean>true</boolean> 
    </void> 
    <void property="moveCount"> 
     <int>10</int> 
    </void> 
    <void property="name"> 
     <string>DriveDiagMove1</string> 
    </void> 
    . . .
    <void property="targetType"> 
     <string>Drive</string> 
    </void> 
   </object> 
  </void> 
 </object> 
</java> 
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▼ Inicio de un movimiento de diagnóstico
1. Seleccione Tools > Diagnostics. 

2. Haga clic en la carpeta Library del árbol de dispositivos.

Se abre la pantalla Library.

3. Haga clic en la ficha DiagMove y, a continuación, en la ficha Manage. 

Se abre la pantalla Diagnostic Move Manage.
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4. En la sección Defined Sequences, haga clic en un movimiento de diagnóstico y, a 
continuación, haga clic en Open. 

La ventana Monitor está activada. 

Puede repetir este paso para abrir varios movimientos, siempre que no se solapen los 
rangos de dirección de destino y de conjunto de los movimientos.

Se muestra una ventana de supervisión para cada movimiento que abra.

5. En cada ventana de supervisión, seleccione File > Start Sequence para iniciar el 
movimiento. 
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▼ Supervisión y control de los movimientos de 
diagnóstico abiertos
Utilice este procedimiento para controlar y supervisar el estado de uno o más de los 
movimientos de diagnóstico abiertos. 

1. Consulte “Inicio de un movimiento de diagnóstico” en la página 463 para obtener 
instrucciones sobre cómo empezar uno o más movimientos de diagnóstico. 

2. Haga clic en la ficha Monitor. 

Se abre la pantalla Monitor, con una ventana de supervisión para cada movimiento 
abierto.
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Cada ventana de supervisión tiene los siguientes indicadores de estado:

3. Utilice el menú File en cada ventana Monitor para realizar cualquiera de las 
funciones siguientes:

Indicadores de 
estado Descripción Valores válidos

Spooling Status Indica si la salida del movimiento se está 
enviando a un archivo 

True, False

State Estado de ejecución actual del 
movimiento

En ejecución, poniéndose en 
pausa, en pausa, deteniéndose, 
detenido

Health Estado de salud actual del movimiento OK, aviso, error

Completed moves Número de movimientos finalizados en el 
contador de movimientos solicitado 

Seleccione la opción Para Notas

File > Start Sequence Iniciar 

File > Pause Sequence Poner en pausa Detiene todos los movimientos de 
diagnóstico, pero mantiene la ubicación 
actual en el orden de acceso.

File > Stop Sequence Detener   Detiene el movimiento que está en 
ejecución o en pausa.

File > Start Sequence Reanudar Reanuda un movimiento que está en 
pausa, a partir de la última ubicación 
conocida en el rango de direcciones de 
destino.

File > Clear Output Window Borrar los mensajes que se 
muestran en pantalla

Borra las líneas de mensajes anteriores y 
continúa rellenando la pantalla con 
mensajes nuevos.

Spool File > Start Spooling Enviar datos a archivo Dirige la salida de los movimientos hacia 
un archivo.

Spool File > Stop Spooling Dejar de enviar la salida de 
los movimientos a un 
archivo

Detiene el envío de la salida de los 
movimientos al archivo.
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Tareas de utilidad de la puerta de 
seguridad AEM

Tarea Página

Reinicio de una puerta de seguridad AEM 468
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▼ Reinicio de una puerta de seguridad AEM 
Utilice este procedimiento para reiniciar una puerta de seguridad AEM. Puede 
necesitar hacer esto para borrar errores si la puerta de seguridad AEM ha 
experimentado una condición anormal. 

1. Seleccione Tools > Diagnostics.

2. Expanda la carpeta Safety Door Folder y haga clic en la puerta de seguridad AEM 
que desee reiniciar. 

3. En la barra de opciones, haga clic en Reboot.

Si la biblioteca está conectada, se abre el cuadro emergente Offline Confirm. 
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4. Haga clic en OK para poner la puerta de seguridad en desconexión. 

Se abre el cuadro emergente Reboot Confirm. 

5. Haga clic en OK. 

El controlador de biblioteca reinicia la puerta de seguridad. La puerta de seguridad se 
reinicializa y el TallBot audita el CAP de AEM.

Se abre el cuadro emergente Reboot Success. 

6. Haga clic en OK para descartar el elemento emergente. 
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CAPÍTULO 8

Operaciones manuales

Cuando está en modo de operación manual, la biblioteca no está disponible para acceso 
del host. Esto puede ser porque la biblioteca ha experimentado un error irrecuperable o 
porque un componente de la biblioteca requiere servicio o instalación. Cuando la 
biblioteca está en este modo, los montajes y desmontajes de cartuchos requieren la 
intervención de una persona. 

Seguridad de la biblioteca
Revise detalladamente las medidas de seguridad descritas en esta sección antes de 
entrar en la biblioteca. Es fundamental que siga los procedimientos de seguridad 
adecuados en todo momento. 

Medidas generales de seguridad

Aviso: posible daño físico. Para evitar el cierre por accidente de la puerta de 
acceso mientras alguien está en la biblioteca, se recomienda que cuando abra la 
puerta de acceso, la bloquee mientras esté abierta y guarde la llave con usted. 

Antes de entrar en la biblioteca, asegúrese de: 

■ Conocer la ubicación de los mecanismos de desbloqueo de la puerta de emergencia. 
Consulte “Interbloqueos de puerta en SL3000” en la página 472.

■ Dejar la puerta de acceso abierta siempre que esté trabajando en la biblioteca. Hay 
un interruptor en cada marco de la puerta que desconecta las líneas de señales y de 
potencia CC que van a los motores de la biblioteca cuando una puerta de acceso está 
abierta. Consulte “Interrupción de servopotencia SL3000” en la página 472.

■ Conocer la ubicación de las palancas liberadoras mecánicas de la puerta. Consulte 
“Palancas liberadoras mecánicas de puerta” en la página 473. 

■ Conocer las restricciones físicas. Consulte “Restricciones físicas” en la página 473. 
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Interbloqueos de puerta en SL3000
Los interbloqueos de seguridad de puerta están situados detrás de las puertas de acceso 
frontales del módulo básico y el módulo DEM. Para abrir una puerta de acceso, se 
necesita una clave de acceso. 

Los interbloqueos de seguridad de puerta están constantemente supervisados por el 
controlador de biblioteca. Durante el funcionamiento normal, si se abre una puerta de 
acceso, se inicia una condición de detención de robótica de emergencia y todos los 
motores de la biblioteca se desactivan de forma inmediata. Esto evita que los motores 
estén funcionando mientras una puerta de la biblioteca está abierta. Si la biblioteca se 
varía para que esté en desconexión, la apertura de la puerta de acceso desconecta los 
voltajes CC a los raíles y el bus de potencia. 

Los interruptores de la puerta también se supervisan cuando la biblioteca está 
desconectada. Una batería suministra potencia al circuito para detectar un evento de 
apertura o cierre de puerta mientras la biblioteca está desconectada.

Cuando el módulo básico y el módulo DEM se conectan juntos, al abrir una puerta de 
acceso a cualquiera de los dos módulos se suspenden automáticamente las operaciones 
en toda la biblioteca (los dos interruptores de puerta están conectados en serie).

Interrupción de servopotencia SL3000
Una función de seguridad adicional es la interrupción de la servopotencia (SPI). Si el 
controlador de biblioteca detecta que un motor de la biblioteca falla, generará una SPI 
para cortar el voltaje de la unidad al motor defectuoso. Esto evita un escape de servo 
hasta que se pueda determinar la causa del problema. 
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Palancas liberadoras mecánicas de puerta
Cada controlador de bloqueo en las puertas de acceso del módulo básico y el módulo 
DEM incluye una palanca liberadora mecánica que está pintada en amarillo (vea la 
FIGURA 8-1.) Esta palanca liberadora sirve como medida preventiva en caso de que 
una persona esté dentro de la biblioteca y la puerta de acceso se cierre y se bloquee por 
accidente. Cuando empuja la palanca liberadora, la puerta se desbloquea y se abre. 

FIGURA 8-1 Palanca liberadora mecánica de la puerta 

Iluminación interior
El interior de la biblioteca está siempre iluminado con indicadores LED en el techo. 

Restricciones físicas
La biblioteca no deja mucho espacio libre para movimiento. Debe ser consciente del 
restringido espacio de la biblioteca en todo momento. 

■ Tenga cuidado de no engancharse con las matrices de plástico que alojan los 
cartuchos (sólo 0,4 m [18 pulg.] de espacio libre en pasillo).

■ Tenga cuidado de no golpearse la cabeza o el cuerpo con estos elementos. 

■ Para acceder a un cartucho, es posible que tenga que mover un TallBot, en cuyo caso 
debe tener cuidado de no dañar los componentes electrónicos del TallBot. 

■ Si está cargando o descargando un cartucho manualmente, las manos deben 
permanecer apartadas de los componentes de carga mecánicos y electrónicos del 
cartucho.
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Tareas de operaciones manuales

Tarea Página

Variación de la biblioteca para desconexión 475

Variación de la biblioteca para conexión 477

Apagado de la biblioteca 479

Encendido de la biblioteca 480

Apertura de puerta principal de acceso de la biblioteca 482

Cierre y bloqueo de la puerta principal de acceso de la biblioteca 483

Realización de un “acceso rápido” al AEM 484

Cierre de la puerta de acceso AEM después de un “acceso rápido” 485
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▼ Variación de la biblioteca para desconexión 
Utilice este procedimiento para poner una biblioteca en desconexión a través de 
SL Console. 

Nota: You should use this procedure only if you are not using ACSLS or HSC tape 
management software, or if their servers are not able to communicate with the library. 
ACSLS and HSC are not notified when the state of the library or its components are 
changed through the SL Console, possibly leading to disruption in library operations. 
For instructions on changing the state of the library and its components through ACSLS 
or HSC, see the appropriate tape management software documentation. 

Puede que necesita utilizar este procedimiento en las ocasiones siguientes:

■ Antes de apagar la biblioteca

■ Antes de abrir una puerta de acceso de la biblioteca

■ Cuando la biblioteca no esté operativa y necesite mantenimiento 

1. Varíe todas las unidades de la biblioteca para desconexión. 

Consulte “Variación de una unidad para desconexión” en la página 447 para obtener 
más detalles. 

2. Seleccione Tools > System Detail.

3. Haga clic en la carpeta Library del árbol de dispositivos.
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4. Haga clic en la ficha Status y, a continuación, en la ficha General.

Se muestra el estado actual de la biblioteca. 

5. En el campo Transition Request, haga clic en Take Offline. Haga clic en Apply.

Todos los trabajos pendientes de la biblioteca se completan y, a continuación, el estado 
de la biblioteca cambia, como se indica:

■ Health State: Warn

■ Device State: Not accessible (conexiones de host HLI); Not ready (conexiones de host 
SCSI) 

■ Access State: Offline 
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▼ Variación de la biblioteca para conexión 
Utilice este procedimiento para poner una biblioteca en conexión a través de 
SL Console. 

Nota: You should use this procedure only if you are not using ACSLS or HSC tape 
management software, or if their servers are not able to communicate with the library. 
ACSLS and HSC are not notified when the state of the library or its components are 
changed through the SL Console, possibly leading to disruption in library operations. 
For instructions on changing the state of the library and its components through ACSLS 
or HSC, see the appropriate tape management software documentation. 

Nota: Las unidades LTO Ultrium se activan automáticamente cuando activa la 
biblioteca.

1. Seleccione Tools > System Detail.

2. Haga clic en la carpeta Library del árbol de dispositivos.

3. Haga clic en la ficha Status y, a continuación, en la ficha General.

La pantalla muestra el estado actual de la biblioteca. 

4. En el campo Transition Request, haga clic en Bring online. 
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5. Haga clic en Apply. 

El estado de la biblioteca se actualiza, de la siguiente manera:

■ Health State: ok

■ Device State: Ready

■ Access State: Online

6. Si procede, varíe la biblioteca para ponerla en conexión con hosts ACSLS y HSC. 
Consulte la documentación de HSC o ACSLS para obtener los procedimientos 
detallados. 
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▼ Apagado de la biblioteca
Utilice este procedimiento para apagar la biblioteca. 

1. Varíe todas las unidades de la biblioteca para desconexión. 

Consulte “Variación de una unidad para desconexión” en la página 447 para obtener 
más detalles. 

2. Varíe la biblioteca para ponerla en desconexión. 

Consulte “Variación de la biblioteca para desconexión” en la página 475 para obtener 
más detalles. 

3. Abra las puertas traseras del módulo básico y el módulo DEM (si está). 

4. Apague los interruptores de activación de la potencia. 

5. Si es necesario, apague los cortacircuitos de las PDU. 
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▼ Encendido de la biblioteca
Utilice este procedimiento para encender la biblioteca. Si las puertas de acceso se han 
abierto y cerrado, se realizará una auditoría completa de la biblioteca. 

1. Abra las puertas traseras del módulo básico y el módulo DEM (si está). 

2. Si es necesario, encienda los cortacircuitos de las PDU. 

3. Encienda los interruptores de activación de la potencia. 

4. La biblioteca pasa por la secuencia de inicialización, de la siguiente forma:

Nota:  SL Console obtiene todos los datos de configuración del controlador de 
biblioteca. Por tanto, debe tener cuidado de no iniciar sesión en SL Console antes de 
que la biblioteca se haya inicializado completamente. Podría tener avisos de que los 
datos de configuración aún no están disponibles, en cuyo caso debe salir y volver a 
iniciar sesión de nuevo. Además, si se realiza una auditoría como parte de la 
inicialización, hasta que la auditoría se complete, puede que los datos de configuración 
mostrados no sean totalmente actualizados y precisos. 

1. El código de controlador de la biblioteca está activado.

2. El controlador de biblioteca realiza el reconocimiento electrónico de los componentes 
de la biblioteca:

a. Determina la configuración de potencia CA (N+1 o 2N). 

b. Verifica la función del controlador de unidades de cinta. 

c. Comprueba las funciones opcionales (por ejemplo, un panel de operador local). 

d. Establece comunicación y configuración del controlador de TallBot. 

e. Agrupa todas las unidades de cinta y determina sus ubicaciones. 

f. Realiza consultas de todos los CAP giratorios y de AEM:

- Si la puerta de un CAP está completamente abierta, la puerta se quedará 
abierta. 

- Si el estado de la puerta de un CAP está sin determinar, se actualiza a cerrado 
y bloqueado.

3. El TallBot realiza el proceso de reconocimiento físico:

a. El TallBot barre toda la biblioteca para determinar el tamaño de la misma. 

b. El TallBot escanea el bloque de identificación de módulos en cada módulo. 

c. Según esta información, la biblioteca se configura automáticamente. 

4. Si una de las puertas de acceso se ha cerrado y se ha abierto, se iniciará una auditoría 
de la biblioteca, como se indica: 

a. El TallBot se ocupa de cada columna de conjuntos (de arriba a abajo). 

b. El TallBot escanea cada columna y registra los ID de volumen de todos los 
cartuchos. 

c. La ubicación de cada ID de volumen se registra en la base de datos del 
controlador de la biblioteca. 
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d. Las celdas de almacenamiento sin cartuchos se marcan como vacías.

e. Si se encuentra un cartucho en un CAP giratorio o de AEM, el CAP se cierra y se 
bloquea. 

Nota: Esta auditoría no actualiza las bases de datos de cartuchos del host. Consulte la 
documentación del software de administración de cintas correspondiente para obtener 
detalles sobre la actualización de bases de datos de hosts. 

5. La biblioteca adquiere el estado Ready (preparada).

5. Varíe la biblioteca para ponerla en conexión.

Consulte “Variación de la biblioteca para conexión” en la página 477 para obtener 
instrucciones detalladas. 
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▼ Apertura de puerta principal de acceso de la 
biblioteca 
Utilice este procedimiento para abrir las principales puertas de la biblioteca. 

Aviso: posible daño físico. Para evitar el cierre por accidente de la puerta de 
acceso mientras alguien está en la biblioteca, se recomienda que cuando abra la 
puerta de acceso, la bloquee mientras esté abierta y guarde la llave con usted. 

1. Varíe todas las unidades de la biblioteca para desconexión. 

Consulte “Variación de una unidad para desconexión” en la página 447 para obtener 
más detalles. 

2. Varíe la biblioteca para ponerla en desconexión. 

Consulte “Variación de la biblioteca para desconexión” en la página 475 para obtener 
más detalles. 

3. Inserte la llave en la cerradura de la puerta y gire la llave para desbloquear la puerta. 

4. Levante el seguro de la puerta para liberarla y abra la puerta.

5. Gire la llave en la cerradura, para cerrar la puerta abierta, y, a continuación, quite la 
llave de la cerradura y guárdela con usted. Esto evitará que la puerta se cierre 
mientras está en la biblioteca.

6. Entre en la biblioteca. 
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▼ Cierre y bloqueo de la puerta principal de acceso 
de la biblioteca 
Utilice este procedimiento para cerrar y bloquear las principales puertas de la 
biblioteca. 

1. Compruebe que no hay elementos sueltos en la biblioteca.

2. Si las puertas de acceso están abiertas y bloqueadas, inserte la llave en la cerradura 
de la puerta y gire la llave para desbloquear la puerta. 

3. Empuje la puerta para cerrarla y asegúrese de echar el cierre de seguridad. 

4. Gire la llave en la cerradura para bloquear la puerta y cerrar.

5. Quite la llave de la cerradura y guárdela en un lugar seguro. 

6. Si la biblioteca se ha apagado, enciéndala. 

Consulte “Encendido de la biblioteca” en la página 480 para obtener más detalles. 

Nota: Puesto que las puertas de acceso se han abierto, la biblioteca tendrá que pasar 
una auditoría completa. 
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▼ Realización de un “acceso rápido” al AEM
Utilice este procedimiento para acceder en caso de emergencia al AEM. 

Atención: Este procedimiento tiene el mismo efecto en las operaciones de la biblioteca 
que la apertura de la puerta principal de acceso a la biblioteca. Esto origina una 
interrupción repentina de la actividad de la biblioteca y sólo se debe utilizar en 
circunstancias excepcionales, como un fallo de componentes del AEM. Este 
procedimiento no baja la puerta de seguridad interior AEM. 

Nota: Cuando la puerta de acceso AEM está cerrada, se inicia una auditoría completa 
de toda la biblioteca. Consulte “Cierre de la puerta de acceso AEM después de un 
“acceso rápido”” en la página 485. 

1. Inserte la llave de la puerta de acceso a la biblioteca en la cerradura Deadbolt 
Override y abra la puerta girando la llave en la dirección de las agujas del reloj.

Nota: La llave no se puede quitar de la cerradura mientras está en posición de 
desbloqueo.

2. Levante el seguro de la puerta de acceso AEM y abra la puerta.

Atención: Posible daño de equipo. NO fuerce la apertura o cierre de la puerta de acceso 
AEM.

Se corta todo el suministro de potencia a los raíles y los TallBots se detienen 
automáticamente. 

Todos los trabajos en progreso se detienen repentinamente y los TallBots y CAP de 
AEM se desconectan. 

Atención: La puerta de seguridad AEM no está bajada. 
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▼ Cierre de la puerta de acceso AEM después de un 
“acceso rápido”
Utilice este procedimiento para cerrar la puerta de acceso AEM y reinicializar la 
biblioteca después de haber realizado un “acceso rápido” al AEM. 

Nota: Este procedimiento inicia una auditoría completa de la biblioteca. 

1. Cierre y eche el seguro de la puerta de acceso AEM.

Atención: Posible daño de equipo. NO fuerce la apertura o cierre de la puerta de acceso 
AEM.

2. Cierre la puerta girando la llave en la dirección de las agujas del reloj en la cerradura 
Deadbolt Override. 

■ La biblioteca se reinicializa. 

■ Los TallBots pasan a través de una secuencia de inicialización. 

■ Se lleva a cabo una auditoría completa de la biblioteca. 

■ El CAP de AEM se conecta y se devuelve a su estado prederminado. 
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APÉNDICE A

Direcciones de recursos de biblioteca 

Este apéndice describe los siguientes esquemas de direcciones de la biblioteca: 

■ Dirección interna de biblioteca: la utiliza el controlador de la biblioteca.

■ Ubicaciones HLI-PRC: las utilizan hosts con conexiones TCP/IP a la biblioteca.

■ Ubicaciones de elementos FC-SCSI: las utilizan hosts con conexiones FC SCSI a la 
biblioteca. 

■ Números de hardware de unidad: ranura de matriz física en la que se instala una 
unidad. 

■ Nombres de ámbito mundial (WWN, World-Wide Names) dinámicos de unidad: 
generados automáticamente por el controlador de biblioteca para unidades 
instaladas. 

Estos esquemas se utilizan para localizar todos los recursos de la biblioteca, entre los 
que se incluyen:

■ Celdas de almacenamiento de cartuchos

■ Ranuras de unidad de cinta

■ Unidades instaladas 

■ Celdas del sistema o reservadas

■ Celdas CAP giratorio y de AEM 

Tecnología CenterLine 
El diseño modular de SL3000 utiliza tecnología CenterLine para equilibrar la carga de 
trabajo y mejorar el rendimiento de la biblioteca. El lado izquierdo del módulo básico, 
que el único módulo obligatorio, sirve como eje central. Puede añadir otros módulos a 
la izquierda y derecha del módulo básico. Las columnas situadas a la derecha del eje 
central tienen números positivos (+) y las columnas situadas a la izquierda tienen 
números negativos (–). 
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FIGURA A-1 Direcciones de columnas y eje central 

Eje central

Columnas con numeración negativa (-) Columnas con numeración positiva (+) 

 Unidades -4,    -3,    -2,     -1 1,     2,     3,     4 

Cartuchos -12, -11, -10, -9, -8, -7 -6, -5, -4, -3, -2, -1  1,  2,  3,  4,  5,  6 7,  8,  9,  10, 11, 12
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Dirección interna de biblioteca

Celdas de almacenamiento
Existen cinco componentes en el esquema de direcciones internas de la biblioteca 
SL3000: 

1. Número de biblioteca: siempre “1.” 

2. Número de raíl: siempre “1.”

3. Número de columna: la ubicación horizontal. La numeración de columnas empieza 
en el borde izquierdo de la pared posterior del módulo básico, vista desde la parte 
frontal de la biblioteca. Las columnas situadas a la derecha de este borde, ya sea en 
el módulo básico mismo o en módulos conectados a la derecha, se numeran en 
positivo (+), de izquierda a derecha, empezando por +1. Las columnas en módulos 
conectados a la izquierda del módulo básico se numeran en negativo (–), de derecha 
a izquierda, empezando por –1. 

4. Lado: pared posterior = 1; pared frontal = 2.

5. Fila: la posición vertical. La numeración de filas se ejecuta de arriba a abajo y puede 
ir del 1 al 52. 

Nota: Para cualquier biblioteca, la numeración real de columnas y filas depende 
de los módulos instalados y de la configuración de unidades frente a celdas de 
almacenamiento. Consulte TABLA A-1 en la página 490 para obtener más detalles. 

Ejemplo de dirección interna de biblioteca: módulo básico
Como ejemplo de uso del esquema de direcciones internas de la biblioteca, consulte la 
TABLA A-1 en la página 490, el hardware de unidad número 13 sería 1, 1, +4, 1, 4, de la 
siguiente manera: 

1. Número de biblioteca = 1 

2. Número de raíl = 1

3. Número de columna = +4

4. Lado = 1

5. Fila = 4
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TABLA A-1 Módulo básico: ubicaciones de pared posterior (vistas desde la parte frontal de la biblioteca) 

Fila          +1          +2          +3          +4

   +1     Unidad 4     Unidad 3    Unidad 2      Unidad 1

   +2     Unidad 8     Unidad 7    Unidad 6      Unidad 5

   +3     Unidad 12     Unidad 11    Unidad 10      Unidad 9

   +4     Unidad 16     Unidad 15    Unidad 14      Unidad 13

         +1          +2          +3          +4          +5          +6

+24 Celdas de al-
macena-
miento 

Celdas de 
almacena-
miento 

Celdas de al-
macena-
miento 

Celdas de 
almacena-
miento 

Celdas de al-
macenamien-
to 

Celdas de al-
macenamien-
to   ~

+35

+36 Celdas de al-
macena-
miento 

Celdas de 
almacena-
miento 

Celdas de al-
macena-
miento 

Celdas de 
almacena-
miento 

Celdas de al-
macenamien-
to 

Celdas de al-
macenamien-
to   ~

+48

+49
  ~

Sin conjunto Parte supe-
rior 2 = 
Subordinar

Diagnóstico 
o limpieza 
de 4 celdas

ID de 4 cel-
das

Diagnóstico 
o limpieza 
de 4 celdas

Diagnóstico 
o limpieza 
de 4 celdas

+52 Parte 
inferior = 
Intercambio

Nota: perspectiva desde la parte frontal de la biblioteca.
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Como segundo ejemplo, la ubicación de las dos celdas de entrega de esta pared es...

1. Número de biblioteca = 1

2. Número de raíl = 1

3. Número de columna = +2

4. Lado = 1

5. Filas = 49 y 50

...lo que se traduce en 1, 1, +2, 1, 49 y 1, 1, +2, 1, 50.

Ejemplo de dirección interna de biblioteca: DEM
Consulte la TABLA A-2 en la página 492 para hardware de unidad número 27. Como 
ejemplo de uso del esquema de direcciones internas de la biblioteca, la ubicación de 
esta unidad sería... 

1. Número de biblioteca = 1

2. Número de raíl = 1

3. Número de columna = -3

4. Lado = 1

5. Fila = 1

...lo que se traduce en 1, 1, -3, 1, 1.

Como segundo ejemplo, la ubicación del conjunto de cuatro celdas que puede contener 
cartuchos de diagnóstico en esta pared es...

1. Número de biblioteca = 1

2. Número de raíl = 1

3. Número de columna = -4

4. Lado = 1

5. Filas = 49 a 52

...lo que se traduce en 1, 1, -4, 1, 49 a 1, 1, -4, 1, 52.
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Celdas del sistema/reservadas 
Un total de dos celdas se reservan en el módulo básico sólo para ubicaciones de entrega 
y una celda se reserva como celda de intercambio. Todas las celdas del sistema restantes 
se pueden utilizar para cartuchos de diagnóstico o de limpieza; se incluyen en una lista 
en la TABLA A-3 en la página 493.

Hay un total de 12 celdas para cartuchos de diagnóstico o de limpieza en el módulo 
básico; hay un total de 12 o 15 celdas para cartuchos de diagnóstico o de limpieza en el 
DEM. También se incluyen en una lista en la TABLA A-3 en la página 493.

TABLA A-2 Módulo de expansión de unidades: ubicaciones de pared posterior (vistas desde la parte 
frontal de la biblioteca) 

         -4          -3          -2          -1 Fila

   Unidad 28    Unidad 27   Unidad 26    Unidad 25    1

   Unidad 32    Unidad 31   Unidad 30    Unidad 29    2

         -6          -5          -4          -3          -2          -1

Celdas de 
almacena-
miento

Celdas de 
almacena-
miento

Celdas de 
almacena-
miento

Celdas de 
almacena-
miento

Celdas de 
almacena-
miento

Celdas de 
almacena-
miento

   13

   ~

   23

Celdas de 
almacena-
miento

Celdas de 
almacena-
miento

Celdas de 
almacena-
miento

Celdas de 
almacena-
miento

Celdas de 
almacena-
miento

Celdas de 
almacena-
miento

   24

   ~

   35

Celdas de 
almacena-
miento 

Celdas de 
almacena-
miento 

Celdas de 
almacena-
miento 

Celdas de 
almacena-
miento 

Celdas de 
almacena-
miento 

Celdas de 
almacena-
miento 

   36

   ~

   48

Sin conjun-
to

Parte supe-
rior 2 = Su-
bordinar

Diagnósti-
co o limpie-
za de 4 
celdas

ID de 4 cel-
das

Diagnóstico 
o limpieza 
de 4 celdas

Diagnóstico 
o limpieza 
de 4 celdas

   49
   ~

Parte infe-
rior = In-
tercambio

   52

Nota: perspectiva desde la parte frontal de la biblioteca.
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No hay celdas reservadas en un módulo CEM o PEM.

Celdas CAP 
Las ubicaciones de celda dentro de los CAP siguen un esquema de anotaciones similar 
a las demás ubicaciones dentro de la biblioteca: 

1. Número de biblioteca: (siempre “1”)

2. Número de raíl: (siempre “1”)

3. Número de columna: la ubicación horizontal. La numeración de columna se indica 
a partir del borde izquierdo del módulo básico (si uno se coloca frente a la parte 
frontal interna). A partir de este punto, las columnas se numeran en positivo (+), 
en orden consecutivo, de izquierda a derecha, a lo largo de todos los módulos 
conectados al lado derecho del módulo básico. 

De forma contraria, si un módulo se adjunta a la izquierda del módulo básico, las 
ubicaciones de las columnas se numeran en negativo (–), en orden consecutivo, de 
derecha a izquierda, a lo largo de todos los módulos.

4. Lado: (siempre “2” [pared frontal]).

5. Fila: la posición vertical, según se indica desde la celda superior en la columna. 
Las celdas se numeran del 1 al 13 para el magazine superior y del 14 al 26 para el 
magazine inferior. Los controladores del magazine se sitúan en la parte superior de 
cada magazine de CAP. 

Nota: El controlador del magazine no se cuenta como celda.

TABLA A-3 Celdas reservadas 

Ubicaciones 
de celda Tipo de módulo Uso Ubicación

1, 1, 2, 1, 49 – 50 Módulo básico Subordinar celdas (reservadas)
Pared posterior del módulo 
básico 

1, 1, -4, 1, 49 – 50
DEM Cartuchos de limpieza y 

diagnóstico
Pared posterior del DEM 

1, 1, 2, 1, 51 Módulo básico Celda de intercambio (reservada)
Pared posterior del módulo 
básico 

1, 1, -5, 1, 51 DEM
Cartuchos de limpieza y 
diagnóstico

Pared posterior del DEM 

1, 1, 5, 1, 49 – 52
1, 1, 6, 1, 49 – 52

Módulo básico
Cartuchos de limpieza y 
diagnóstico 

Pared posterior del módulo 
básico 

1, 1, -1, 1, 49 – 52
1, 1, -2, 1, 49 – 52

DEM
Cartuchos de limpieza y 
diagnóstico

Pared posterior del DEM 

 Nota: No coloque cartuchos de datos en una celda reservada. Estas celdas están ocultas para la base 
de datos del cliente (es decir, un TallBot conectado nunca accederá a estas celdas).
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Ejemplos de dirección interna de biblioteca: celdas CAP
La cuarta celda CAP en un módulo básico sería... 

1. Número de biblioteca = 1

2. Número de raíl = 1

3. Número de columna = +5

4. Lado = 2

5. Fila = 4

...lo que se traduce en 1, 1, +5, 2, 4.

La sexta celda CAP en un módulo DEM sería...

1. Número de biblioteca = 1

2. Número de raíl = 1

3. Número de columna = -2

4. Lado = 2

5. Fila = 6

...lo que se traduce en 1, 1, -2, 2, 6.
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Ubicaciones HLI-PRC

Celdas de almacenamiento
La ubicación (dirección) de la interfaz de biblioteca del host, panel, fila, columna (HLI-
PRC) es un valor de ocho -dígitos separado por comas (LL, PP, RR, CC) equivalente a 
LSM, Panel, Row, Column. Este esquema de dirección lo utilizan clientes HLI, entre los 
que se incluyen ACSLS y HSC, para representar las celdas de almacenamiento de 
cartuchos accesibles para estos clientes HLI. 

Nota: La dirección interna de la biblioteca SL3000 identifica la ubicación física del 
cartucho en la biblioteca y el valor HLI-PRC indica la dirección asignada por el 
software del host.

La ubicación de las celdas presenta el formato siguiente: 

donde, 

LL: número LSM (siempre “00”) 
PP: Panel (relativo al módulo básico, números descendentes a la izquierda y números 
ascendentes a la derecha; números pares = paredes posteriores, números impares = 
paredes frontales)

■ Módulo básico = paneles 12 y 13

■ DEM añadido a la izquierda = paneles 10 y 11

Nota: Excepción: Si se añade un CEM a la izquierda de un módulo básico en vez de un 
DEM, la numeración de paneles de ese módulo será 8 y 9 (consulte “Ubicaciones de 
celdas de almacenamiento HLI-PRC: ejemplo 3” en la página 497). Esto permite instalar 
un módulo DEM más adelante sin necesidad de volver a numerar los módulos.

■ módulo añadido a la derecha = paneles 14 y 15

Nota: RR: Fila en el panel (un número del 0 al 51) 
Observe la diferencia aquí. Las filas de la dirección interna de la biblioteca empiezan 
por “1” y las filas HLI-PRC empiezan por “0.”

CC: Columna en la fila (numerada de izquierda a derecha, desde la parte frontal del 
módulo)

Nota: CC: Columnas en el panel (un número del 0 al 5) 
Observe la diferencia aquí. Las columnas de la dirección interna de la biblioteca 
empiezan por “1” y las filas HLI-PRC empiezan por “0.”

      L       L       P       P       R       R       C       C
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Ubicaciones de celdas de almacenamiento HLI-PRC: ejemplo 1
Para ver un ejemplo de cómo se formula este esquema de numeración, consulte la 
TABLA A-4. 

En el ejemplo 1, la biblioteca se compone de dos módulos. La ubicación de las celdas de 
un cartucho en la pared posterior del módulo básico en la columna 5, fila 24, se traduce 
así: 

LL = 00, PP = 12, RR = 24, CC = 05; o bien, 00, 12, 24, 05 

Ubicaciones de celdas de almacenamiento HLI-PRC: ejemplo 2
Añadir un módulo a la izquierda de la biblioteca descrita en el ejemplo 1 ilustra el 
esquema de numeración descendente a la izquierda. Consulte la TABLA A-5 para ver 
cómo funciona esto. 

En este ejemplo, se ha añadido un CEM a la izquierda del DEM. Los paneles ahora 
tienen los números 8 y 9. Añada otro módulo a la izquierda de esta biblioteca y los 
paneles serán 6 y 7. 

De forma contraria, añadir un módulo a la derecha del módulo básico haría que los 
números de los paneles del módulo fueran 14 y 15, y así sucesivamente. 

TABLA A-4 Ubicaciones de celdas de interfaz de biblioteca de host: ejemplo 1

                Módulo de expansión de unidades                       Módulo básico

Pared posterior = Panel 10 Pared posterior = Panel 12

Números de columna de cartuchos Números de columna de cartuchos

0 1 2 3 4 5 0 1 2 3 4 5

0 1 2 3 4 5 0 1 2 3 4 5

Números de columna de cartuchos Números de columna de cartuchos

Pared frontal = Panel 11 Pared frontal = Panel 13

Nota: perspectiva desde la parte frontal de la biblioteca.

TABLA A-5 Ubicaciones de celdas de interfaz de biblioteca de host: ejemplo 2

Módulo de expansión de 
cartuchos

Módulo de expansión de 
unidades

Módulo básico

Pared posterior = Panel 8 Pared posterior = Panel 10 Pared posterior = Panel 12

Números de columna de 
cartuchos

Números de columna de 
cartuchos

Números de columna de 
cartuchos

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

Números de columna de 
cartuchos

Números de columna de 
cartuchos

Números de columna de 
cartuchos

Pared frontal = Panel 9 Pared frontal = Panel 11 Pared frontal = Panel 13

Nota: perspectiva desde la parte frontal de la biblioteca.
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Ubicaciones de celdas de almacenamiento HLI-PRC: ejemplo 3
Para ver una excepción a la numeración de paneles continua, se presenta un tercer 
ejemplo en la TABLA A-6. En esta biblioteca, se han añadido dos módulos CEM a la 
izquierda de un módulo básico. Observe que, sin un DEM, la numeración de los 
paneles situados a la izquierda del módulo básico es ahora 8 y 9, en vez de 10 y 11.

Esto demuestra:

■ La única excepción al esquema de numeración consecutiva de paneles

■ Que si en un futuro se instala un DEM, ninguna numeración de paneles cambiará 
para los módulos existentes

Nota: Este esquema de numeración beneficia enormemente a los clientes ya que el 
hecho de añadir un módulo no requiere ningún cambio en las configuraciones de panel 
existentes.

Aunque el software de administración de cintas del host sigue un esquema de 
numeración de cinco dígitos como el de una dirección SL3000, existen importantes 
diferencias en las designaciones de celdas, comportamiento de CAP giratorio y de AEM 
y otros aspectos de funcionamiento según se describe más abajo.

Si necesita buscar la ubicación HLI-PRC de un cartucho, consulte “Búsqueda de 
cartuchos por ID de volumen” en la página 140. Este procedimiento muestra la 
información del cartucho en los formatos de dirección interna de biblioteca y dirección 
HLI-PRC. 

TABLA A-6 Ubicaciones de celdas de interfaz de biblioteca de host: ejemplo 3

Módulo de expansión de 
cartuchos

Módulo de expansión de 
cartuchos

              Módulo básico

Pared posterior = Panel 6 Pared posterior = Panel 8 Pared posterior = Panel 12

Números de columna de 
cartuchos

Números de columna de 
cartuchos

Números de columna de 
cartuchos

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

0 1 2 3 4 5 0 1 2 3 4 5 0 1 2 3 4 5

Números de columna de 
cartuchos

Números de columna de 
cartuchos

Números de columna de 
cartuchos

Pared frontal = Panel 7 Pared frontal = Panel 9 Pared frontal = Panel 13

Nota: perspectiva desde la parte frontal de la biblioteca.
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Ranuras de unidad
Para las unidades, las ubicaciones HLI-PRC son diferentes de la anotación que verá con 
celdas de almacenamiento de cartuchos. La TABLA A-7 ilustra cómo funciona este 
esquema de numeración, visto desde la parte posterior de la biblioteca. 

■ Los números estándar se corresponden con la numeración física de las unidades.

■ Los números de superíndice (en negrita) se corresponden con las ubicaciones HLI-
PRC (fila).

■ La numeración HLI-PRC es secuencial de derecha a izquierda, de 0 a 3, para la 
primera fila (parte superior) del primer módulo.

■ El esquema de numeración secuencial de HLI-PRC se reinicia, de derecha a izquierda 
y de 0 a 3, en el módulo siguiente.

■ El número de columna es siempre 0.

Ubicaciones de unidades HLI-PRC: ejemplo 1
Las unidades utilizan números de unidad en lugar de ubicaciones de fila y columna. El 
número de unidad se asigna a la posición tomada por una fila de celda, y la posición 
tomada por una columna de celda es siempre “00”. Por ejemplo, el hardware de unidad 
de cinta número 20 es equivalente a esta ubicación HLI-PRC:

Biblioteca = 00

Panel = 12

Unidad = 16

Columna = 00

TABLA A-7 Ubicaciones de unidades de cinta de interfaz de biblioteca del host

Módulo básico Módulo de expansión de unidades

Panel posterior =12 Panel posterior =10

        13         22         31         40         253         262         271         280

        57         66         75         84         297         306         315         324

        911         1010         119         128         3311         3410         359         368

        1315         1414         1513         1612         3715         3814         3913         4012

        1719         1818         1917         2016         4119         4218         4317         4416

        2123         2222         2321         2420         4523         4622         4721         4820

        4927         5026         5125         5224

        5331         5430         5529         5628

Notas: Perspectiva desde la parte posterior de la biblioteca.
Los números de superíndice (en negrita) representan las ubicaciones HLI-PRC (que se traducen 
en el número de fila).
La anotación de número estándar representa el número de hardware de la unidad. 
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Ubicaciones de unidades HLI-PRC: ejemplo 2
Como segundo ejemplo, ir de una ubicación HLI-PRC a una ubicación de hardware, la 
unidad de cinta 00, 10, 25, 00 es equivalente al hardware de unidad de cinta número 51.

Celdas CAP 
Las ubicaciones HLI-PRC de los CAP son diferentes de las notación que se utiliza para 
celdas de almacenamiento de cartuchos. Los CAP utilizan números CAP en lugar de 
números de panel. 

CAP giratorios
■ Biblioteca = siempre 00

■ CAP = de 01 a 10, de la siguiente manera:

■ CEM de lado izquierdo = de 01 a 04, de izquierda a derecha

■ DEM = 05

■ Módulo básico = 06

■ CEM de lado derecho = de 06 a 10, de izquierda a derecha

■ Filas = de 00 a 25

■ Columna = siempre 00

CAP de AEM
■ Biblioteca = siempre 00

■ CAP de AEM = 00 ó 11, de la siguiente manera:

■ AEM del lado izquierdo = 00

■ AEM del lado derecho = 11

■ Filas = de 00 a 38

■ Columnas = de 00 a 05 
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Ubicaciones de elementos FC-SCSI
Puesto que la biblioteca SL3000 también ofrece una interfaz de control (biblioteca) Fibre 
Channel, debe conocer la numeración de cartucho, CAP y unidad según los elementos 
FC-SCSI. 

La TABLA A-8 en la página 501 muestra ubicaciones de elementos FC-SCSI para las 
paredes posteriores de una biblioteca que tiene: 

■ Cuatro módulos

■ 166 celdas de almacenamiento de cartuchos con licencia 
■ 36 unidades de cinta 

La TABLA A-9 en la página 502 muestra elementos FC-SCSI para las paredes frontales 
de la misma biblioteca.

Nota: Las dos tablas presentan una lista de los elementos FC-SCSI para una biblioteca 
nativa no particionada.
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La TABLA A-8 y la TABLA A-9 son sólo ejemplos que se muestran para que observe 
que la numeración de elementos FC-SCSI es: 

■ Para elementos de almacenamiento: de arriba a abajo, de izquierda a derecha, 
empezando en la pared posterior (visto desde la parte frontal, con número 2000) y 
continuando con el mismo esquema en las paredes frontales (visto desde la parte 
frontal de la biblioteca). 

■ Para elementos CAP giratorio CAP (elementos de importación y exportación): de 
arriba a abajo, de izquierda a derecha, empezando por el elemento número 10 en el 
CAP del módulo situado más a la izquierda.

■ Unidades de cinta (elementos de transferencia de datos): izquierda a derecha, de 
arriba a abajo, empezando en el eje central del módulo básico (elemento 1000) y 
continuando en el módulo DEM. 

Una ranura de unidad vacante no se incluirá en la secuencia. 

TABLA A-8 Ubicaciones de elementos FC-SCSI: paredes posteriores (visto desde la parte frontal) 

Módulo de 
expansión 
de cartuchos

Módulo de expansión de 
unidades 

(Eje central)
Módulo básico 

(Eje central)

Módulo de 
expansión 
de 
cartuchos

2000 2010 1022 1023 1024 1025 1000 1001 1002 1003 2060 2070

2001 2011 1026 Vacío 1027 1028 1004 1005 1006 1007 2061 2071

2002 2012 1029 1030 Vacío 1031 1008 1009 1010 1011 2062 2072

2003 2013 1032 1033 1034 1035 1012 1013 1014 1015 2063 2073

2004 2014 2020 2026 2032 2038 1016 Vacío 1017 1018 2064 2074

2005 2015 2021 2027 2033 2039 1019 1020 1021 Vacío 2065 2075

2006 2016 2022 2028 2034 2040 2044 2048 2052 2056 2066 2076

2007 2017 2023 2029 2035 2041 2045 2049 2053 2057 2067 2077

2008 2018 2024 2030 2036 2042 2046 2050 2054 2058 2068 2078

2009 2019 2025 2031 2037 2043 2047 2051 2055 2059 2069 2079

Notas: Las unidades de cinta comienzan la numeración desde el eje central (pared izquierda del 
módulo básico).
Las ranuras de unidades de cinta vacías no se cuentan.
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La TABLA A-9 muestra ubicaciones de elementos FC-SCSI para las paredes frontales de 
la misma biblioteca, vista de frente. 

TABLA A-9 Ubicaciones de elementos FC-SCSI: paredes frontales (visto desde la parte frontal) 

Módulo de 
expansión 
de cartuchos

Módulo de expansión de 
unidades 

(Eje central)
Módulo básico 

(Eje central)

Módulo de 
expansión 
de 
cartuchos

2080 2090 2100 2107   (CAP) 10 2123 2130   (CAP) 36 2146 2156

2081 2091 2101 2108              2124 2131               2147 2157

2082 2092 2102 2109               2125 2132               2148 2158

2083 2093 2103 2110             ~ 2126 2133             ~ 2149 2159

2084 2094 2104 2111               2127 2134               2150 2160

2085 2095 
Segu-
ro de 
puerta

2112               
Segu-
ro de 
puerta

2135               2151 2161

2086 2096 2113               35 2136              51 2152 2162

2087 2097 2114 2117 2120 2137 2140 2143 2153 2163

2088 2098 2105 2115 2118 2121 2128 2138 2141 2144 2154 2164

2089 2099 2106 2116 2119 2122 2129 2139 2142 2155 2155 2165

Notas: Perspectiva por la parte frontal de la biblioteca.
Las ubicaciones de celdas de almacenamiento de cartuchos son consecutivas, ignorando las 
ubicaciones para los seguros de puerta.
Las celdas CAP son únicas y secuenciales, de izquierda a derecha, según se ve por la parte 
frontal de la biblioteca.



Números de hardware de unidad

418605401 • Revisión AB Apéndice A Direcciones de recursos de biblioteca 503

Números de hardware de unidad
El número de hardware de una unidad es exclusivamente interno de la biblioteca y se 
define por el cableado eléctrico a la ranura de unidad. Estos números se imprimen en 
calcos en el interior de las puertas posteriores de los módulos de la biblioteca.

La TABLA A-10 presenta este esquema de numeración para el módulo básico, según se 
ve desde la parte posterior del módulo. La TABLA A-11 en la página 504 presenta la 
numeración del DEM.

TABLA A-10 Numeración de unidades de cinta del módulo básico: hardware 

Número de 
conjunto Bandejas de unidades

1 Unidad 1 Unidad 2 Unidad 3 Unidad 4

Unidad 5 Unidad 6 Unidad 7 Unidad 8

Número de 
conjunto Bandejas de unidades

2 Unidad 9 Unidad 10 Unidad 11 Unidad 12

Unidad 13 Unidad 14 Unidad 15 Unidad 16

Número de 
conjunto Bandejas de unidades

3 Unidad 17 Unidad 18 Unidad 19 Unidad 20

Unidad 21 Unidad 22 Unidad 23 Unidad 24

Nota: Los números mostrados se indican en la parte posterior del módulo básico.
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Nombres de ámbito mundial (WWN, 
World-Wide Names) dinámicos de unidad
Los nombres de ámbito mundial dinámicos (dWWN) de unidad, o direcciones Fibre 
Channel, los genera automáticamente el controlador de biblioteca durante la 
inicialización de la biblioteca. Los dWWN se asignan a las ranuras de unidad de la 
biblioteca en vez de a los dispositivos. Si se reemplaza una unidad, la nueva unidad 
recibe el mismo nombre que la reemplazada, eliminando así la necesidad de volver a 
configurar el sistema. Hay tres WWN reservados para cada ranura de unidad: nodo, 
puerto A y puerto B.

Nota: La función dWWN generalmente se activa en el momento de la instalación. La 
biblioteca y las unidades de cinta deben tener todas un firmware compatible con la 
función dWWN. Cuando la función dWWN está activada, todas las unidades deben 
estar en el nivel de firmware apropiado. Si una unidad tiene firmware de nivel bajo, 
permanece en estado de “en configuración” y no está disponible para uso en el host.

TABLA A-11 Numeración de unidades de cinta del módulo de expansión de unidades: hardware

Número de 
conjunto Bandejas de unidades

1 Unidad 25 Unidad 26 Unidad 27 Unidad 28

Unidad 29 Unidad 30 Unidad 31 Unidad 32

Número de 
conjunto Bandejas de unidades

2 Unidad 33 Unidad 34 Unidad 35 Unidad 36

Unidad 37 Unidad 38 Unidad 39 Unidad 40

Número de 
conjunto Bandejas de unidades

3 Unidad 41 Unidad 42 Unidad 43 Unidad 44

Unidad 45 Unidad 46 Unidad 47 Unidad 48

Número de 
conjunto Bandejas de unidades

4 Unidad 49 Unidad 50 Unidad 51 Unidad 52

Unidad 53 Unidad 54 Unidad 55 Unidad 56

Nota: Los números mostrados se indican en la parte posterior del DEM.
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APÉNDICE B

Diagramas de pared 

Este apéndice contiene diagramas y tablas que incluyen detalles de lo siguiente:

■ “Paredes de módulo básico” en la página 506

■ “Paredes de módulo de expansión” en la página 507

■ “Paredes de módulo de expansión de cartuchos” en la página 508

■ “Paredes de módulo de expansión de parking” en la página 510

■ “Paredes de módulo de expansión de acceso” en la página 511

■ “Bloque de configuración” en la página 512

■ “Numeración de filas” en la página 513

■ “Celdas de sistema/reservadas” en la página 514
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Nota: Las celdas en gris claro no están accesibles a menos se instale un módulo 
adyacente en ese lado. 

FIGURA B-1 Paredes de módulo básico

Módulo básico 
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 ■ 140 celdas de 
cartucho de datos

■ Con CAP giratorio de 
26 celdas 

■ Con ventana o panel 
de operador

■ 163 celdas de cartucho 
de datos 

■ Con CAP giratorio de 
26 celdas 

■ Con conjunto de 
cartuchos en ventana

P
ar

ed
 p

o
st

er
io
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■ 8 ranuras de unidad 
de cinta 

■ 180 cartuchos de 
datos 

■ 16 ranuras de unidad 
de cinta 

■ 125 cartuchos de 
datos 

■ 24 ranuras de unidad 
de cinta 

■ 65 cartuchos de datos 
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Nota: Las celdas en gris claro no están accesibles a menos se instale un módulo 
adyacente en ese lado. 

FIGURA B-2 Paredes de módulo de expansión 

Módulo de expansión de unidades 
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■ 253 celdas de 
cartucho 

■ Con conjunto de 
cartuchos en 
ventana 

■ Sin CAP giratorio

■ 230 celdas de 
cartucho 

■ Con ventana o 
panel de operador 

■ Sin CAP giratorio 

■ 176 celdas de 
cartucho 

■ Con CAP giratorio 
de 26 celdas 

■ Con conjunto de 
cartuchos en 
ventana 

■ 153 celdas de 
cartucho 

■ Con CAP giratorio 
de 26 celdas 

■ Con ventana o 
panel de operador 

P
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ed
 p

o
st
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■ 8 ranuras de unidad 
de cinta 

■ 180 cartuchos de 
datos 

■ 16 ranuras de 
unidad de cinta 

■ 125 cartuchos de 
datos 

■ 24 ranuras de 
unidad de cinta 

■ 65 cartuchos de 
datos 

■ 32 ranuras de 
unidad de cinta 

■ 0 cartuchos de datos 
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FIGURA B-3 Paredes de módulo de expansión de cartuchos 

Módulo de expansión de cartuchos izquierdo 

Pared frontal 
■ 260 celdas de 

cartucho 

Pared frontal 
■ 182 celdas de 

cartucho
■ Con CAP giratorio 

de 26 celdas 

Pared posterior 
■ 256 celdas de 

cartucho

Módulo de expansión de cartuchos derecho 

Pared posterior 
■ 308 celdas de 

cartucho 

Pared frontal 
■ 234 celdas de 

cartucho 
■ Con CAP giratorio 

de 26 celdas 

Pared frontal 
■ 312 celdas de 

cartucho 
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Nota: Las celdas en gris claro no están accesibles a menos se instale un módulo 
adyacente en ese lado. 
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Nota: Seis columnas de conjuntos (tres en pared posterior y tres en pared frontal, en los 
lados izquierdo y derecho) no están accesibles para una unidad robótica defectuosa. 

FIGURA B-4 Paredes de módulo de expansión de parking 

Módulo de expansión de parking izquierdo 

Pared frontal 
■ 156 celdas de 

cartucho 

Pared posterior 
■ 152 celdas de 

cartucho 

Módulo de expansión de parking derecho 

Pared posterior 
■ 156 celdas de 

cartucho 

Pared frontal 
■ 156 celdas de 

cartucho 
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FIGURA B-5 Paredes de módulo de expansión de acceso 

Módulo de expansión de acceso izquierdo. 

Pared frontal 
■ 117 celdas CAP de 

AEM 

Pared posterior 
■ 117 celdas CAP de 

AEM

Módulo de expansión de acceso derecho 

Pared posterior 
■ 117 celdas CAP de 

AEM 

Pared frontal 
■ 117 celdas CAP de 

AEM 
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Bloque de configuración
Cada módulo de la biblioteca SL3000 tiene un bloque de configuración en la parte 
inferior de la pared posterior, columna 4, filas 49, 50, 51 y 52. Este bloque identifica los 
elementos siguientes: 

■ Tipo de módulo 

■ Configuración de pared posterior 

■ Configuración de pared frontal 

■ Opciones para ese módulo

Durante la inicialización de la biblioteca, la unidad robótica visita este bloque de 
configuración para determinar la configuración del módulo.

FIGURA B-6 Bloque de configuración 

Tipos de módulo: 

■ Módulo básico 
■ DEM 
■ CEM 

■ PEM
■ AEM 

Configuración de pared posterior: 

Destino 

Configuración de pared frontal: 

Opciones: 

■ Panel de operador 
local 

■ Ventana 
■ Conjuntos de 

cartuchos

I   I\I   I
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Numeración de filas 
FIGURA B-7 Numeración de filas 

Ejemplo 1 
Módulo 
básico 

Ejemplo 2 
CEM 

Las filas indican la ubicación vertical de un 
cartucho o una unidad de cinta.

Las filas siempre son números positivos. 

Las filas de celdas de almacenamiento se 
numeran de arriba  (1) a abajo  (52). 
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Celdas de sistema/reservadas 
El módulo básico y el módulo de expansión de unidades tienen ranuras especiales en la 
parte inferior de la pared posterior. Estas ranuras incluyen funciones especiales para la 
biblioteca y las unidades de cinta. 

La FIGURA B-8 muestra un ejemplo de estas ranuras: 

1. Ranuras de intercambio (2) en columna 2, filas 49 y 50.

2. Ranura de diagnóstico (1) en columna 2, fila 51. 

3. Ranuras de diagnóstico (4) en columna 3, filas 49, 50, 51 y 52. 

4. Bloque de configuración en columna 4, filas 49, 50, 51 y 52.

5. Cartuchos de limpieza (4) en columna 5, filas 49, 50, 51 y 52. 

6. Cartuchos de limpieza (4) en columna 6, filas 49, 50, 51 y 52. 

FIGURA B-8 Ranuras reservadas 

Intercam-
bio Diag-
nóstico

Diagnósti-
co

Bloque 
de confi-
guración

Limpieza Limpieza

Destino
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APÉNDICE C

Manejo de los cartuchos 

Este apéndice contiene información sobre el etiquetado y manejo de los cartuchos de 
cinta utilizados en las bibliotecas Sun StorageTek. 

Requisitos de cartucho
Los cartuchos de la biblioteca deben satisfacer las especificaciones definidas en 
American National Standard Magnetic Tape and Cartridge for Information Interchange. 
Consulte las publicaciones y el sitio web del proveedor de unidades para obtener 
información específica sobre requisitos y especificaciones de cartucho.

Los cartuchos de color sólo son válidos si la densidad reflectora medida es superior a 
0,1 según la medición realizada con un densitómetro de reflexión de color X-rite 404G. 
Para obtener más información acerca de los cartuchos de color, póngase en contacto con 
el representante comercial de Sun StorageTek. 

Las medidas de los cartuchos de color son:

Para obtener más información acerca de los cartuchos de color, póngase en contacto con 
el representante comercial de Sun StorageTek.

Ancho de banda Banda ancha de estado T de ANSI (380 a 780 nm)

Margen de medida Densidad (0,00 a 2,50) D

Precisión ±0,02 D

Repetibilidad ±0,01 D

Diámetro de apertura 3,4 mm (0,13 pulg.)
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Etiquetas de cartucho válidas 
Los cartuchos de la biblioteca deben estar etiquetados con una etiqueta externa válida. 
La biblioteca admite varias etiquetas de código de barras Código 39 estándar. 

Notas: 

■ No se admiten los cartuchos sin etiqueta. Consulte “Cartuchos sin etiqueta” en la 
página 520.

Sun StorageTek ofrece cartuchos preetiquetados. Para obtener información sobre cómo 
pedir estos cartuchos, consulte “Pedido de cartuchos y etiquetas” en la página 522.

Si no ordena cartuchos preetiquetados, consulte “Aplicación de la etiqueta del cartu-
cho” en la página 522 para obtener instrucciones detalladas sobre cómo etiquetar los 
cartuchos correctamente. Sun StorageTek no suministra etiquetas de cartucho. Para ob-
tener información solamente sobre suministradores de etiquetas, consulte “Pedido de 
cartuchos y etiquetas” en la página 522. 

Dominio de medio e ID de medio
El dominio de medio y el ID de medio identifican conjuntamente el medio y el uso de 
un cartucho en la biblioteca. Permiten combinar tipos de unidad de cinta y tipos de 
medios en una biblioteca. La etiqueta de ID de medio equivale a la unidad o transporte 
de cinta que puede usar el cartucho. El dominio de medio refleja el uso del cartucho: 
datos, limpieza y diagnóstico.

Cartuchos de limpieza y diagnóstico 
Los cartuchos de limpieza tienen CLN en el VOLID; los cartuchos de diagnóstico tienen 
DG en el VOLID

Cada kit de limpieza y diagnóstico contiene un cartucho de limpieza etiquetado y un 
cartucho de diagnóstico etiquetado, con un número de serie de volumen de 0 (cero) 
para cada uno. Se incluyen etiquetas adicionales de limpieza y diagnóstico con cada 
biblioteca. 

Los cartuchos de limpieza y diagnóstico no se pueden usar como cartuchos nuevos ni 
pueden ser inicializados por utilidades de software.

Atención: ERROR DEL PROCEDIMIENTO: Cuando se introduce un cartucho de 
limpieza, el software considera que el cartucho es nuevo y establece el contador de uso 
en cero. NO VUELVA A INTRODUCIR UN CARTUCHO DE LIMPIEZA QUE LA 
BIBLIOTECA EXPULSE MEDIANTE EL CAP. 
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Códigos de cartucho
La biblioteca SL3000 admite tres tipos de etiquetas de código de barras: 

■ Para las unidades T9x40, se admiten las etiquetas de 1/2 pulgada suministradas 
por Trioptic (Engineered Data Products/Colorflex) o Tricode (American Eagle/
Writeline). Las dos versiones requieren un tipo diferente de ID de medio, el cual es 
un carácter. 

■ Para las unidades T10000, se admiten etiquetas con ocho caracteres y los dos últimos 
son los caracteres obligatorios de dominio de ID de medio y de tipo de ID de medio.

■ Para las unidades LTO®, se admiten etiquetas con ocho caracteres y los dos últimos 
son los caracteres obligatorios de dominio de ID de medio y tipo de ID de medio. 

■ Para unidades SDLT, etiquetas con siete caracteres, los últimos de éstos son los 
caracteres obligatorios ID de medio. 

Sun Unidades de cinta y cartuchos StorageTek 
Las etiquetas de cartucho para Sun StorageTek T9840 (modelos C y D) y las unidades 
de cinta T10000 se enumeran en la TABLA C-1. Dichas unidades de cinta también 
admiten cifrado. 

TABLA C-1 Sun Códigos de cartucho StorageTek 

ID de medio Tipo de cartucho

VOLID + R Cartucho de datos T9840

VOLID + R (fondo verde) Cartucho de datos T9840C VolSafe

VOLID + R (fondo morado) Cartucho de datos T9840D VolSafe

CLN (espacio en blanco) VOLID + U Cartucho de limpieza T9840

CLN (espacio en blanco) VOLID + Y Cartucho de limpieza T9840D (Nota: 
T9840D tiene un cartucho de limpieza 
único).

DG (espacio en blanco) VOLID + R Cartucho de diagnóstico T9840 

VOLID + T1 Cartucho de datos T10000

DG (espacio en blanco) VOLID + T1 Cartucho de diagnóstico T10000

CLN (espacio en blanco) VOLID + 
CT

Cartucho de limpieza T10000

VOLID + TS Cartucho de datos T10000 (sport)

DG (espacio en blanco) VOLID + TS Cartucho de diagnóstico T10000 (sport)

CLN (espacio en blanco) VOLID + 
CT

Cartucho de limpieza T10000 (sport)
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Cartuchos y unidades de cinta LTO

Nota: La tecnología LTO fue desarrollada inicialmente por IBM, Hewlett-Packard y 
Quantum. LTO es una tecnología de “formato abierto", lo cual significa que los usuarios 
tienen varias fuentes de productos y medios. 

Las etiquetas de cartucho LTO tienen ocho caracteres. Los dos últimos caracteres son los 
identificadores de medios (L3, L4, LT o LU). CLN y DG son los primeros caracteres en 
las etiquetas de limpieza o diagnóstico. Las unidades de cinta LTO 4 también admiten 
cifrado. 

Manejo de los cartuchos
El manejo incorrecto de los cartuchos podría originar la pérdida de datos o dañar algún 
componente de la biblioteca. Para manejar los cartuchos correctamente:

■ No transporte varios cartuchos de forma suelta en un contenedor. Los bloques de 
carga se podrían enganchar con otros cartuchos y el cierre podría abrirse. 

Nota: Los cartuchos T9940 y LTO Ultrium tienen bloques de carga. Los cartuchos T9840 
no los tienen.

TABLA C-2 Códigos de cartuchos LTO  

ID de medio Tipo de cartucho

L3 Cartucho de datos de generación 3

L4 Cartucho de datos de generación 4

LT Una sola escritura y varias lecturas 
(WORM), 400 GB
Esta función evita que el usuario altere o 
borre información de la cinta. Para obtener 
más información, vaya al sitio web del 
proveedor y haga una búsqueda de 
WORM. 

LU Una sola escritura y varias lecturas 
(WORM), 800 GB

CLN (espacio en blanco) + CU Cartucho de limpieza universal
Sun recomienda el uso de la etiqueta 
universal CLN + CU en vez de una etiqueta 
única de proveedor (CLN + C1 para 
Hewlett-Packard o CLN + C2 para IBM).

DG (espacio en blanco) + VOLID Cartucho de diagnóstico (aplique una 
etiqueta DG a un cartucho de datos en 
blanco para usar en pruebas de diagnóstico 
de biblioteca) 
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■ Asegúrese de que el bloque de carga tenga el cierre ajustado cada vez que agarre un 
cartucho. 

■ Mantenga los cartuchos limpios. 

■ Revise el cartucho antes de cada uso y nunca ponga un cartucho dañado en una 
unidad o biblioteca. 

■ Nunca libere el bloque de carga ni tire de la cinta de un cartucho. 

■ Nunca abra un cartucho. 

■ No manipule la cinta que esté fuera del cartucho ya que podría dañar el borde de la 
cinta. 

■ No exponga la cinta ni el cartucho a la luz directa del sol o a la humedad. 

■ No exponga un cartucho grabado a campos magnéticos ya que podría destruir los 
datos de la cinta. 

Inserción de un cartucho en una unidad o celda
Si un cartucho está defectuoso o sucio podría dañar la unidad. Revise siempre el 
cartucho antes de insertarlo en una unidad o en una biblioteca de cintas. Busque:

■ Cartucho resquebrajado o roto

■ Cargador roto

■ Puerta de acceso a la cinta rota

■ Selector de protección del archivo o conmutador de protección contra escritura 
dañados

■ Líquido en el cartucho

■ Etiquetas incorrectamente adheridas o que sobrepasen el borde del cartucho

■ Cualquier otro daño evidente

El cartucho se debe insertar en una celda de almacenamiento, en una celda CAP 
giratorio o de AEM o en una unidad con el código de barras en la parte inferior y el 
identificador de volumen (VOLID) legible de derecha a izquierda. El eje del cartucho 
siempre debe estar abajo. 

Cartuchos ilegibles
Los cartuchos se podrían identificar como ilegibles por las razones siguientes:

■ Cartuchos sin etiqueta

■ Cartuchos al revés

HSC y ACSLS expulsan automáticamente los cartuchos ilegibles de la biblioteca. Es 
probable que los hosts FC-SCSI no lo hagan; el cartucho ilegible se podría mover 
automáticamente a un CAP durante la inicialización de la biblioteca. 

Nota: Si se le informa que hay un gran número de cartuchos ilegibles, existe la 
posibilidad de haya una cámara o un escáner TallBotdefectuoso. Esto podría ocasionar 
que numerosos cartuchos se expulsen por error de la biblioteca. 



Cartuchos ilegibles

520 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

Cartuchos sin etiqueta
Los cartuchos sin etiquetas externas no se admiten totalmente en SL3000. Los cartuchos 
sin etiqueta no se montarán en las unidades; sin embargo, se pueden mover entre los 
CAP y las celdas de almacenamiento. 

■ Si se coloca un cartucho sin etiqueta en un CAP, TallBot dejará el cartucho allí. La 
disposición del cartucho depende del software del host. 

■ Si un cartucho sin etiqueta se coloca en una celda de almacenamiento de la 
biblioteca, durante la auditoría el cartucho se considerará como “un tipo de medio 
no válido e ilegible”. Según el software del host, es posible que el host no reconozca 
el cartucho o que se expulse el mismo a través del CAP. 

Cartuchos al revés
La inserción de cartuchos al revés no se debe intentar nunca, sobre todo con los 
cartuchos Sun StorageTek. El modo en que la biblioteca trate esta situación depende del 
tipo de cartucho.

Sun Cartuchos StorageTek 

Atención: Los cartuchos Sun StorageTek al revés no encajan en las celdas de 
almacenamiento de la biblioteca y podría dañarse el cartucho y el TallBot.

■ Si se coloca un cartucho Sun StorageTek al revés en un magazine CAP, el CAP no se 
podrá cerrar. 

■ Si se coloca un cartucho Sun StorageTek al revés en una celda de almacenamiento de 
biblioteca, el cartucho podría extenderse desde la celda de almacenamiento y dañar 
el TallBot. 

Cartuchos LTO
■ Si se coloca un cartucho LTO al revés en un magazine CAP, TallBot dejará el cartucho 

allí. La disposición del cartucho depende del software del host. 

■ Si se coloca un cartucho LTO al revés en una celda de almacenamiento de la 
biblioteca, durante la auditoría el cartucho se considerará como “un tipo de medio 
no válido e ilegible”. Según el software del host, es posible que el host no reconozca 
el cartucho o que se expulse el mismo a través del CAP. 
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Mantenimiento de los cartuchos
La sección siguiente describe las instrucciones generales de mantenimiento de los 
cartuchos 

Limpieza del exterior del cartucho 

Atención: DAÑO DE LOS CARTUCHOS: Ciertos disolventes podrían dañar los 
cartuchos. NO UTILICE ACETONA, TRICLOROETANO, TOLUENO, XILENO, 
BENCENO, CETONA, METILETILCETONA, CLORURO DE METILENO, 
ETILDICLORO, ÉTERES, ACETATO ETÍLICO O SUSTANCIAS QUÍMICAS SIMILARES 
PARA QUITAR LAS ETIQUETAS O LIMPIAR LOS CARTUCHOS. 

Limpie el polvo, la suciedad y la humedad de los cartuchos con un trapo que no deje 
pelusa. 

Para limpiar los cartuchos, utilice las toallitas de limpieza de cintas de StorageTek, 
PN 4046289-01. Dichas toallitas están empapadas con alcohol isopropílico. Vigile que 
las soluciones no toquen la cinta ni entren en el cartucho. 

Reparación de un bloque de carga suelto
Si se daña un cartucho T9940 o LTO Ultrium, utilice una cinta de reserva si es posible. 
Si se suelta un bloque de carga de cartucho, no cuenta con una cinta de reserva y el 
cartucho o la cinta no tienen daños evidentes, puede reparar el bloque de carga usando 
un kit de reparación suministrado por el proveedor de la cinta. Puede usar la cinta una 
sola vez para copiar los datos en otra cinta. 

Almacenamiento de los cartuchos
Siga estas instrucciones para el almacenamiento de los cartuchos:

■ No saque el cartucho del envoltorio protector hasta que lo tenga que utilizar. Para 
quitar el envoltorio, utilice la tira de rasgado y no un instrumento punzante. 

■ Almacene los cartuchos en un entorno limpio que duplique las condiciones de la 
habitación en la que se utilicen. 

■ Antes de usar un cartucho, asegúrese de que éste haya estado en su entorno 
operativo al menos durante 24 horas.

■ El almacenamiento de los archivos es de 1 a 10 años para las cintas de cartucho 9x40 
y de 15 a 30 años para las cintas de cartucho LTO Ultrium.
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Pedido de cartuchos y etiquetas
Póngase en contacto con un agente de ventas autorizado de Sun StorageTek para 
obtener cartuchos etiquetados.

Para adquirir etiquetas de cartucho, póngase en contacto con EDP/Colorflex mediante:

■ Teléfono: (0)1 888 438 8362 (local e internacional)
■ Sitio web: http://www.colorflex.com

Para obtener respuestas a preguntas técnicas, póngase en contacto con el servicio de 
ventas de Sun StorageTek mediante:

■ Teléfono: 1 800 275 4785
■ Correo electrónico: sales_support@storagetek.com 

▼ Aplicación de la etiqueta del cartucho
1. Asegúrese de que el cartucho haya estado a temperatura ambiental durante al menos 

24 horas.

2. Limpie la superficie donde se vaya a colocar la etiqueta con una solución especial 
para este propósito. Consulte “Limpieza del exterior del cartucho” en la página 521. 

3. Pele la parte posterior de la etiqueta VOLID. 

4. Ponga el cartucho en una superficie plana, en la posición en la que se inserta en la 
unidad de cinta. 

5. Coloque la etiqueta VOLID con los caracteres de código de barras debajo de los 
caracteres alfanuméricos. Presiónela para que se adhiera.

Nota: En las etiquetas VOLID LTO Ultrium, los caracteres alfanuméricos pueden estar 
horizontales o verticales.

6. Si el cartucho tiene una etiqueta de cliente, coloque la etiqueta en el área y presione 
para que se adhiera. 

7. Repita los pasos del 2 al 5 para la etiqueta de ID de medio.

8. La etiqueta debe estar dentro del área marcada del cartucho, de modo que los bordes 
de la etiqueta estén paralelos con los bordes del cartucho. La etiqueta debe estar 
cerca del borde interior del área marcada pero no debe nunca solapar el borde de 
dicha área. 

Notas: 

■ Asegúrese de que la etiqueta no esté colocada en ningún otro lugar de la superficie 
del cartucho. 

■ Asegúrese de que los bordes de la etiqueta no se enrollen ya que esto haría que el 
cartucho se atasque en el cargador de la unidad. 

■ Utilice etiquetas que no dejen restos cuando se quiten. 

■ Asegúrese de que la etiqueta contenga un VOLID.

http://www.colorflex.com
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APÉNDICE D

Servidor de SL Console en Web

SL Console en Web es una función estándar de la SL3000 y se incluye en el CD 
distribuido con cada biblioteca. Permite instalar SL Console en un servidor web 
centralizado. Los clientes individuales podrán utilizar un explorador web compatible 
para descargar SL Console en Web. 

SL Console en Web se implementa en forma de archivo Java WebARchive (.war). 

Factores de seguridad
El cliente es responsable de la implementación de todos los sistemas de seguridad 
correspondientes, como los cortafuegos, el acceso de los usuarios, etc. 

Requisitos de servidor
Puede implementar SL Console en Web en cualquier servidor web que sea compatible 
con la plataforma J2EE (Java 2 Platform, Enterprise Edition). Se recomienda que utilice 
Java System Web Server. 

Nota: En todos los procedimientos que aparecen en este documento se entiende que 
está utilizando el programa Java System Web Server. 
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Instalación y administración del servidor
La instalación y administración del servidor SL Console en Web comprende los 
siguientes procedimientos:

■ “Descarga de Java System Web Server” en la página 524

■ “Instalación de Java System Web Server” en la página 528

■ “Inicio de sesión en Java System Web Server Administration Console” en la 
página 532

■ “Instalación e implementación de SL Console en Web” en la página 535

■ “Inicio de SL Console en Web” en la página 541

■ “Actualización de SL Console en Web” en la página 543

▼ Descarga de Java System Web Server
Utilice este procedimiento para descargar Java System Web Server, si no está instalado 
ya en su servidor. 

Nota: El procedimiento requiere que tenga un nombre de usuario y una contraseña de 
cuenta en línea Sun (Sun Online Account). 

1. Abra un explorador web y en la barra o campo de direcciones, escriba la dirección 
URL de la página de servidores Web de Sun:

http://www.sun.com/download/index.jsp?cat=Web%20%26%20Proxy%20Servers&tab=3&subcat=Web%20Servers  

2. En la página de los servidores Web, haga clic en el enlace de servidor web que se 
corresponda con la plataforma de su servidor. 
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3. En la pantalla Sun Java System Web Server (será distinta según la selección del paso 
anterior), desplácese para ver la lista de plataformas compatibles y haga clic en 
Download. 

4. En la pantalla Sun Download Center Login, escriba su nombre de usuario y 
contraseña, y haga clic en Login.
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Nota: Si todavía no tiene una cuenta, haga clic en Register Now y siga las 
instrucciones para crear una cuenta. 

5. En la pantalla Sun Download Center, realice las siguientes selecciones:

■ Haga clic en el botón de radio Accept License Agreement.
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■ Haga clic en el enlace de Sun Java System Web Server que se corresponda con la 
plataforma de su servidor.

6. En el cuadro emergente, haga clic en Save to Disk para guardar el archivo 
comprimido en el directorio de su elección y, a continuación, haga clic en OK. 

Nota: El proceso puede tardar varios minutos.

7. Con una utilidad de extracciones apropiada (por ejemplo: gunzip, pkunzip), 
descomprima los archivos Sun Java System Web Server y guárdelos en el directorio 
que desee. 



 

Instalación y administración del servidor

528 Guía del usuario de SL3000 • Mayo de 2009 Revisión AB • 418605401

▼ Instalación de Java System Web Server 
Utilice este procedimiento para instalar el programa Java System Web Server, si no está 
instalado ya en su servidor. 

1. En el directorio donde están guardados los archivos de Sun Java System Web Server, 
haga doble clic en el archivo de instalación, o bien, ejecútelo por línea de comandos 
(setup o setup.exe, según la plataforma). 

Si realiza la instalación en la plataforma Solaris, quizá tenga que invocar los permisos 
root o sudo, según el directorio en el que vaya a instalar. Si es así, proceda con los 
siguientes pasos:

a. cd directorio_de_extracción

donde directorio_de_extracción es el directorio donde ha guardado los archivos 
comprimidos de Java Web Server. 

b. xhost + 

c. sudo ./setup 

2. En la pantalla de bienvenida Welcome, haga clic en Next. 
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3. En la pantalla Software License Agreement, haga clic en el botón de radio Yes y, a 
continuación, en Next. 

4. En la pantalla Select Installation Directory, especifique el directorio donde va a 
instalar el programa Web Server, y haga clic en Next.
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5. En la pantalla Type of Installation, haga clic en Express y, a continuación, en Next.

6. En la pantalla Administration Server Settings, especifique una contraseña segura 
para el usuario admin, y haga clic en Next. 
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7. En la pantalla Ready to Install, compruebe la información de instalación y haga clic 
en Install Now. 

Comienza la instalación y aparece una pantalla con la barra de progreso. 

8. En la pantalla Installation Complete, compruebe la información y escriba la dirección 
URL de la consola de administración que aparece en el paso número 2 de "Next 
Steps". Necesitará la dirección URL para el siguiente procedimiento. 

9. Haga clic en Finish para salir del programa de instalación. 
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▼ Inicio de sesión en Java System Web Server 
Administration Console

1. Inicie el programa Sun Java System Web Server, si no está ya en ejecución: 

■ En Windows, haga clic en Start > All Programs > Sun Microsystems >Web 
Server 7.0 > Start Administration Server. 

■ En Solaris, abra una ventana de terminal y escriba lo siguiente:

sudo /opt/webserver7/admin-server/bin/startserv 

Nota: Espere varios minutos para que se inicie el servidor. 

2. Abra un explorador web y en la barra o campo de direcciones, escriba la dirección 
URL de la página que anotó al final del procedimiento anterior (“Instalación de Java 
System Web Server”). Se abrirá la consola de administración. 

3. En el cuadro emergente, acepte el certificado del servidor y, a continuación, haga clic 
en OK. 
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4. En el explorador web donde abrió la dirección URL de la consola de administración, 
escriba el nombre de usuario y la contraseña admin, y haga clic en Log in. 
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5. Aparece la pantalla Common Tasks. 
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▼ Instalación e implementación de SL Console en 
Web 

Nota: Antes de realizar esta tarea, debe obtener el CD de instalación de SL Console en 
Web. 

1. En el servidor, inserte en la unidad el CD de instalación de SL Console en Web. 

2. Conéctese a la consola de administración Java System Web Server Consulte “Inicio de 
sesión en Java System Web Server Administration Console” en la página 532 para 
obtener más detalles. 

3. En la pantalla Common Tasks, haga clic en Add Web Application.

4. En la pantalla Add Web Application, haga lo siguiente:

■ Web Application Location: haga clic en el botón Browse y busque la ubicación del 
archivo opel.war en el CD de instalación. 

■ URI: escriba /opel

■ Deje los demás campos con los valores predeterminados. 
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■ Haga clic en OK. 
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5. En la pantalla Web Applications, haga clic en Save.
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6. En la pantalla actualizada Web Applications, haga clic en el enlace Deployment 
Pending situado en la esquina superior derecha. 

7. En la pantalla Configuration Deployment, haga clic en Deploy. 
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8. En la pantalla Results, haga clic en Close. 
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9. La pantalla Web Applications muestra un mensaje que indica que la aplicación se ha 
añadido correctamente. 

Puede hacer clic en el botón Home, situado en la esquina superior derecha, para volver 
a la pantalla Common Tasks. 
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▼ Inicio de SL Console en Web 
1. Conéctese a la consola de administración Java System Web Server Consulte “Inicio de 

sesión en Java System Web Server Administration Console” en la página 532 para 
obtener más detalles. 

2. En la pantalla Common Tasks, haga clic en Start/Stop Instances. 
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3. En la pantalla Configuration Instances, haga clic en la casilla situada junto a la 
instancia local del servidor SL Console en Web y, a continuación, haga clic en Start. 

Se inician las instancias de la aplicación SL Console en Web y aparece una pantalla con 
barra de progreso. 

4. En la pantalla Results, haga clic en Close. 
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▼ Actualización de SL Console en Web 
Puede actualizar SL Console en Web mientras está en ejecución. Las actualizaciones 
se propagarán automáticamente a los clientes cuando éstos obtienen la aplicación 
SL Console en Web del servidor. 

Nota: Antes de realizar esta tarea, debe obtener el CD de actualización de SL Console 
en Web. 

1. En el servidor, inserte el CD de actualización de SL Console en Web en la unidad. 

2. Conéctese a la consola de administración Java System Web Server Consulte “Inicio de 
sesión en Java System Web Server Administration Console” en la página 532 para 
obtener más detalles. 

3. En la pantalla Common Tasks, haga clic en Edit Virtual Server.
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4. En la pantalla General Properties, haga clic en la ficha Web Applications.

5. En la pantalla Web Applications, haga clic en la casilla situada junto al URI /opel y, a 
continuación, haga clic en Update.
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6. En la pantalla Update Web Application, haga lo siguiente:

■ Web Application Location: Haga clic en el botón Browse y vaya a la ubicación del 
archivo opel.war en el CD de actualización. 

■ Deje los demás campos con los valores predeterminados. 

■ Haga clic en OK. 

Comienza la actualización del servidor y aparece una pantalla con barra de progreso. 
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7. En la pantalla Web Applications, haga clic en el enlace Deployment Pending situado 
en la esquina superior derecha. 

8. En la pantalla Configuration Deployment, haga clic en Deploy. 

Comienza la implementación y aparece una pantalla con barra de progreso. 
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9. En la pantalla Results, haga clic en Close para volver a la pantalla Web Applications. 
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Problemas comunes y soluciones
Esta sección describe las soluciones de algunos problemas comunes que ocurren 
durante la instalación y el mantenimiento de Java System Web Server. 

Errores de instalación de Windows 2000 Sun Java 
System Web Server 

Error de Windows MSVCP60.dll 
Si realiza la instalación en una plataforma Windows 2000 que no incluye la DLL de 
tiempo de ejecución de Microsoft Visual C v6, MSVCP60.dll, durante la instalación se 
producirán errores similares al de abajo:
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El registro de instalación del servidor web contendrá errores similares al siguiente:

▼ Solución del error de Windows MSVCP60.dll 
Utilice el siguiente procedimiento para solucionar el error de Windows MSVCP60.dll. 

1. Realice una búsqueda en la Web para encontrar la cadena siguiente:

msvcp60.dll download 

2. Descargue el archivo DLL en el directorio /winnt/system32. 

3. Elimine el directorio en el que ha instalado parcialmente Java System Web Server 
durante la instalación fallida.

4. Repita la instalación de Java System Web Server desde el principio.

La instalación debe finalizar correctamente sin repetirse el error. 
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▼ Errores de instalación Sun Java System Web 
Server en los sistemas Solaris 9 y 10

Error de Java Home
Si no puede iniciar la instancia del servidor y recibe mensajes de error que indican que 
falló el HotSpot y que no pudo encontrarse la JVM, debe cambiar la configuración de 
Java Home de la aplicación Sun Java System Web Server. 

▼ Solución del error de Java Home en Solaris 
Utilice el siguiente procedimiento para solucionar el error de Java Home: 

1. Conéctese a la consola de administración Java System Web Server Consulte “Inicio de 
sesión en Java System Web Server Administration Console” en la página 532 para 
obtener más detalles. 

2. Seleccione Home > Common Tasks. 

3. En Configuration Tasks, haga clic en Edit Java Settings. 
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4. En Java Home, introduzca el directorio donde está instalado JDK o JRE. Por ejemplo:

/usr/java 

Nota: Es posible que también deba cambiar los permisos en el directorio de nivel 
superior donde ha instalado Sun Java System Web Server. Para que un usuario no raíz 
pueda iniciar una instancia del servidor, el usuario debe tener permiso de escritura en 
el directorio del servidor. Por ejemplo, si ha instalado el servidor en el directorio de 
nivel superior /opt/webserver7, el usuario que inicia la instancia del servidor debe 
poder escribir en este directorio y en el directorio https-nombre_de_servidor situado 
debajo. Para obtener más información, vaya al sitio de Sun Java System Web Server. 
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